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About this Manual

1 Preface

1.1 About this Manual

This User Manual describes general instrument functions and settings common to all
applications and operating modes in the R&S FPS. Furthermore, it provides all the
information specific to RF measurements in the Spectrum application. All other
operating modes and applications are described in the specific application manuals.

The main focus in this manual is on the measurement results and the tasks required to
obtain them.

Manual operation

6 Although the R&S FPS does not have a built-in display, it is recommended that you
connect an external monitor to the instrument initially to get familiar with the instrument
and its manual operation before using it in pure remote mode. Thus, this manual starts
with a detailed description on how to operate the instrument manually using an exter-
nal monitor and mouse. The commands required for remote operation are provided as
a reference at the end of this document.

The following topics are included:

® Welcome to the R&S FPS
Introduction to and getting familiar with the instrument

® Operating Modes and Applications
The concept of using multiple operating modes

® Measurements
Descriptions of the individual measurements in the Spectrum application, including
result types and configuration settings.

e Common Measurement Settings
Description of the measurement settings common to all measurement types with
their corresponding remote control commands

® Common Measurement Analysis and Display Functions
Description of the settings and functions provided to analyze results independently
of the measurement type with their corresponding remote control commands

e Data Management
Description of general functions to handle data files (configuration and result data,
not I/Q data)

® General Instrument Setup
Description of general instrument settings and functions that are independant of
the current operating mode

® Network and Remote Operation
Detailed information on setting up the instrument in a network and operating it
remotely.

¢ Remote Commands
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Remote commands required to configure and perform measurements in a remote
environment, sorted by tasks

Remote commands required to set up the environment and to perform common
tasks on the instrument, sorted by tasks

Programming examples demonstrate the use of many commands and can usually
be executed directly for test purposes

® Maintenance
Information on tasks required to maintain operability of the instrument

® Troubleshooting
Hints and tips on how to handle errors

® List of Commands
Alphabetical list of all remote commands described in the manual

® |ndex

1.2 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description
"Graphical user interface ele- All names of graphical user interface elements on the screen, such as
ments" dialog boxes, menus, options, buttons, and softkeys are enclosed by

quotation marks.

KEYS Key names are written in capital letters.

File names, commands, File names, commands, coding samples and screen output are distin-

program code guished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.
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2.1

2.2

2.3

Service Manual

Documentation Overview

This section provides an overview of the R&S FPS user documentation. Unless speci-
fied otherwise, you find the documents on the R&S FPS product page at:

www.rohde-schwarz.com/manual/FPS

Getting Started Manual

Introduces the R&S FPS and describes how to set up and start working with the prod-
uct. Includes basic operations, typical measurement examples, and general informa-
tion, e.g. safety instructions, etc.

A printed version is delivered with the instrument. A PDF version is available for down-
load on the Internet.

User Manuals and Help

Separate user manuals are provided for the base unit and the firmware applications:

® Base unit manual
Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control com-
mands with programming examples, and information on maintenance, instrument
interfaces and error messages. Includes the contents of the getting started manual.

® Firmware application manual
Contains the description of the specific functions of a firmware application, includ-
ing remote control commands. Basic information on operating the R&S FPS is not
included.

The contents of the user manuals are available as help in the R&S FPS. The help
offers quick, context-sensitive access to the complete information for the base unit and
the firmware applications.

All user manuals are also available for download or for immediate display on the Inter-
net.

Service Manual

Describes the performance test for checking the rated specifications, module replace-
ment and repair, firmware update, troubleshooting and fault elimination, and contains
mechanical drawings and spare part lists.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):


http://www.rohde-schwarz.com/manual/FPS

24

2.5

2.6

2.7

2.8

Application Notes, Application Cards, White Papers, etc.

https://gloris.rohde-schwarz.com

Instrument Security Procedures

Deals with security issues when working with the R&S FPS in secure areas. It is avail-
able for download on the Internet.

Basic Safety Instructions

Contains safety instructions, operating conditions and further important information.
The printed document is delivered with the instrument.

Data Sheets and Brochures

The data sheet contains the technical specifications of the R&S FPS. It also lists the
firmware applications and their order numbers, and optional accessories.

The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/FPS

Release Notes and Open Source Acknowledgment
(OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The open source acknowledgment document provides verbatim license texts of the
used open source software.

See www.rohde-schwarz.com/firmware/FPS

Application Notes, Application Cards, White Papers,
etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/FPS


https://gloris.rohde-schwarz.com/irj/portal/SearchDetailView?downloadContainerID=28942
http://www.rohde-schwarz.com/brochure-datasheet/FPS
http://www.rohde-schwarz.com/firmware/FPS
http://www.rohde-schwarz.com/application/FPS

3 Welcome to the R&S FPS

The R&S FPS is a new high-performance Rohde & Schwarz signal and spectrum ana-
lyzer developed to meet demanding customer requirements. Offering low phase noise,
wide analysis bandwidth and straightforward and intuitive operation, the analyzer
makes measurements fast and easy.

This user manual contains a description of the functionality that the instrument pro-
vides, including remote control operation. The latest version is available for download
at the product homepage (http://www2.rohde-schwarz.com/product/FPS.html).


http://www2.rohde-schwarz.com/product/FPS.html
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4 Getting Started

Note: the following chapters are identical to those in the printed R&S FPS Getting Star-

ted manual.

®  Preparing fOr USE....uuiii ittt sttt e e e e e s sb e e s s nnreee e e 20
®  INSITUMENT TOUN ...t e e e e e e e e e e e e e e ennnnes 35
®  MiINIAture DiSPIAY........coiiiiiuiiiiiiiiiie et 41
o Controlling the R&S FPS RemOtely.....cccooiiiiiiiiiiiiii e 50
e Operating the Instrument in Manual MOdE...........ccueeeeiieiiiiiiiiicceeeeee e 80

4.1 Preparing for Use

o  Putting into OPeration..........ooiiiiiii e 20
e  Windows Operating SYStEM.........uuuiiiiiiiiiei it e e ssrerrr e e e e e e e e e s e esenrnnes 25
®  ConNECtiNg USB DEVICES.......ccccuiiiiieiiiei e ettt e e e e e s e s e e e e e e e e e e e s e ennrenes 30
e Performing a Self Alignment and @ Self TeSt.......cccovccieieiiicer e, 31
e Checking the Supplied OpPtioNS.........ccceiicciiiie e 33
e Protecting Data Using the Secure User MOde..........cccueeieiiiiiiiiiiiiicie e 33

411 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S FPS for
the first time.

Risk of injury due to disregarding safety information

Observe the information on appropriate operating conditions provided in the data sheet
to prevent personal injury or damage to the instrument. Read and observe the basic
safety instructions provided with the instrument, in addition to the safety instructions in
the following sections. In particular:

® Do not open the instrument casing.

Risk of instrument damage due to inappropriate operating conditions

Specific operating conditions are required to ensure accurate measurements and to
avoid damage to the instrument. Observe the information on appropriate operating
conditions provided in the basic safety instructions and the instrument's data sheet.
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Instrument damage caused by electrostatic discharge

Electrostatic discharge (ESD) can damage the electronic components of the instrument
and the device under test (DUT). Electrostatic discharge is most likely to occur when
you connect or disconnect a DUT or test fixture to the instrument's test ports. To pre-
vent electrostatic discharge, use a wrist strap and cord and connect yourself to the
ground, or use a conductive floor mat and heel strap combination.

Risk of instrument damage due to inappropriate operating conditions

An unsuitable operating site or test setup can damage the instrument and connected
devices. Before switching on the instrument, observe the information on appropriate
operating conditions provided in the data sheet. In particular, ensure the following:

® All fan openings are unobstructed and the airflow perforations are unimpeded. The
minimum distance from the wall is 10 cm.

® The instrument is dry and shows no sign of condensation.

® The instrument is positioned as described in the following sections.

® The ambient temperature does not exceed the range specified in the data sheet.
® Signal levels at the input connectors are all within the specified ranges.

® Signal outputs are connected correctly and are not overloaded.

EMI impact on measurement results
Electromagnetic interference (EMI) may affect the measurement results.

To suppress generated electromagnetic interference (EMI):

® Use suitable shielded cables of high quality. For example, use double-shielded RF
and LAN cables.

® Always terminate open cable ends.
® Note the EMC classification in the data sheet.

e Unpacking and Checking the Instrument...........cccccveeiiiiiiiciiieee e, 21
®  ACCESSONY LISt .iiiiiiiiiiiiiiicccciie e e e e e e e e e e e e e ae e e e eaaaara—a 22
e Placing or Mounting the Instrument...........c.oooi e 22
o  Connecting the AC POWET...... ...t e e e e 24
e Switching the Instrument On and Off..........ooo i, 24

4.1.1.1 Unpacking and Checking the Instrument

Check the equipment for completeness using the delivery note and the accessory lists
for the various items. Check the instrument for any damage. If there is damage, imme-
diately contact the carrier who delivered the instrument. Make sure not to discard the
box and packing material.
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Packing material
Retain the original packing material. If the instrument needs to be transported or ship-
ped later, you can use the material to protect the control elements and connectors.

Risk of injury during transportation

The carrying handles at the front and side of the casing are designed to lift or carry the
instrument. Do not apply excessive force to the handles. If a handle is ripped off, the
falling instrument can cause injury.

Be aware of the weight of the instrument when lifting it. Observe the information on
transporting heavy instruments in the basic safety instructions provided with the instru-
ment.

41.1.2 Accessory List

The instrument comes with the following accessories:

® Power cable
® "Getting Started" printed manual

4.1.1.3 Placing or Mounting the Instrument

The R&S FPS is designed for use under laboratory conditions, either on a bench top or
in a rack.

Bench Top Operation

If the R&S FPS is operated on a bench top, the surface should be flat. The instrument
can be used in horizontal position, standing on its feet, or with the support feet on the
bottom extended.
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Risk of injury if feet are folded out

The feet can fold in if they are not folded out completely or if the instrument is shifted.
Collapsing feet can cause injury or damage the instrument.

® Fold the feet completely in or out to ensure stability of the instrument. Never shift
the instrument when the feet are folded out.

® When the feet are folded out, do not work under the instrument or place anything
underneath.

® The feet can break if they are overloaded. The overall load on the folded-out feet
must not exceed 500 N.

R Frmax

Risk of injury when stacking instruments

A stack of instruments can tilt over and cause injury if not stacked correctly. Further-
more, the instruments at the bottom of the stack can be damaged due to the load
imposed by the instruments on top.

Observe the following instructions when stacking instruments:

® Never stack more than three instruments. If you need to stack more than three
instruments, install them in a rack.

® The overall load imposed on the lowest instrument must not exceed 500 N.

® ltis best if all instruments have the same dimensions (width and length).
If you need to stack smaller instruments on the top, the overall load imposed on the
lowest instrument must not exceed 250 N.

® |f the instruments have foldable feet, fold them in completely.
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Rackmounting

The R&S FPS can be installed in a rack using a rack adapter kit (Order No. see data
sheet). The installation instructions are part of the adapter kit.

Risk of instrument damage due to insufficient airflow in a rack

If the instrument is run with insufficient airflow for a longer period, the instrument over-
heats, which can disturb the operation and even cause damage.

Make sure that all fan openings are unobstructed, that the airflow perforations are
unimpeded, and that the minimum distance from the wall is 10 cm.

41.1.4

4115

Connecting the AC Power

In the standard version, the R&S FPS is equipped with an AC power supply connector.
The R&S FPS can be used with different AC power voltages and adapts itself automat-
ically to it. Refer to the datasheet for the requirements of voltage and frequency. The
AC power connector is located on the rear panel of the instrument.

For details on the connector refer to Chapter 4.2.2.10, "AC Power Supply Connection
and Main Power Switch", on page 40.

» Connect the R&S FPS to the AC power supply using the supplied power cable.
Since the instrument is assembled in line with the specifications for safety class
EN61010, it may only be connected to an outlet that has a ground contact.

Switching the Instrument On and Off

Switching the instrument on

> Press the AC power switch on the rear panel to position "I".

The instrument is supplied with AC power. After booting, the instrument is ready for
operation. A green LED above the POWER key indicates this.

Warm-up time for OCXO

When the instrument is switched on, the OCXO requires an extended warm-up time
(see data sheet).

Switching the instrument off
1. Press the POWER key on the front panel of the R&S FPS.

2. Change the AC power switch on the rear panel to position "O", or disconnect the
instrument from the AC power supply.

The R&S FPS changes into off mode.
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Risk of losing data

If you switch off the running instrument using the rear panel switch or by disconnecting
the power cord, the instrument loses its current settings. Furthermore, program data
can be lost.

Press the Power key first to shut down the application properly.

41.2

Windows Operating System

The instrument contains the Windows 7 operating system which has been configured
according to the instrument's features and needs. Changes in the system setup are
only required when peripherals like keyboard or a printer are installed or if the network
configuration does not comply with the default settings. After the R&S FPS is started,
the operating system boots and the instrument firmware is started automatically.

To ensure that the instrument software functions properly, certain rules must be
adhered to concerning the operating system.

Risk of rendering instrument unusable

The instrument is equipped with the Windows 7 operating system. You can install addi-
tional software on the instrument, however, additional software can impair instrument
function. Thus, run only programs that Rohde & Schwarz has tested for compatibility
with the instrument software.

The drivers and programs used on the instrument under Windows 7 are adapted to the
instrument. Only install update software released by Rohde & Schwarz to modify exist-
ing instrument software.

The following program packages have been tested:
® Symantec Endpoint Security — virus-protection software
® FileShredder - for reliable deletion of files on the hard disk

Error message display

Note that any error messages caused by the Windows 7 operating system are only
visible on an external monitor or via Remote Desktop from a controller PC. Thus, if
operation of the R&S FPS seems to fail for no obvious reason, try connecting a monitor
or a controller PC to check for any messages awaiting confirmation or action.

(See Chapter 4.1.3, "Connecting USB Devices", on page 30 or Chapter 4.4.6, "How
to Set Up Remote Desktop", on page 70)
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4.1.2.1 Virus Protection

Take appropriate steps to protect your instruments from infection. Use strong firewall
settings and scan any removable storage device used with a Rohde & Schwarz instru-
ment regularly. It is also recommended that you install anti-virus software on the instru-
ment. Rohde & Schwarz does NOT recommend running anti-virus software in the
background ("on- access" mode) on Windows-based instruments, due to potentially
degrading instrument performance. However, Rohde & Schwarz does recommend run-
ning it during non-critical hours.

For details and recommendations, see the following Rohde & Schwarz white paper:
® 1EF73: Malware Protection Windows XP

e 1DCO1: Malware Protection Windows 7

® 1EF96: Malware Protection Windows 10

4.1.2.2 Service Packs and Updates

Microsoft regularly creates security updates and other patches to protect Windows-
based operating systems. These are released through the Microsoft Update website
and associated update server. Instruments using Windows, especially those that con-
nect to a network, should be updated regularly.

For details and recommendations, see the Rohde & Schwarz White Papers "1DCO01:
Malware Protection" or "1EF73: Malware Protection" (for Windows XP).

For details and recommendations, see the Rohde & Schwarz White Paper 1DCO01:
Malware Protection.

For details and recommendations, see the Rohde & Schwarz White Paper 1EF96: Mal-
ware Protection Windows 10

41.2.3 Login

Windows 7 requires that users identify themselves by entering a user name and pass-
word in a login window. By default, the R&S FPS provides two user accounts:

® "Instrument™: an administrator account with unrestricted access to the computer/
domain

® "NormalUser": a standard user account with limited access

Some administrative tasks require administrator rights (e.g. the configuration of a LAN

network). Refer to the description of the basic instrument setup (SETUP menu) to find
out which functions are affected.


http://www.rohde-schwarz.com/appnote/1EF73
http://www.rohde-schwarz.com/appnote/1DC01
http://www.rohde-schwarz.com/appnote/1EF96
http://www.rohde-schwarz.com/appnote/1DC01
http://www.rohde-schwarz.com/appnote/1DC01
http://www.rohde-schwarz.com/appnote/1EF73
http://www.rohde-schwarz.com/appnote/1DC01
http://www.rohde-schwarz.com/appnote/1DC01
http://www.rohde-schwarz.com/appnote/1EF96
http://www.rohde-schwarz.com/appnote/1EF96
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Secure user mode

If the secure user mode option (R&S FPS-K33) is installed, an additional account is
provided: the "SecureUser".

The "SecureUser" is a standard user account with limited functionality. In particular,
administrative tasks such as LAN configuration or general instrument settings are not
available. Furthermore, for a "SecureUser", data that the R&S FPS normally stores on
the solid-state drive is redirected to volatile memory instead. You can access data that
is stored in volatile memory during the current instrument session. However, when the
instrument’s power is removed, all data in volatile memory is erased.

For details, see Chapter 4.1.6, "Protecting Data Using the Secure User Mode",
on page 33.

Automatic login

For the administrator account, an automatic login function is active by default. If activa-
ted, login is carried out automatically for the administrator (with full access) in the back-
ground when the R&S FPS is started, without having to enter a password. This func-
tion is active until you explicitly deactivate it or change the password.

For information on how to deactivate or reactivate the automatic login, refer to "Auto-
matic Login Function" on page 27.
Passwords

For all default user accounts, the initial password is 894129. Note that this password is
very weak, and it is recommended that you change the password for both users after
initial login.

You can change the password in Windows 7 for any user at any time via "Start > Con-
trol Panel > User Accounts”.

You can change the password in Windows 7 for any user at any time via "Start > Set-
tings > Account > Signin Options > Password > Change".

Changing the password and use of auto-login function

Note that when you change the default passwords, the default auto-login function no
longer works! Reactivate it manually as described in "Reactivating the automatic login
function" on page 29.

Be aware if the auto-login function is deactivated and the R&S FPS is rebooted: since
the R&S FPS has no real display, you require an external monitor and keyboard or a
Remote Desktop access to the R&S FPS to enter the password. Otherwise, the Win-
dows operating system does not complete login and the R&S FPS remains inoperable.

Automatic Login Function

When shipped, the instrument automatically logs on the default "Instrument" user to
Windows 7 using the default password.
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To change the settings for the automatic login function for the R&S FPS, a controller
PC or an external monitor and keyboard must be connected to the R&S FPS. See
Chapter 4.4.6, "How to Set Up Remote Desktop", on page 70.

If the auto-login function is deactivated and the R&S FPS is rebooted, you require an
external monitor and keyboard or a Remote Desktop access on the R&S FPS to enter
the password. Otherwise, the Windows operating system does not complete login and
the R&S FPS remains inoperable.

Switching users when using the automatic login function

Which user account is used is defined during login. If automatic login is active, the
login window is not displayed. However, you can also switch the user account to be
used when the automatic login function is active.

1. Select the "Windows" icon in the toolbar to access the operating system of the
R&S FPS (see also Chapter 4.1.2.4, "Accessing the Start Menu", on page 29).

2. Press CTRL + ALT + DEL, then select "Sign out".
In the "Start" menu, select the arrow next to the "Shut down" button and then "Log
off".
The "Login" dialog box is displayed, in which you can enter the different user
account name and password.

Deactivating the automatic login function
To deactivate the automatic login function, perform the following steps:

1. Select the "Windows" icon in the toolbar to access the operating system of the
R&S FPS (see also Chapter 4.1.2.4, "Accessing the Start Menu", on page 29).

2. Inthe "Start" menu, select "Run".
In the "Start" menu, select "All applications > Windows System > Run".
The "Run" dialog box is displayed.

3. Enter the command C:\R_S\INSTR\USER\NO AUTOLOGIN.REG.

4. Press the ENTER key to confirm.
This command deactivates the automatic login function. The next time you switch
on the instrument, the operating system prompts you to enter your user name and
password before it starts the firmware. (You must use an external monitor and key-
board or Remote Desktop from a controller PC, not the R&S FPS miniature dis-

play!)

Adapting the automatic login function to a new password

If you change the "Instrument" user's password, which is used during automatic login,
this function no longer works. Adapt the settings for the command that activates the
auto login function first.
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If the SecureUser or the NormalUser are enabled, those passwords are used for auto-
login. In that case, if you change any of the passwords, the autologin function must be
adapted each time you change the user account.

1. Openthe C:\R _S\INSTR\USER\NO AUTOLOGIN.REG file in any text editor (e.g.
Notepad).

2. Intheline "DefaultPassword"="894129", replace the default password
(894129) by the new password for automatic login.

3. Save the changes to the file.

Reactivating the automatic login function

1. Select the "Windows" icon in the toolbar to access the operating system of the
R&S FPS (see also Chapter 4.1.2.4, "Accessing the Start Menu", on page 29).

2. In the "Start" menu, select "Run".
In the "Start" menu, select "All applications > Windows System > Run".
The "Run" dialog box is displayed.

3. Enter the command C:\R_S\INSTR\USER\AUTOLOGIN.REG.

4. Press the ENTER key to confirm.
This command reactivates automatic login function. It is active the next time the
instrument reboots.

Accessing the Start Menu

The Windows "Start" menu provides access to the Windows 7 functionality and instal-
led programs.

To open the "Start" menu:

1. In Windows 10:
Press the "Windows" key or the CTRL + ESC key combination on your (external)
keyboard.

2. In Windows 7:
Select the "Windows" icon on the R&S FPS toolbar, or press the "Windows" key or
the CTRL + ESC key combination on the (external) keyboard.

All necessary system settings can be defined in the "Start > Control Panel" menu (for
required settings refer to the Windows 7 documentation and to the hardware descrip-
tion).

All necessary system settings can be defined in the "Start > Settings" menu (for
required settings refer to the Windows 7 documentation and to the hardware descrip-
tion).
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Accessing the Windows Taskbar

The Windows taskbar also provides quick access to commonly used programs, for
example Paint or WordPad. IECWIN, the auxiliary remote control tool provided free of
charge and installed by Rohde & Schwarz, is also available from the taskbar.

@

For details on the IECWIN tool, see the "Network and Remote Control" chapter of the
R&S FPS user manual.

o

41.3

To open the taskbar, select the "Windows" icon on the R&S FPS toolbar, or press the
"Windows" key or the CTRL + ESC key combination on your (external) keyboard.

Connecting USB Devices

The USB interfaces of the R&S FPS allow you to connect USB devices directly to the
instrument. Increase the number of possible connections using USB hubs. Due to the
large number of available USB devices, there is almost no limit to the expansions that
are possible with the R&S FPS.

The following list shows various USB devices that can be useful:

® Memory stick for easy transfer of data to/from a computer (e.g. firmware updates)
® CD-ROM drives for easy installation of firmware applications

Keyboard or mouse to simplify the entry of data, comments, filenames, etc.

Printer for printing measurement results

Installing USB devices is easy under Windows, because all USB devices are
plug&play. After a device is connected to the USB interface, the operating system
automatically searches for a suitable device driver.

If Windows does not find a suitable driver, it prompts you to specify a directory that
contains the driver software. If the driver software is on a CD, connect a USB CD-ROM
drive to the instrument before proceeding.

When a USB device is then disconnected from the R&S FPS, Windows immediately
detects the change in hardware configuration and deactivates the corresponding
driver.

All USB devices can be connected to or disconnected from the instrument during oper-
ation.
Connecting a memory stick or CD-ROM drive

If installation of a memory stick or CD-ROM drive is successful, Windows informs you
that the device is ready to use. The device is made available as a new drive and is dis-
played in Windows Explorer. The name of the drive depends on the manufacturer.

Connecting a keyboard

The keyboard is detected automatically when it is connected. The default input lan-
guage is English — US.
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Select "Start > Control Panel > Clock, Language, and Region > Change keyboards or
other input methods" to configure the keyboard properties. To access the Windows
operating system, press the Windows key on the external keyboard.

Select "Start > Settings > Time & language > Region & language > Add a language" to
configure the keyboard language. To access the Windows operating system, press the
Windows key on the external keyboard.

Connecting a mouse
The mouse is detected automatically when it is connected.

Select "Start > Control Panel > Devices and Printers > Mouse" to configure the mouse
properties. To access the Windows operating system, press the Windows key on the
external keyboard.

Select "Start > Settings > Devices > Mouse & touchpad" to configure the mouse prop-
erties. To access the Windows operating system, press the Windows key on the exter-
nal keyboard.

Connecting a printer

When printing a file, the instrument checks whether a printer is connected and turned
on and whether the appropriate printer driver is installed. If necessary, printer driver
installation is initiated. You only have to install a printer driver once.

To install a printer, select "Start > Control Panel > Devices and Printers > Add a
printer". To access the Windows operating system, press the Windows key on the
external keyboard.

To install a printer, select "Start > Settings > Devices > Add a printer or scanner". To
access the Windows operating system, press the Windows key on the external key-
board.

You can load updated and improved driver versions or new drivers from an installation
disk, USB memory stick or another external storage medium. If the instrument is inte-
grated in a network, you can also install driver data stored in a network directory.

Select "Start > Control Panel > Devices and Printers > Device Manager > Update
Device drivers" to install the driver.

Select "Start > Settings > Devices > Device Manager > Update Device drivers" to
install the driver.

4.1.4 Performing a Self Alignment and a Self Test

version to ensure the hardware is supported. If not, an error message is displayed
("WRONG_FW") and you are asked to update the firmware. Until the firmware version
is updated, self-alignment fails.

(For details refer to the R&S FPS User Manual).

6 During instrument start, the installed hardware is checked against the current firmware
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Furthermore, it may be necessary to align the data to a reference source by performing
a self alignment when strong temperature changes occur.

Operating temperature
Before performing this functional test, make sure that the instrument has reached its
operating temperature (for details, refer to the data sheet).

To perform a self alignment directly on the R&S FPS
» In the R&S FPS's mini display, navigate to "System commands" > "Self align".

For details on working with the mini display, see Chapter 4.3, "Miniature Display",
on page 41.
To perform a self alignment via Remote Desktop

Performing a self alignment via Remote Desktop requires a controller PC to be con-
nected, see Chapter 4.4.6, "How to Set Up Remote Desktop”, on page 70.

1. Select the SETUP key in the soft front panel on the Remote Desktop.
2. Select the "Alignment" softkey.
3. Select the "Start Self Alignment" button in the "Alignment" dialog box.

Once the system correction values have been calculated successfully, a message
is displayed.

To display the alignment results again later
® Select the SETUP key in the soft front panel on the Remote Desktop.

® Select the "Alignment" softkey.

Self tests

The self test does not need to be repeated every time the instrument is switched on. It
is only necessary when instrument malfunction is suspected.

To perform a self test directly on the R&S FPS

» In the R&S FPS's mini display, navigate to "System commands" > "Selftest".
For details on working with the mini display, see Chapter 4.3, "Miniature Display",
on page 41.

To perform a self test via Remote Desktop

Performing a self alignment via Remote Desktop requires a controller PC to be con-
nected, see Chapter 4.4.6, "How to Set Up Remote Desktop", on page 70.

1. Select the SETUP key in the soft front panel on the Remote Desktop.
2. Select the "Service" softkey.

3. Switch to the "Selftest" tab in the "Service" dialog box.
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4. Select the "Start Selftest" button.

Once the instrument modules have been checked successfully, a message is dis-
played.

4.1.5 Checking the Supplied Options

The instrument may be equipped with both hardware and firmware options. In order to
check whether the installed options correspond to the options indicated on the delivery
note, proceed as follows.

Checking the supplied options via Remote Desktop requires a controller pc or an exter-
nal monitor, mouse and keyboard to be connected, see Chapter 4.4.6, "How to Set Up
Remote Desktop", on page 70.

1. Select the SETUP key in the soft front panel on the Remote Desktop.
2. Select the "System Config" softkey.

3. Switch to the "Versions + Options" tab in the "System Configuration" dialog box.

A list with hardware and firmware information is displayed.

4. Check the availability of the hardware options as indicated in the delivery note.

4.1.6 Protecting Data Using the Secure User Mode

During normal operation, the R&S FPS uses a solid-state drive to store its operating
system, instrument firmware, instrument self-alignment data, and any user data cre-
ated during operation. If necessary, the solid-state drive can be removed from the

R&S FPS and locked in a secure place to protect any classified data it may contain.

Redirecting storage to volatile memory

Alternatively, to avoid storing any sensitive data on the R&S FPS permanently, the
secure user mode was introduced (option R&S FPS-K33). In secure user mode the
instrument’s solid-state drive is write-protected so that no information can be written to
memory permanently. Data that the R&S FPS normally stores on the solid-state drive
is redirected to volatile memory instead, which remains available only until the instru-
ment is switched off. This data includes:

® Windows 7 operating system files

® Firmware shutdown files containing information on last instrument state

® Self-alignment data

® General instrument settings such as the IP address

® Measurement settings

® User data created during operation
(see also Table 9-1)

® Any data created by other applications installed on the R&S FPS, for example text
editors (Notepad), the Clipboard, drawing tools, etc.

User Manual 1176.8445.02 — 09 33



Preparing for Use

Users can access data that is stored in volatile memory just as in normal operation.
However, when the instrument’s power is switched off, all data in this memory is
cleared. Thus, in secure user mode, the instrument always starts in a defined, fixed
state when switched on.

To store data such as measurement results permanently, it must be stored to an exter-
nal storage device, such as a memory stick.

Limited storage space

The volatile memory used to store data in secure user mode is restricted to 256 MB.
Thus, a "Memory full" error can occur although the hard disk indicates that storage
space is still available.

Storing required data permanently

Any data that is to be available for subsequent sessions with the R&S FPS must be
stored on the instrument permanently, before activating the secure user mode. This
includes predefined instrument settings, transducer factors and self-alignment data.

Self-alignment data

Note that self-alignment data becomes invalid with time and due to temperature
changes. Therefore, to achieve optimal accuracy, it may be preferable to perform a
new self-alignment at the start of each new session on the R&S FPS.

Restricted operation

Since permanent storage is not possible, the following functions are not available in
secure user mode:

® Firmware update

® Activating a new option key

Furthermore, since the "SecureUser" used in secure user mode does not have admin-
istrator rights, administrative tasks such as LAN configuration and some general

instrument settings are not available. Refer to the description of the basic instrument
setup (SETUP menu) to find out which functions are affected.

6 Remote Desktop restricted for "SecureUser" by default

For security reasons, the "SecureUser" is not allowed Remote Desktop access to the
R&S FPS by default. You must explicitly add the "SecureUser" to the Remote Desktop
group (see Chapter 4.4.6.5, "How to Add or Remove Users to the Remote Desktop
Users Group", on page 75). If you do not allow this user Remote Desktop access, the
"SecureUser" can only operate the R&S FPS using remote commands or via the minia-
ture display.

Activating and deactivating secure user mode

Only a user with administrator rights can activate (and deactivate) the secure user
mode. Once activated, a restart is required. The special user "SecureUser" is then log-
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ged on to the R&S FPS automatically (using the automatic login function, see "Auto-
matic Login Function" on page 27). While the secure user mode is active, a message is
displayed in the status bar at the bottom of the screen, and in the miniature display
"SecUsr" is displayed.

To deactivate the secure user mode, the "SecureUser" must log off and the "Instru-
ment" user (administrator) must log on.

Switching users when using the automatic login function
In the "Start" menu, select the arrow next to the "Shut down" button and then "Log off".

The "Login" dialog box is displayed, in which you can enter the different user account
name and password.

The secure user mode setting and automatic login is automatically deactivated when
the "Instrument" user logs on. The "SecureUser" is no longer available.

For administrators ("Instrument" user), the secure user mode setting is available in the
general system configuration settings (see " SecureUser Mode " on page 565).

Alternatively, you can activate or deactivate the secure user function via the miniature
display (see "Enable SecureUser/Disable SecureUser" on page 45. In this case,
enter the administrator ("Instrument” user) password.

Remote control

Initially after installation of the R&S FPS-K33 option, secure user mode must be
enabled manually once before remote control is possible.

(See sYSTem:SECurity[:STATe].)

4.2 Instrument Tour

4.2.1 Front Panel View

This chapter describes the front panel, including all function keys and connectors.

& ROHDE&SCHWARZ FPS - SIGNAL & SPECTRUM ANALYZER

© EXTREF
‘€ WAIT FOR TRIGGER

@D WARNING

Figure 4-1: Front panel view
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1 = On/Off button

2 = USB connectors

3 = Mini display

4 = Navigation and data input controls

5 = Status LEDs

6 = Solid State Disk (SSD) containing instrument firmware
7 = RF Input 50 Q connector (optionally front or rear panel)

Instrument damage caused by cleaning agents

Cleaning agents contain substances such as solvents (thinners, acetone, etc.), acids,
bases, or other substances. Solvents can damage the front panel labeling, plastic
parts, or screens, for example.

Never use cleaning agents to clean the outside of the instrument. Use a soft, dry, lint-
free dust cloth instead.

On / off button

The POWER key is located on the lower left corner of the front panel. It starts up and
shuts down the instrument.

See also Chapter 4.1.1.5, "Switching the Instrument On and Off", on page 24.

Mini display

The R&S FPS is equipped with a miniature display on the front panel that provides
basic information and allows for very basic instrument configuration (such as changing
the IP address). For details see Chapter 4.3, "Miniature Display", on page 41.

usB

The front panel provides three female USB connectors (USB-A) to connect devices like
an external monitor, a mouse or a keyboard. In addition, a memory stick can be con-
nected to store and reload instrument settings and measurement data.

The rear panel provides further USB connectors, including a male (USB-B) connector.
See Chapter 4.2.2.9, "USB", on page 40.
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Navigation Keys

The navigation keys can be used to navigate through menus or entries in the display.

Data Input Controls

Type of key Description

ESC key Exits the current function without storing changes
ENTER key Stores the current entry and closes the edit mode
DEL key Deletes the character to the left of the cursor

Status LEDs

Indicate the instrument's operating status:
Table 4-1: Status LEDs

Label Description

EXT REF External reference connected and active
WAIT FOR TRIGGER Measurement waiting for trigger
WARNING Warning or system error

Removable Solid State Disk (SSD)

The removable solid state disk contains the instrument firmware and all measurement
data from the R&S FPS, allowing you to store the data securely in an external location.
RF INPUT 50Q

A device under test (DUT) can be connected to the R&S FPS to provide RF input
which is then analyzed. The DUT is connected to the instrument's RF INPUT via a
cable equipped with an appropriate connector.

The RF Input connector may be provided on the front or rear panel, as requested by
the customer.

Risk of instrument damage

Do not overload the input. For maximum allowed values, see the data sheet. For AC-
coupling, a DC input voltage of 50 V must never be exceeded. For DC-coupling, DC
voltage must not be applied at the input. In both cases, noncompliance will destroy the
input mixers.

4.2.2

Rear Panel View

This figure shows the rear panel view of the R&S FPS. The individual elements are
described in more detail in the subsequent sections.
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TRGIN  TRGAUX

100...240V
50... 60 Hz / 400 Hz
max. 25A

Figure 4-2: Rear panel view

= RF Input 50 Q connector (optionally front or rear panel)
= NOISE SOURCE CONTROL

= REF INPUT/OUTPUT connectors

= |[EC 625 (GPIB) SCPI interface

= Remote Control Out Ports 1/2 (currently not available)
= TRG IN connector

= TRG AUX connector

9 = DIGITAL BASEBAND INPUT/OUTPUT connectors (option B17, currently not available)
10 = IF/VIDEO out connector

11 = DISPLAY PORT for external display

12 = DVI connector for external display

13 = LAN connector

14 = USB (DEVICE) connectors

15 = AC Power Supply Connection and Main Power Switch

0N oA N -

4.2.21 RFINPUT 50Q

A device under test (DUT) can be connected to the R&S FPS to provide RF input
which is then analyzed. The DUT is connected to the instrument's RF INPUT via a
cable equipped with an appropriate connector.

The RF Input connector may be provided on the front or rear panel, as requested by
the customer.

Risk of instrument damage

Do not overload the input. For maximum allowed values, see the data sheet. For AC-
coupling, a DC input voltage of 50 V must never be exceeded. For DC-coupling, DC
voltage must not be applied at the input. In both cases, noncompliance will destroy the
input mixers.
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4.2.2.6
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NOISE SOURCE CONTROL

The noise source control female connector is used to provide the supply voltage for an
external noise source, e.g., to measure the noise figure and gain of amplifiers and fre-
quency converting devices.

Conventional noise sources require a voltage of +28 V in order to be switched on and
0 V to be switched off. The output supports a maximum load of 100 mA.

REF INPUT / REF OUTPUT

The REF INPUT connector is used to provide an external reference signal to the
R&S FPS.

The REF OUTPUT connector can be used to provide an external reference signal (or
the OCXO reference signal) from the R&S FPS to other devices that are connected to
this instrument.

Connector Reference signal Usage

REF INPUT 1...20 MHz To provide an external reference signal on the
0..10 dBm R&S FPS.

REF OUTPUT 10 MHz To provide the internal reference signal from the

10 dBm R&S FPS to another device continuously.

Also used to provide OCXO reference signal to another

device.

GPIB (SCPI) Remote Control Connector

The IEC 625 GPIB interface is in compliance with IEEE488 and SCPI. A computer for
remote control of the R&S FPS can be connected via this interface. For more details
refer to Chapter 4.4, "Controlling the R&S FPS Remotely", on page 50.

TRIGGER INPUT / OUTPUT

The female TRG IN connector for external trigger or gate input is used to control the
measurement by means of an external signal. The voltage levels can range from 0.5 to
3.5 V. The default value is 1.4 V. The typical input impedance is 10 kQ.

The female BNC TRG AUX connector can be used to receive a second external signal
or to provide a signal to another device. The signal is TTL compatible (0 V /5 V). You
can control the connector usage in the "Trigger" settings (TRIG key).

IF/VIDEO OUTPUT

The female BNC connector can be used for various outputs:

® Intermediate frequency (IF) output of approximately 20 MHz
® Video output (1V)
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Which output is provided is defined in the software (INPUT/OUTPUT key). For details
see the User Manual.

4.2.2.7 DISPLAY PORT and DVI

You can connect an external monitor or other display device to the R&S FPS to oper-
ate the instrument from a remote PC (see also Chapter 4.4.6, "How to Set Up Remote
Desktop", on page 70).

Two different types of connectors are provided for this purpose:
e DISPLAY PORT
e DVI (Digital visual interface)

4.2.2.8 LAN

The LAN interface can be used to connect the R&S FPS to a local network for remote
control, printouts and data transfer. The assignment of the RJ-45 connector supports
twisted-pair category 5 UTP/STP cables in a star configuration (UTP stands for
unshielded twisted pair, and STP for shielded twisted pair).

For details see Chapter 11, "Network and Remote Operation”, on page 574.

4229 USB

The rear panel provides four additional female USB (USB-A) connectors to connect
devices like a keyboard, a mouse or a memory stick (see also "USB" on page 36). The
two left-most connectors provide USB 3.0 interfaces.

Furthermore, a male USB DEVICE connector (USB-B) is provided, for example to con-
nect a printer.

4.2.2.10 AC Power Supply Connection and Main Power Switch
An AC power supply connector and main power switch are located in a unit on the rear
panel of the instrument.
Main power switch function:
Position 1: The instrument is in operation.
Position O: The entire instrument is disconnected from the AC power supply.

For details refer to Chapter 4.1.1.4, "Connecting the AC Power", on page 24.
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4.2.3 Additional Hardware Options Without External Connectors

Some additional hardware options are available which have no external connectors
and are not visible on the outside of the R&S FPS.

0 OCXO Option (R&S FPS-B4).....ccciueeiiieieiiieeiiee ettt s 41
e Bandwidth Extension 160 MHz (R&S FPS-B160).........cooeiiiiiiiiiiiiiieeeeieee e, 41

4.2.31 OCXO Option (R&S FPS-B4)

This option generates a 10 MHz reference signal with a very precise frequency. If
installed, and if no external signal is used, this signal is used as an internal reference.

Warm-up time for OCXO
When the instrument is switched on, the OCXO requires an extended warm-up time
(see data sheet).

4.2.3.2 Bandwidth Extension 160 MHz (R&S FPS-B160)

The signal analysis bandwidth of the R&S FPS can be extended by a hardware option
(R&S FPS-B160). The bandwidth extension allows for a linear bandwidth up to a maxi-
mum of 160 MHz with an output sample rate of up to 10 GHz. While the extension can
be activated or deactivated manually in the R&S FPS base unit (I/Q Analyzer applica-

tion), it is activated automatically in some applications that also support I/Q data analy-
sis. See the application-specific documentation for details.

4.3 Miniature Display

The R&S FPS is equipped with a miniature display on the front panel (see also "Mini
display" on page 36).

The display provides the following information:

® The serial number, firmware version and model of the instrument

® The IP address of the instrument

® The GPIB address of the instrument

® System messages, for example when errors occur

Furthermore, it provides the following functions directly on the instrument:
® Configuring network settings, including LXI and GPIB parameters

® Performing selftests, self alignment

® Resetting the instrument to a predefined state

® Changing display settings
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i

The miniature front panel display is meant as a service interface, not for measurement
display. If the display fails for any reason, switch the instrument off and back on again
to restore the display.

Note that any error messages caused by the Windows 7 operating system are not dis-
played on the miniature front panel display. They are only visible on an external moni-
tor or via RemoteDesktop from a controller PC. Thus, if operation of the R&S FPS
seems to fail for no obvious reason, try connecting a monitor or a controller PC to
check for any messages awaiting confirmation or action.

(See Chapter 4.1.3, "Connecting USB Devices", on page 30 or Chapter 4.4.6, "How to
Set Up Remote Desktop”, on page 70)

431

Functions and Settings in the Mini Display Menu

The following functions and settings are available via the menu in the R&S FPS's mini
display.

Some of the following functions are also available in manual mode via the soft front
panel, see Chapter 11, "Network and Remote Operation”, on page 574 and Chap-
ter 10, "General Instrument Setup”, on page 532.
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Network

Configures the settings for operation in a local area network (LAN), for example to con-
trol the instrument from a remote PC or use a network printer.

NOTICE! Risk of network problems. All network parameters can be edited by the
administrator ("Instrument" user) only. Beware that changing the computer name has
major effects in a network.

For details, see Chapter 4.4, "Controlling the R&S FPS Remotely", on page 50.

Computer Name «— Network

Each instrument is delivered with an assigned computer name, but this name can be
changed. The naming conventions of Windows apply. If too many characters and/or
numbers are entered, an error message is displayed in the status line.

The default instrument name is a non-case-sensitive string with the following syntax:
<Type><variant>-<serial_number>
For example FPS13-123456

The serial number can be found on the rear panel of the instrument. It is the third part
of the device ID printed on the bar code sticker:

&> 1D: 1419.0035K02 -|102030]- Zd | seriat number

DHCP « Network

Switches between DHCP server available (On) or not available (Off). If a DHCP server
is available in the network, the IP address and subnet mask of the instrument are
obtained automatically from the DHCP server.

IP Address < Network
Defines the IP address. The TCP/IP protocol is preinstalled with the IP address
10.0.0.10. If the DHCP server is available ("DHCP On"), the setting is read-only.

The IP address consists of four number blocks separated by dots. Each block contains
3 numbers in maximum (e.g. 100.100.100.100), but also one or two numbers are
allowed in a block (as an example see the preinstalled address).

Subnet Mask — Network
Defines the subnet mask. The TCP/IP protocol is preinstalled with the subnet mask
255.255.255.0. If the DHCP server is available ("DHCP On"), this setting is read-only.

HE
User Manual 1176.8445.02 — 09 43



Miniature Display

The subnet mask consists of four number blocks separated by dots. Each block con-
tains 3 numbers in maximum (e.g. 100.100.100.100), but also one or two numbers are
allowed in a block (as an example see the preinstalled address).

System commands
Provides basic system functions.

Preset «— System commands

When delivered, the R&S FPS has a default configuration. You can restore this defined
initial state at any time as a known starting point for measurements. This is often rec-
ommendable as a first step in troubleshooting when unusual measurement results
arise.

Remote command:
*RST Or SYSTem: PRESet

Self align — System commands

Starts recording correction data for the instrument. If the correction data acquisition
fails or if the correction values are deactivated, a corresponding message is displayed
in the status field.

For details see Chapter 10.1.1, "Basics on Alignment", on page 532.

Remote command:
*CAL? on page 619, see also CALibration[:ALL]? on page 971

Selftest — System commands
If the R&S FPS fails you can perform a self test of the instrument to identify any defec-
tive modules.

Once the self test is started, all modules are checked consecutively and the test result
is displayed.

Remote command:

*TST? on page 622

DIAGnostic:SERVice:STESt:RESult? on page 974

LAN Reset — System commands
Resets the LAN configuration to its default settings (LCI function).

According to the LXI standard, an LCI must set the following parameters to a default

state.
Parameter Value
TCP/IP Mode DHCP + Auto IP Address
Dynamic DNS Enabled
ICMP Ping Enabled
Password for LAN configuration LxiWeblfc
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The LAN configuration can be reset to its default settings directly on the instrument via
the R&S FPS's mini display ("System commands" > "LAN reset"), or in the "Network"
tab of the "Network + Remote" dialog box or using the instrument's LXI Browser inter-
face.

Remote command:
SYSTem:LXT:LANReset on page 988

Clear All Messages < System commands
Deletes all system messages.

Remote command:
SYSTem:ERRor:CLEar:ALL on page 991

Reboot — System commands
Reboots the instrument, including the operating system.

Remote command:
SYSTem:REBoot on page 1001

Enable NormalUser/Disable NormalUser — System commands
Activates or deactivates the "NormalUser" account.

The NormalUser can only be activated by a user with administrator rights.

If enabled, the R&S FPS requires a reboot and then automatically logs in using the
"NormalUser" account (indicated by "NormUsr" in the miniature display.).

The "NormalUser" is a standard user account with limited functionality. In particular,
administrative tasks such as LAN configuration or general instrument settings are not
available. Refer to the description of the basic instrument setup (SETUP menu) to find
out which functions are affected.

If disabled, the R&S FPS requires a reboot. The R&S FPS attempts to login using the
"Instrument" (administrator) account. You must enter the administrator ("Instrument”
user) password on the R&S FPS (default: "894129"). For details see "To enter a pass-
word" on page 49.

Note: Deactivated auto-login function. If the auto-login function is deactivated and the
R&S FPS is rebooted, you require an external monitor and keyboard and a Remote-
Desktop access on the R&S FPS to enter the password. Otherwise, the Windows oper-
ating system will not complete login and the R&S FPS remains inoperable.

For details see "Automatic Login Function" on page 27

Enable SecureUser/Disable SecureUser — System commands
Activates or deactivates the secure user mode.

The secure user mode can only be activated or deactivated by a user with administra-
tor rights. You must enter the administrator ("Instrument" user) password on the
R&S FPS (default: "894129"). For details see "To enter a password" on page 49.

If enabled, the R&S FPS requires a reboot and then automatically logs in using the
"SecureUser" account (indicated by "SecUsr" in the miniature display.)
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For a "SecureUser", data that the R&S FPS normally stores on the solid-state drive is
redirected to volatile memory instead. Data that is stored in volatile memory can be
accessed by the user during the current instrument session; however, when the instru-
ment’s power is removed, all data in volatile memory is erased. Administrative tasks
are not allowed by the "SecureUser".

Before you activate secure user mode, store any instrument settings that are required
beyond the current session, such as predefined instrument settings, transducer files, or
self-alignment data.

If disabled, the R&S FPS requires a reboot and then automatically logs in using the
"Instrument" (administrator) account.

Note: Deactivated auto-login function. If the auto-login function is deactivated and the
R&S FPS is rebooted, you require an external monitor and keyboard and a Remote-
Desktop access on the R&S FPS to enter the password. Otherwise, the Windows oper-
ating system will not complete login and the R&S FPS remains inoperable.

For details see "Automatic Login Function" on page 27

For details on the secure user mode see Chapter 4.1.6, "Protecting Data Using the
Secure User Mode", on page 33.

Remote command:

SYSTem:SECurity[:STATe] on page 994

Note: Initially after installation of the R&S FPS-K33 option, secure user mode must be
enabled manually once before remote control is possible.

GPIB
Alternatively to connecting the R&S FPS to a LAN, the GPIB interface can be used to
connect a remote PC.

For details see Chapter 4.4.1.2, "GPIB Interface (IEC 625/IEEE 418 Bus Interface)",
on page 56).

GPIB Address < GPIB
Defines the GPIB address. Values from 0 to 30 are allowed. The default address is 20.

Remote command:
SYSTem:COMMunicate:GPIB[:SELF] : ADDRess on page 985

LXI parameters

On the R&S FPS the LXI Class C functionality is already installed and enabled; thus,
the instrument can be accessed via any web browser (e.g. the Microsoft Internet
Explorer), for example to change the LAN settings using the LXI Web browser inter-
face.

Note that LXI parameters are not available for the "SecureUser" or "NormalUser"
accounts (see "Enable NormalUser/Disable NormalUser" on page 45 and "Enable
SecureUser/Disable SecureUser" on page 45). See also the restrictions mentioned in
"LXI Web Browser Interface" on page 54.

Version — LXI parameters
Displays the current LXI version on the R&S FPS (read-only).
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Features — LXI parameters
Displays the extended LXI features installed on the R&S FPS (read-only).

Computer Name « LXI parameters

Each instrument is delivered with an assigned computer name, but this name can be
changed. The naming conventions of Windows apply. If too many characters and/or
numbers are entered, an error message is displayed in the status line.

The default instrument name is a non-case-sensitive string with the following syntax:
<Type><variant>-<serial_number>
For example FPS13-123456

The serial number can be found on the rear panel of the instrument. It is the third part
of the device ID printed on the bar code sticker:

&> 1D: 1419.0035K02 - 102030 Zd | seriat number

MAC — LXI parameters
Media Access Control address (MAC address), a unique identifier for the network card
in the R&S FPS

IP — LXI parameters
IP address of the R&S FPS as defined in the operating system (see also "IP Address"
on page 43).

ICMP/VXI-11 Discovery «— LXI parameters
"ICMP" indicates whether the ping responder is active or not.

If "VXI-11 Discovery" is enabled, connected devices are detected automatically using
the VXI-11 protocol.

(See "VXI-11 Protocol" on page 53).

System messages
Displays the system messages generated by the R&S FPS.

The messages are displayed in the order of their occurrence; the most recent mes-
sages are placed at the top of the list.

Display
Provides functions for the display itself.

Backlight saving — Display
If enabled, the backlight of the display is turned off to save energy.

Normall/inverse color <— Display
Switches between a display with light characters on a dark background (normal) or
dark characters on a light background (inverted).

HE
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Info
Provides information on the R&S FPS installation.

This information can be useful when problems occur with the instrument and you
require support from Rohde & Schwarz.

Serial < Info
Serial number of the R&S FPS

FW version — Info
Currently installed firmware version

Model < Info
Instrument model

uC version — Info
Microcontroller version

Working with the Miniature Instrument Display

Using the miniature display on the front panel of the R&S FPS you can change basic
instrument settings and perform hardware functions directly on the instrument, without
additional devices such as a controller PC or external monitor.

To display a particular setting in the menu

The information and configuration settings are displayed in a hierarchical menu struc-
ture.

» To navigate within the menu structure, do one of the following:
e Press the <Up Arrow> and <Down Arrow> keys to scroll through the menus.
e Press the ENTER key to select a particular menu item (either to edit a setting
or to select the submenu).
e Press the ESC key to move back up in the menu structure.

To edit a configuration value

1. Navigate to the required menu item as described in "To display a particular setting
in the menu" on page 48.

2. Press the ENTER key to select the displayed configuration setting and switch to
edit mode.

3. To change the value, do one of the following:
e Press the <Up Arrow> and <Down Arrow> keys to scroll through the available
entry values (e.g. digits in an IP address).
e Press the <Left Arrow> and <Right Arrow> keys to scroll within the entry (e.g.
to the second or third part of the IP address).
e Press the DEL key to delete the character to the left of the cursor.

4. Press the ENTER key again to store the entry and exit the edit mode.
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To enter a password

For some functions you must enter the administrator ("Instrument" user) password on
the R&S FPS (default: "894129").

1. Navigate to the required menu item as described in "To display a particular setting
in the menu" on page 48.

2. Press the ENTER key to select the function.

3. For each character in the password:

a) Press the <Up Arrow> and <Down Arrow> keys to scroll through the available
characters.

b) When the required character appears, press the <Right Arrow> key to move to
the next character.
The currently selected character is displayed normally, all others are hidden by
asterisks (*) for discretion.

4. When the password is complete, press the ENTER key again to store the entry and
exit the edit mode.

4.3.3 Configuring the Display Settings

This section describes how to configure basic display settings on the R&S FPS. For
further basic instrument settings see the R&S FPS User Manual.

To change the display colors

You can switch between a display with light characters on a dark background (normal)
or dark characters on a light background (inverted).

1. In the R&S FPS's mini display menu, navigate to "Display” > "Normal/inverse col-
ors" and press the ENTER key.

2. Use the <Left Arrow> and <Right Arrow> keys to toggle the setting.
3. Press the ENTER key again to store the entry and exit the edit mode.

To turn off the display backlight
You can turn off the backlight of the display to save energy.

1. Inthe R&S FPS's mini display menu, navigate to "Display" > "Backlight saving" and
press the ENTER key.

2. Use the <Left Arrow> and <Right Arrow> keys to toggle the setting.
3. Press the ENTER key again to store the entry and exit the edit mode.
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4.4 Controlling the R&S FPS Remotely

Since the R&S FPS was designed without a screen (except for the mini display for
basic information and settings), it will typically be used to perform measurements under
remote control. However, the developers of such programs will find it convenient to get
familiar with the instrument and its functions using manual operation initially, and then
design the programs accordingly. Once developed and tested, the programs can be
executed from a remote PC, with no manual interaction required. The computer that is
used for remote control is called "controller" here.

described for manual operation, assuming an external keyboard, mouse and monitor

6 All instrument functions and settings, as well as any background information, are
are connected, or a controller PC with Remote Desktop is being used.

Various methods for remote control are supported:

® Connecting the instrument to a (LAN) network (see Chapter 4.4.2, "How to Config-
ure a Network", on page 61)

® Using the LXI browser interface in a LAN network (see Chapter 4.4.2.3, "How to
Configure the LAN Using the LXI Web Browser Interface", on page 63)

® Using the Windows Remote Desktop application in a LAN network (see Chap-
ter 4.4.6, "How to Set Up Remote Desktop”, on page 70)

For details on remote control interfaces see Chapter 4.4.1, "Remote Control Interfaces
and Protocols", on page 51

Remote operation

Remote operation of the instrument from a connected computer is possible using SCPI
commands. Sending remote commands requires the instrument to be configured in a
LAN network or connected to a PC via the GPIB interface as described in Chap-

ter 4.4.2, "How to Configure a Network", on page 61 and Chapter 4.4.5, "How to Start
a Remote Control Session from a PC", on page 69.

Manual operation via Remote Desktop

Remote Desktop is a Windows application which can be used to access and control
the instrument from a remote computer through a LAN connection. While the R&S FPS
is in operation, the instrument's graphical results and control elements are displayed on
the remote computer, and Remote Desktop provides access to all of the applications,
files, and network resources of the instrument. Thus, remote (manual) operation of the
instrument is possible. The following tasks can be performed using Remote Desktop:

® Access to the control functions via a virtual front panel
® Printout of measurement results directly from the controller
® Storage of measured data on the controller's hard disk

This documentation provides basic instructions on setting up the Remote Desktop for
the R&S FPS. For details refer to the Windows 7 operating system documentation.
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4.4.1 Remote Control Interfaces and Protocols

The instrument supports different interfaces and protocols for remote control. The fol-
lowing table gives an overview.

Table 4-2: Remote control interfaces and protocols

Interface | Protocols, VISA" address string Remarks
Local Area | ® HiSLIP High-Speed LAN Instrument Protocol (1VI-6.1) A LAN connector is located on the
Network TCPIP::host address::hislipO[::INSTR] rear panel of the instrument.
(LAN) e VXI-11 . .
TCPIP::host address::inst0[::INSTR] The mterfacg is based or: TCP/IP and
Library: VISA supports various protocols.
® socket communication (Raw Ethernet, simple Telnet) For a description of the protocols refer
TCPIP::host address[::LAN device name]::<port>:: to:
SOCKET

VXI-11 Protocol
HiSLIP Protocol

Socket Communication

Library: VISA or socket controller

GPIB (IEC/ | VISA" address string: A GPIB bus interface according to the

IEEE Bus GPTB: :primary address|::INSTR] IEC 625.1/IEEE 488.1 standard is

Interface) located on the rear panel of the instru-
(no secondary address) ment.

For a description of the interface refer
to 4.4.1.2 GPIB Interface (IEC 625/
IEEE 418 Bus Interface).

UsB VISA") address string: USB connectors are located on the

USB::<vendor ID>::<product ID>::<serial number>[::INSTR] front and rear panel of the instrument.

For a description of the interface refer
to 4.4.1.3 USB Interface.

") VISA is a standardized software interface library providing input and output functions to communicate with instruments. A VISA
installation on the controller is a prerequisite for remote control using the indicated interfaces.

(See also Chapter 4.4.1.4, "VISA Libraries", on page 60).

Within this interface description, the term GPIB is used as a synonym for the IEC/IEEE
bus interface.

4411 LAN Interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, consisting
of a connector, a network interface card and protocols. The network card can be oper-
ated with the following interfaces:

® 10 Mbit/s Ethernet IEEE 802.3

® 100 Mbit/s Ethernet IEEE 802.3u

® 1Gbit/s Ethernet IEEE 802.3ab

For remote control via a network, the PC and the instrument must be connected via the
LAN interface to a common network with TCP/IP network protocol. They are connected

using a commercial RJ45 cable (shielded or unshielded twisted pair category 5). The
TCP/IP network protocol and the associated network services are preconfigured on the
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instrument. Software for instrument control and the VISA program library must be
installed on the controller.

VISA library

Instrument access is usually achieved from high level programming platforms using
VISA as an intermediate abstraction layer. VISA encapsulates the low level VXI, GPIB,
LAN or USB function calls and thus makes the transport interface transparent for the
user. See Chapter 4.4.1.4, "VISA Libraries", on page 60 for details.

The R&S FPS supports various LAN protocols such as LXI, RSIB, raw socket or the
newer HiSLIP protocol.

IP address

Only the IP address or a valid DNS host name is required to set up the connection.
The host address is part of the "VISA resource string" used by the programs to identify
and control the instrument.

The VISA resource string has the form:

TCPIP::host address[::LAN device name] [::INSTR]
or

TCPIP::host address::port::SOCKET

where:

® TCPIP designates the network protocol used
® host address is the IP address or host name of the device

® LAN device name defines the protocol and the instance number of a sub-instru-
ment;

— 1instO selects the VXI-11 protocol (default)

— hislipO selects the newer HiSLIP protocol
® INSTR indicates the instrument resource class (optional)
® port determines the used port number
® SOCKET indicates the raw network socket resource class

Example:

® |Instrument has the IP address 792.1.2.3; the valid resource string using VXI-11
protocol is:
TCPIP::192.1.2.3::INSTR

® A raw socket connection can be established using:
TCPIP::192.1.2.3::5025::SOCKET

6 Identifying instruments in a network

If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
means of the resource string.
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For details on configuring the LAN connection, see Chapter 4.4.2, "How to Configure a
Network", on page 61.
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VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the
exchanged messages is adhered to and interrupted links are identified. With this proto-
col, messages cannot be lost.

HiSLIP Protocol

The HiSLIP (High Speed LAN Instrument Protocol) is the successor protocol for
VXI-11 for TCP-based instruments specified by the IVI foundation. The protocol uses
two TCP sockets for a single connection - one for fast data transfer, the other for non-
sequential control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

® High performance as with raw socket network connections

® Compatible IEEE 488.2 support for Message Exchange Protocol, Device Clear,
Serial Poll, Remote/Local, Trigger, and Service Request

® Uses a single IANA registered port (4880), which simplifies the configuration of fire-
walls

® Supports simultaneous access of multiple users by providing versatile locking
mechanisms

® Usable for IPv6 or IPv4 networks

However, using HiSLIP, data is sent to the device using the "fire and forget" method
with immediate return. Thus, a successful return of a VISA operation such as
viWrite () does not guarantee that the instrument has finished or started the reques-
ted command, but is delivered to the TCP/IP buffers.

6 Using VXI-11, each operation is blocked until a VXI-11 device handshake returns.

For more information see also the application note:

1MA208: Fast Remote Instrument Control with HiSLIP

Socket Communication

An alternative way for remote control of the software is to establish a simple network
communication using sockets. The socket communication, also referred to as "Raw
Ethernet communication”, does not necessarily require a VISA installation on the
remote controller side. It is available by default on all operating systems.


http://www.rohde-schwarz.com/appnotes/1MA208_2e_HiSLIP.pdf

Controlling the R&S FPS Remotely

The simplest way to establish socket communication is to use the built-in telnet pro-
gram. The telnet program is part of every operating system and supports a communi-
cation with the software on a command-by-command basis. For more convenience and
to enable automation by means of programs, user-defined sockets can be program-
med.

Socket connections are established on a specially defined port. The socket address is
a combination of the IP address or the host name of the instrument and the number of
the port configured for remote-control. All R&S FPS use port number 5025 for this pur-
pose. The port is configured for communication on a command-to-command basis and
for remote control from a program.

LXI Web Browser Interface

LAN eXtensions for Instrumentation (LXI) is an instrumentation platform for measuring
instruments and test systems that is based on standard Ethernet technology. LXI is
intended to be the LAN-based successor to GPIB, combining the advantages of Ether-
net with the simplicity and familiarity of GPIB. The LXI browser interface allows for
easy configuration of the LAN and remote control of the R&S FPS without additional
installation requirements.

The instrument's LXI web browser interface works correctly with all W3C compliant
browsers.

Via the LXI browser interface to the R&S FPS you can control the instrument remotely
from another PC. Manual instrument controls are available via the front panel simula-
tion. File upload and download between the instrument and the remote PC is also
available. Using this feature, several users can access and operate the R&S FPS
simultaneously. This is useful for troubleshooting or training purposes.

For details, see Chapter 4.4.2.3, "How to Configure the LAN Using the LXI Web
Browser Interface”, on page 63 and Chapter 4.4.7, "How to Control the R&S FPS via
the Web Browser Interface”, on page 77.

If you do not want other users in the LAN to be able to access and operate the
R&S FPS you can deactivate this function.

See Chapter 4.4.8, "How to Deactivate the Web Browser Interface", on page 79.
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N\ Restrictions

/ Only user accounts with administrator rights can use the LXI functionality.

For details, see Chapter 4.1.2.3, "Login", on page 26.

To configure the LAN interface using the LXI web browser Interface, a controller PC or
an external monitor, mouse and keyboard must be connected to the R&S FPS. The
settings required to set up this function are available directly on the R&S FPS, via the

mini display.

If no external monitor is connected to the R&S FPS, an additional driver is required on
the instrument in order to control the R&S FPS via its web browser interface. If the
driver is not available, the browser shows only a black screen.

Download the TightVNC DFMirage driver from the official TightVNC website (http://
www.tightvnc.com/download.php) and install it on the R&S FPS as described on the

website.

The current R&S FPS firmware was tested with the TightYNC DFMirage driver version

2.0.301.

To display the LXI web browser interface

» Type the host name or IP address of the instrument in the address field of the
browser on your PC, for example "http://10.113.10.203".

The instrument home page (welcome page) opens.

Note: If only a black screen is displayed in the browser, install the required driver
(see "Restrictions" on page 55).

®
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The navigation pane of the browser interface contains the following elements:
. IILXIII

"Home" opens the instrument home page.
The home page displays the device information required by the LXI standard,
including the VISA resource string in read-only format.
The "Device Indicator" button allows you to physically identify the instrument.
This is useful if you have several instruments and want to know which instru-
ment the LXI home page belongs to. To identify the instrument, activate the
"Device Indicator" . Then check the "LAN Status" indicator of the instruments.
— "LAN Configuration" allows you to configure LAN parameters and to initiate a
ping.
(See "Ping Client" on page 65.)
(See
— "Status Bar" displays information about the LXI status of the instrument.

— "Utilities" provides access to the LXI event log functionality required by the LXI
standard.

® "Instrument Control"

"Web Control" provides remote access to the instrument via VNC (no installa-
tion required). Manual instrument controls are available via the front panel sim-
ulation.

— "File Download" downloads files from the instrument.
— "File Upload" uploads files to the instrument.
(See Chapter 4.4.7, "How to Control the R&S FPS via the Web Browser Interface”,
on page 77.)
® '"License Manager"
"License Manager" allows you to install or uninstall license keys and to acti-
vate, register or unregister licenses.
e "Help"
"Glossary" explains terms related to the LXI standard.
"www.rohde-schwarz.com" opens the Rohde & Schwarz home page.

4.41.2 GPIB Interface (IEC 625/IEEE 418 Bus Interface)

By connecting a PC to the R&S FPS via the GPIB connection you can send remote
commands to control and operate the instrument.

To be able to control the instrument via the GPIB bus, the instrument and the controller
must be linked by a GPIB bus cable. A GPIB bus card, the card drivers and the pro-
gram libraries for the programming language used must be provided in the controller.
The controller must address the instrument with the GPIB bus address (see Chap-

ter 4.4.2.4, "How to Change the GPIB Instrument Address", on page 66). You can set
the GPIB address and the ID response string. The GPIB language is set as SCPI by
default and cannot be changed for the R&S FPS.
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Notes and Conditions
In connection with the GPIB interface, note the following:

® Up to 15 instruments can be connected

® The total cable length is restricted to a maximum of 15 m or 2 m times the number
of devices, whichever is less; the cable length between two instruments should not
exceed 2 m.

e A wired "OR"-connection is used if several instruments are connected in parallel.
® Any connected IEC-bus cables should be terminated by an instrument or controller.

GPIB Interface Messages

Interface messages are transmitted to the instrument on the data lines, with the atten-
tion line (ATN) being active (LOW). They are used for communication between the

controller and the instrument and can only be sent by a computer which has the func-
tion of a GPIB bus controller. GPIB interface messages can be further subdivided into:

® Universal commands: act on all instruments connected to the GPIB bus without
previous addressing
® Addressed commands: only act on instruments previously addressed as listeners

The following figure provides an overview of the available communication lines used by
the GPIB interface.
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Figure 4-3: Communication lines used by the GPIB interface
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Universal Commands

Universal commands are encoded in the range 10 through 1F hex. They affect all
instruments connected to the bus and do not require addressing.

Command Effect on the instrument

DCL (Device Clear) Aborts the processing of the commands just received and sets the com-
mand processing software to a defined initial state. Does not change the
instrument settings.

IFC (Interface Clear) *) Resets the interfaces to the default setting.

LLO (Local Lockout) The "Local" softkey is disabled. Manual operation is no longer available
until GTL is executed.

SPE (Serial Poll Enable) Ready for serial poll.

SPD (Serial Poll Disable) End of serial poll.

PPU (Parallel Poll Unconfig- | End of the parallel-poll state.
ure)

*) IFC is not a real universal command, it is sent via a separate line; however, it also affects all instruments
connected to the bus and does not require addressing

Addressed Commands

Addressed commands are encoded in the range 00 through OF hex. They only affect
instruments addressed as listeners.

Command Effect on the instrument

GET (Group Execute Trigger) Triggers a previously active instrument function (e.g. a sweep).
The effect of the command is the same as with that of a pulse at
the external trigger signal input.

GTL (Go to Local) Transition to the "local" state (manual control).

GTR (Go to Remote) Transition to the "remote" state (remote control).

PPC (Parallel Poll Configure) Configures the instrument for parallel poll.

SDC (Selected Device Clear) Aborts the processing of the commands just received and sets the

command processing software to a defined initial state. Does not
change the instrument setting.

4.4.1.3 USB Interface

For remote control via the USB connection, the PC and the instrument must be con-
nected via the USB type B interface. A USB connection requires the VISA library to be
installed. VISA detects and configures the R&S instrument automatically when the
USB connection is established. You do not have to enter an address string or install a
separate driver.

USB address
The used USB address string is:



Controlling the R&S FPS Remotely

USB: :<vendor ID>::<product ID>::<serial number>[::INSTR]
where:

® <vendor ID> is the vendor ID for Rohde & Schwarz (0xOAAD)

® <product ID> is the product ID for the Rohde & Schwarz instrument

® <serial number> is the individual serial number on the rear of the instrument
Table 4-3: Product IDs for R&S FPS

Instrument model Product ID
FPS4 F9

FPS7 FA
FPS13 FB

FPS30 FC

FPS40 FD
Example:

USB::0x0AAD: :0x00FB::100001::INSTR
O0x0AAD is the vendor ID for Rohde&Schwarz

0x00FB is the product ID for the R&S FPS13

100001 is the serial number of the particular instrument

44.1.4 VISA Libraries

VISA is a standardized software interface library providing input and output functions to
communicate with instruments. The 1/0 channel (LAN or TCP/IP, USB, ...) is selected
at initialization time by one of the following:

® The channel-specific address string ("VISA resource string") indicated in Table 4-2
® An appropriately defined VISA alias (short name).

A VISA installation is a prerequisite for remote control using the following interfaces:
® Chapter 4.4.1.2, "GPIB Interface (IEC 625/IEEE 418 Bus Interface)", on page 56
® Chapter4.4.1.1, "LAN Interface", on page 51
® Chapter 4.4.1.3, "USB Interface", on page 59

For more information about VISA, refer to the user documentation.
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4.4.2 How to Configure a Network

Risk of network failure

Consult your network administrator before performing the following tasks:
® Connecting the instrument to the network

® Configuring the network

® Changing IP addresses

® Exchanging hardware

Errors can affect the entire network.

The R&S FPS is equipped with a network interface and can be connected to an Ether-
net LAN (local area network). Provided the appropriate rights have been assigned by
the network administrator and the Windows 7 firewall configuration is adapted accord-
ingly, the interface can be used, for example:

® To transfer data between a controller and the tester, e.g. in order to run a remote
control program; see the "Remote Control" chapter in the R&S FPS User Manual

® To access or control the measurement from a remote computer using the "Remote
Desktop" application (or a similar tool); see Chapter 4.4.6, "How to Set Up Remote
Desktop", on page 70

® To connect external network devices (e.g. printers)
® To transfer data from a remote computer and back, e.g. using network folders

A precondition for operating or monitoring the R&S FPS remotely is that it is connected
to a LAN network or a PC connected to the GPIB interface. This is described here.

Windows Firewall Settings

6 A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. Rohde & Schwarz highly recommends the use of the firewall on
your instrument. R&S instruments are shipped with the Windows firewall enabled and
preconfigured in such a way that all ports and connections for remote control are
enabled. For more details on firewall configuration see the Rohde & Schwarz White
Paper 1DCO01: Malware Protection and the Windows 7 help system.

4.4.21 How to Connect the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:

® A non-dedicated network (Ethernet) connection from the instrument to an existing
network made with an ordinary RJ-45 network cable. The instrument is assigned
an IP address and can coexist with a computer and with other hosts on the same
network.


http://www.rohde-schwarz.com/appnote/1DC01
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® A dedicated network connection (Point-to-point connection) between the instru-
ment and a single computer made with a (crossover) RJ-45 network cable. The
computer must be equipped with a network adapter and is directly connected to the
instrument. The use of hubs, switches, or gateways is not required, however, data
transfer is still performed using the TCP/IP protocol. An IP address has to be
assigned to the instrument and the computer, see Chapter 4.4.2.2, "How to Assign
the IP Address", on page 62.
Note: As the R&S FPS uses a 1 GBit LAN, a crossover cable is not necessary
(due to Auto-MDI(X) functionality).

» To establish a non-dedicated network connection, connect a commercial RJ-45
cable to one of the LAN ports.
To establish a dedicated connection, connect a (crossover) RJ-45 cable between
the instrument and a single PC.

If the instrument is connected to the LAN, Windows 7 automatically detects the net-
work connection and activates the required drivers.

The network card can be operated with a 1 GBit Ethernet IEEE 802.3u interface.

How to Assign the IP Address

Depending on the network capacities, the TCP/IP address information for the instru-

ment can be obtained in different ways.

® If the network supports dynamic TCP/IP configuration using the Dynamic Host
Configuration Protocol (DHCP), all address information can be assigned automati-
cally.

® |f the network does not support DHCP, or if the instrument is set to use alternate
TCP/IP configuration, the addresses must be set manually.

By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically. This means that it is safe to establish a
physical connection to the LAN without any previous instrument configuration.

Risk of network errors

Connection errors can affect the entire network. If your network does not support
DHCP, or if you choose to disable dynamic TCP/IP configuration, you must assign
valid address information before connecting the instrument to the LAN. Contact your
network administrator to obtain a valid IP address.

Assigning the IP address directly on the R&S FPS
1. In the R&S FPS's mini display, navigate to "Network" > "DHCP".

2. If DHCP is "Off", you must enter the IP address manually, as described in the fol-
lowing steps.
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Note: When DHCP is changed from "On" to "Off", the previously set IP address
and subnet mask are retrieved.

If DHCP is "On", the IP address of the DHCP server is obtained automatically. The
configuration is saved, and you are prompted to restart the instrument. You can
skip the remaining steps.

Note: When a DHCP server is used, a new IP address may be assigned each time
the instrument is restarted. This address must first be determined on the instrument
itself. Thus, when using a DHCP server, it is recommended that you use the per-
manent computer name, which determines the address via the DNS server.

3. Inthe R&S FPS's mini display, navigate to "Network" > "IP".

4. Enter the "IP Address", for example 70.0.0.70. The IP address consists of four
number blocks separated by dots. Every block contains 3 numbers in maximum.
Enter the required address: Use the <Up Arrow> and <Down Arrow> keys to scroll
through the digits 1-10 and the <Left Arrow> and <Right Arrow> keys to move
between the individual numbers and blocks.

5. Enter the "Subnet Mask", for example 255.255.255.0. The subnet mask consists of
four number blocks separated by dots. Every block contains 3 numbers in maxi-
mum.

6. Press the ENTER key to store the entry and exit the edit mode.

7. Inthe R&S FPS's mini display, navigate to "System commands" > "Reboot system"
to restart the system.

How to Configure the LAN Using the LXI Web Browser Interface

The instrument's LXI browser interface works correctly with all W3C compliant brows-
ers.

If no external monitor is connected to the R&S FPS, an additional driver is required on
the instrument in order to control the R&S FPS via its web browser interface. If the
driver is not available, the browser shows only a black screen.

Download the TightVNC DFMirage driver from the official TightYNC website (http://
www.tightvnc.com/download.php) and install it on the R&S FPS as described on the
website.

The current R&S FPS firmware was tested with the TightVNC DFMirage driver version
2.0.301.

» In the web browser, open the http://<instrument-hostname> or http://
<instrument-ip-address> page, e.g. http://10.113.10.203.
The default password to change LAN configurations is LxiWeblfc.

The "Instrument Home Page" (welcome page) opens.


http://www.tightvnc.com/download.php
http://www.tightvnc.com/download.php
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The instrument home page displays the device information required by the LXI stan-
dard including the VISA resource string in read-only format.

EE

» Press the "Device Indicator" button on the "Instrument Home Page" to activate or
deactivate the LXI status icon on the status bar of the R&S FPS. A green LXI sta-

tus symbol indicates that a LAN connection has been established; a red symbol

indicates an error, for example, that no LAN cable is connected. When a device is
connecting to the instrument, the LXI logo blinks. The "Device Indicator" setting is
not password-protected.

The most important control elements in the navigation pane of the browser interface

are the following:

® "LAN Configuration" opens the menu with configuration pages.

e "Status" displays information about the LXI status of the instrument.

® "Help > Glossary" opens a document with a glossary of terms related to the LXI

standard.

LAN Configuration

The LAN configuration consists of three parts:

® "|P configuration" provides all mandatory LAN parameters.

e "Advanced LAN Configuration" provides LAN settings that are not declared manda-
tory by the LXI standard.

User Manual 1176.8445.02 — 09
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® "Ping Client" provides the ping utility to verify the connection between the instru-
ment and other devices.

IP Configuration

The "LAN Configuration > IP configuration" web page displays all mandatory LAN
parameters and allows their modification.

The "TCP/IP Mode" configuration field controls how the IP address for the instrument
gets assigned (see also Chapter 4.4.2.2, "How to Assign the IP Address", on page 62).

For the manual configuration mode, the static IP address, subnet mask, and default
gateway are used to configure the LAN. The automatic configuration mode uses DHCP
server or Dynamic Link Local Addressing (Automatic IP) to obtain the instrument IP
address.

Changing the LAN configuration is password-protected. The default password is Lxi-
Weblfc (notice upper and lower case characters).

Advanced LAN Configuration

The "LAN Configuration > Advanced LAN Configuration" parameters are used as fol-

lows:

® The "Negotiation" configuration field provides different Ethernet speed and duplex
mode settings. In general, the "Auto Detect" mode is sufficient.

e "ICMP Ping" must be enabled to use the ping utility.

e "VXI-11"is the protocol that is used to detect the instrument in the LAN. According
to the standard, LXI devices must use VXI-11 to provide a detection mechanism;
other additional detection mechanisms are permitted.

® mDNS and DNS-SD are two additional protocols: Multicast DNS and DNS Service
Discovery. They are used for device communication in zero configuration networks
working without DNS and DHCP

Ping Client

Ping is a utility that verifies the connection between the LXI-compliant instrument and
another device. The ping command uses the ICMP echo request and echo reply pack-
ets to determine whether the LAN connection is functional. Ping is useful for diagnos-
ing IP network or router failures. The ping utility is not password-protected.

To initiate a ping between the LXI-compliant instrument and a second connected

device:

1. Enable "ICMP Ping" on the "Advanced LAN Configuration" page (enabled after an
LCI).

2. Enter the IP address of the second device without the ping command and with-
out any further parameters into the "Destination Address" field (e.g.
10.113.10.203).
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3. Select "Submit".

How to Change the GPIB Instrument Address

In order to operate the instrument via remote control, it must be addressed using the
GPIB address. The remote control address is factory-set to 20, but it can be changed if
it does not fit in the network environment. For remote control, addresses 0 through 30
are allowed. The GPIB address is maintained after a reset of the instrument settings.

To change the GPIB address

1. Inthe R&S FPS's mini display menu, navigate to "GPIB" > "GPIB address" and
press the ENTER key.

2. Enter the required address: Use the <Up Arrow> and <Down Arrow> keys to scroll
through the digits 1-10 and the <Left Arrow> and <Right Arrow> keys to move
between the first and second digits.

3. Press the ENTER key again to store the entry and exit the edit mode.

Remote command:

SYST:COMM:GPIB:ADDR 18

How to Log on to the Network

Windows 7 requires that users identify themselves by entering a user name and pass-
word in a login window. You can set up two types of user accounts, either an adminis-
trator account with unrestricted access to the computer/domain or a standard user
account with limited access. The instrument provides an auto-login function for the
administrator account, i.e. login with unrestricted access is carried out automatically in
the background. By default, the user name for the administrator account is "Instru-
ment", and the user name for the standard user account is "NormalUser". In both
cases the initial password is "894129". You can change the password in Windows 7 for
any user at any time. Some administrative tasks require administrator rights (e.g. firm-
ware updates or the configuration of a LAN network).

Refer to Chapter 10, "General Instrument Setup”, on page 532 to find out which func-
tions are affected.

At the same time you log on to the operating system, you are automatically logged on
to the network. As a prerequisite, the user name and the password must be identical
on the instrument and on the network.

How to Create Users

After the software for the network has been installed, the instrument issues an error
message the next time it is switched on because there is no user named "instrument"
(= default user ID for Windows 7 automatic login) in the network. Thus, a matching
user must be created in the R&S FPS and in the network, the password must be adap-

HE
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ted to the network password, and the automatic login mechanism must then be deacti-
vated.

In order to configure users for the R&S FPS, a controller pc or an external monitor,
mouse and keyboard must be connected to the R&S FPS. See Chapter 4.4.6, "How to
Set Up Remote Desktop", on page 70.

The network administrator is responsible for creating new users in the network. A new
user can be created on the instrument using the "User Account" dialog box:

"R
Select the "Windows" icon in the toolbar to access the operating system of the
R&S FPS.

2. In the "Start" menu, select "Control Panel" and then select "User Accounts."

3. Select "Give other users access to this computer" and then "Add".
The "Add New User" dialog box is displayed.

4. Enter the name of the new user in the text field and select "Next".

5. Define the level of access you want to allow the new user:

e Select "Standard" to create an account with limited rights.
e Select "Administrator" to create an account with administrator rights.

Note: Full firmware functionality requires administrator rights.

6. Select the "Finish" button.
The new user is created.

4.4.3.2 How to Change the User Password

monitor, mouse and keyboard must be connected to the R&S FPS. See Chapter 4.4.6,

6 In order to change the user passwords for the R&S FPS, a controller pc or an external
"How to Set Up Remote Desktop", on page 70.

After the new user has been created on the instrument, the password must be adapted
to the network password. This is also done using the "User Accounts" dialog box.

R
Select the "Windows" icon in the toolbar to access the operating system of the
R&S FPS.

2. Select CTRL + ALT + DELETE, then select "Change a password".

3. Enter the user account name.

4. Enter the old password.
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5. Enter the new password in the upper text line and repeat it in the following line.

6. Select ENTER.
The new password is now active.

4.4.3.3 How to Activate or Deactivate the Automatic Login Mechanism

controller pc or an external monitor, mouse and keyboard must be connected to the

6 In order to activate or deactivate the automatic login mechanism on the R&S FPS, a
R&S FPS. See Chapter 4.4.6, "How to Set Up Remote Desktop”, on page 70.

Deactivating the automatic login mechanism

When shipped, the instrument is already configured to automatically log on under Win-
dows 7. To deactivate the automatic login mechanism, perform the following steps:

1. #
Select the "Windows" icon in the toolbar to access the operating system of the

R&S FPS.

2. Inthe "Start" menu, select "Run".
The "Run" dialog box is displayed.

3. Enter the command C:\R_S\INSTR\USER\NO AUTOLOGIN.REG.

4. Select the ENTER key to confirm.
The automatic login mechanism is deactivated. The next time you switch on the
instrument, you are prompted to enter your user name and password before the
firmware is started.

Reactivating the automatic login mechanism

"R
Select the "Windows" icon in the toolbar to access the operating system of the

R&S FPS.

2. In the "Start" menu, select "Run".
The "Run" dialog box is displayed.

3. Enter the command C:\R_S\INSTR\USER\AUTOLOGIN.REG.

4. Select the ENTER key to confirm.
The automatic login mechanism is reactivated. It will be applied the next time the
instrument is switched on.
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4.4.4 How to Share Directories (only with Microsoft Networks)

Sharing directories makes data available for other users. This is only possible in Micro-
soft networks. Sharing is a property of a file or directory.

i

In order to configure shared directories on the R&S FPS, a controller pc or an external
monitor, mouse and keyboard must be connected to the R&S FPS. See Chapter 4.4.6,
"How to Set Up Remote Desktop", on page 70.

445

1.

!

Select the "Windows" icon in the toolbar to access the operating system of the
R&S FPS.

In the "Start" menu, select "Programs”, "Accessories" and then select "Windows
Explorer".

Select the desired folder with the right mouse button.

In the context menu, select "Sharing with > Specific people”.
The dialog box for sharing a directory is displayed.

Select a user from the list or add a new name and select the "Add" button.
Select the "Share" button.

Select "Done" to close the dialog box.
The drive is shared and can be accessed by the selected users.

How to Start a Remote Control Session from a PC

When you switch on the instrument, it is always in manual operation state ("local”
state) and can be operated via Remote Desktop from an external PC.

1.

Send an addressed command (GTR - Go to Remote) from a controller to the instru-
ment.

The instrument is switched to remote control ("remote” state). Operation via the
soft front panel (on the Remote Desktop) is disabled. (The keys on the R&S FPS
remain enabled.) The instrument remains in the remote state until it is reset to the
manual state via the remote control interface.

Switching from manual operation to remote control and vice versa does not affect
the other instrument settings.

To obtain optimum performance during remote control, send the
SYSTem:DISPlay:UPDate OFF command to hide the display of results and dia-
grams on the controller PC or external monitor (default setting in remote control).
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3. To enable manual operation via the soft front panel on the Remote Desktop again,
switch the instrument to local mode using the remote command GTL (Go to Local),
that is, deactivate the REN line of the remote control interface.

4.4.6 How to Set Up Remote Desktop

4.4.6.1

Remote Desktop is a Windows application which can be used to access and control
the instrument from a remote computer through a LAN connection. While the instru-
ment is in operation, the instrument uses the display on the remote computer, and
Remote Desktop provides access to all of the applications, files, and network resour-
ces of the instrument. Thus, remote operation of the R&S FPS is possible.

With Windows 7, Remote Desktop Client is part of the operating system. For other ver-
sions of Windows, Microsoft offers the Remote Desktop Client as an add-on.

This section provides basic instructions on setting up the Remote Desktop for the
R&S FPS. For details refer to the Windows 7 operating system documentation.

How to Configure the R&S FPS for Remote Operation via Remote Desktop

By default, the R&S FPS is configured to allow Remote Desktop access by any user
(except for the "SecureUser", see Chapter 4.4.6.5, "How to Add or Remove Users to
the Remote Desktop Users Group", on page 75), and to use a fixed IP address.

To change the settings for remote operation, you must connect an external monitor,
mouse and keyboard, or connect a controller PC and set up a Remote Desktop con-
nection with the default settings as described in Chapter 4.4.6.3, "How to Start and
Close the Remote Desktop", on page 73.

To change the settings for Remote Desktop access

To avoid problems, use a fixed IP address (see Chapter 4.4.2.2, "How to Assign the IP
Address", on page 62).

When a DHCP server is used, a new IP address is assigned each time the instrument

is restarted. This address must first be determined on the instrument itself. Thus, using
a DHCP server is not suitable for remote operation of the R&S FPS via Remote Desk-

top.

1.*

Select the "Windows" icon in the toolbar to access the operating system of the
R&S FPS.

2. In the "Start" menu, select the "Control Panel” and then "System and Security".

3. Inthe "System" area, select "Allow remote access".



Controlling the R&S FPS Remotely

ErarE

G_'ﬁ .r% v Contrel Panel » System and Security »

Control Panel Home

 eetumand Sty Review your computer's 4 | 2 d | System Protection | Remote .

ﬂ‘ Change User Account A ki

Netwrork and Intemet Troubleshoot commaon ¢

Hardware and Sound . - [¥] Alow Remate Asastance connections to this computer
Windows Firewall

Programs Check firewall status e Fricis: il a2

User Accounts
Systemn

Sppesrancens [ (Ao

.

anguage, a ion

B A a Windows Update

Tum automatic updating| Click &n oplion, and then specify who can conned, f neadad

k4
%

Action Center

Power Options
Require 3 password when|
Change when the compul

Backup and Restore

- | +y | I—'z_—fﬂnc.‘: Contral Panel p el |

(21 Don't allow connechons to this computer

@ Allow connections from computers unning army wersion of
Remate Deskicp fess sscure)

Backup yourcomputer ] | | © flom ovredions ooy compucsaerion Fewts
Administrative Too
Free up disk space | Del

ﬁ' Create and format har

Help me chopse

& Seect User.. |

Foply

4. Inthe "Remote" tab, in the "Remote Desktop" area, activate the "Allow connections
from computers running Remote Desktop" option.

5. Define which users are to be given access to the R&S FPS via Remote Desktop.
If the secure user mode is deactivated, the "SecureUser" account is also deactiva-
ted. Thus, the procedure described here will not work for the "SecureUser".
Instead, see Chapter 4.4.6.5, "How to Add or Remove Users to the Remote Desk-
top Users Group", on page 75.
Note: Administrator user accounts (e.g. "Instrument") are automatically enabled for
Remote Desktop.

a) Select the "Select Users" button.

b) Select the users or create new user accounts as described in Chapter 4.4.3.1,
"How to Create Users", on page 66.

c) Select "OK" to confirm the settings.

6. The R&S FPS is now ready for connection setup with the Remote Desktop pro-
gram of the controller.

4.4.6.2 How to Configure the Controller

i

Remote Desktop Client

With Windows 7, Remote Desktop Client is part of the operating system and can be
accessed via "Start > Programs > Accessories > Remote Desktop Connection”.

For other versions of Windows, Microsoft offers the Remote Desktop Client as an add-
on.
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In the "Start" menu of the controller, select "All Programs > Accessories > Remote
Desktop Connection".
The "Remote Desktop Connection" dialog box is displayed.

Select the "Options >>" button.
The dialog box is expanded to display the configuration data.

‘B Rernote Desktop Connection || =[=]
L) P (S8

4 Remote Desktop
¢ Connection

General |Display|LocaJF€&Bom|ngm|E;q}eﬂenmlemd
Logon settings
ﬂ! | Enterthe name of the remote computer.
|

Computer: 123456 -

Usermame:  instrumert]|

You will be asked for credentials when you connect.

Allow me to save credentials

Connection settings
Save the cument connection settings to an ROP file or open a
i saved connection.
[ Save ] ’ Sawve As.. ] [ Cpen... ]
'CE)- Cptions l Connect I [ Help ]

Open the "Experience" tab.
The settings on this tab are used to select and optimize the connection speed.

In the list, select the appropriate connection (for example: LAN (10 Mbps or
higher)).

Depending on your selection (and how powerful the connection is), the options are
activated or deactivated.

To improve the performance, you can deactivate the "Desktop background", "Show
window contents while dragging" and "Menu and window animation" options.

Open the "Local Resources" tab to enable printers, local drives and serial interfa-
ces.

If you will need to access drives of the controller from the R&S FPS (e.g. in order to
store settings or to copy files from the controller to the R&S FPS), activate the
"Disk drives" option.

Windows will then map drives of the controller to the corresponding network drives.

To use printers connected to the controller while accessing them from the
R&S FPS, activate the "Printers" options. Do not change the remaining settings.

Open the "Display" tab.
The options to configure the R&S FPS screen display are displayed.
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10. Under "Remote desktop size", you can set the size of the R&S FPS window on the
desktop of the controller.

11. Under "Colors", do not change the settings.

12. Set the "Display the connection bar when | use the full screen" option:
If activated, a bar showing the network address of the R&S FPS will appear at the
top edge of the screen. You can use this bar to reduce, minimize or close the win-
dow.
If deactivated, the only way you can return to the controller desktop from the
R&S FPS screen in full screen mode is to select "Disconnect” from the "Start"
menu.

4.4.6.3 How to Start and Close the Remote Desktop

To set up a connection from the controller to the R&S FPS

1. On the controller, in the "Remote Desktop Connection" dialog box (see Chap-
ter 4.4.6.2, "How to Configure the Controller", on page 71), open the "General" tab.

2. In the "Computer" field, enter the IP address of the R&S FPS (see Chapter 4.4.2.2,
"How to Assign the IP Address", on page 62 to determine the IP address).
In the "User name" field, enter instrument to log in as an administrator, or Normal
User to log in as a standard user.
In the "Password" field, enter 894129.

3. To save the connection configuration for later use:

a) Select the "Save As" button.
The "Save As" dialog box is displayed.
b) Enter the name for the connection information (* . RDP).

4. To load an existing connection configuration:

a) Select the "Open" button.
The "Open" dialog box is displayed.
b) Select the * .RDP file.

5. Select the "Connect" button.
The connection is set up.

6. If the "Disk drives" option is activated on the "Local Resources" tab, a warning is
displayed indicating that the drives are enabled for access from the R&S FPS.
Select "OK" to confirm the warning.

7. After a few moments, the R&S FPS screen is displayed and manual operation is
possible.

For details on manual operation see Chapter 4.5, "Operating the Instrument in
Manual Mode", on page 80.
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8. If a dark screen appears or a dark square appears in the upper left-hand corner of
the screen, you must restart the R&S FPS in order to see the modified screen reso-

lution.
®  Select the key combination ALT + F4.
[ i ® The R&S FPS firmware is shut down, which may take a few sec-
H— onds.

®  On the desktop, double-click the "Analyzer" icon.
Analyzer

The firmware restarts and then automatically opens the graphical user interface
from which you can access all instrument functions and settings.
For more information see Chapter 4.5.1.3, "Front Panels", on page 83.

9. After the connection is established, the R&S FPS screen is displayed in the
"Remote Desktop" application window.
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To terminate Remote Desktop control

» On the controller, close the "Remote Desktop" window at any time.
The connection to the R&S FPS is terminated.
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Restoring the connection to the R&S FPS

Follow the instructions above for setting up a connection to the R&S FPS. If the con-
nection is terminated and then restored, the R&S FPS remains in the same state.

How to Shut Down the R&S FPS via Remote Desktop

1. Select the R&S FPS's soft front panel on the Remote Desktop and close the appli-
cation with the key combination ALT + F4.

A safety query is displayed to warn you that the instrument cannot be reactivated
via remote operation and asks you whether you want to continue the shutdown
process.

2. Confirm the safety query with "Yes".
The connection with the controller is terminated and the R&S FPS is shut down.

How to Add or Remove Users to the Remote Desktop Users Group

Only users in the Remote Desktop Users Group are allowed to connect to the

R&S FPS via Remote Desktop. You can add the users to this group directly when you
allow remote access on the R&S FPS, as described in Chapter 4.4.6, "How to Set Up
Remote Desktop", on page 70. Furthermore, you can add or remove users to this
group at any time.

©,

In order to add or remove users to the Remote Desktop users group for the R&S FPS,
a controller pc or an external monitor, mouse and keyboard must be connected to the
R&S FPS. See Chapter 4.4.6, "How to Set Up Remote Desktop", on page 70.

O

Secure User Mode

For security reasons, the "SecureUser" used in secure user mode is not allowed
Remote Desktop access to the R&S FPS by default (see Chapter 4.1.6, "Protecting
Data Using the Secure User Mode", on page 33). You must explicitely add the
"SecureUser" to the Remote Desktop group. If you do not allow this user RemoteDesk-
top access, the "SecureUser" will only be able to operate the R&S FPS using remote
commands or via the miniature display.

1. If necessary, disable the "SecureUser" on the R&S FPS (miniature display: "Sys-
tem commands > Disable SecureUser").

2. Login using the administrator ("Instrument" user) account.

3. Start a RemoteDesktop connection to the R&S FPS as described in "To set up a
connection from the controller to the R&S FPS" on page 73.

4.&
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Select the "Windows" icon in the toolbar to access the operating system of the
R&S FPS.

5. Open the Windows Explorer.

6. Select the directory:
Control Panel\All Control Panel Items\Administrative Tools.

7. Double-click "Computer Management".
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8. In the "Computer Management" dialog box, select "Local Users and Groups\Users"
on the left side.
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10. In the "SecureUser Properties" dialog box, switch to the "Member of" tab and click
"Add".
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11. In the "Select Groups" dialog box, enter the "Remote Desktop Users" group and
select "OK".
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12. Select "Apply".
13. Select "OK" and close all dialog boxes.
14. Reboot the R&S FPS firmware so the changes become effective.

The new user (e.g. "SecureUser") should now be able to access the R&S FPS via
RemoteDesktop.

How to Control the R&S FPS via the Web Browser Interface

Via the LXI browser interface to the R&S FPS one or more users can control the instru-
ment remotely from another PC without additional installation. Most instrument controls
are available via the front panel simulation. File upload and download between the
instrument and the remote PC is also available.



Controlling the R&S FPS Remotely

the instrument in order to control the R&S FPS via its web browser interface. If the
driver is not available, the browser shows only a black screen.

Download the TightVNC DFMirage driver from the official TightVNC website (http://
www.tightvnc.com/download.php) and install it on the R&S FPS as described on the
website.

6 If no external monitor is connected to the R&S FPS, an additional driver is required on

The current R&S FPS firmware was tested with the TightYNC DFMirage driver version
2.0.301.

To access the R&S FPS via the web browser interface

1. Start a web browser that supports htmlI5 (W3C compliant).

2. Enter the IP address of the R&S FPS in the browser's address bar.
The R&S FPS's Welcome page is displayed.

3. Inthe navigation pane, select "Instrument Control > Web Control".

The instrument's display is shown in a new browser window, with a software front
panel displayed beside or below it.

4. Use the mouse cursor to access the functionality in the software front panel or in
the display as you would directly on the instrument's front panel.
To exchange files with the R&S FPS

You can download files, for example stored measurement data, from the R&S FPS to
the remote PC, or upload files, for example limit line definitions, from the PC to the
R&S FPS.

1. In the web browser, select the Welcome page window.

2. In the navigation pane, select "Instrument Control" > "File Upload" or "File Down-
load".


http://www.tightvnc.com/download.php
http://www.tightvnc.com/download.php
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The most commonly used folders on the instrument are displayed, for example
those that contain user data, as well as the top-most My Computer folder, from
which you can access all other folders on the instrument.

3. To download a file from the R&S FPS, select the file from the displayed folders and
then select "Download File".

4. To upload a file to the R&S FPS:

a) From the displayed folders in the web browser window, select the folder on the
R&S FPS to which you want to copy a file.

b) Under "File to Upload", select "Browse" to open a file selection dialog box and
select the required file on the PC.

c) Select "Upload" to copy the file from the PC to the defined folder on the
R&S FPS.

4.4.8 How to Deactivate the Web Browser Interface

If you want to prevent other users in the LAN from accessing or operating the

R&S FPS via its LXI web browser interface, you must deactivate this function. Note
that after a firmware update the function is automatically active again until you
deactivate it manually.

To deactivate the LXI web browser interface

1..

Select the "Windows" icon in the toolbar to access the operating system.

2. In the "Start" menu, select "Control Panel".
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3. Select "System and Security" > "Administrative Tools".
4. From the list on the right, select "Services".

5. From the list of local services, select "R&S TightVNC Server".
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6. Set "Startup type" to "Disabled".
7. Select "Stop".
8. Select "Apply".

The next time a user enters the IP address of the instrument in a web browser, an
error message is displayed:
Failed to connect to server (code. 1006)

4.5 Operating the Instrument in Manual Mode

The R&S FPS is completely remote-controlled; it does not provide a display for manual
measurement control. The miniature display on the front panel of the R&S FPS allows
only for very basic instrument configuration (see Chapter 4.3, "Miniature Display",

on page 41).

However, although the R&S FPS does not have a built-in display for manual measure-
ment control, it is possible to operate it interactively in manual mode using a graphical
user interface on an external monitor or a controller PC.

It is recommended that you use the manual mode initially to get familiar with the instru-
ment and its functions before using it in pure remote mode. Thus, this section
describes in detail how to operate the instrument manually using a controller PC and
mouse, or an external monitor, mouse and keyboard. It describes what kind of informa-
tion is displayed in the diagram area, how to use the soft front panel keys and other
interface elements, and how to use the Online Help.

User Manual 1176.8445.02 — 09 80
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Graphical User Interface Elements (Soft Front Panel)

All tasks necessary to operate the instrument can be performed using the graphical
user interface provided by the soft front panel, a virtual front panel displayed on the
external monitor or the Remote Desktop.

All measurement results are displayed. Additionally, the display provides status and
setting information, allows you to switch between various measurement tasks, and pro-
vides access to all measurement functions.
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Figure 4-4: Graphical user interface elements in the R&S FPS's soft front panel

= Toolbar with standard application functions, e.g. print, save/open file etc.
= Tabs for individual measurement channels

= Channel bar for firmware and measurement settings

= Input field for measurement setting

= Softkeys for function access

= Window title bar with diagram-specific (trace) information

= Measurement results area

NOoO g WOWN -

|
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8 = Diagram footer with diagram-specific information, depending on application
9 = Instrument status bar with error messages, progress bar and date/time display
10 = Front panel with keys, keypad, navigation elements

4511 Toolbar

Standard functions can be performed via the icons in the toolbar at the top of the
screen.

ment results ("Setup > Display > Displayed ltems"). See the R&S FPS User Manual for

@ You can hide the toolbar display in order to enlarge the display area for the measure-
details.

The following functions are available:

Table 4-4: Standard Application Functions in the Toolbar

Icon Description

Windows: displays the Windows "Start" menu and task bar

Open: opens a file from the instrument ("Save/Recall" menu)

Store: stores data on the instrument ("Save/Recall" menu)

m | % &

Print: defines print settings ("Print" menu)

ez

Undo: reverts last operation

Redo: repeats previously reverted operation

Selection mode: the cursor can be used to select (and move) markers in a zoomed display

Zoom mode: displays a dotted rectangle in the diagram that can be expanded to define the
zoom area

Multiple zoom mode: multiple zoom areas can be defined for the same diagram

Zoom off: displays the diagram in its original size

SmartGrid: activates "SmartGrid" mode to configure the screen layout

o B B & 3|9
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Icon Description

S@ Sequencer: opens the "Sequencer" menu to perform consecutive measurements

t{\."? Help (+ Select): allows you to select an object for which context-specific help is displayed

AL Analysis line (MSRA mode only): opens a dialog box to display and position an analysis line in
MSRA measurements (see R&S FPS MSRA User Manual)

? Help: displays context-sensitive help topic for currently selected element

Print immediately: prints the current display (screenshot) as configured

In "SmartGrid" mode only:

Exit "SmartGrid" mode

X

Softkeys

Softkeys are virtual keys provided by the software. Softkeys are dynamic, i.e. depend-
ing on the selected function key, a different list of softkeys is displayed on the right side
of the screen.

A list of softkeys for a certain function key is also called a menu. Softkeys can either
perform a specific function or open a dialog box.

The "More" softkey indicates that the menu contains more softkeys than can be dis-
played at once on the screen. When selected, it displays the next set of softkeys.

Recognizing the softkey status by color

A softkey is highlighted orange when its associated dialog box is open. If it is a toggle
softkey, the current state is highlighted blue. If an instrument function is not available
temporarily due to a specific setting, the associated softkey is deactivated and its text
is colored gray.

Some softkeys belong to a certain (firmware) option. If this option is not installed in
your instrument, the associated softkeys are not displayed.

You can hide the softkey display in order to enlarge the display area for the measure-
ment results ("Setup > Display > Displayed ltems"). See the User Manual for details.

4.51.3

Front Panels

The virtual "Front Panel" provides (static) function keys to access basic instrument
functions and softkey menus, as well as a keypad and navigation keys.
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Figure 4-5: Front panel elements

1 = System keys

2 = Function keys
3 = Keypad

4 = Navigation keys

The measurement and instrument functions and settings can be accessed by selecting
the corresponding keys in the front panel. To activate a key, select the key in the dis-
play using the mouse pointer.

The virtual front panel is displayed by default when you connect an external monitor or
use Remote Desktop with the R&S FPS.

To toggle the front panel display, press the F6 key on the controller PC or an external
keyboard.

Mini Front Panel

The Mini Front Panel displays only the basic system and function keys in a detached
dialog box that can be moved around the screen.

Mini Front Panel E @

FREDQ AMPT AUTO PEAK
CHAMMEL A SCALE 5ET [ s ] SEARCH

BW SWEEP TRACE TRIG [ MKR ][ MKR -= ]

FUNLCT

o) ) (o
HEEl S8
[ Close Panel ]

Figure 4-6: Mini Front Panel

You can close the window by selecting "Close Panel" or the key combination ALT + M
(be aware of the keyboard language defined in the operating system!).
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To display the front panel or mini front panel

1. If neither the default front panel nor the mini front panel are displayed, press the F6
key on the controller pc or external keyboard to access the virtual system keys.

2. Select the SETUP key and then the "Display” softkey.

3. Select the "Displayed ltems" tab.

4. Select "Front Panel: On" or "Mini Front Panel: On".
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SYSTEM Keys

The virtual SYSTEM keys set the instrument to a defined state, change basic settings,
and provide print and display functions.

A detailed description of the corresponding functions is provided in the R&S FPS User
Manual.

Table 4-5: SYSTEM keys

SYSTEM key Assigned functions

PRESET Resets the instrument to the default state.

MODE Provides the selection between applications

SETUP Provides basic instrument configuration functions, e.g.:

e  Reference frequency (external/internal)

® Date, time, display configuration

®  Firmware update and enabling of options

® |nformation about instrument configuration incl. firmware version and
system error messages

®  Service support functions

E Switches between the on-screen keyboard display:
at the top of the screen

at the bottom of the screen

off
E “ﬂ Switches between maximized and split (tiled) display of the focused area
(Tile-Max)
@ Toggles the focus area between windows.
(Toggle)

Function Keys

The virtual function keys provide access to the most common measurement settings
and functions.
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A detailed description of the corresponding functions is provided in the R&S FPS User
Manual.

Table 4-6: Function keys

Function key Assigned functions

Basic measurement settings

FREQ Sets the center frequency as well as the start and stop frequencies for
the frequency range under consideration. This key is also used to set the
frequency offset and the signal track function.

SPAN Sets the frequency span to be analyzed.

AMPT Sets the reference level, the displayed dynamic range, the RF attenua-
tion and the unit for the level display.

Sets the level offset and the input impedance.
Activates the preamplifier (option RF Preamplifier, R&S FPS-B22).

AUTO SET Enables automatic settings for level, frequency or sweep type mode.
BW Sets the resolution bandwidth and the video bandwidth.
SWEEP Sets the sweep time and the number of measurement points.

Selects continuous measurement or single measurement.

TRACE Configures the measured data acquisition and the analysis of the mea-
surement data.

TRIG Sets the trigger mode, the trigger threshold, the trigger delay, and the
gate configuration in the case of gated sweep.

Marker functions

MKR Sets and positions the absolute and relative measurement markers
(markers and delta markers).

PEAK SEARCH Performs a peak search for active marker. If no marker is active, normal
marker 1 is activated and the peak search is performed for it.

MKR FUNC Provides additional analysis functions of the measurement markers:
Frequency counter (Sig Count)

Fixed reference point for relative measurement markers (Ref Fixed)
Noise marker (Noise Meas)

Phase noise (Phase Noise)

n dB down function

Peak list

MKR-> Used for search functions of the measurement markers (maximum/mini-
mum of the trace).

Assigns the marker frequency to the center frequency, and the marker
level to the reference level.

Restricts the search area (Search Limits) and characterizes the maxi-
mum points and minimum points (Peak Excursion).

Measurement and evaluation functions
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Function key Assigned functions

MEAS Provides the measurement functions.

Measurement of multicarrier adjacent channel power (Ch Power ACLR)
Carrier to noise spacing (C/N C/No)

Occupied bandwidth (OBW)

Spectrum emission mask measurement (Spectrum Emission Mask)
Spurious emissions (Spurious Emissions)

Measurement of time domain power (Time Domain Power)

Signal statistics: amplitude probability distribution (APD) and cumulative
complementary distribution function (CCDF)

Third-order intercept point (TOI)
AM modulation depth (AM Mod Depth)

MEAS CONFIG Provides access to measurement configuration.
LINES Configures display lines and limit lines.
INPUT/OQUTPUT Displays softkeys for input/output functions.

Measurement start functions

RUN SINGLE Starts a single new measurement (Single Sweep Mode).

RUN CONT Starts a continuous measurement (Continuous Sweep Mode).

Function execution

UNDO Reverts last operation

REDO Repeats previously reverted operation.

UNDO/REDO keys

® The virtual UNDO key reverts the previously performed action, i.e. the status
before the previous action is retrieved.
The undo function is useful, for example, if you are performing a zero span mea-
surement with several markers and a limit line defined and accidentally click the
"ACP" softkey. In this case, very many settings would be lost. However, if you
select UNDO immediately afterwards, the previous status is retrieved, i.e. the zero
span measurement and all settings.

® The virtual REDO key repeats the previously reverted action, i.e. the most recently
performed action is repeated.

The UNDO function is not available after a PRESET or "RECALL" operation. When
these functions are used, the history of previous actions is deleted.

The UNDO/REDO functions are not available for some applications; see Release
Notes for details.

Keypad

The virtual keypad is used to enter alphanumeric parameters, including the corre-
sponding units (see also Chapter 4.5.4, "Entering Data", on page 98). It contains the
following keys:



Table 4-7: Keys on the keypad

Operating the Instrument in Manual Mode

Type of key

Description

Alphanumeric keys

Enter numbers and (special) characters in edit dialog boxes.

Decimal point

Inserts a decimal point "." at the cursor position.

Sign key

Changes the sign of a numeric parameter. In the case of an alphanu-
meric parameter, inserts a "-" at the cursor position.

Unit keys (GHz/-dBm MHz/
dBm, kHz/dB and Hz/dB)

These keys add the selected unit to the entered numeric value and com-
plete the entry.

In the case of level entries (e.g. in dB) or dimensionless values, all units
have the value "1" as multiplying factor. Thus, they have the same func-
tion as an ENTER key.

Navigation Controls

The navigation controls include a virtual rotary knob, navigation keys, and data input
function keys. They allow you to navigate within the display or within dialog boxes.

Rotary knob simulation

The virtual rotary knob has several functions:

® Increments (clockwise direction) or decrements (counter-clockwise direction) the
instrument parameter at a defined step width in the case of a numeric entry.

® Shifts the selection bar within focussed areas (e.g. lists).

® Shifts markers, limit lines, etc on the screen.

® Moves the scroll bar vertically, if the scroll bar is focussed.

® Acts like the ENTER key, when it is selected.

To simulate the use of a rotary knob, use the keys displayed beneath the arrow keys:

Table 4-8: Rotary know simulation keys

Icon Function
O Turn left
(-] Enter

® Turn right

Navigation keys

The virtual navigation keys can be used alternatively to the rotary knob to navigate
through dialog boxes, diagrams or tables.

Arrow Up/Arrow Down Keys

The <arrow up> or <arrow down> keys do the following:

® |n a numeric edit dialog box, increase or decrease the instrument parameter.
® |n alist, scroll forward and backward through the list entries.

® |n atable, move the selection bar vertically.
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® |n windows or dialog boxes with vertical scroll bar, move the scroll bar.

Arrow Left/Arrow Right Keys

The <arrow left> or <arrow right> keys do the following:

® |n an alphanumeric edit dialog box, move the cursor.

® |n alist, scroll forward and backward through the list entries.

® |n atable, move the selection bar horizontally.

® |n windows or dialog boxes with horizontal scroll bar, move the scroll bar.

Data input keys

Some additional virtual keys are provided for data input in dialog boxes and input
fields.

Table 4-9: Data input keys

Type of key Description

ESC key Closes all kinds of dialog boxes, if the edit mode is not active. Quits the
edit mode, if the edit mode is active. In dialog boxes that contain a "Can-
cel" button it activates that button.

For "Edit" dialog boxes the following mechanism is used:

® |f data entry has been started, it retains the original value and
closes the dialog box.

e |f data entry has not been started or has been completed, it closes
the dialog box.

BACKSPACE key If an alphanumeric entry has already been started, this key deletes the
character to the left of the cursor.
ENTER key ®  Concludes the entry of dimensionless entries. The new value is
accepted.
®  With other entries, this key can be used instead of the "Hz/dB" unit
key.

® |n adialog box, selects the default or focussed element.

4.51.4 On-screen Keyboard

The on-screen keyboard is an additional means of interacting with the instrument with-
out having to connect an external keyboard.
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Enter

N\ Shift

R

The on-screen keyboard display can be switched on and off as desired using the "On-
Screen Keyboard" function key beneath the screen.

(i,

When you press this key, the display switches between the following options:

e Keyboard displayed at the top of the screen
® Keyboard displayed at the bottom of the screen
® No keyboard displayed

You can use the TAB key on the on-screen keyboard to move the focus from one field
to another in dialog boxes.

4.5.2 Understanding the Display Information

The following figure shows a measurement diagram during manual analyzer operation.
All different information areas are labeled. They are explained in more detail in the fol-
lowing sections.
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= Channel bar for firmware and measurement settings

= Window title bar with diagram-specific (trace) information

= Diagram area with marker information

= Diagram footer with diagram-specific information, depending on measurement application
= Instrument status bar with error messages, progress bar and date/time display
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4.5.2.1 Channel Bar

Using the R&S FPS you can handle several different measurement tasks (channels) at

the

nel,

same time (although they can only be performed asynchronously). For each chan-
a separate tab is displayed on the screen. In order to switch from one channel dis-

play to another, simply select the corresponding tab.

MultiView
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The E icon on the tab label indicates that the displayed trace no longer matches the
current instrument settings. This may be the case, for example, if a trace is frozen and
the instrument settings are changed. As soon as a new measurement is performed, the
icon disappears.

An orange "IQ" (in MSRA mode only) indicates that the results displayed in the MSRA

slave application(s) no longer match the data captured by the MSRA Master. The "IQ"
disappears after the results in the slave application(s) are refreshed.

Alternatively, if many tabs are displayed, select the tab selection list icon at the right
end of the channel bar and select the channel you want to switch to from the list.

Channel-specific settings

Beneath the channel name, information on channel-specific settings for the measure-
ment are displayed in the channel bar. A bullet next to the setting indicates that user-
defined settings are used, not automatic settings. A green bullet indicates this setting is
valid and the measurement is correct. A red bullet indicates an invalid setting that does
not provide useful results. Channel information varies depending on the active applica-
tion.

In the Spectrum application, the R&S FPS shows the following settings:

Table 4-10: Channel settings displayed in the channel bar in the Spectrum application

Ref Level Reference level

m.+el.Att Mechanical and electronic RF attenuation that has been set.
Ref Offset Reference level offset

SWT Sweep time that has been set.

If the sweep time does not correspond to the value for automatic coupling,
a bullet is displayed in front of the field. The color of the bullet turns red if
the sweep time is set below the value for automatic coupling. In addition,
the UNCAL flag is shown. In this case, the sweep time must be increased.

Meas Time Measurement time, calculated from analysis bandwidth and number of
samples (for statistics measurements)

RBW Resolution bandwidth that has been set.

If the bandwidth does not correspond to the value for automatic coupling,
a green bullet appears in front of the field.

VBW Video bandwidth that has been set.

If the bandwidth does not correspond to the value for automatic coupling,
a green bullet is displayed in front of the field.

AnBW Analysis bandwidth (for statistics measurements)
Compatible Compatible device mode (default not displayed)
Mode Indicates which sweep mode type is selected:

® "Auto FFT": automatically selected FFT sweep mode

® "Auto sweep": automatically selected swept sweep mode
® "Sweep": manually selected frequency sweep mode

® "FFT": manually selected FFT sweep mode
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Common settings

In addition to the channel-specific settings, the channel bar above the diagram also
displays information on instrument settings that affect the measurement results even
though this is not immediately apparent from the display of the measured values. This
information is displayed in gray font and only when applicable for the current measure-
ment, as opposed to the channel-specific settings that are always displayed.

MultiView Spectrum

Ref Level -20.00 dBm = RBW 3 MHz SGL
= Att 0 de 45 mis VBW 3 MH: Auto Swee Count 1/12
- TRL > :

The following types of information may be displayed, if applicable.

Table 4-11: Common settings displayed in the channel bar

SGL The sweep is set to single sweep mode.

Sweep Count | The current signal count for measurement tasks that involve a specific number of subse-
quent sweeps

see " Sweep/Average Count " on page 370

TRG Trigger source

see " Trigger Source " on page 381

e EXT: External

IFP: IF power (+trigger bandwidth)
RFP: RF power

VID: Video

6dB/RRC/CHN | Filter type for sweep bandwidth
see " Filter Type " on page 369

YIG Bypass The YIG filter is deactivated.

PA The preamplifier is activated.

GAT The frequency sweep is controlled via the TRIGGER INPUT connector.
TDF A transducer factor is activated.

75 Q The input impedance of the instrument is set to 75 Q.

FRQ A frequency offset # 0 Hz is set.

DC/AC An external DC or AC calibration signal is in use.

<NOR | APR> | An external generator is being controlled by the R&S FPS.

Ext. Gen NOR: the measurements are normalized with the results of the external generator cali-
bration

APR (approximation): the measurements are normalized with the results of the external
generator calibration; however, the measurement settings have been changed since cali-
bration

If neither label is displayed, no calibration has been performed yet or normalization is not
active.

For details see Chapter 7.2.4, "External Generator Control", on page 314 .

LVL A level offset is applied to the external generator signal (only if external generator control
is active).
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Window Title Bar

Each channel in the R&S FPS display may contain several windows. Each window can
display either a graph or a table as a result of the channel measurement. Which type of
result evaluation is displayed in which window is defined in the display configuration
(see Chapter 4.5.5, "Displaying Results", on page 100). The window's title bar indi-
cates which type of evaluation is displayed.

Trace Information in Window Title Bar

Information on the displayed traces is indicated in the window title bar.

Trace no. Trace mode

Trace
i —:a‘w_‘zmz’

Detector
Trace color Color of trace display in diagram
Trace no. Trace number (1 to 6)
Detector Selected detector:
AP AUTOPEAK detector
Pk MAX PEAK detector
Mi MIN PEAK detector
Sa SAMPLE detector
Av AVERAGE detector
Rm RMS detector
Trace Mode Sweep mode:
Clrw CLEAR/WRITE
Max MAX HOLD
Min MIN HOLD
Avg AVERAGE (Lin/Log/Pwr)
View VIEW
Norm/NCor Correction data is not used.

Marker Information

Marker information is provided either in the diagram grid or in a separate marker table,
depending on the configuration.
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Marker information in diagram grid

Within the diagram grid, the x and y-axis positions of the last 2 markers or delta mark-
ers that were set, if available, as well as their index are displayed. The value in the
square brackets after the index indicates the trace to which the marker is assigned.
(Example: M2[1] defines marker 2 on trace 1.) For more than 2 markers, a separate
marker table is displayed beneath the diagram by default.

Marker information in marker table

In addition to the marker information displayed within the diagram grid, a separate
marker table may be displayed beneath the diagram. This table provides the following
information for all active markers:

Type Marker type: N (normal), D (delta), T (temporary, internal)
Ref Reference (for delta markers)

Trc Trace to which the marker is assigned

X-value x-value of the marker

Y-value y-value of the marker

Func Activated marker or measurement function

Func. Result Result of the active marker or measurement function

The functions are indicated with the following abbreviations:

FXD Fixed reference marker

PHNoise Phase noise measurement

CNT Signal count

TRK Signal tracking

NOlse Noise measurement

MDepth AM modulation depth

TOI Third order intercept measurement

4.5.2.5 Frequency and Span Information in Diagram Footer

The diagram footer (beneath the diagram) contains the following information, depend-
ing on the current application:

Label Information
CF Center frequency
Span Frequency span (frequency domain display)
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Label Information

ms/ Time per division (time domain display)

Pts Number of sweep points or (rounded) number of currently displayed points in zoom
mode

4.5.2.6 Instrument and Status Information

Global instrument settings, the instrument status and any irregularities are indicated in
the status bar beneath the diagram.

Hiding the status bar
You can hide the status bar display, e.g. in order to enlarge the display area for the
measurement results ("Setup > Display > Displayed ltems").

See Chapter 12.10.4.1, "General Display Settings and Items", on page 979.

The following information is displayed:

Instrument status

[+ The instrument is configured for operation with an external reference.

Progress

The progress of the current operation is displayed in the status bar.

Measuring... ||| [ [[[]

Date and time

The date and time settings of the instrument are displayed in the status bar.

22.00.2011

10:39:44

You can hide the date and time display in the status bar, or the entire status bar
("Setup > Display > Displayed Items").

For details see the R&S FPS User Manual.

Error messages

If errors or irregularities are detected, a keyword and an error message, if available,
are displayed in the status bar.
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4.5.2.7 Error Information

If errors or irregularities are detected, a keyword and an error message, if available,
are displayed in the status bar.

T T — |

from a controller PC (see Chapter 4.1.3, "Connecting USB Devices", on page 30 or

6 Note that the status bar is only visible on an external monitor or via RemoteDesktop
Chapter 4.4.6, "How to Set Up Remote Desktop", on page 70).

Depending on the type of message, the status message is indicated in varying colors.

Table 4-12: Status bar information - color coding

Color Type Description

red Fatal A serious error occurred in the application; regular operation is no longer
possible.

red Error An error occurred during a measurement, e.g. due to missing data or wrong

settings, so that the measurement cannot be completed correctly.

orange Warning An irregular situation occurred during measurement, e.g. the settings no lon-
ger match the displayed results, or the connection to an external device was
interrupted temporarily.

gray Information Information on the status of individual processing steps.

gray Message An event or state has occurred that may lead to an error during further oper-
ation.

green No errors No messages displayed.

If any error information is available for a measurement channel, the B icon is displayed
next to the channel name.

This is particularly useful when the MultiView tab is displayed, as the status bar in the
MultiView tab always displays the information for the currently selected measurement
only.

Furthermore, a status bit is set in the STATus:QUEStionable:EXTended: INFO reg-
ister for the application concerned (see "STATus:QUEStionable:EXTended:INFO Reg-

ister" on page 595). Messages of a specific type can be queried using the
SYST:ERR:EXT? command, see SYSTem:ERRor: EXTended? on page 991.

The following keywords are used:

IF OVLD Overload of the IF signal path after the input mixer.
® Increase the reference level.

INPUT OVLD The signal level at the RF input connector exceeds the maximum.

The RF input is disconnected from the input mixer to protect the device. In order to
re-enable measurement, decrease the level at the RF input connector and reconnect
the RF input to the mixer input.

LOUNL Error in the instrument's frequency processing hardware was detected.
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NO REF Instrument was set to an external reference but no signal was detected on the refer-
ence input.

OVEN OCXO reference frequency (option R&S FPS-B4) has not yet reached its operating
temperature. The message usually disappears a few minutes after power has been
switched on.

RF OVLD Overload of the input mixer.

® |Increase the RF attenuation (for RF input).
®  Reduce the input level (for digital input)

UNCAL One of the following conditions applies:
®  Correction data has been switched off.
®  No correction values are available, for example after a firmware update.
®  Record the correction data by performing a self alignment
(For details refer to Chapter 10.1.4, "How to Align the Instrument",
on page 535).

WRONG_FW The firmware version is out-of-date and does not support the currently installed hard-
ware. Until the firmware version is updated, this error message is displayed and self-
alignment fails.

(For details refer to Chapter 10.5.4, "Firmware Updates", on page 563).

Changing the Focus

Any selected function is always performed on the currently focused element in the dis-
play, e.g. a dialog field, diagram, or table row. Which element is focused is indicated by
a blue frame (diagram, window, table) or is otherwise highlighted (softkey, marker etc.).
Moving the focus is most easily done by selecting the element in the display using the
mouse pointer. Alternatively, use the "Tab" key on the on-screen keyboard to move the
focus from one element to the next on the display.

To move the focus between any displayed diagrams or tables in a window, select the
"Change focus" key. The focus moves from the diagram to the first table to the next
table etc. and then back to the diagram, within the same window.

Entering Data

Data can be entered in dialog boxes using an external keyboard or the keyboard of the
controller PC.

Entering Numeric Parameters
If a field requires numeric input, the keypad provides only numbers.

1. Enter the parameter value using the keypad, or change the currently used parame-
ter value by using the rotary knob (small steps) or the UP or DOWN keys (large
steps) in the soft front panel.

2. After entering the numeric value via keypad, select the corresponding unit key.
The unit is added to the entry.
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3. If the parameter does not require a unit, confirm the entered value by selecting the
ENTER key or any of the unit keys.
The editing line is highlighted in order to confirm the entry.

4.54.2 Entering Alphanumeric Parameters

If a field requires alphanumeric input, you can use the on-screen keyboard to enter
numbers and (special) characters (see Chapter 4.5.1.4, "On-screen Keyboard",
on page 89).

Alternatively, you can use the virtual keypad. Every alphanumeric key represents sev-
eral characters and one number. The decimal point key (.) represents special charac-
ters, and the sign key (-) toggles between capital and small letters. For the assignment
refer to Table 4-13. In principle, the input of alphanumeric parameters works like writ-
ing an SMS on your cell phone.

To enter numbers and (special) characters via the virtual keypad

1. Select the key once to enter the first possible value.

All characters available via this key are displayed in a popup.

2. To choose a different value provided by this key, select the key again, until your
desired value is displayed.

With each key stroke the next possible value of this key is displayed. If all possible
values have been displayed, the series starts with the first value again. For infor-
mation on the series refer to Table 4-13.

3. To change from capital to small letters and vice versa, select the sign key (-).

4. After entering a value, wait for 2 seconds (to use the same key again), or start the
next entry by selecting another key.

To enter a blank

» Select the "Space" bar, or select the "0" key and wait 2 seconds.

To correct an entry
1. Using the arrow keys, move the cursor to the right of the entry you want to delete.

2. Select the BACKSPACE key.

The entry to the left of the cursor is deleted.

3. Enter your correction.

To complete the entry

» Select the ENTER key or the rotary knob.

To cancel the entry

» Select the ESC key.
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The dialog box is closed without changing the settings.

Table 4-13: Keys for alphanumeric parameters

Key name Series of (special) characters and number provided
(upper inscription)
7 THQ°E¥S¢
8 ABCS8AZEAC
9 DEF9E
4 GHI4
5 JKL5
6 MNOBNO
1 PQRS1
2 TUV2U
3 WXYZ3
0 <blank>0-@ +/\<>=% &
" ?r(O)#
- <toggles between capital and small letters>

4.5.5 Displaying Results

4.5.5.1

The R&S FPS provides several instrument applications for different analysis tasks and
different types of signals, e.g. 3G FDD, I/Q analysis or basic spectrum analysis. For
each application, a new measurement channel is created and displayed in a separate
tab on the screen.

The results of a measurement channel can be evaluated in many different ways, both
graphically and numerically. For each evaluation method the results are displayed in a
separate window in the tab.

The R&S FPS allows you to configure the display to suit your specific requirements
and optimize analysis.

Activating channels

When you activate an application, a new measurement channel is created which deter-
mines the measurement settings for that application. The same application can be acti-
vated with different measurement settings by creating several channels for the same
application. Whenever you switch channels, the corresponding measurement settings
are restored. Each channel is displayed in a separate tab on the screen.

An additional tab ("MultiView") provides an overview of all currently active channels at
once.
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4.5.5.2

Only one measurement can be performed at any time, namely the one in the currently
active channel. However, in order to perform the configured measurements consecu-
tively, a Sequencer function is provided.

MultiView 52 5 1 2 Spectrum 3
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To start a new channel
1. Select the MODE key in the soft front panel.

2. Inthe "Mode" dialog box, select the required application on the "New Channel" tab.
A new tab is displayed for the new channel.

To change the application in an active channel
1. Select the tab of the channel you want to change.
2. Select the MODE key.

3. Inthe "Mode" dialog box, select the new application to be displayed on the
"Replace Current Channel" tab.
The selected application is displayed in the current channel.

Laying out the Result Display with the SmartGrid

Measurement results can be evaluated in many different ways, for example graphi-
cally, as summary tables, statistical evaluations etc. Each type of evaluation is dis-
played in a separate window in the channel tab. Up to 16 individual windows can be
displayed per channel (i.e. per tab). To arrange the diagrams and tables on the screen,
the Rohde & Schwarz SmartGrid function helps you find the target position simply and
quickly.

Principally, the layout of the windows on the screen is based on an underlying grid, the
SmartGrid. However, the SmartGrid is dynamic and flexible, allowing for many different
layout possibilities. The SmartGrid functionality provides the following basic features:

® Windows can be arranged in columns or in rows, or in a combination of both.

User Manual 1176.8445.02 — 09 101



R&S®FPS

Getting Started

Windows can be arranged in up to four rows and four columns.

Windows are moved simply by dragging them to a new position on the screen, pos-
sibly changing the layout of the other windows, as well.

All evaluation methods available for the currently selected measurement are dis-
played as icons in the evaluation bar. If the evaluation bar contains more icons
than can be displayed at once on the screen, it can be scrolled vertically. The
same evaluation method can be displayed in multiple windows simultaneously.

New windows are added by dragging an evaluation icon from the evaluation bar to
the screen. The position of each new window depends on where you drop the eval-
uation icon in relation to the existing windows.

All display configuration actions are only possible in SmartGrid mode. When Smart-
Grid mode is activated, the evaluation bar replaces the current softkey menu dis-
play. When the SmartGrid mode is deactivated again, the previous softkey menu
display is restored.

Background Information: The SmartGrid Principle..........ccoooiiiiiiiiiiiiiiiieeee 102
How to Activate SmartGrid Mode..........oooiioiiiiiiiiiie e 103
How to Add a New Result WINAOW..........coeiiiiiiiiiiiiiiieieee e 104
How to Close @ ReSUIt WINAOW.........ccceiiiiiiiiiiiiiieice et 104
How to Arrange the Result WINAOWS..........coevviiiiiiiiiiiiiiieie e 105

Background Information: The SmartGrid Principle

SmartGrid display

During any positioning action, the underlying SmartGrid is displayed. Different colors
and frames indicate the possible new positions. The position in the SmartGrid where
you drop the window determines its position on the screen.

Figure 4-7: Moving a window in SmartGrid mode

HE
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The brown area indicates the possible "drop area" for the window, i.e. the area in
which the window can be placed. A blue area indicates the (approximate) layout of the
window as it would be if the icon were dropped at the current position. The frames indi-
cate the possible destinations of the new window with respect to the existing windows:
above/below, right/left or replacement (as illustrated in Figure 4-8). If an existing win-
dow would be replaced, the drop area is highlighted in a darker color shade.

Positioning the window

The screen can be divided into up to four rows. Each row can be split into up to four
columns, where each row can have a different number of columns. However, rows
always span the entire width of the screen and may not be interrupted by a column. A
single row is available as the drop area for the window in the SmartGrid. The row can
be split into columns, or a new row can be inserted above or below the existing row (if
the maximum of 4 has not yet been reached).

Figure 4-8: SmartGrid window positions

1 = Insert row above or below the existing row
2 = Create a new column in the existing row
3 = Replace a window in the existing row

SmartGrid functions

Once the evaluation icon has been dropped, icons in each window provide delete and
move functions.

The "Move" icon allows you to move the position of the window, possibly changing the
size and position of the other displayed windows.

The "Delete" icon allows you to close the window, enlarging the display of the remain-
ing windows.

How to Activate SmartGrid Mode

All display configuration actions are only possible in SmartGrid mode. In SmartGrid
mode the evaluation bar replaces the current softkey menu display. When the Smart-
Grid mode is deactivated again, the previous softkey menu display is restored.

» To activate SmartGrid mode, do one of the following:



Operating the Instrument in Manual Mode
B

Select the "SmartGrid" icon from the toolbar.
e Select the "Display Config" button in the configuration "Overview" .
e Select the "Display Config" softkey from the MEAS CONFIG menu.

The SmartGrid functions and the evaluation bar are displayed.
To close the SmartGrid mode and restore the previous softkey menu select the "Close"
icon in the right-hand corner of the toolbar, or press any key.
How to Add a New Result Window
Each type of evaluation is displayed in a separate window. Up to 16 individual windows

can be displayed per channel (i.e. per tab).

1. Activate SmartGrid mode.

All evaluation methods available for the currently selected measurement are dis-
played as icons in the evaluation bar.

2. Select the icon for the required evaluation method from the evaluation bar.
If the evaluation bar contains more icons than can be displayed at once on the
screen, it can be scrolled vertically. Set the mouse pointer in the evaluation bar
between the icons and move it up or down until the required icon appears.

3. Drag the required icon from the evaluation bar to the SmartGrid, which is displayed
in the diagram area, and drop it at the required position. (See "How to Arrange the
Result Windows" on page 105 for more information on positioning the window).

Remote command:

LAYout:ADD[:WINDow]? on page 767 / LAYout :WINDow<n>:ADD? on page 771

How to Close a Result Window

» To close a window, activate SmartGrid mode and select the "Delete" icon for the
window.

il

Remote command:

LAYout :REMove [ :WINDow] on page 769/ LAYout : WINDow<n>: REMove
on page 772
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How to Arrange the Result Windows

1. Select an icon from the evaluation bar or the "Move" icon for an existing evaluation
window.

2. Drag the evaluation over the SmartGrid.
A blue area shows where the window will be placed.

.

3. Move the window until a suitable area is indicated in blue.

4. Drop the window in the target area.

The windows are rearranged to the selected layout, and "Delete" and "Move" icons
are displayed in each window.

5. To close a window, select the corresponding "Delete" icon.

Remote command:

LAYout:REPLace[:WINDow] on page 769/ LAYout :WINDow<n>:REPLace
on page 772

4.5.5.3 Changing the Size of Windows

Each channel tab may contain several windows to evaluate the measurement results
using different methods. A "splitter" allows you to change the size of neighboring win-
dows.
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The splitters are not available in SmartGrid mode.

» To change the size of two neighboring windows, drag the splitter between the win-
dows in either direction.

Switching Between a Split and Maximized Window Display

To get an overview of the results, displaying several windows at the same time may be
helpful. However, the individual windows may become rather small. In this case it is
useful to maximize an individual window to the entire screen temporarily in order to
analyze the results in more detail.

=

To switch between a split and a maximized display without having to close and re-open
windows, select the SPLIT/MAXIMIZE key. In maximized display, the currently focused
window is maximized. In split display, all active windows are displayed.

Changing the Display

The display can be optimized for your individual needs. The following display functions
are available and are described in detail in Chapter 12.10.4.1, "General Display Set-
tings and Items", on page 979 and Chapter 8, "Common Analysis and Display Func-
tions", on page 393.

® Displaying or hiding a simulation of the entire front panel of the instrument on the
screen ("Soft Front Panel")

® Displaying the main function hardkeys in a separate window on the screen ("Mini
Front Panel")

HE
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® Hiding or showing various screen elements
® Selecting a display theme and colors

® Changing the display update rate

® Zooming into the diagram

4.5.6 Getting Help

If any questions or problems concerning the R&S FPS arise, an extensive online help
system is provided on the instrument and can be consulted at any time. The help sys-
tem is context-sensitive and provides information specifically for the current operation
or setting to be performed. In addition, general topics provide an overview on complete
tasks or function groups as well as background information.

4.5.6.1 Calling Up Help

The online help can be opened at any time by selecting one of the "Help" icons on the
toolbar or by selecting the F1 key on an external or the online keyboard.

Calling context-sensitive help

» To display the "Help" dialog box for the currently focused screen element, e.g. a
softkey or a setting in an opened dialog box, select the "Help" icon on the toolbar.

4

The "Help" dialog box "View" tab is displayed. A topic containing information about
the focused screen element is displayed.

If no context-specific help topic is available, a more general topic or the "Contents"
tab is displayed.

For standard Windows dialog boxes (e.g. File Properties, Print dialog etc.), no context-
sensitive help is available.

» To display a help topic for a screen element not currently focused:

a) Select the "Help pointer" icon on the toolbar.
Re

The pointer changes its shape to a "?" and an arrow.
b) Select the screen element to change the focus.

A topic containing information about the selected (now focused) screen element is
displayed.
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4.5.6.2 Using the Help Window

The Help window contains several tabs:

® "View" - shows the selected help topic

® "Contents" - contains a table of help contents

® "Index" - contains index entries to search for help topics
® "Search" - provides text search

The Help toolbar provides some buttons:

® To browse the topics in the order of the table of contents: Up arrow = previous
topic, Down arrow = next topic

® To browse the topics visited before: Left arrow = back, Right arrow = forward
® To increase or decrease the font

Tt e e 8

To search for a topic in the index

The index is sorted alphabetically. You can browse the list, or search for entries in the
list.

—_

Switch to the "Index" tab.

2. Select the "Keyboard" icon besides the entry field.

3. Enter the first characters of the keyword you are interested in.
The entries containing these characters are displayed.

4. Double-click the suitable index entry.

The "View" tab with the corresponding help topic is displayed.

To search topics for a text string
1. Switch to the "Search" tab.
2. Select the "Keyboard" icon besides the entry field.

3. Enter the string you want to find.
If you enter several strings with blanks between, topics containing all words are
found (same as AND operator).

For advanced search, consider the following:

e To find a defined string of several words, enclose it in quotation marks. For
example, a search for "trigger qualification" finds all topics with exactly "trigger
qualification". A search for trigger qualification finds all topics that contain the
words trigger and qualification.

e Use "Match whole word" and "Match case" to refine the search.

e Use operators AND, OR, and NOT.
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To close the Help window

» Select the "Close" icon in the upper right corner of the help window.
Or: Press the ESC key.
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5 Applications, Measurement Channels, and
Operating Modes

The R&S FPS allows you to perform all sorts of different analysis tasks on different
types of signals, e.g. W-CDMA, 1/Q analysis or basic spectrum analysis. Depending on
the task or type of signal, a different set of measurement functions and parameters are
required. Therefore, the R&S FPS provides various applications - some of which are
included in the base unit, others are optional. The default application when you start
the R&S FPS is "Spectrum"”, for basic spectrum analysis measurements on any type of
signal.

For each application, a separate measurement channel is created, which determines
the measurement settings for that application. The same application can be activated
with different measurement settings by creating several channels for the same applica-
tion. Each channel is displayed in a separate tab on the screen.

The maximum number of measurement channels may be limited by the available
memory on the instrument.

By default, each application operates independently of the others, measuring and ana-
lyzing its own distinct data. However, the R&S FPS also provides other operating
modes, in which the individual applications are correlated and analyze the same set of
data.

Signal and Spectrum Analyzer Mode

With the conventional R&S FPS Signal and Spectrum Analyzer mode, you can per-
form several different measurements almost simultaneously. However, the individual
measurements are independent of each other - each application captures and eval-
uates its own set of data, regardless of what the other applications do.

In some cases it may be useful to analyze the exact same input data using different
applications. For example, imagine capturing data from a base station and analyzing
the RF spectrum in the Analog Demodulation application. If a spur or an unexpected
peak occurs, you may want to analyze the same data in the I/Q Analyzer to see the
real and imaginary components of the signal and thus detect the reason for the irregu-
lar signal. Normally when you switch to a different application, evaluation is performed
on the data that was captured by that application, and not the previous one. In our
example that would mean the irregular signal would be lost. Therefore, a second oper-
ating mode is available in the R&S FPS: Multi-Standard Radio Analyzer (MSRA) mode.

Multi-Standard Radio Analyzer mode

In Multi-Standard Radio Analyzer (MSRA) mode, data acquisition is performed once
as an I/Q measurement in a master application, and the captured data is then evalu-
ated by any number of slave applications for different radio standards. Data acquisition
and global configuration settings are controlled globally, while the evaluation and dis-
play settings can be configured individually for each slave application. Using the Multi-
Standard Radio Analyzer, unwanted correlations between different signal components

HE
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using different transmission standards can be detected. Thus, for example, an irregu-
larity in @ GSM burst can be examined closer in the R&S FPS 3G FDD BTS (W-CDMA)
slave application to reveal dependencies like a change in the EVM value.

Distinct operating modes

Although the applications themselves are identical in all operating modes, the handling
of the data between applications is not. Thus, the operating mode determines which
slave applications are available and active. Whenever you change the operating mode,
the currently active measurement channels are closed. The default operating mode is
Signal and Spectrum Analyzer mode; however, the presetting can be changed.

Remote command:

INST:MODE SAN, see INSTrument : MODE on page 626

Switching between slave applications

When you switch to a new slave application, a set of parameters is passed on from the
current slave application to the new one:

® center frequency and frequency offset

e reference level and reference level offset

® attenuation

After initial setup, the parameters for the measurement channel are stored upon exiting

and restored upon re-entering the channel. Thus, you can switch between slave appli-
cations quickly and easily.

Available Applications

Access: MODE

The R&S FPS provides some applications in the base unit while others are available
only if the corresponding firmware options are installed. Not all R&S FPS applications
are supported in MSRA mode.

For details on the MSRA operating mode, see the R&S FPS MSRA User Manual.

Spectrogram application

Spectrogram measurements are not a separate application, but rather a trace evalua-
tion method, thus they are available as an evaluation method for the Display Configu-
ration, not by creating a new channel. Spectrograms are configured and activated in
the "Trace" settings. See Chapter 8.5.2.1, "Working with Spectrograms", on page 471
for details.
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Spectrum

In the Spectrum application the provided functions correspond to those of a conven-
tional spectrum analyzer. The analyzer measures the frequency spectrum of the RF
input signal over the selected frequency range with the selected resolution and sweep
time, or, for a fixed frequency, displays the waveform of the video signal. This applica-
tion is used in the initial configuration.

For details see Chapter 6, "Measurements and Results", on page 123.

Remote command:
INST:SEL SAN, see INSTrument [:SELect] on page 627

1xEV-DO BTS

The 1XxEV-DO BTS application requires an instrument equipped with the 1XEV-DO
BTS Measurements option, R&S FPS-K84. This application provides test measure-
ments for 1XEV-DO BTS downlink signals (base station signals) according to the test
specification.

For details see the R&S FPS-K84/-K85 User Manual.

Remote command:
INST:SEL BDO, see INSTrument [ :SELect] on page 627

1xEV-DO MS

The 1xEV-DO MS application requires an instrument equipped with the 1xEV-DO MS
Measurements option, R&S FPS-K85. This application provides test measurements for
1xEV-DO MS uplink signals (mobile signals) according to the test specification.

For details see the R&S FPS-K84/-K85 User Manual.

Remote command:
INST:SEL MDO, see INSTrument [ :SELect] on page 627
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3G FDD BTS

The 3G FDD BTS application requires an instrument equipped with the 3GPP Base
Station Measurements option, R&S FPS-K72. This application provides test measure-
ments for W-CDMA downlink signals (base station signals) according to the test speci-
fication.

For details see the R&S FPS-K72/-K73 User Manual.

Remote command:
INST:SEL BWCD, see INSTrument [:SELect] on page 627

3G FDD UE

The 3G FDD UE application requires an instrument equipped with the 3GPP User
Equipment Measurements option, R&S FPS-K73. This application provides test mea-
surements for W-CDMA uplink signals (mobile signals) according to the test specifica-
tion.

For details see the R&S FPS-K72/-K73 User Manual.

Remote command:
INST:SEL MWCD, see INSTrument [:SELect] on page 627

Ampilifier

The Amplifier Measurement application requires an instrument equipped with the
Amplifier Measurement option R&S FPS-K18. This application provides measurements
to measure the efficiency of traditional amplifiers and amplifiers that support envelope
tracking with the R&S FPS.

Also available is option R&S FPS-K18D, which provides direct DPD functionality.

For details see the R&S FPS-K18 User Manual (also contains information about
R&S FPS-K18D.

Remote command:
INST:SEL AMPL, see INSTrument [:SELect] on page 627

Analog Demodulation

The Analog Demodulation application requires an instrument equipped with the corre-
sponding optional software. This application provides measurement functions for
demodulating AM, FM, or PM signals.

For details see the R&S FPS-K7 User Manual.

Remote command:
INST:SEL ADEM, see INSTrument [:SELect] on page 627

cdma2000 BTS

The cdma2000 BTS application requires an instrument equipped with the cdma2000
BTS Measurements option, R&S FPS-K82. This application provides test measure-
ments for cdma2000 BTS downlink signals (base station signals) according to the test
specification.

For details see the R&S FPS-K82/-K83 User Manual.

Remote command:
INST:SEL BC2K, see INSTrument [:SELect] on page 627
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cdma2000 MS

The cdma2000 MS application requires an instrument equipped with the cdma2000
MS Measurements option, R&S FPS-K83. This application provides test measure-
ments for cdma2000 MS uplink signals (mobile signals) according to the test specifica-
tion.

For details see the R&S FPS-K82/-K83 User Manual.

Remote command:
INST:SEL MC2K, see INSTrument [:SELect] on page 627

GSM
The GSM application requires an instrument equipped with the GSM Measurements
option R&S FPS-K10. This application provides GSM measurements.

For details see the R&S FPS-K10 User Manual.

Remote command:
INST:SEL GSM, see INSTrument [ :SELect] on page 627

1/Q Analyzer
The 1/Q Analyzer application provides measurement and display functions for 1/Q data.

For details see the R&S FPS 1/Q Analyzer User Manual.

Remote command:
INST:SEL IQ,see INSTrument[:SELect] on page 627

LTE
The LTE application requires an instrument equipped with the LTE Measurements
option R&S FPS-K10x. This application provides LTE measurements.

For details see the R&S FPS-K10x User Manuals (one for downlink, one for uplink).

Remote command:
INST:SEL LTE, see INSTrument [ :SELect] on page 627

NB-loT

The NB-loT application requires an instrument equipped with the NB-loT measure-
ments option R&S FPS-K106. This application provides NB-loT measurements in the
downlink.

For details see the R&S FPS-K106 (NB-loT Downlink) User Manual.

Remote command:
INST:SEL NIOT, see INSTrument[:SELect] on page 627

Noise Figure

The Noise Figure application requires an instrument equipped with the Noise Figure
Measurements option R&S FPS-K30. This application provides noise figure measure-
ments.

For details see the R&S FPS-K30 User Manual.

Remote command:
INST:SEL NOISE, see INSTrument |[:SELect] on page 627
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Phase Noise

The Phase Noise application requires an instrument equipped with the Phase Noise
Measurements option, R&S FPS-K40. This application provides measurements for
phase noise tests.

For details see the R&S FPS-K40 User Manual.

Remote command:
INST:SEL PNOISE, see INSTrument [:SELect] on page 627

Pulse Measurements

The Pulse application requires an instrument equipped with the Pulse Measurements
option, R&S FPS-K6. This application provides measurement functions for pulsed sig-
nals.

For details see the R&S FPS-K6 User Manual.

Remote command:
INST:SEL PULSE, see INSTrument [:SELect] on page 627

TD-SCDMA BTS

The TD-SCDMA BTS application requires an instrument equipped with the TD-SCDMA
Base Station Measurements option, R&S FPS-K76. This application provides test mea-
surements for TD-SCDMA downlink signals (base station signals) according to the test
specification.

For details see the R&S FPS-K76/-K77 User Manual.

Remote command:
INST:SEL BTDS, see INSTrument [:SELect] on page 627

TD-SCDMA UE

The TD-SCDMA UE application requires an instrument equipped with the TD-SCDMA
User Equipment Measurements option, R&S FPS-K77. This application provides test
measurements for TD-SCDMA uplink signals (mobile signals) according to the test
specification.

For details see the R&S FPS-K76/-K77 User Manual.

Remote command:
INST:SEL MTDS, see INSTrument [:SELect] on page 627

Verizon 5GTF Measurement Application (V5GTF)

The Verizon 5GTF measurement application requires an instrument equipped with the
V5GTF option, R&S FPS-K118/K119. This application provides measurements and
evaluations for uplink and downlink signals according to the Verizon 5G technical
forum (TS V5G.211 standard).

For details see the R&S FPS-K118/-K119 User Manual.

Remote command:
INST:SEL V5GT, see INSTrument [:SELect] on page 627
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Vector Signal Analysis (VSA)

The VSA application requires an instrument equipped with the Vector Signal Analysis
option, R&S FPS-K70. This application provides measurements and evaluations for
single-carrier digitally modulated signals.

For details see the R&S FPS-K70 User Manual.

Remote command:
INST:SEL DDEM, see INSTrument [:SELect] on page 627

WLAN

The WLAN application requires an instrument equipped with the WLAN option,

R&S FPS-K91/91n. This application provides measurements and evaluations accord-
ing to the WLAN IEEE 802.11 standards.

For details see the R&S FPS-K91 User Manual.

Remote command:
INST:SEL WLAN, see INSTrument [:SELect] on page 627

R&S MultiView

Each application is displayed in a separate tab. An additional tab ("MultiView") pro-
vides an overview of all currently active channels at a glance. In the "MultiView" tab,
each individual window contains its own channel bar with an additional button. Select
this button to switch to the corresponding channel display quickly.

MultiView Spectrum Spectrum 2 Spectrum 3 IQ Analyzer

Ref Lev 3m RBWY s Ref Leve 0.0 RBW 3 MHz
ALt 10 SWT 418 iz VBW iz Mode wto FFT Att 10 SWT 1 ms VBW 3 MHz
1 Frequency Sweep s 1Pk Clrw 1 Frequency Sweep

= RBW z of Le AQT

dB = SWT 145 s VBW 2 MHz Freq LOMHz ReclLe
1 Time Sweep * 14P Clrw 1 Real Real/Imag (1/Q)

1 Imag Real/Imag (1/Q)

CF 64.0 MHz 1001 pts 1.45 pus/  CF 64.0 MHz

Remote command:

DISPlay:FORMat on page 766

User Manual 1176.8445.02 — 09 116



R&S®FPS Applications, Measurement Channels, and Operating Modes

5.3 Selecting the Operating Mode and Applications

Access: MODE

The default operating mode is Signal and Spectrum Analyzer mode, however, the pre-
setting can be changed (see " Preset Mode " on page 565).

f Mode

Signal + Spectrum Mode

New
Channel @ @
Spectrum Analog Demod

Replace

Current (o)
Channel 1IQ Analyzer

The default application in Signal and Spectrum Analyzer mode is a Spectrum measure-
ment.

Switching between applications

When you switch to a new application, a set of parameters is passed on from the cur-
rent application to the new one:

® center frequency and frequency offset

e reference level and reference level offset

® attenuation

After initial setup, the parameters for the measurement channel are stored upon exiting

and restored upon re-entering the channel. Thus, you can switch between applications
quickly and easily.

Switching the operating MOdE.........uuuuiiiiieie e 117
Selecting an appliCation...........oooiiiiiiiicccer e ————————— 117
L NEW CRANNEL. ...ttt 118
L Replace CUIrent ChanNEL...........cooieeeeeeeeeeeeeeeeeeeeeeeee e 118
L Duplicate CUITent ChanNEl ...........ccooveeeeeeeeeeeeeeeeeeeeee e, 118
Closing an apPliCatiON.......coicieee e e e 118

Switching the operating mode
To switch the operating mode, select the corresponding tab.

Remote command:
INSTrument : MODE on page 626

Selecting an application
To start a new or replace an existing application, select the corresponding button in the
correct tab.

User Manual 1176.8445.02 — 09 117



Running a Sequence of Measurements

Note: The measurement channels are labeled with their default name. If that name
already exists, a sequential number is added. You can change the name of the mea-
surement channel by double-tapping the name in the channel bar and entering a new
name.

For an overview of default names see Table 12-2.

Remote command:
INSTrument [ :SELect] on page 627

New Channel — Selecting an application
The applications selected on this tab are started in a new measurement channel, i.e. a
new tab in the display.

Remote command:
INSTrument:CREate [ :NEW] on page 624
INSTrument [ :SELect] on page 627

Replace Current Channel < Selecting an application
The applications selected on this tab are started in the currently displayed measure-
ment channel, replacing the current application.

Remote command:
INSTrument:CREate:REPLace on page 625

Duplicate Current Channel — Selecting an application

The currently active channel can be duplicated, i.e. a new channel of the same type
and with the identical measurement settings is started. The name of the new channel is
the same as the copied channel, extended by a consecutive number (e.g. "Spectrum"” -
> "Spectrum 2" ).

This command is not available if the MSRA Master channel is selected.

Remote command:
INSTrument:CREate:DUPLicate on page 624

Closing an application
To close an application, simply close the corresponding tab by selecting the "x" next to
the channel name.

Remote command:
INSTrument :DELete on page 625

5.4 Running a Sequence of Measurements

Only one measurement can be performed at any time, namely the one in the currently
active channel. However, in order to perform the configured measurements consecu-
tively, a Sequencer function is provided.

®  The SeqUENCEr CONCEPL.....ccccciiiiiiieiieee e e e e ce ettt e e e e e e e e e e e sre e ar e e e e aaaeeeeesaennnes 119
®  SEQUENCET SELHNGS. . uttiiiiiieii it e e e e e e e e e e s e e n e e e e e e aaaeeeeaans 121
o How to Set Up the SEQUENCET ..o 121
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5.4.1 The Sequencer Concept

The instrument can only activate one specific channel at any time. Thus, only one
measurement can be performed at any time, namely the one in the currently active
channel. However, in order to perform the configured measurements consecutively, a
Sequencer function is provided, which changes the channel of the instrument as
required. If activated, the measurements configured in the currently defined "Channel"
s are performed one after the other in the order of the tabs.

For each individual measurement, the sweep count is considered. Thus, each mea-
surement may consist of several sweeps. The currently active measurement is indica-
ted by a €8 symbol in the tab label.

The result displays of the individual channels are updated in the tabs as the measure-
ments are performed. Sequential operation itself is independent of the currently dis-
played tab.

Sequencer modes
Three different Sequencer modes are available:

® Single Sequence
Similar to single sweep mode; each measurement is performed once, until all mea-
surements in all defined "Channel" s have been performed.

® Continuous Sequence
Similar to continuous sweep mode; the measurements in each defined "Channel"
are performed one after the other, repeatedly, in the same order, until sequential
operation is stopped. This is the default Sequencer mode.

® Channel-defined Sequence
First, a single sequence is performed. Then, only "Channel" s in continuous sweep
mode are repeated continuously.
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Example: Sequencer procedure
Assume the following active channel definition:

MultiView Spectrum Spectrum 2 Spectrum 3 IQ Analyzer
Ref Lev .0 1 : Ref Leve

ALt 0 dB z Att 1 SWT 1 ms

1 Frequency : w 1 Frequency Sweep

64,0 Ml

AHAwY

:ll:h:l 1 pts

Freq LOT
1 Time Sweep 1 1 Real Real/Imag (1/Q)

1 Imag Real/Imag (1/Q)

CF 64.0 MHz 1001 pts 1.45 pus/  CF 64.0 MHz

Tab name Application Sweep mode Sweep count
Spectrum Spectrum Cont. Sweep 5
Spectrum 2 Spectrum Single Sweep 6
Spectrum 3 Spectrum Cont. Sweep 2
1Q Analyzer 1Q Analyzer Single Sweep 7

For Single Sequence, the following sweeps will be performed:

5x Spectrum, 6x Spectrum 2, 2 x Spectrum 3, 7x 1Q Analyzer

For Continuous Sequence, the following sweeps will be performed:
5x Spectrum, 6x Spectrum 2, 2 x Spectrum 3, 7x 1Q Analyzer,

5x Spectrum, 6x Spectrum 2, 2 x Spectrum 3, 7x 1Q Analyzer,

For Channel-defined Sequence, the following sweeps will be performed:
5x Spectrum, 6x Spectrum 2, 2 x Spectrum 3, 7x 1Q Analyzer,

5x Spectrum, 2 x Spectrum 3,

5x Spectrum, 2 x Spectrum 3,

RUN SINGLE/RUN CONT and Single Sweep/Sweep Continuous keys

While the Sequencer is active, the RUN SINGLE and RUN CONT keys control the
Sequencer, not individual sweeps. RUN SINGLE starts the Sequencer in single mode,
while RUN CONT starts the Sequencer in continuous mode.
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The "Single Sweep" and "Continuous Sweep" softkeys control the sweep mode for the
currently selected channel only; the sweep mode only has an effect the next time the
Sequencer activates that channel, and only for a channel-defined sequence. In this
case, a channel in single sweep mode is swept only once by the Sequencer. A channel
in continuous sweep mode is swept repeatedly.

Sequencer Settings

The "Sequencer" menu is available from the toolbar.

SEQUENCET STALE oiiiii i e e e e e e e s e aaa s 121
SEQUENCET IMIOTE ...ttt e e e e e e e e e e e et e e e e e e s e e s narrnraeeeeeeaaaaens 121

Sequencer State
Activates or deactivates the Sequencer. If activated, sequential operation according to
the selected Sequencer mode is started immediately.

Remote command:

SYSTem:SEQuencer on page 630
INITiate<n>:SEQuencer:IMMediate on page 629
INITiate<n>:SEQuencer:ABORt on page 628

Sequencer Mode

Defines how often which measurements are performed. The currently selected mode
softkey is highlighted blue. During an active Sequencer process, the selected mode
softkey is highlighted orange.

"Single Sequence"
Each measurement is performed once, until all measurements in all
active channels have been performed.

"Continuous Sequence"
The measurements in each active channel are performed one after
the other, repeatedly, in the same order, until sequential operation is
stopped.
This is the default Sequencer mode.

"Channel Defined Sequence"
First, a single sequence is performed. Then, only channels in continu-
ous sweep mode are repeated.

Remote command:
INITiate<n>:SEQuencer:MODE on page 629

How to Set Up the Sequencer

In order to perform the configured measurements consecutively, a Sequencer function
is provided.

1. Configure a channel for each measurement configuration as required, including the
sweep mode.
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2. In the toolbar, select the "Sequencer" icon.

w3

The "Sequencer" menu is displayed.

3. Toggle the "Sequencer" softkey to "On" .

A continuous sequence is started immediately.

4. To change the Sequencer mode and start a new sequence immediately, select the
corresponding mode softkey, or press the RUN SINGLE or RUN CONT key.

The measurements configured in the currently active channels are performed one
after the other in the order of the tabs until the Sequencer is stopped.

The result displays in the individual channels are updated as the measurements
are performed.

To stop the Sequencer

» To stop the Sequencer temporarily, press the highlighted RUN SINGLE or RUN
CONT key (not for a channel-defined sequence). To continue the Sequencer,
press the key again.

To stop the Sequencer permanently, select the "Sequencer” icon in the toolbar and
toggle the "Sequencer" softkey to "Off" .



6 Measurements and Results

Access: "Overview" > "Select Measurement"
Or: MEAS

In the Spectrum application, the R&S FPS provides a variety of different measurement
functions.

® Basic measurements - measure the spectrum of your signal or watch your signal
in time domain

® Power measurements - calculate the powers involved in modulated carrier signals
® Emission measurements - detect unwanted signal emission

® Statistic measurements - evaluate the spectral distribution of the signal

® Special measurements - provide characteristic values of the signal

The individual functions are described in detail in the following chapters.

The measurement function determines which settings, functions and evaluation meth-
ods are available in the R&S FPS. The various measurement functions are described
in detail here.

When you select a measurement function, the measurement is started with its default
settings immediately and the corresponding measurement configuration menu is dis-
played. The measurement configuration menu can be displayed at any time by press-
ing the MEAS CONFIG key.

The easiest way to configure measurements is using the configuration "Overview" ,
see Chapter 7.1, "Configuration Overview", on page 300.

In addition to the measurement-specific parameters, the general parameters can be
configured as usual, see Chapter 7, "Common Measurement Settings", on page 300.
Many measurement functions provide special result displays or evaluation methods;
however, in most cases the general evaluation methods are also available, see Chap-
ter 8, "Common Analysis and Display Functions", on page 393.

After a preset, and when all other functions are switched off ("All Functions Off" in the
"Select Measurement" dialog) the R&S FPS performs a basic frequency sweep.

The remote commands required to retrieve measurement results are described in
Chapter 12.8.2.4, "Retrieving Trace Results", on page 853.
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Measurements on I/Q-based data

The 1/Q Analyzer application (not Master) in MSRA mode can also perform measure-
ments on the captured I/Q data in the time and frequency domain.

The measurements are configured using the same settings as described here for the
Spectrum application.

The results, however, may differ slightly as hardware settings are not adapted auto-
matically as for the Spectrum application. Additionally, the analysis interval used for the
measurement is indicated as in all MSRA applications.

For more information see the R&S FPS MSRA User Manual.

6.1

6.1.1

o BasiC MeasuremMeNnts. ... .. ... it 124
e Channel Power and Adjacent-Channel Power (ACLR) Measurement.................. 145
e Carrier-to-N0iSe MEaSUrEMENTS.......cuuiiiiiiiee it e e e e e e e e e e e eeeaes 194
e Occupied Bandwidth Measurement (OBW).........ceeeeiieeeiiiiiiiciinieeieeece e 198
e Spectrum Emission Mask (SEM) Measurement..........cccccceeeeveiiciiniinieeeeeeeeeeseeennns 205
e Spurious Emissions MeasuremeNt...........cccuuveeeeeieiiiiiiieciiiiiieeeeee e 248
e Statistical Measurements (APD, CCDF)......ccccuiiieiiciiiee e eeiiee e 261
e Time Domain Power Measurement..........c...eiiiiiiiiiiiiiiiii e 276
e Harmonic Distortion Measurement..........ccc.uueieeeeieeee i 280
e Third Order Intercept (TOI) MEaSUIrEmMENt........ccccuuviieiiieeeee e 286
e AM Modulation Depth Measurement............cuueeeieeeeiiiiecciiiieeeece e 296

Basic Measurements

Basic measurements are common sweeps in the time or frequency domain which pro-
vide an overview of the basic input signal characteristics.

If no other measurement function is selected, or if all measurement functions are
switched off, the R&S FPS performs a basic frequency or time sweep.

After a preset, a frequency sweep is performed.

Use the general measurement settings to configure the measurement, e.g. via the
"Overview" (see Chapter 7, "Common Measurement Settings", on page 300).

Basic Measurement Types

Yo [ U= a0y S AT YT RSP 124
p =Y (o IR - | o R 125
All FUNCHONS Off ..uiiiiiiiiiie ittt e e e e e e e e e e nnareaee s 125

Frequency Sweep

A common frequency sweep of the input signal over a specified span. Can be used for
general purposes to obtain basic measurement results such as peak levels and spec-
trum traces. The "Frequency" menu is displayed. This is the default measurement if no
other function is selected.
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Use the general measurement settings to configure the measurement, e.g. via the
"Overview" (see Chapter 7, "Common Measurement Settings", on page 300).

Remote command:

[SENSe: ] FREQuency:STARt on page 780, [SENSe: ] FREQuency:STOP
on page 780

INITiate<n>[:IMMediate] on page 636

INITiate<n>:CONTinuous on page 635

Zero Span

A sweep in the time domain at the specified (center) frequency, i.e. the frequency span
is set to zero. The display shows the time on the x-axis and the signal level on the y-
axis, as on an oscilloscope. On the time axis, the grid lines correspond to 1/10 of the
current sweep time.

Use the general measurement settings to configure the measurement, e.g. via the
"Overview" (see Chapter 7, "Common Measurement Settings", on page 300).

Most result evaluations can also be used for zero span measurements, although some
functions (e.g. markers) may work slightly differently and some may not be available. If
so, this will be indicated in the function descriptions (see Chapter 8, "Common Analysis
and Display Functions", on page 393).

Remote command:

[SENSe: ] FREQuency: SPAN on page 779

INITiate<n>[:IMMediate] on page 636

INITiate<n>:CONTinuous on page 635

All Functions Off
Switches off all measurement functions and returns to a basic frequency sweep.

Selecting "Frequency Sweep" has the same effect.

How to Perform a Basic Sweep Measurement

The following step-by-step instructions demonstrate how to perform basic sweep mea-
surements.

For remote operation, see Chapter 12.15.1, "Programming Example: Performing a
Basic Frequency Sweep", on page 1042.

To perform one or more single sweeps

1. Configure the frequency and span to be measured ( "Frequency" dialog box, see
Chapter 7.3, "Frequency and Span Configuration”, on page 343).

2. Configure the number of sweeps to be performed in a single measurement
( "Sweep Config" dialog box, see " Sweep/Average Count " on page 370).

3. If necessary, configure how the signal is processed internally ( "Bandwidth" dialog
box, see " Sweep Type " on page 371).
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If necessary, configure a trigger for the measurement ( "Trigger/ Gate Config" dia-
log box, see Chapter 7.6, "Trigger and Gate Configuration", on page 375).

Define how the results are evaluated for display ( "Trace" dialog box, see Chap-
ter 8.5.1.2, "Trace Settings", on page 465).

If necessary, configure the vertical axis of the display ( "Amplitude" dialog box, see
Chapter 7.4, "Amplitude and Vertical Axis Configuration", on page 351).

To start the measurement, select one of the following:

e RUN SINGLE key
e "Single Sweep" softkey in the "Sweep" menu

The defined number of sweeps are performed, then the measurement is stopped.
While the measurement is running, the RUN SINGLE key is highlighted. To abort
the measurement, press the RUN SINGLE key again. The key is no longer high-

lighted. The results are not deleted until a new measurement is started.

To repeat the same number of sweeps without deleting the last trace, select the
"Continue Single Sweep" softkey in the "Sweep" menu.

To start continuous sweeping

1.

If you want to average the trace or search for a maximum over more (or less) than
10 sweeps, configure the "Sweep/Average Count" ( "Sweep Config" dialog box,
see " Sweep/Average Count " on page 370).

To start the measurement, select one of the following:

e RUN CONT key
e "Continuous Sweep" softkey in the "Sweep" menu

After each sweep is completed, a new one is started automatically. While the mea-
surement is running, the RUN CONT key is highlighted. To stop the measurement,
press the RUN CONT key again. The key is no longer highlighted. The results are
not deleted until a new measurement is started.

Measurement Examples - Measuring a Sinusoidal Signal

One of the most common measurement tasks that can be handled using a signal ana-
lyzer is determining the level and frequency of a signal. When measuring an unknown
signal, you can usually start with the presettings.

High input values

If levels higher than +30 dBm (=1 W) are expected or are possible, a power attenuator
must be inserted before the RF input of the analyzer. Otherwise, signal levels exceed-
ing 30 dBm can damage the RF attenuator or the input mixer. The total power of all
occurring signals must be taken into account.




6.1.3.1

Basic Measurements

Test setup
® Connect the RF output of the signal generator to the RF input of the R&S FPS.
Table 6-1: Signal generator settings (e.g. R&S SMW)

Frequency 128 MHz
Level -30 dBm
e Measuring the Level and Frequency Using Markers..........ccccccoiiieiiiininieenieen. 127
e Measuring the Signal Frequency Using the Signal Counter............ccccceeeiiiiieeeen. 128

Measuring the Level and Frequency Using Markers

The level and frequency of a sinusoidal signal can be measured easily using the
marker function. The R&S FPS always displays its amplitude and frequency at the
marker position. The frequency measurement uncertainty is determined by the refer-
ence frequency of the R&S FPS, the resolution of the marker frequency display and
the number of sweep points.

1. Select PRESET to reset the instrument.

2. Connect the signal to be measured to the RF INPUT connector on the R&S FPS.
3. Set the center frequency to 128 MHz.

4. Reduce the frequency span to 7 MHz.

Note: Coupled settings. When the frequency span is defined, the resolution band-
width, the video bandwidth and the sweep time are automatically adjusted,
because these functions are defined as coupled functions in the presettings.

5. Select MKR to activate marker 1 and automatically set it to the maximum of the
trace.

The level and frequency values measured by the marker are displayed in the
marker information at the top of the display.

Note: Performing a peak search. When a marker is initially activated, it automati-
cally performs the peak search function (as shown in the example).

If a marker was already active, select the PEAK SEARCH key or the "Peak" soft-
key in the MKR > menu in order to set the currently active marker to the maximum
of the displayed signal.

Increasing the Frequency Resolution

The frequency resolution of the marker is determined by the resolution of the trace. A
trace consists of 1001 trace points, i.e. if the frequency span is 1 MHz, each trace point
represents a span of approximately 1 kHz. This corresponds to a maximum uncertainty
of +/- 0.5 kHz.

You can increase the resolution of the trace by reducing the frequency span.
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Reducing the frequency span to 10 kHz
» Reduce the frequency span to 10 kHz.

The resolution of the trace is now approximately 10 Hz (10 kHz span / 1001 trace
points), thus, the precision of the marker frequency display increases to approxi-
mately +5 Hz.

Setting the Reference Level

The reference level is the level at the upper limit of the diagram. To achieve the widest
dynamic range possible for a spectrum measurement, use the entire level span of the

R&S FPS. In other words, the highest level that occurs in the signal should be located

at the top edge of the diagram ( = reference level) or immediately below it.

Low Reference Levels

If the selected reference level is lower than the highest signal that occurs in the spec-
trum, the signal path in the R&S FPS is overloaded.

In this case, the message "IFOVL" is displayed in the error message field.

6.1.3.2

In the presettings, the value of the reference level is 0 dBm. If the input signal is

-30 dBm, the reference level can be reduced by 30 dB without causing the signal path
to be overloaded.

Reducing the reference level by 30 dB

» Set the reference level to -30 dBm.

The maximum of the trace is near the maximum of the measurement diagram. The
increase in the displayed noise is not substantial. Thus, the distance between the
signal maximum and the noise display (=dynamic range) has increased.

Setting the reference level with the help of a marker

You can also use a marker to shift the maximum value of the trace directly to the top
edge of the diagram. If the marker is located at the maximum level of the trace (as in
this example), the reference level can be moved to the marker level as follows:

1. Press the MKR -> key.
2. Select "Ref Lvl = Mkr LvI" .

The reference level is set to the current marker level.

Measuring the Signal Frequency Using the Signal Counter

The built-in signal counter allows you to measure the frequency more accurately than
measuring it with the marker. The frequency sweep is stopped at the marker, and the
R&S FPS measures the frequency of the signal at the marker position (see also Chap-
ter 8.3.4.1, "Precise Frequency (Signal Count) Marker", on page 421).

In the following example, the frequency of the generator at 128 MHz is shown using
the marker.



Basic Measurements

Prerequisite

Precise frequency measurements require a precise reference frequency. Therefore, an
external reference frequency from the signal generator is used. Connect the signal
generator's REF OUT connector to the analyzer's REF IN connector.

1. Select PRESET to reset the instrument.

2. Set the center frequency to 7128 MHz.

3. Set the frequency span to 1 MHz.
4

Select "Setup" > "Reference" > "External Reference 10 MHZz" to activate the exter-
nal reference frequency.

5. Select MKR to activate marker 1 and automatically set it to the maximum of the
trace.

The level and the frequency of the marker are displayed in the marker results in the
diagram or the marker table.

6. Select MKR FUNC > "Signal Count" to activate the signal counter.

The result of the signal counter is displayed in the marker results.

7. If necessary, increase the resolution of the signal counter by selecting "Signal
Count Resolution" (in the "Signal Count" menu).

In order to obtain a correct result when measuring the frequency with the internal sig-
nal counter, an RF sinusoidal signal or a spectral line must be available. The marker
must be located more than 25 dB above the noise level to ensure that the specified
measurement accuracy is adhered to.

6 Prerequisites for using the internal signal counter

6.1.4 Measurement Example — Measuring Levels at Low S/N Ratios

The minimum signal level a signal analyzer can measure is limited by its intrinsic noise.
Small signals can be swamped by noise and therefore cannot be measured. For sig-
nals that are just above the intrinsic noise, the accuracy of the level measurement is
influenced by the intrinsic noise of the R&S FPS.

The displayed noise level of a signal analyzer depends on its noise figure, the selected
RF attenuation, the selected reference level, the selected resolution and video band-
width and the detector.

For details see:

® Chapter 7.4.1.2, "RF Attenuation”, on page 353

® Chapter 7.4.1.1, "Reference Level", on page 352

® Chapter 7.5.1.1, "Separating Signals by Selecting an Appropriate Resolution Band-
width", on page 361

® Chapter 7.5.1.2, "Smoothing the Trace Using the Video Bandwidth", on page 362
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"Mapping Samples to sweep Points with the Trace Detector" on page 459

This measurement example shows the different factors influencing the S/N ratio.

Table 6-2: Signal generator settings (e.g. R&S SMW)

Frequency 128 MHz

Level -95 dBm

A w0 b

Preset the R&S FPS.
Set the center frequency to 128 MHz.
Set the span to 700 MHz.

Set the reference level to-30 dBm.

The signal is measured with the auto peak detector and is completely hidden in the
intrinsic noise of the R&S FPS.

MultiViiew
Ref Level -20 n RBW L MHz
= ALl 0GB SWT Sps VBW LhMHz  Mode futs FFT
1 Frequency Sweep = L AP Clrw

LALLEL AR U T

1001 pis 10.0 MHz / Span 100,0 MHz

Figure 6-1: Sine wave signal with low S/N ratio

To suppress noise spikes, average the trace. In the "Traces" configuration dialog,
set the "Trace Mode" to "Average" (see " Trace Mode " on page 466).

The traces of consecutive sweeps are averaged. To perform averaging, the
R&S FPS automatically switches on the sample detector. The RF signal, therefore,
can be more clearly distinguished from noise.
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R&S®FPS
I EEEEEEEEEEEEEEEEEEE——————————————

MultiView  Spectium

Ref Level RBW 1 MHz
= ALL B SWT Spz VBW LMHZ Moade futo FFT
1 Frequency Sweep

CF 178.0 MHz 1001 pis 10.0 MHz / Span 100, 0 MHz

Figure 6-2: RF sine wave signal with low S/N ratio with an averaged trace

6. Instead of trace averaging, you can select a video filter that is narrower than the
resolution bandwidth. Set the trace mode back to "Clear/ Write" , then set the VBW
to 10 kHz manually in the "Bandwidth" configuration dialog.

The RF signal can be distinguished from noise more clearly.

MultiView Spectrum

Ref Leval -3 d RBW 1 MHz
= Att i SWT Sps = VBW 1kHz  Maode Auto FFT

1 Frequency Sweep AP Clrw

Span 100.0 MHz

1001 pts 10,0 MHz /

Figure 6-3: RF sine wave signal with low S/N ratio with a smaller video bandwidth

7. By reducing the resolution bandwidth by a factor of 10, the noise is reduced by
10 dB. Set the RBW to 100 kHz.

| —
131
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The displayed noise is reduced by approximately 10 dB. The signal, therefore,
emerges from noise by about 10 dB. Compared to the previous setting, the video
bandwidth has remained the same, i.e. it has increased relative to the smaller reso-
lution bandwidth. The averaging effect of the video bandwidth is therefore reduced.
The trace will be noisier.

MultiView  Spectrum Markar 1
RafLevel -30 = RBW 100 kHz

= Att SWT 251 pz = VBW 1kHz  Mode futo FFT
1 Frequency Sweeg

CF 128.0 MHz 1001 pks 0.0 MHz/ Span 100,0 MHz

Figure 6-4: Reference signal at a smaller resolution bandwidth

6.1.5 Measurement Examples - Measuring Signal Spectra with Multiple

Signals
Separating Signals by Selecting the Resolution Bandwidth......................c...... 132
Measuring the Modulation Depth of an AM-Modulated Carrier in the Frequency
1D T 1 0= 1o S RRSRRPRSR 136
e Measuring AM-Modulated Signals............cooeeccieiiiiiiiieee e 137

6.1.5.1 Separating Signals by Selecting the Resolution Bandwidth

A basic feature of a Signal and Spectrum Analyzer is the ability to separate the spec-
tral components of a mixture of signals. The resolution at which the individual compo-
nents can be separated is determined by the resolution bandwidth. Selecting a resolu-
tion bandwidth that is too large may make it impossible to distinguish between spectral
components, i.e. they are displayed as a single component (see also Chapter 7.5.1.1,
"Separating Signals by Selecting an Appropriate Resolution Bandwidth",

on page 361).

Two signals with the same amplitude can be resolved if the resolution bandwidth is
smaller than or equal to the frequency spacing of the signal. If the resolution bandwidth
is equal to the frequency spacing, the spectrum display shows a level drop of 3 dB pre-
cisely in the center of the two signals. Decreasing the resolution bandwidth makes the
level drop larger, which thus makes the individual signals clearer.
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In this measurement example we will analyze two signals with a level of -30 dBm each
and a frequency spacing of 30 kHz.

Signal
Generator 1 l
Coupler Spectrum
Emm—
[- & dB] Analyzer
Signal T
Generator 2
Figure 6-5: Test setup
Table 6-3: Signal generator settings (e.g. R&S SMW)
Level Frequency
Signal generator 1 -30 dBm 128,00 MHz
Signal generator 2 -30 dBm 128,03 MHz

1. Select PRESET to reset the instrument.
Set the center frequency to 128.015 MHz.

Set the frequency span to 300 kHz.

p w0 DN

Set the resolution bandwidth to 30 kHz and the video bandwidth to 7 kHz.

Note: Larger video bandwidths. The video bandwidth is set to 1 kHz in order to
make the level drop in the center of the two signals clearly visible. At larger video
bandwidths, the video voltage that results from envelope detection is not suffi-
ciently suppressed. This produces additional voltages, which are visible in the
trace, in the transition area between the two signals.




R&S®FPS Measurements and Results

Ref Level -20.00 dBm = RBW 320 kHz
Att 10 dB SWT 6 . = ¥BW 1kHz Wode FFT
SiGL

-30 dBm ====-----
-40 dBm H----

-50 dBmn
-60 dBm
-70 dBm
-80 dBm

-90 dem

CF 12B.015 MHz Span 300.0 kHz

Figure 6-6: Measurement of two equally-leveled RF sinusoidal signals with the resolution band-
width which corresponds to the frequency spacing of the signals

Matching generator and R&S FPS frequencies

The level drop is located exactly in the center of the display only if the generator
frequencies match the frequency display of the R&S FPS exactly. To achieve exact
matching, the frequencies of the generators and the R&S FPS must be synchron-
ized.

5. Set the resolution bandwidth to 700 kHz.

It is no longer possible to clearly distinguish the two generator signals.
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RBW 100
1k Mode FFT

-90 dim

-100 dem

-110dem

CF 128.015 MHz Span 300.0 kHz

Figure 6-7: Measurement of two equally-leveled RF sinusoidal signals with a resolution band-
width which is larger than their frequency spacing

6. Set the resolution bandwidth to 7 kHz.

The two generator signals are shown with high resolution. However, the sweep
time becomes longer. At smaller bandwidths, the noise display decreases simulta-
neously (10 dB decrease in noise floor for a decrease in bandwidth by a factor of
10).
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Ref Level -20.00 dBm
Att dB SWT 1.9ms <H:z Mode FFT

-30 dBm
-40 dBm
-50 dBm
-60 dBm
=70 dBm
-80 dBm

-90 dBm

-100 dBm

|
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CF 128.015 MHz Span 300.0 kHz

Figure 6-8: Measurement of two equally-leveled RF sinusoidal signals with a resolution band-
width (1 kHz) which is significantly smaller than their frequency spacing

6.1.5.2 Measuring the Modulation Depth of an AM-Modulated Carrier in the Frequency
Domain

In the frequency range display, the AM side bands can be resolved with a narrow
bandwidth and measured separately. The modulation depth of a carrier modulated with
a sinusoidal signal can then be measured. Since the dynamic range of a signal ana-
lyzer is very large, extremely small modulation depths can also be measured precisely.
For this purpose, the R&S FPS provides measurement routines that output the modu-
lation depth numerically in percent directly.

Signal
Generator

Signal
Analyzer

Figure 6-9: Test setup

Table 6-4: Signal generator settings (e.g. R&S SMW)

Frequency 128 MHz
Level -30 dBm
Modulation 50 % AM, 10 kHz AF

|
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1. Select PRESET to reset the instrument.
Set the center frequency to 128 MHz.
Set the frequency span to 50 kHz.

> w0 BN

Select MEAS > "AM Modulation Depth" to activate the modulation depth measure-
ment.

The R&S FPS automatically sets a marker to the carrier signal in the center of the
diagram and one delta marker each to the upper and lower AM sidebands. The
R&S FPS calculates the AM modulation depth from the level differences of the
delta markers to the main marker and outputs the numeric value in the marker
information.

1 AM Mod Depth

1001 pis ) z/ " Span 1.0 MHz

Stimulus Response L Function Result
225.0 MHz -4.29 dBm
279.7 kHz -10.51 dB
-279.7 kHz -10.49 dB

59.718 %

Figure 6-10: Measurement of the AM modulation depth

The modulation depth is displayed as "MDepth" . The frequency of the AF signal can
be obtained from the frequency display of the delta marker.

6.1.5.3 Measuring AM-Modulated Signals

The R&S FPS rectifies the RF input signal (that is, removes the negative parts) and
displays it as a magnitude spectrum. The rectification also demodulates AM-modulated
signals. The AF voltage can be displayed in zero span if the modulation sidebands fall
within the resolution bandwidth.

Displaying the AF of an AM-modulated signal (Zero Span)

Signal
Generator

Signal
Analyzer

Figure 6-11: Test setup
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Table 6-5: Signal generator settings (e.g. R&S SMW)

Frequency 128 MHz
Level -30 dBm
Modulation 50 % AM, 1 kHz AF

1. Select PRESET to reset the instrument.
Set the center frequency to 128 MHz.
Set the frequency span to 0 Hz or select "Zero Span" .

Set the sweep time to 2.5 ms.

o & 0N

Set the reference level to 6 dBm and the display range to linear (AMPT > "Scale
Config" > "Scaling" : "Linear Percent" ).

6. Define triggering in response to the AF signal using the video trigger to produce a
static image.

a) Press the TRIG key.
b) Select "Video" .
c) Setthe "Trg/Gate Level" to 50%.

The trigger level is displayed as a horizontal line across the entire measurement
diagram. The R&S FPS displays the 1 kHz AF signal as a static image in zero
span.
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Ref Level -26.00 dBm
= Att 0dB = SWT 2.5ms
® 1AP Clrw

---------
E--'.l---'.l-

CF 128.0 MHz

Figure 6-12: Measurement of the AF signal of a carrier that is AM-modulated with 1 kHz

6.1.6 Measurement Examples in Zero Span

For radio transmission systems that use the TDMA method (for example, GSM), trans-
mission quality is determined not only by spectral characteristics but also by character-
istics in zero span. A timeslot is assigned to each user since several users share the
same frequency. Smooth operation is ensured only if all users adhere exactly to their
assigned timeslots.

Both the power during the send phase as well as the timing and duration of the TDMA
burst, and rise and fall times of the burst, are important.

e Measuring the Power Characteristic of Burst Signals.........c.ccocceeiiiiicniiiiiieenn. 139
e Measuring the Signal-to-Noise Ratio of Burst Signals..........ccccccvveeeeveeeiiiiicicnnns 143

6.1.6.1 Measuring the Power Characteristic of Burst Signals

To measure power in zero span, the R&S FPS offers easy-to-use functions that mea-
sure the power over a predefined time.

|
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Measuring the Power of a GSM Burst During the Activation Phase

Signal
e
Generator Analyzer

Signal

Figure 6-13: Test setup

Table 6-6: Signal generator settings (e.g. R&S SMW)

Frequency 890 MHz
Level 0 dBm
Modulation GSM, one timeslot activated

N o o M w0 DN

Select PRESET to reset the instrument.

Set the center frequency to 890 MHz (FREQ).

Set the frequency span to 0 Hz (SPAN > "Zero Span").

Set the reference level to 70 dBm (= level of the signal generator +10 dB) (AMPT).
Set the attenuation to 20 dB (AMPT > "RF Atten Manual" ).

Set the resolution bandwidth to 7 MHz (BW > "Res BW" ).

Set the sweep time to 7 ms (SWEEP > "Sweep Time Manual" ).
The R&S FPS shows the GSM burst continuously across the display.

Using the video trigger, set triggering on the rising edge of the burst.

a) Press the TRIG key.
b) Set the "Trg Source" to "Video" .
c) Setthe "Trg/Gate Level" to 70%.

The R&S FPS shows a static image with the GSM burst at the start of the trace.
The trigger level is displayed as a horizontal line labeled with the absolute level for
the trigger threshold in the measurement diagram.

Activate power measurement within the activation phase of the burst in zero span.

a) Press the MEAS key.

b) Select "Time Domain Power" .

c) Select "Time Dom Power Config" .

d) Set the "Limits" state to "On" .

e) Select the "Left Limit" input field.

f) Using the navigation keys, move the vertical line "S1" to the start of the burst.
g) Select the "Right Limit" input field.

h) Using the navigation keys, move the vertical line "S2" to the end of the burst.

The R&S FPS displays the average (mean) power during the activation phase of
the burst.
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Ref Level 10.00 dBm = RBW 1 MHz
20dB = SWT 1ms YBW 1 MHz

M1[1] -0.57 dBm
a00.00 ps

Power
-0.53 dBm

+30 dBm
40 dBm
50 dBm

150 dBm

L8 O L
I RN

20 dBm

CF 890.0 MHz 100.0 ps/
Marker

| No | Type |Diagl Trc| _ Stimulus | __Response | _Func__| __Func.Result
1 1 1

1N s mdBm

Figure 6-14: Measurement of the average power during the burst of a GSM signal

Measuring the Edges of a GSM Burst with High Time Resolution

Due to the high time resolution of the R&S FPS at the 0 Hz display range, the edges of
TDMA bursts can be measured precisely. The edges can be shifted to the display area
using the trigger offset.

Signal
Generator

Signal
> Analyzer

Figure 6-15: Test setup

Table 6-7: Signal generator settings (e.g. R&S SMW)

Frequency 890 MHz
Level 0 dBm
Modulation GSM, one timeslot activated

The measurement is based on the example "Measuring the Power of a GSM Burst
During the Activation Phase" on page 140.

1. Switch off the power measurement.

|
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a) Press the MEAS key.
b) Select "All Functions Off" .

2. Increase the time resolution to 700 us (SWEEP > "Sweep Time Manual" ).

3. Shift the rising edge of the GSM burst to the center of the display by defining a trig-
ger offset.

a) Press the TRIG key.

b) Select "Trigger Offset" .

c) Using the navigation key (Down), reduce the trigger offset until the burst edge
is displayed in the center of the display, or enter -50 us.
The R&S FPS displays the rising edge of the GSM burst.

Ref Level 10.00 dBm = RBW 1 MHz
= Att 20 dB = SwWT 100ps vBwW 1 MHz
@ 15a Clrw

I s
-10 dBm i
|II
|

ST AT e
=

|
-40 dBm

-50 dBm

-60 dBm
fil. b

_J IJ'I:.II‘ IIJ:'..'r|]'| —

T A A I LR
A, A O

CF 890.0 MHz 10.0 ps/
Marker

| No | __Type |Diag| Trc| _ Stimulus | __Response | _Func | __Func.Result
1 1M 1 1 S

-525.51 mdBm

Figure 6-16: Rising edge of the GSM burst displayed with high time resolution

4. Move the falling edge of the burst to the center of the display. To do so, switch the
trigger "Slope" to "Falling" (TRIG > "Trigger/ Gate Config" ).

The R&S FPS displays the falling edge of the GSM burst.

|
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Ref Level 10.00

-81.88 dBm
43.500 ps

Power
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-40 dBm
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Figure 6-17: Falling edge of the GSM burst displayed with high time resolution

6.1.6.2 Measuring the Signal-to-Noise Ratio of Burst Signals

When TDMA transmission methods are used, the signal-to-noise ratio or the dynamic
range for deactivation can be measured by comparing the power values during the
activation phase and the deactivation phase of the transmission burst. Therefore, the
R&S FPS provides a measurement for absolute and relative power in zero span. In the
following example, the measurement is performed using a GSM burst.

Signal-to-Noise Ratio of a GSM Signal

Signal
Generator

Signal
Analyzer

Figure 6-18: Test setup

Table 6-8: Signal generator settings (e.g. R&S SMW)

Frequency 890 MHz
Level 0 dBm
Modulation GSM, one time slot is switched on

|
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1. Select PRESET to reset the instrument.
Set the center frequency to 890 MHz.
Set the frequency span to 0 Hz.

Set the resolution bandwidth to 1 MHz.

Set the reference level to 0 dBm (= level of the signal generator).

o o b~ w DN

Set the sweep time to 2 ms (SWEEP > "Sweep Time Manual" ).
The R&S FPS shows the GSM burst continuously across the display.

7. Use the trigger source "Video" and the trigger slope "Rising" to trigger on the rising
edge of the burst and shift the start of the burst to the center of the display (see
step 3 in "Measuring the Edges of a GSM Burst with High Time Resolution”
on page 141).

8. Activate power measurement within the activation phase of the burst in zero span.

a) Press the MEAS key.

b) Select "Time Domain Power" .

c) Select "Time Dom Power Config" .

d) Set the "Limits" state to "On" .

e) Select the "Left Limit" input field.

f) Using the navigation keys, move the vertical line "S1" to the start of the burst.
g) Select the "Right Limit" input field.

h) Using the navigation keys, move the vertical line "S2" to the end of the burst.

9. Measure the power during the deactivation phase of the burst by switching the trig-
ger slope to "Falling" (TRIG > "Trigger/ Gate Config" ).

The R&S FPS initiates triggering in response to the falling edge of the burst. This
shifts the burst to the left-hand side of the measurement diagram. The power is
measured in the deactivation phase.
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Figure 6-19: Measurement of the signal-to-noise ratio of a GSM burst signal in zero span

6.2 Channel Power and Adjacent-Channel Power (ACLR)
Measurement

Measuring the power in channels adjacent to the carrier or transmission channel is
useful to detect interference. The results are displayed as a bar chart for the individual

channels.

o About Channel Power Measurements.........cooeeuuuieeiiiiieiiieieeeeeeeee e 146
o  Channel POWEr RESUILS........couuiiiiiiieiie et e e e et e 146
@ Channel POWET BaSICS.....uoiieiiiiiiiie ettt et e e e e ee s 148
e Channel Power Configuration.........cccuuee oo 159
o MSR ACLR CoNnfiguration............ueeeeeiieeeeiiieicciiiiie e e e e e e e s eee e e e e e e e e e s e ssnnnes 169
e How to Perform Channel Power Measurements...........cuuveeveeiieeieieeeeeeeveieeeeeeeeeen, 184
o  Measurement EXamPpIES.......uuuuuuciiiiieie e 188
e Optimizing and Troubleshooting the Measurement............ccccccceceeiiiiiniieeieeeeen, 192
e Reference: Predefined CP/ACLR Standards..........ccoooveiviiieeieiiiiiiieeeeeeeeeeee e, 192
e Reference: Predefined ACLR User Standard XML Files........ccccceeeevviiveveeeeeerennne.. 193
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6.2.1 About Channel Power Measurements

Measuring channel power and adjacent channel power is one of the most important
tasks during signal analysis with the necessary test routines in the field of digital trans-
mission. Theoretically, a power meter could be used to measure channel power at
highest accuracy. However, its low selectivity means that it is not suitable for measur-
ing adjacent channel power as an absolute value or relative to the transmit channel
power. Only a selective power meter can measure the power in the adjacent channels.

A signal analyzer cannot be classified as a true power meter, because it displays the IF
envelope voltage. However, it is calibrated such as to display the power of a pure sine
wave signal correctly, irrespective of the selected detector. This calibration cannot be
applied for non-sinusoidal signals. Assuming that the digitally modulated signal has a
Gaussian amplitude distribution, the signal power within the selected resolution band-
width can be obtained using correction factors. The internal power measurement rou-
tines in a signal analyzer normally use these correction factors to determine the signal
power from IF envelope measurements. These factors apply if and only if the assump-
tion of a Gaussian amplitude distribution is correct.

Apart from this common method, the R&S FPS also has a true power detector, i.e. an
RMS detector. It displays the power of the test signal within the selected resolution
bandwidth correctly, irrespective of the amplitude distribution, without additional correc-
tion factors being required.

The R&S FPS software allows you to perform ACLR measurements on input contain-
ing multiple signals for different communication standards. A measurement standard is
provided that allows you to define multiple discontiguous transmit channels at specified
frequencies, independent from the selected center frequency. The ACLR measurement
determines the power levels of the individual transmit, adjacent, and gap channels, as
well as the total power for each sub block of transmit channels.

A detailed measurement example is provided in Chapter 6.2.7, "Measurement Exam-
ples", on page 188.

6.2.2 Channel Power Results

For channel or adjacent-channel power measurements, the individual channels are
indicated by different colored bars in the diagram. The height of each bar corresponds
to the measured power of that channel. In addition, the name of the channel ( "Adj"
"Alt %1" , "Tx %1" , etc., or a user-defined name) is indicated above the bar (separated
by a line which has no further meaning).

For "Fast ACLR" measurements, which are performed in the time domain, the power
versus time is shown for each channel.

@ Multi-standard radio (MSR) channel power results

The channel power results for MSR signals are described in Chapter 6.2.3.4, "Mea-
surement on Multi-Standard Radio (MSR) Signals", on page 155.
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Results are provided for the TX channel and the number of defined adjacent channels
above and below the TX channel. If more than one TX channel is defined, you must
specify the channel to which the relative adjacent-channel power values refer. By
default, it is the TX channel with the maximum power.

Table 6-9: Measurements performed depending on the number of adjacent channels

Number | Measurement results
of adj.
chan.
0 Channel powers
1 ®  Channel powers
®  Power of the upper and lower adjacent channel
2 ®  Channel powers
®  Power of the upper and lower adjacent channel
®  Power of the next higher and lower channel (alternate channel 1)
3 ®  Channel powers
®  Power of the upper and lower adjacent channel
®  Power of the next higher and lower channel (alternate channel 1)
®  Power of the second next higher and lower adjacent channel (alternate channel 2)
12 ®  Channel powers
®  Power of the upper and lower adjacent channel
®  Power of all the higher and lower channels (alternate channels 1 to 11)

In the R&S FPS display, only the first neighboring channel of the carrier (TX) channel
is labeled "Adj" (adjacent) channel; all others are labeled "Alt" (alternate) channels. In
this manual, "Adjacent" refers to both adjacent and alternate channels.

The measured power values for the TX and adjacent channels are also output as a
table in the Result Summary window. Which powers are measured depends on the
number of configured channels.

|
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6.2.3.1

Channel Power and Adjacent-Channel Power (ACLR) Measurement

For each channel, the following values are displayed:

Label Description

Channel Channel name as specified in the "Channel Settings" (see " Channel Names "
on page 168).

Bandwidth Configured channel bandwidth (see " Channel Bandwidth " on page 166)

Offset Offset of the channel to the TX channel (configured channel spacing, see " Channel
Bandwidth " on page 166)

Power The measured power values for the TX and lower and upper adjacent channels. The
powers of the transmission channels are output in dBm or dBm/Hz, or in dBc, relative

Lower/Upper
( pper) to the specified reference TX channel.

Retrieving Results via Remote Control

All or specific channel power measurement results can be retrieved using the
CALC:MARK:FUNC: POW:RES? command from a remote computer (see
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:RESult? on page 637).
Alternatively, the results can be output as channel power density, i.e. in reference to
the measurement bandwidth.

Furthermore, the measured power values of the displayed trace can be retrieved as
usual using the TRAC: DATA? commands (see TRACe<n>[ : DATA] on page 854). In
this case, the measured power value for each sweep point (by default 1001) is
returned.

Channel Power Basics
Some background knowledge on basic terms and principles used in channel power

measurements is provided here for a better understanding of the required configuration
settings.

o  Measurement MEthOUS.......cciiiiieeei e e e s 148
e Measurement Repeatability..........ccccoiiiiiiiiiii e 150
e Recommended Common Measurement Parameters...........ccccceevevvveeveeeevevevvnvnnnnn. 151
e Measurement on Multi-Standard Radio (MSR) Signals........ccccceccveveeiiiiinneenneneen. 155

Measurement Methods

The channel power is defined as the integration of the power across the channel band-
width.

The Adjacent Channel Leakage Power Ratio (ACLR) is also known as the Adjacent
Channel Power Ratio (ACPR). It is defined as the ratio between the total power of the
adjacent channel to the power of the carrier channel. An ACLR measurement with sev-
eral carrier channels (also known as transmission or TX channels) is also possible and
is referred to as a multicarrier ACLR measurement.



Channel Power and Adjacent-Channel Power (ACLR) Measurement

There are two possible methods for measuring channel and adjacent channel power
with a signal analyzer:

® |BW method (Integration BandWidth method)
® Fast ACLR (Zero-span method ), i.e. using a channel filter

IBW method

When measuring the channel power, the R&S FPS integrates the linear power which
corresponds to the levels of the measurement points within the selected channel. The
signal analyzer uses a resolution bandwidth which is far smaller than the channel
bandwidth. When sweeping over the channel, the channel filter is formed by the pass-
band characteristics of the resolution bandwidth.

-3dB ad
Resolution filter
Ewe-ep

B

Figure 6-20: Approximating the channel filter by sweeping with a small resolution bandwidth

Channel bandwith —— 4

The following steps are performed:

1. The linear power of all the trace points within the channel is calculated.
Pi = 1Q(Li10)
Where P; = power of the trace pixel i
L; = displayed level of trace point i

2. The powers of all trace points within the channel are summed up and the sum is
divided by the number of trace points in the channel.

3. The result is multiplied by the quotient of the selected channel bandwidth and the
noise bandwidth of the resolution filter (RBW).

Since the power calculation is performed by integrating the trace within the channel
bandwidth, this method is called the IBW method (Integration Bandwidth method).

Fast ACLR

The integrated bandwidth method (IBW) calculates channel power and ACLR from the
trace data obtained during a continuous sweep over the selected span. Most parts of
this sweep are not part of the channel itself or the defined adjacent channels. There-
fore, most of the samples taken during the sweep time cannot be used for channel
power or ACLR calculation.
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To decrease the measurement times, the R&S FPS offers a "Fast ACLR" mode. In
Fast ACLR mode, the power of the frequency range between the channels of interest
is not measured, because it is not required for channel power or ACLR calculation. The
measurement time per channel is set with the sweep time. It is equal to the selected
measurement time divided by the selected number of channels.

In the "Fast ACLR" mode, the R&S FPS measures the power of each channel in the
time domain, with the defined channel bandwidth, at the center frequency of the chan-
nel in question. The digital implementation of the resolution bandwidths makes it possi-
ble to select filter characteristics that are precisely tailored to the signal. For
CDMA2000, for example, the power in the useful channel is measured with a band-
width of 1.23 MHz. The power of the adjacent channels is measured with a bandwidth
of 30 kHz. Therefore the R&S FPS changes from one channel to the other and meas-
ures the power at a bandwidth of 1.23 MHz or 30 kHz using the RMS detector.

MultiView  Spectrum
RefLevel m

Att dB  SWT 233.3 ms
1 ACLR

i 1;"‘1 g bbbk u,l..li"“\"""ln.d"J"*l"mnw-w""l-'["

1001 pts 23.33 ms/
CDMAZ000
Offset Power
-28.86 dBm
-28.86 dBm
Offset Lower Upper
5 -68.32 dB -68.47 dB
-68.38 dB -68.50 dB

Figure 6-21: Measuring the channel power and adjacent channel power ratio for CDMA2000 signals
with zero span (Fast ACLR)

6.2.3.2 Measurement Repeatability

The repeatability of the results, especially in the narrow adjacent channels, strongly
depends on the measurement time for a given resolution bandwidth. A longer sweep
time can increase the probability that the measured value converges to the true value
of the adjacent channel power, but obviously increases measurement time.

Assume a measurement with five channels (1 channel plus 2 lower and 2 upper adja-
cent channels) and a sweep time of 100 ms. This measurement requires a measure-
ment time per channel of 20 ms. To calculate the power in one channel, the analyzer
considers the following number of effective samples:

<sweep time in channel> * <selected resolution bandwidth>

For example, for a sweep time of 100 ms the analyzer considers (30 kHz / 4.19 MHz) *
100 ms * 10 kHz = 7 samples. Whereas in Fast ACLR mode, it considers (100 ms/5) *
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30 kHz = 600 samples. If you compare these numbers, you understand the increase of
repeatability with a 95 % confidence level (25). It rises from + 2.8 dB in normal mode to
1+ 0.34 dB in Fast ACLR mode for a sweep time of 100 ms.

For the same repeatability, the integration method requires a sweep time of 8.5 s. The
Figure 6-22 shows the standard deviation of the results as a function of the sweep

time.
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Figure 6-22: Repeatability of adjacent channel power measurement on CDMA2000 standard signals if
the integration bandwidth method is used

The Figure 6-23 shows the repeatability of power measurements in the transmit chan-
nel and of relative power measurements in the adjacent channels as a function of
sweep time. The standard deviation of measurement results is calculated from 100
consecutive measurements. Consider the scaling when you compare power values.
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Figure 6-23: Repeatability of adjacent channel power measurements on CDMA2000 signals in the fast
ACLR mode

6.2.3.3 Recommended Common Measurement Parameters

The following sections provide recommendations on the most important measurement
parameters for channel power measurements.
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All instrument settings for the selected channel setup (channel bandwidth, channel
spacing) can be optimized automatically using the "Adjust Settings" function (see "Opti-
mized Settings ( Adjust Settings )" on page 165).

The easiest way to configure a measurement is using the configuration "Overview" ,

see Chapter 7.1, "Configuration Overview", on page 300.

®  SWEEP TIME .ottt e e e e e e e e e e e e e e e e e e e e s e ssrntnreeaeeeeeaaaeeeeeaannnnns 152
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e Resolution Bandwidth (RBW).........cooiiiiiieieeee et 153
o Video Bandwidth (VBW)......uuiiiiiciiieie ettt e e 154
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®  REfEreNCE LEVEL.....ueiiiiieiee s 155
Sweep Time

The "Sweep Time" is selected depending on the desired reproducibility of results.
Reproducibility increases with "Sweep Time" since power measurement is then per-
formed over a longer time period. As a general approach, approximately 500 non-cor-
related measured values are required for a reproducibility of 0.5 dB. (That means: 95
% of the measurements are within 0.5 dB of the true measured value). Approximately
5000 measured values are required for a reproducibility of 0.1 dB (99 %). These values
are valid for white noise. The measured values are considered as non-correlated if
their time interval corresponds to the reciprocal of the measured bandwidth.

The number of A/D converter values, N, used to calculate the power, is defined by the
"Sweep Time" . The time per trace pixel for power measurements is directly propor-
tional to the selected "Sweep Time" .

If the sample detector is used, it is best to select the smallest "Sweep Time" possible
for a given span and resolution bandwidth. The minimum time is obtained if the setting
is coupled, that is: the time per measurement is minimal. Extending the measurement
time does not have any advantages. The number of samples for calculating the power
is defined by the number of trace points in the channel.

If the RMS detector is used, the selection of "Sweep Time" s can affect the repeatabil-
ity of the measurement results. Repeatability is increased at longer "Sweep Time" s.

If the RMS detector is used, the number of samples can be estimated as follows:

Since only uncorrelated samples contribute to the RMS value, the number of samples
can be calculated from the "Sweep Time" and the resolution bandwidth.

Samples can be assumed to be uncorrelated if sampling is performed at intervals of 1/
RBW. The number of uncorrelated samples is calculated as follows:

Ngecorr = SWT * RBW
(Ngecorr means uncorrelated samples)

The number of uncorrelated samples per trace pixel is obtained by dividing Ngesorr DY
1001 (= pixels per trace).
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The "Sweep Time" can be defined using the softkey in the "Ch Power" menu or in the
"Sweep" configuration dialog box (see " Sweep Time " on page 165).

Frequency Span

The frequency span must cover at least the channels to be measured plus a measure-
ment margin of approximately 10 %.

If the frequency span is large in comparison to the channel bandwidth (or the adjacent-
channel bandwidths) being analyzed, only a few points on the trace are available per
channel. The calculated waveform for the used channel filter is less accurate, which
has a negative effect on the measurement accuracy. It is therefore strongly recommen-
ded that you consider the described formulas when you select the frequency span.

The frequency span for the defined channel settings can be optimized. Use the "Adjust
Settings" function in the "Ch Power" menu or the "General Settings" tab of the "ACLR
Setup" dialog box (see "Optimized Settings ( Adjust Settings )" on page 165). You can
set the frequency span manually in the "Frequency" configuration dialog box.

(See Chapter 7.3.4, "How To Define the Frequency Range", on page 350.)

For channel power measurements the "Adjust Settings" function sets the frequency
span as follows:

"(No. of transmission channels — 1) x transmission channel spacing + 2 x transmission
channel bandwidth + measurement margin"

For adjacent-channel power measurements, the "Adjust Settings" function sets the fre-
quency span as a function of the following parameters:

® Number of transmission channels
® Transmission channel spacing
® Adjacent-channel spacing

® Bandwidth of one of adjacent-channels ADJ, ALT1 or ALT2, whichever is furthest
away from the transmission channels

"(No. of transmission channels — 1) * (transmission channel spacing + 2) * (adjacent-
channel spacing + adjacent-channel bandwidth) + measurement margin"

The measurement margin is approximately 10 % of the value obtained by adding the
channel spacing and the channel bandwidth.

Resolution Bandwidth (RBW)

It is important to suppress spectral components outside the channel to be measured,
especially of the adjacent channels. At the same time, you expect an acceptable mea-
surement speed. To fulfill both these requirements, the appropriate resolution band-
width is essential. As a general approach, set the resolution bandwidth to values
between 1 % and 4 % of the channel bandwidth.

If the spectrum within the channel to be measured and the spectrum around the chan-
nel has a flat characteristic, you can select a larger resolution bandwidth. In the stan-
dard setting, e.g. for standard IS95A REV at an adjacent channel bandwidth of 30 kHz,
a resolution bandwidth of 30 kHz is used. This yields correct results since the spectrum
near the adjacent channels normally has a constant level.
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You can optimize the resolution bandwidth for the defined channel settings. Use the
"Adjust Settings" function in the "Ch Power" menu or the "General Settings" tab of the
"ACLR Setup" dialog box (see "Optimized Settings ( Adjust Settings )" on page 165).
You can set the RBW manually in the "Bandwidth" configuration dialog box, see " RBW
" on page 368.

Except for the IS95 CDMA standards, the "Adjust Settings" function sets the resolution
bandwidth (RBW) as a function of the channel bandwidth:

"RBW" = 1/40 of "Channel Bandwidth"

The maximum resolution bandwidth (concerning the requirement RBW < 1/40) result-
ing from the available RBW steps (1, 3) is selected.

Video Bandwidth (VBW)

For a correct power measurement, the video signal must not be limited in bandwidth. A
restricted bandwidth of the logarithmic video signal causes signal averaging and thus
results in a too low indication of the power (-2.51 dB at very low video bandwidths).
Thus, select the video bandwidth at least three times the resolution bandwidth:

VBW 23 * RBW

For FFT sweeps, instead of increasing the VBW, you can also select the trace average
mode "Power" to ensure correct power measurements (see " Average Mode "

on page 468). Note that in power measurements this setting affects the VBW regard-
less of whether or not a trace is actually averaged.

The video bandwidth for the defined channel settings can be optimized. Use the
"Adjust Settings" function in the "Ch Power" menu or the "General Settings" tab of the
"ACLR Setup" dialog box (see "Optimized Settings ( Adjust Settings )" on page 165).
You can set the VBW manually in the "Bandwidth" configuration dialog box, see " VBW
" on page 368.

The video bandwidth (VBW) is set as a function of the channel bandwidth (see formula
above) and the smallest possible VBW with regard to the available step size is
selected.

Detector

The RMS detector correctly indicates the power irrespective of the characteristics of
the signal to be measured. The whole IF envelope is used to calculate the power for
each measurement point. The IF envelope is digitized using a sampling frequency
which is at least five times the resolution bandwidth which has been selected. Based
on the sample values, the power is calculated for each measurement point using the
following formula:

P, .= L isz
RMS N P i

Where:
s; = linear digitized video voltage at the output of the A/D converter

N = number of A/D converter values per measurement point
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Prus = power represented by a measurement point

When the power has been calculated, the power units are converted into decibels and
the value is displayed as a measurement point.

In principle, the sample detector would be possible as well. Due to the limited number
of measurement points used to calculate the power in the channel, the sample detector
would yield less stable results.

The RMS detector can be set for the defined channel settings automatically. Use the
"Adjust Settings" function in the "Ch Power" menu or the "General Settings" tab of the
"ACLR Setup" dialog box (see "Optimized Settings ( Adjust Settings )" on page 165).
You can set the detector manually in the "Traces" configuration dialog box, see "
Detector " on page 467.

Trace Averaging

Avoid averaging, which is often performed to stabilize the measurement results but
leads to a level indication that is too low. The reduction in the displayed power
depends on the number of averages and the signal characteristics in the channel to be
measured.

The "Adjust Settings" function switches off trace averaging. You can deactivate the
trace averaging manually in the "Traces" configuration dialog box, see " Average Mode
"on page 468.

Reference Level

To achieve an optimum dynamic range, set the reference level so that the signal is as
close to the reference level as possible without forcing an overload message. How-
ever, if the signal-to-noise ratio becomes too small, the dynamic range is also limited.
The measurement bandwidth for channel power measurements is significantly smaller
than the signal bandwidth. Thus, the signal path can be overloaded although the trace
is still significantly below the reference level.

Selecting a predefined standard or automatically adjusting settings does not affect the
reference level. The reference level can be set automatically using the "Auto Level"
function in the AUTO SET menu, or manually in the "Amplitude" menu.

6.2.3.4

Measurement on Multi-Standard Radio (MSR) Signals

Modern base stations can contain multiple signals for different communication stand-
ards. A new measurement standard is provided for the R&S FPS ACLR measurement
that allows you to measure such MSR signals, including non-contiguous setups. Multi-
ple (also non-) contiguous transmit channels can be specified at absolute frequencies,
independent from the common center frequency selected for display.

Signal structure

Up to 18 transmit channels can be grouped in a maximum of 5 sub blocks. Between
two sub blocks, two gaps are defined: a lower gap and an upper gap. Each gap in turn
contains two channels (gap channels). The channels in the upper gap are identical to
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those in the lower gap, but inverted. To either side of the outermost transmit channels,
lower and upper adjacent channels can be defined as in common ACLR measurement
setups.
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Figure 6-24: MSR signal structure

Sub block and channel definition

The sub blocks are defined by a specified center frequency, RF bandwidth, and num-
ber of transmit channels.

Figure 6-25: Sub block definition

As opposed to common ACLR channel definitions, the Tx channels are defined at
absolute frequencies, rather than by a spacing relative to the (common) center fre-

HE
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quency. Each transmit channel can be assigned a different technology, used to prede-
fine the required bandwidth.

Gap channels and CACLR

If two or more sub blocks are defined, the power in the gaps between the sub blocks
must also be measured. Gap channels are defined using bandwidths and spacings,
relative to the outer edges of the surrounding sub blocks. Since the upper and lower
gap channels are symmetrical, only two gap channels must be configured. The
required spacing can be determined according to the following formula (indicated for
lower channels):

Spacing = [CF of the gap channel] - [left sub block center] + ([RF bandwidth of left sub
block] /2)

ALTE_10mM1
ALTE_10M2

bl e, Ly

II'|.__| r '.--._I_I‘ltI | Uj.*hfl'l' |".l-

Sub block CF

Figure 6-26: Gap channel definition for lower gap

According to the MSR standard, the Cumulative Adjacent Channel Leakage Ratio
(CACLR) power must be determined for the gap channels. The CACLR power is mea-
sured in the two gap channels for the upper and lower gap. The power in the gap chan-
nels is then set in relation to the power of the two closest transmission channels to
either side of the gap. The CACLR power for the gap channels is indicated in the
Result Summary.

In addition, the ACLR power for the individual gap channels is indicated in the Result

Summary. The ACLR power of the lower gap channels refers to the TX channel to the
left of the gap. The ACLR power of the upper gap channels refers to the TX channel to
the right of the gap. A separate relative limit value can be defined for the ACLR power.
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Adjacent channels

Adjacent channels are defined as in common ACLR measurements using bandwidths
and spacings, relative to the uppermost or lowermost transmit channels in the sub
blocks (see also Figure 6-24):

® The spacing of the lower adjacent channels refers to the CF of the first Tx channel
in the first sub block.

® The spacing of the upper adjacent channels refers to the CF of the last Tx channel
in the last sub block.

The upper and lower adjacent channels can also be defined asymmetrically (see "

ﬁ Symmetrical Adjacent Setup " on page 174). This is particularly useful if the lowest Tx
channel and highest Tx channel use different standards and thus require different
bandwidths for adjacent channel power measurement.

Channel display for MSR signals

As in common ACLR measurements, the individual channels are indicated by different
colored bars in the diagram. The height of each bar corresponds to the measured
power of that channel. In addition, the name of the channel is indicated above the bar.
Sub blocks are named A,B,C,D,E and are also indicated by a slim blue bar along the
frequency axis.

Tx channel names correspond to the specified technology (for LTE including the band-
width), followed by a consecutive number. (If the channel is too narrow to display the
channel name, "..." is displayed instead.) The assigned sub block is indicated with the
channel name, e.g. "B: LTE_5M1" for the first Tx channel in sub block B that uses the
LTE 5 MHz bandwidth technology.

Adjacent and alternate channels are displayed as in common ACLR measurements.

Gap channels are indicated using the following syntax:

® The names of the surrounding sub blocks (e.g. "AB" for the gap between sub
blocks A and B),

® The channel name ( "Gap1" or "Gap2")
e "L" (for lower) or "U" (for upper)

For example: "ABGap1L" indicates the first lower gap channel between sub blocks A
and B

Both the lower and upper gap channels are displayed.

entirely. This enhances the result display, as fewer lines and bars are displayed. If gap
channels are deactivated, the power results are not calculated and thus are not shown
in the Result Summary table.

@ The gap channels can be hidden if they do not reach a minimum size, or deactivated

Furthermore, channel names for all TX, adjacent, and alternate channels are now user-
definable.
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Channel power results

The Result Summary for MSR signal measurements is similar to the table for common
signals (see Chapter 6.2.2, "Channel Power Resulis", on page 146). However, the Tx
channel results are grouped by sub blocks, and sub block totals are provided instead
of a total Tx channel power. Instead of the individual channel frequency offsets, the
absolute center frequencies are indicated for the transmit channels.

The CACLR and ACLR power results for each gap channel are appended at the end of
the table. The CACLR results are calculated as the power in the gap channel divided
by the power sum of the two closest transmission channels to either side of it.

Bandwidth rECILE Power
-19.11 dBm
-19.21 dBm
-16.15 dBm
Power
-18.72 dBm
-18.72 dBm
ACLR Power
-56.31 dB

-47.50 dB
-58.46 dB
-56.97 dB

ACLR Power CACLR Power

Figure 6-27: Result summary for asymmetrical channel definition

Remote command:

CALCulate:MARKer:FUNCtion:POWer<sb>:RESult? GACLr Or
CALCulate:MARKer:FUNCtion:POWer<sb>:RESult? MACM , see
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:RESult? on page 637

Restrictions and dependencies

As the signal structure in multi-standard radio signals can vary considerably, you can
define the channels very flexibly for the ACLR measurement with the R&S FPS. No
checks or limitations are implemented concerning the channel definitions, apart from
the maximum number of channels to be defined. Thus, you are not notified if transmit
channels for a specific sub block lie outside the defined frequency range for the sub
block, or if transmit and gap channels overlap.

6.2.4 Channel Power Configuration

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" >"CP / ACLR
Config"

Both Channel Power (CP) and Adjacent-Channel Power (ACLR) measurements are
available.

"ACLR Setup" dialog box is replaced by the "MSR ACLR Setup" dialog box. See Chap-

. If the "Multi-Standard Radio" standard is selected (see " Standard " on page 161), the
ter 6.2.5, "MSR ACLR Configuration”, on page 169 for a description of these settings.
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6.2.4.1

General Settings Channel Settings

Standard Channel Coun
EUTRA/LTE Square | Tx
Manage User Standards ADJ

PSR R oG EN N MAX POWER TX CHANNEL : ACLR Mode

Fast ACLR Or Power Mode |

Set CP Reference Adjust Settings

The remote commands required to perform these tasks are described in Chap-
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Standard

The main measurement settings can be stored as a standard file. When such a stan-
dard is loaded, the required channel and general measurement settings are automati-
cally set on the R&S FPS. However, the settings can be changed. Predefined stand-
ards are available for standard measurements, but standard files with user-defined
configurations can also be created.

Note: If the "Multi-Standard Radio" standard is selected, the "ACLR Setup" dialog box
is replaced by the "MSR ACLR Setup" dialog box (see Chapter 6.2.5, "MSR ACLR
Configuration", on page 169).

If any other predefined standard (or "NONE" ) is selected, the "ACLR Setup" dialog box
is restored (see Chapter 6.2.4, "Channel Power Configuration", on page 159).

Note that changes in the configuration are not stored when the dialog boxes are
exchanged.

Predefined Standards < Standard

Predefined standards contain the main measurement settings for standard measure-
ments. When such a standard is loaded, the required channel settings are automati-
cally set on the R&S FPS. However, the settings can be changed.

The predefined standards contain the following settings:

Channel bandwidths

Channel spacings

Detector

Trace Average setting

Resolution Bandwidth (RBW)

® \Weighting Filter

Predefined standards can be selected via the "CP / ACLR Standard" softkey in the "Ch
Power" menu or in the "General Settings" tab of the "CP / ACLR Config" dialog box.

For details on the available standards, see Chapter 6.2.9, "Reference: Predefined CP/
ACLR Standards", on page 192.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer : PRESet on page 642

User Standards — Standard
Access: "CP / ACLR Config" > "General Settings" tab > "Manage User Standards"

In addition to the predefined standards, you can save your own standards with your
specific measurement settings in an XML file so you can use them again later. User-
defined standards are stored on the instrument in the C: \R_S\INSTR\acp_ std direc-
tory.

A set of predefined XML files for common ACLR measurements are provided in this
directory (see Chapter 6.2.10, "Reference: Predefined ACLR User Standard XML
Files", on page 193).

A sample file is provided for an MSR ACLR measurement (MSR_ACLRExample.xml).
It sets up the measurement for the MSR signal generator waveform described in the
file C:\R_S\INSTR\USER\waveform\MSRA GSM WCDMA LTE GSM.wv.

Note that ACLR user standards are not supported for Fast ACLR and multicarrier
ACLR measurements.
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Note: User standards created on an analyzer of the R&S FSP family are compatible to
the R&S FPS. User standards created on an R&S FPS, however, are not necessarily
compatible to the analyzers of the R&S FSP family and may not work there.

The following parameter definitions are saved in a user-defined standard:
® Number of adjacent channels

® Channel bandwidth of transmission (Tx), adjacent (Adj) and alternate (Alt) chan-
nels

Channel spacings

Weighting filters

Resolution bandwidth

Video bandwidth

Detector

ACLR limits and their state

"Sweep Time" and "Sweep Time" coupling

Trace and power mode

(MSR only: sub block and gap channel definition)

Save the current measurement settings as a user-defined standard, load a stored mea-
surement configuration, or delete an existing configuration file.

For details see Chapter 6.2.6.4, "How to Manage User-Defined Configurations”,
on page 187.

Remote command:

To query all available standards:
CALCulate<n>:MARKer<m>:FUNCtion:POWer:STANdard:CATalog?

on page 642

To load a standard:

CALCulate<n>:MARKer<m>:FUNCtion:POWer :PRESet on page 642

To save a standard:

CALCulate<n>:MARKer<m>:FUNCtion:POWer:STANdard: SAVE on page 643
To delete a standard:
CALCulate<n>:MARKer<m>:FUNCtion:POWer:STANdard:DELete on page 642

Number of channels: Tx , Adj
Up to 18 carrier channels and up to 12 adjacent channels can be defined.

Results are provided for the Tx channel and the number of defined adjacent channels
above and below the Tx channel. If more than one Tx channel is defined, the carrier
channel to which the relative adjacent-channel power values should be referenced
must be defined (see " Reference Channel " on page 163).

Note: If several carriers (Tx channels) are activated for the measurement, the number
of sweep points is increased to ensure that adjacent-channel powers are measured
with adequate accuracy.

For more information on how the number of channels affects the measured powers,
see Chapter 6.2.2, "Channel Power Results", on page 146.

Remote command:

Number of Tx channels:

[SENSe: ] POWer:ACHannel : TXCHannel : COUNt on page 647
Number of Adjacent channels:

[SENSe: ] POWer:ACHannel :ACPairs on page 643
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Reference Channel

The measured power values in the adjacent channels can be displayed relative to the
transmission channel. If more than one Tx channel is defined, define which one is used
as a reference channel.

Tx Channel 1 Transmission channel 1 is used.
(Not available for MSR ACLR)

Min Power Tx Channel | The transmission channel with the lowest power is used as a reference channel.

Max Power Tx Chan- | The transmission channel with the highest power is used as a reference channel

nel (Default).
Lowest & Highest The outer left-hand transmission channel is the reference channel for the lower
Channel adjacent channels, the outer right-hand transmission channel that for the upper

adjacent channels.

Remote command:
[SENSe:] POWer:ACHannel :REFerence: TXCHannel :MANual on page 650
[SENSe: ] POWer:ACHannel :REFerence: TXCHannel : AUTO on page 650

Noise Cancellation
The R&S FPS can correct the results by removing the inherent noise of the analyzer,
which increases the dynamic range.

In this case, a reference measurement of the inherent noise of the analyzer is carried
out. The measured noise power is then subtracted from the power in the channel that
is being analyzed (first active trace only).

The inherent noise of the instrument depends on the selected center frequency, resolu-
tion bandwidth and level setting. Therefore, the correction function is disabled when-
ever one of these parameters is changed. A disable message is displayed on the
screen. To enable the correction function after changing one of these settings, activate
it again. A new reference measurement is carried out.

Noise cancellation is also available in zero span.

Currently, noise cancellation is only available for the following trace detectors (see "
Detector " on page 467):

® RMS

® Average
e Sample
o

Positive peak

Remote command:
[SENSe: ] POWer:NCORrection on page 794

Fast ACLR

If activated, instead of using the IBW method, the R&S FPS sets the center frequency
to the different channel center frequencies consecutively and measures the power with
the selected measurement time (= sweep time/number of channels).

Remote command:
[SENSe: ] POWer:HSPeed on page 657
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Selected Trace
The CP/ACLR measurement can be performed on any active trace.

Remote command:
[SENSe: ] POWer: TRACe on page 641

Absolute and Relative Values (ACLR Mode)
The powers of the adjacent channels are output in dBm or dBm/Hz (absolute values),
or in dBc, relative to the specified reference Tx channel.

"Abs" The absolute power in the adjacent channels is displayed in the unit
of the y-axis, e.g. in dBm, dBuV.

"Rel" The level of the adjacent channels is displayed relative to the level of
the transmission channel in dBc.

Remote command:
[SENSe: ] POWer:ACHannel :MODE on page 672

Channel power level and density ( Power Unit )

By default, the channel power is displayed in absolute values. If "/Hz" is activated, the
channel power density is displayed instead. Thus, the absolute unit of the channel
power is switched from dBm to dBm/Hz.

Note: The channel power density in dBm/Hz corresponds to the power inside a band-
width of 1 Hz and is calculated as follows:
"channel power density = channel power — logo(channel bandwidth)"

Thus you can measure the signal/noise power density, for example, or use the addi-
tional functions Absolute and Relative Values (ACLR Mode) and Reference Channel to
obtain the signal to noise ratio.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer:RESult:PHZ on page 672

Power Mode

The measured power values can be displayed directly for each trace ( "Clear/ Write" ),
or only the maximum values over a series of measurements can be displayed ( "Max
Hold" ). In the latter case, the power values are calculated from the current trace and
compared with the previous power value using a maximum algorithm. The higher value
is retained. If "Max Hold" mode is activated, "Pwr Max" is indicated in the table header.
Note that the trace mode remains unaffected by this setting.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer :MODE on page 637

Setting a fixed reference for Channel Power measurements ( Set CP Reference )
If only one Tx channel and no adjacent channels are defined, the currently measured

channel power can be used as a fixed reference value for subsequent channel power
measurements.

When you select this button, the channel power currently measured on the Tx channel
is stored as a fixed reference power. In the following channel power measurements,
the power is indicated relative to the fixed reference power. The reference value is dis-
played in the "Reference" field (in relative ACLR mode); the default value is 0 dBm.

User Manual 1176.8445.02 — 09 164



6.2.4.2

Channel Power and Adjacent-Channel Power (ACLR) Measurement

Note: In adjacent-channel power measurement, the power is always referenced to a
transmission channel (see " Reference Channel " on page 163), thus, this function is
not available.

Remote command:
[SENSe: ] POWer:ACHannel :REFerence:AUTO ONCE on page 650

Optimized Settings ( Adjust Settings )
All instrument settings for the selected channel setup (channel bandwidth, channel
spacing) can be optimized automatically.

The adjustment is carried out only once. If necessary, the instrument settings can be
changed later.

The following settings are optimized by "Adjust Settings" :

"Frequency Span" on page 153

"Resolution Bandwidth (RBW)" on page 153
"Video Bandwidth (VBW)" on page 154
"Detector" on page 154

"Trace Averaging" on page 155

Note: The reference level is not affected by this function. To adjust the reference level
automatically, use the Setting the Reference Level Automatically ( Auto Level ) function
in the AUTO SET menu.

Remote command:
[SENSe: ] POWer:ACHannel : PRESet on page 640

Sweep Time

With the RMS detector, a longer "Sweep Time" increases the stability of the measure-
ment results. For recommendations on setting this parameter, see " Sweep Time "

on page 152.

The "Sweep Time" can be set via the softkey in the "Ch Power" menu and is identical
to the general setting in the "Sweep" configuration dialog box.

Remote command:
[SENSe: ] SWEep: TIME on page 790

Channel Setup

The "Channel Settings" tab in the "ACLR Setup" dialog box provides all the channel
settings to configure the channel power or ACLR measurement. You can define the
channel settings for all channels, independent of the defined number of used Tx or
adjacent channels (see " Number of channels: Tx , Adj " on page 162).

For details on setting up channels, see Chapter 6.2.6.2, "How to Set Up the Channels",
on page 185.

i

In addition to the specific channel settings, the general settings " Standard "
on page 161 and " Number of channels: Tx , Adj " on page 162 are also available in
this tab.
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The following settings are available in individual subtabs of the "Channel Settings" tab.

Channel BandWidth ... 166
(07 g F=T o a1 IS o X Lo o S U 167
LMt CRECK ...ttt e e s e e e s sbreeee e 167
WeIghting FIltErs ....eeeeiiiieeiie e 168
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Channel Bandwidth

General Settings Channel Settings

Standard Channel Count

EUTRA/LTE Square = ™ l 1

Manage User Standards ADJ |pd

Bandwidths Spacing Limits Weighting Filters Names

Tx Channels Adjacent Channels

9.015 MHz ADJ] 9.015 MHz

CTT—

9.015 MHz IR 9.015 MHz

9.015 MHz GRS 9.015 MHz

|

9.015 MHz LIREEEN 9.015 MHz

|

9.015 MHz CINEEAN 9.015 MHz

|

9.015 MHz CINESEN 9.015 MHz

|

9.015 MHz CINNGEN 9.015 MHz

The Tx channel bandwidth is normally defined by the transmission standard.

The correct bandwidth is set automatically for the selected standard. The bandwidth for
each channel is indicated by a colored bar in the display.

For measurements that require channel bandwidths which deviate from those defined
in the selected standard, use the IBW method ( "Fast ACLR" "Off" ). With the IBW
method, the channel bandwidth borders are right and left of the channel center fre-
quency. Thus, you can visually check whether the entire power of the signal under test
is within the selected channel bandwidth.

The value entered for any Tx channel is automatically also defined for all subsequent
Tx channels. Thus, only enter one value if all Tx channels have the same bandwidth.

The value entered for any ADJ or ALT channel is automatically also defined for all
alternate (ALT) channels. Thus, only enter one value if all adjacent channels have the
same bandwidth.
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Remote command:

[SENSe: ] POWer:ACHannel : BANDwidth [ : CHANnel<ch>] on page 644
[SENSe: ] POWer:ACHannel :BANDwidth:ACHannel on page 644
[SENSe: ] POWer:ACHannel :BANDwidth:ALTernate<ch> on page 644

Channel Spacings
Channel spacings are normally defined by the transmission standard but can be

changed.

If the spacings are not equal, the channel distribution in relation to the center frequency
is as follows:

Odd number of Tx channels The middle Tx channel is centered to center frequency.

Even number of Tx channels The two Tx channels in the middle are used to calculate the fre-

quency between those two channels. This frequency is aligned to
the center frequency.

The spacings between all Tx channels can be defined individually. When you change
the spacing for one channel, the value is automatically also defined for all subsequent
Tx channels. This allows you to set up a system with equal Tx channel spacing quickly.
For different spacings, set up the channels from top to bottom.

Tx1-2 Spacing between the first and the second carrier

Tx2-3 Spacing between the second and the third carrier

If you change the adjacent-channel spacing (ADJ), all higher adjacent channel spac-
ings (ALT1, ALT2, ...) are multiplied by the same factor (new spacing value/old spac-
ing value). Again, only enter one value for equal channel spacing. For different spac-
ing, configure the spacings from top to bottom.

For details, see Chapter 6.2.6.2, "How to Set Up the Channels", on page 185

Remote command:

[SENSe: ] POWer:ACHannel:SPACing:CHANnel<ch> on page 647
[SENSe: ] POWer:ACHannel:SPACing[:ACHannel] on page 646
[SENSe: ] POWer:ACHannel : SPACing:ALTernate<ch> on page 646

Limit Check

During an ACLR measurement, the power values can be checked whether they
exceed user-defined or standard-defined limits. A relative or absolute limit can be
defined, or both. Both limit types are considered, regardless whether the measured lev-
els are absolute or relative values. The check of both limit values can be activated
independently. If any active limit value is exceeded, the measured value is displayed in
red and marked by a preceding asterisk in the result table.
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Power Abs Po it

053 GHz -40.68 dBm -71.22 dB -17.18 dB
268 GHz =-40.13 dBm i -20.63 dB
-52.60 dBm
-54.30 dBm
-51.51 dBm
270 GHz =54.13 dBm -84.67 dB -33.63 dB

10355 GHz -51.94 dBm -82.48 dB -19.44 dB
10725 GHz -40.01 dBm -70.55 dB -20.51 dB
10911 GHz -40.28 dBm -70.82 dB -16.78 dB

The results of the power limit checks are also indicated in the STAT: QUES : ACPL sta-
tus registry (see "STATus:QUEStionable:ACPLimit Register" on page 594).

Remote command:

CALCulate<n>:LIMit<k>:ACPower [:STATe] on page 656
CALCulate<n>:LIMit<k>:ACPower:ACHannel :ABSolute:STATe on page 651
CALCulate<n>:LIMit<k>:ACPower:ACHannel :ABSolute on page 651
CALCulate<n>:LIMit<k>:ACPower:ACHannel[:RELative] :STATe

on page 653

CALCulate<n>:LIMit<k>:ACPower:ACHannel [:RELative] on page 652
CALCulate<n>:LIMit<k>:ACPower:ALTernate<ch>:ABSolute:STATe

on page 654

CALCulate<n>:LIMit<k>:ACPower:ALTernate<ch>:ABSolute on page 653
CALCulate<n>:LIMit<k>:ACPower:ALTernate<ch>[:RELative] : STATe
on page 655
CALCulate<n>:LIMit<k>:ACPower:ALTernate<ch>[:RELative] on page 654
CALCulate<n>:LIMit<k>:ACPower:ACHannel :RESult? on page 652

Weighting Filters

Weighting filters allow you to determine the influence of individual channels on the total
measurement result. For each channel you can activate or deactivate the use of the
weighting filter and define an individual weighting factor ( "Alpha:" value).

Weighting filters are not available for all supported standards and cannot always be
defined manually where they are available.

Remote command:

Activating/Deactivating:

[SENSe: ] POWer:ACHannel:FILTer [:STATe] : CHANnel<ch> on page 649
[SENSe: ] POWer:ACHannel :FILTer [:STATe] : ACHannel on page 648
[SENSe: ] POWer:ACHannel :FILTer [:STATe] :ALTernate<ch> on page 649
Alpha value:

[SENSe: ] POWer:ACHannel :FILTer :ALPHa: CHANnel<ch> on page 648
[SENSe: ] POWer:ACHannel :FILTer:ALPHa:ACHannel on page 647
[SENSe: ] POWer:ACHannel :FILTer:ALPHa:ALTernate<ch> on page 648

Channel Names

In the R&S FPS's display, carrier channels are labeled "Tx" by default; the first neigh-
boring channel is labeled "Adj" (adjacent) channel; all others are labeled "Alt" (alter-
nate) channels. You can define user-specific channel names for each channel which
are displayed in the result diagram and result table.
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Remote command:

[SENSe: ] POWer:ACHannel : NAME : ACHannel on page 645
[SENSe: ] POWer:ACHannel :NAME : ALTernate<ch> on page 645
[SENSe: ] POWer:ACHannel : NAME : CHANnel<ch> on page 645

6.2.5 MSR ACLR Configuration

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config"

ACLR measurements can also be performed on input containing multiple signals for
different communication standards. A new measurement standard is provided that
allows you to define multiple discontiguous transmit channels at specified frequencies,
independent from the selected center frequency. If the "Multi-Standard Radio" standard
is selected (see " Standard " on page 161), the "ACLR Setup" dialog box is replaced by
the "MSR ACLR Setup" dialog box.

For more information, see Chapter 6.2.3.4, "Measurement on Multi-Standard Radio
(MSR) Signals", on page 155.

The remote commands required to perform these tasks are described in Chap-
ter 12.5.3, "Measuring the Channel Power and ACLR", on page 641.

e General MSR ACLR Measurement Settings.......cccuuveiriiieeieiiiiiiciiieeeeeeee e e 169
e MSR Sub Block and Tx Channel Definition........c.cccccviiiiiieiieerciee e 175
o MSR Adjacent Channel SEIUP........occuuiiieriiiiiiee e seereee e 177
o MSR Gap Channel Setup.........cooo e 180
o MSR Channel Names......oooi i a e 183

6.2.5.1 General MSR ACLR Measurement Settings

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config" > "MSR Gen-
eral Settings" tab
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Standard

The main measurement settings can be stored as a standard file. When such a stan-
dard is loaded, the required channel and general measurement settings are automati-
cally set on the R&S FPS. However, the settings can be changed. Predefined stand-
ards are available for standard measurements, but standard files with user-defined
configurations can also be created.

Note: If the "Multi-Standard Radio" standard is selected, the "ACLR Setup" dialog box
is replaced by the "MSR ACLR Setup" dialog box (see Chapter 6.2.5, "MSR ACLR
Configuration", on page 169).

If any other predefined standard (or "NONE" ) is selected, the "ACLR Setup" dialog box
is restored (see Chapter 6.2.4, "Channel Power Configuration", on page 159).

Note that changes in the configuration are not stored when the dialog boxes are
exchanged.

Predefined Standards < Standard

Predefined standards contain the main measurement settings for standard measure-
ments. When such a standard is loaded, the required channel settings are automati-
cally set on the R&S FPS. However, the settings can be changed.
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The predefined standards contain the following settings:

Channel bandwidths

Channel spacings

Detector

Trace Average setting

Resolution Bandwidth (RBW)

® Weighting Filter

Predefined standards can be selected via the "CP / ACLR Standard" softkey in the "Ch
Power" menu or in the "General Settings" tab of the "CP / ACLR Config" dialog box.

For details on the available standards, see Chapter 6.2.9, "Reference: Predefined CP/
ACLR Standards", on page 192.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer :PRESet on page 642

User Standards — Standard
Access: "CP / ACLR Config" > "General Settings" tab > "Manage User Standards"

In addition to the predefined standards, you can save your own standards with your
specific measurement settings in an XML file so you can use them again later. User-
defined standards are stored on the instrument in the C: \R_S\INSTR\acp_ std direc-

tory.
A set of predefined XML files for common ACLR measurements are provided in this

directory (see Chapter 6.2.10, "Reference: Predefined ACLR User Standard XML
Files", on page 193).
A sample file is provided for an MSR ACLR measurement (MSR_ACLRExample.xml).

It sets up the measurement for the MSR signal generator waveform described in the
file C:\R_S\INSTR\USER\waveform\MSRA GSM WCDMA LTE GSM.wv.

Note that ACLR user standards are not supported for Fast ACLR and multicarrier
ACLR measurements.

Note: User standards created on an analyzer of the R&S FSP family are compatible to
the R&S FPS. User standards created on an R&S FPS, however, are not necessarily
compatible to the analyzers of the R&S FSP family and may not work there.

The following parameter definitions are saved in a user-defined standard:
® Number of adjacent channels

® Channel bandwidth of transmission (Tx), adjacent (Adj) and alternate (Alt) chan-
nels

Channel spacings

Weighting filters

Resolution bandwidth

Video bandwidth

Detector

ACLR limits and their state

"Sweep Time" and "Sweep Time" coupling

Trace and power mode

(MSR only: sub block and gap channel definition)

Save the current measurement settings as a user-defined standard, load a stored mea-
surement configuration, or delete an existing configuration file.
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For details see Chapter 6.2.6.4, "How to Manage User-Defined Configurations",
on page 187.

Remote command:

To query all available standards:
CALCulate<n>:MARKer<m>:FUNCtion:POWer:STANdard:CATalog?

on page 642

To load a standard:

CALCulate<n>:MARKer<m>:FUNCtion:POWer:PRESet on page 642

To save a standard:

CALCulate<n>:MARKer<m>:FUNCtion:POWer:STANdard: SAVE on page 643
To delete a standard:
CALCulate<n>:MARKer<m>:FUNCtion:POWer:STANdard:DELete on page 642

Number of Sub Blocks
Defines the number of sub blocks, i.e. groups of transmission channels in an MSR sig-
nal.

For more information, see Chapter 6.2.3.4, "Measurement on Multi-Standard Radio
(MSR) Signals", on page 155.

Remote command:
[SENSe: ] POWer:ACHannel : SBCount on page 659

Reference Channel

The measured power values in the adjacent channels can be displayed relative to the
transmission channel. If more than one Tx channel is defined, define which one is used
as a reference channel.

Tx Channel 1 Transmission channel 1 is used.
(Not available for MSR ACLR)

Min Power Tx Channel | The transmission channel with the lowest power is used as a reference channel.

Max Power Tx Chan- | The transmission channel with the highest power is used as a reference channel

nel (Default).
Lowest & Highest The outer left-hand transmission channel is the reference channel for the lower
Channel adjacent channels, the outer right-hand transmission channel that for the upper

adjacent channels.

Remote command:
[SENSe: ] POWer:ACHannel :REFerence: TXCHannel :MANual on page 650
[SENSe: ] POWer:ACHannel :REFerence: TXCHannel : AUTO on page 650

Noise Cancellation
The R&S FPS can correct the results by removing the inherent noise of the analyzer,
which increases the dynamic range.

In this case, a reference measurement of the inherent noise of the analyzer is carried
out. The measured noise power is then subtracted from the power in the channel that
is being analyzed (first active trace only).
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The inherent noise of the instrument depends on the selected center frequency, resolu-
tion bandwidth and level setting. Therefore, the correction function is disabled when-
ever one of these parameters is changed. A disable message is displayed on the
screen. To enable the correction function after changing one of these settings, activate
it again. A new reference measurement is carried out.

Noise cancellation is also available in zero span.

Currently, noise cancellation is only available for the following trace detectors (see "
Detector " on page 467):

® RMS

® Average
e Sample
o

Positive peak

Remote command:
[SENSe: ] POWer :NCORrection on page 794

Selected Trace
The CP/ACLR measurement can be performed on any active trace.

Remote command:
[SENSe: ] POWer: TRACe on page 641

Absolute and Relative Values (ACLR Mode)
The powers of the adjacent channels are output in dBm or dBm/Hz (absolute values),
or in dBc, relative to the specified reference Tx channel.

"Abs" The absolute power in the adjacent channels is displayed in the unit
of the y-axis, e.g. in dBm, dBuV.

"Rel" The level of the adjacent channels is displayed relative to the level of
the transmission channel in dBc.

Remote command:
[SENSe: ] POWer:ACHannel :MODE on page 672

Channel power level and density ( Power Unit )

By default, the channel power is displayed in absolute values. If "/Hz" is activated, the
channel power density is displayed instead. Thus, the absolute unit of the channel
power is switched from dBm to dBm/Hz.

Note: The channel power density in dBm/Hz corresponds to the power inside a band-
width of 1 Hz and is calculated as follows:
"channel power density = channel power — log;o(channel bandwidth)"

Thus you can measure the signal/noise power density, for example, or use the addi-
tional functions Absolute and Relative Values (ACLR Mode) and Reference Channel to
obtain the signal to noise ratio.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer:RESult:PHZ on page 672
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Power Mode

The measured power values can be displayed directly for each trace ( "Clear/ Write" ),
or only the maximum values over a series of measurements can be displayed ( "Max
Hold" ). In the latter case, the power values are calculated from the current trace and
compared with the previous power value using a maximum algorithm. The higher value
is retained. If "Max Hold" mode is activated, "Pwr Max" is indicated in the table header.
Note that the trace mode remains unaffected by this setting.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:POWer :MODE on page 637

Optimized Settings ( Adjust Settings )
All instrument settings for the selected channel setup (channel bandwidth, channel
spacing) can be optimized automatically.

The adjustment is carried out only once. If necessary, the instrument settings can be
changed later.

The following settings are optimized by "Adjust Settings" :
"Frequency Span" on page 153

"Resolution Bandwidth (RBW)" on page 153

"Video Bandwidth (VBW)" on page 154

"Detector" on page 154
"Trace Averaging" on page 155

Note: The reference level is not affected by this function. To adjust the reference level
automatically, use the Setting the Reference Level Automatically ( Auto Level ) function
in the AUTO SET menu.

Remote command:
[SENSe: ] POWer:ACHannel : PRESet on page 640

Symmetrical Adjacent Setup
If enabled, the upper and lower adjacent and alternate channels are defined symmetri-
cally. This is the default behavior.

If disabled, the upper and lower channels can be configured differently. This is particu-
larly useful if the lowest Tx channel and highest Tx channel use different standards and
thus require different bandwidths for adjacent channel power measurement.

Remote command:
[SENSe: ] POWer:ACHannel : SSETup on page 663

Limit Checking
Activates or deactivates limit checks globally for all adjacent and gap channels. In addi-
tion to this setting, limits must be defined and activated individually for each channel.

The results of the power limit checks are also indicated in the STAT: QUES : ACPL sta-
tus registry (see "STATus:QUEStionable:ACPLimit Register" on page 594).

Remote command:
CALCulate<n>:LIMit<k>:ACPower [:STATe] on page 656
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6.2.5.2 MSR Sub Block and Tx Channel Definition

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config" > "Tx Chan-
nels" tab

The "Tx Channels" tab provides all the channel settings to configure sub blocks and Tx
channels in MSR ACLR measurements.

x
_ Spectrum 2 ® - -
MSR General Settings Tx Channels Adjacent Channels Gap Channels Names

sub Sub Block Definition

-, 1 (O
Block A o [T J RF Bandwidth [FLIETITF Tx Count

Sub Tx Channels
Block B

Center Technology Bandwidth Weighting Filter

ESW os0.0 Mz JLTE 1000 2 ] 9.
Tx 2 ggounnz LTE_10_00 ¢ /0. |

Ix5 'INCI]HA B . |
(EX T (T
" N o e

For details on MSR signals, see Chapter 6.2.3.4, "Measurement on Multi-Standard
Radio (MSR) Signals", on page 155.

For details on setting up channels, see Chapter 6.2.6.3, "How to Configure an MSR
ACLR Measurement”, on page 186.

The Tx channel settings for the individual sub blocks are configured in individual sub-
tabs of the "Tx Channel Settings" tab.

ST0] o =1 o Yo [ I 11114 o) o P 176
L SUD BIOCK / CENEEN FIEQ ..., 176
L RF BANAWIALH ...ttt ettt enseae s 176
L Number of Tx Channels ( TX COUNt ).....cucveeeueeeeieeeseeeeee st e s 176
TxX Channel DefiNitioNn ... e e e e 176
L TX CeNEr FIEQUENCY ...t ee e e 176
L Technology Used for TranSmiSSION ............ccceeeeveereeeeuesreseeseseseseesneneens 177
L Tx Channel BandWidth ..............ccevvecueveeeeceeeeeecee e s s 177
L WEIGhtING FIILEIS ......vveeeeeeecececteee ettt sttt es s anananeeeeeas 177
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Sub Block Definition

Sub blocks are groups of transmit channels in an MSR signal. Up to five sub blocks
can be defined. They are defined as an RF bandwidth around a center frequency with
a specific number of transmit channels (max. 18).

Sub blocks are named A,B,C,D,E and are indicated by a slim blue bar along the fre-
quency axis.

Sub Block / Center Freq < Sub Block Definition
Defines the center of an MSR sub block. Note that the position of the sub block also
affects the position of the adjacent gap channels.

Remote command:
[SENSe: ] POWer:ACHannel : SBLock<sb>:FREQuency:CENTer on page 660

RF Bandwidth — Sub Block Definition
Defines the bandwidth of the individual MSR sub block. Note that sub block ranges
also affect the position of the adjacent gap channels.

Remote command:
[SENSe: ] POWer:ACHannel : SBLock<sb>:RFBWidth on page 661

Number of Tx Channels ( Tx Count ) — Sub Block Definition
Defines the number of transmit channels the specific sub block contains. The maxi-
mum is 18 Tx channels.

Remote command:
[SENSe: ] POWer:ACHannel : SBLock<sb>:TXCHannel : COUNt on page 662

Tx Channel Definition

As opposed to common ACLR channel definitions, the Tx channels are defined at
absolute frequencies, rather than by a spacing relative to the (common) center fre-
quency. Each transmit channel can be assigned a different technology, used to prede-
fine the required bandwidth.

The Tx channel settings for the individual sub blocks are configured in individual sub-
tabs of the "Tx Channel Settings" tab.

For details on configuring MSR Tx channels, see Chapter 6.2.6.3, "How to Configure
an MSR ACLR Measurement", on page 186.

Remote command:
[SENSe: ] POWer:ACHannel:SBLock<sb>:NAME [ : CHANnel<ch>] on page 670

Tx Center Frequency — Tx Channel Definition

Defines the (absolute) center frequency of an MSR Tx channel. Each Tx channel is
defined independently of the others; automatic spacing as in common ACLR measure-
ments is not performed.

Note that the position of the adjacent channels is also affected by:

® The position of the first Tx channel in the first sub block
® The position of last Tx channel in the last sub block

Remote command:
[SENSe: ] POWer:ACHannel : SBLock<sb>:CENTer [ : CHANnel<ch>] on page 659



6.2.5.3

Channel Power and Adjacent-Channel Power (ACLR) Measurement

Technology Used for Transmission < Tx Channel Definition

The technology used for transmission by the individual channel can be defined for
each channel. The required channel bandwidth and use of a weighting filter are pre-
configured automatically according to the selected technology standard.

"GSM" Transmission according to GSM standard

"W-CDMA" Transmission according to W-CDMA standard

"LTE xxx"
Transmission according to LTE standard for different channel band-
widths

"USER" User-defined transmission; no automatic preconfiguration possible

Remote command:
[SENSe: ] POWer:ACHannel : SBLock<sb>:TECHnology [ : CHANnel<ch>]
on page 661

Tx Channel Bandwidth < Tx Channel Definition

The Tx channel bandwidth is normally defined by the transmission technology stan-
dard. The correct bandwidth is predefined automatically for the selected technology.
Each Tx channel is defined independently of the others; automatic bandwidth configu-
ration for subsequent channels as in common ACLR measurements is not performed.

The bandwidth for each channel is indicated by a colored bar in the display.

Remote command:
[SENSe: ] POWer:ACHannel :SBLock<sb>:BANDwidth[:CHANnel<ch>]
on page 659

Weighting Filters <— Tx Channel Definition

Weighting filters allow you to determine the influence of individual channels on the total
measurement result. For each channel, you can activate or deactivate the use of the
weighting filter and define an individual weighting factor ( "Alpha:" value).

Remote command:

Activating/Deactivating:

[SENSe: ] POWer:ACHannel :FILTer [:STATe] : SBLock<sb>:CHANnel<ch>
on page 658

Alpha value:

[SENSe: ] POWer:ACHannel:FILTer:ALPHa:SBLock<sb>:CHANnel<ch>
on page 658

MSR Adjacent Channel Setup

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config" > "Adjacent
Channels" tab

The "Adjacent Channels" tab provides all the channel settings to configure adjacent
and gap channels in MSR ACLR measurements.
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For symmetrical channel definition (see " Symmetrical Adjacent Setup " on page 174),
the dialog box is reduced as the upper and lower channels are identical.

MSR p
Snai E _ @ nactriam 3 X

| MSR General Settings Tx Channels Adjacent Channels Gap Channels Names

Settings

Adj Channels
Spadng Bandwidth Weighting Filter Relative Limit Absolute Limit

Adjacent

o5z Joosmuz Il N W~ N-4a2a8c I NoodBm |
LWWE 0 . - 0
T N — — e ————]
Upper [20.0 MHz ] [18.015 MHz | . 0.22 | -44.2 dBc ] 0.0 dBm
Alternate 1
— — —_
—aa—— — R ——

Alternate 2

Figure 6-28: Asymmetrical adjacent channel definition

For details on setting up channels, see Chapter 6.2.6.3, "How to Configure an MSR
ACLR Measurement", on page 186.

Number of Adjacent Channels ( Adj COUNT )..ccooiiiiiiiiiiiieieeeee e 178
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Number of Adjacent Channels ( Adj Count )

Defines the number of adjacent channels above and below the Tx channel block in an
MSR signal. You must define the carrier channel to which the relative adjacent-channel
power values refer (see " Reference Channel " on page 163).

Remote command:
[SENSe: ] POWer:ACHannel :ACPairs on page 643

Adjacent Channel Definition
Defines the channels adjacent to the transmission channel block in MSR signals. A
maximum of 12 adjacent channels can be defined.
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For MSR signals, adjacent channels are defined in relation to the center frequency of

the first and last transmission channel in the entire block, i.e.:

® The lower adjacent channels are defined in relation to the CF of the first Tx chan-
nel in the first sub block.

® The upper adjacent channels are defined in relation to the CF of the last Tx chan-
nel in the last sub block.

Adjacent channels are named "Adj" and "Alt1" to "Alt11" by default; the names can be
changed manually (see Chapter 6.2.5.5, "MSR Channel Names", on page 183).

In all other respects, channel definition is identical to common ACLR measurements.

Adjacent Channel Spacings < Adjacent Channel Definition
Channel spacings are normally predefined by the selected technology but can be
changed.

For MSR signals, adjacent channels are defined in relation to the center frequency of

the first and last transmission channel in the entire block, i.e.:

® The spacing of the lower adjacent channels refers to the CF of the first Tx channel
in the first sub block.

® The spacing of the upper adjacent channels refers to the CF of the last Tx channel
in the last sub block.

For details, see Chapter 6.2.6.3, "How to Configure an MSR ACLR Measurement",
on page 186

Remote command:

[SENSe: ] POWer:ACHannel :SPACing[:ACHannel] on page 646

[SENSe: ] POWer:ACHannel : SPACing:ALTernate<ch> on page 646

[SENSe: ] POWer:ACHannel :SPACing:UACHannel on page 662

[SENSe: ] POWer:ACHannel : SPACing:UALTernate<ch> on page 662

Adjacent Channel Bandwidths < Adjacent Channel Definition

The adjacent channel bandwidth is normally predefined by the transmission technology
standard. The correct bandwidth is set automatically for the selected technology. The
bandwidth for each channel is indicated by a colored bar in the display.

Remote command:

[SENSe: ] POWer:ACHannel :BANDwidth:ACHannel on page 644
[SENSe: ] POWer:ACHannel :BANDwidth:ALTernate<ch> on page 644
[SENSe: ] POWer:ACHannel : BANDwidth:UACHannel on page 663
[SENSe: ] POWer:ACHannel : BANDwidth:UALTernate<ch> on page 663

Weighting Filters — Adjacent Channel Definition

Weighting filters allow you to determine the influence of individual channels on the total
measurement result. For each channel, you can activate or deactivate the use of the
weighting filter and define an individual weighting factor ( "Alpha:" value).

Remote command:

Activating/Deactivating:

[SENSe: ] POWer:ACHannel :FILTer [:STATe] : ACHannel on page 648
[SENSe: ] POWer:ACHannel :FILTer [:STATe] :ALTernate<ch> on page 649
[SENSe: ] POWer:ACHannel :FILTer[:STATe] : UACHannel on page 664
[SENSe: ] POWer:ACHannel :FILTer [:STATe] :UALTernate<ch> on page 665
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Alpha value:

[SENSe: ] POWer:ACHannel:FILTer:ALPHa:ACHannel on page 647
[SENSe: ] POWer:ACHannel :FILTer:ALPHa:ALTernate<ch> on page 648
[SENSe: ] POWer:ACHannel :FILTer:ALPHa:UACHannel on page 664
[ ]

SENSe: ]POWer:ACHannel : FILTer : ALPHa:UALTernate<ch> on page 664

Limit Checking — Adjacent Channel Definition

During an ACLR measurement, the power values can be checked whether they
exceed user-defined or standard-defined limits. A relative or absolute limit can be
defined, or both, for each individual adjacent channel. Both limit types are considered,
regardless whether the measured levels are absolute or relative values. The check of
both limit values can be activated independently. If any active limit value is exceeded,
the measured value is displayed in red and marked by a preceding asterisk in the
result table.

Note that in addition to activating limit checking for individual channels, limit checking
must also be activated globally for the MSR ACLR measurement (see " Limit Checking
"on page 174).

andard Radio

Power

-80.44 dBm

-29.15 dBm

Lower

Upper

-49.76 dB -50.37 dB

Remote command:

CALCulate<n>:LIMit<k>:ACPower [:STATe] on page 656
CALCulate<n>:LIMit<k>:ACPower:ACHannel :ABSolute:STATe On page 651
CALCulate<n>:LIMit<k>:ACPower:ACHannel :ABSolute on page 651
CALCulate<n>:LIMit<k>:ACPower:ACHannel[:RELative] : STATe

on page 653
CALCulate<n>:
CALCulate<n>:
on page 654
CALCulate<n>:LIMit<k>:
CALCulate<n>:LIMit<k>:
on page 655
CALCulate<n>:
CALCulate<n>:

LIMit<k>:ACPower:ACHannel [:RELative] on page 652
LIMit<k>:ACPower:ALTernate<ch>:ABSolute:STATe

ACPower:ALTernate<ch>:ABSolute on page 653
ACPower:ALTernate<ch>[:RELative] :STATe

ACPower:ALTernate<ch>[:RELative] on page 654
ACPower :ACHannel :RESult? on page 652

LIMit<k>:
LIMit<k>:

MSR Gap Channel Setup

Access: "Overview" > "Select Measurement" > "Channel Power ACLR" >"CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config" > "Gap Chan-
nels" tab

The "Gap Channels" tab provides all the channel settings to configure adjacent and
gap channels in MSR ACLR measurements.
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MSR ACLR Setuf
. 1 * SEnactram 3|

MSR General Settings Tx Channels Adjacent Channels Gap Channels Names
Gap Activation

Activate Gaps

Minimum gap size to show Gap 1 |[sXi} 1], F3

Minimum gap size to show Gap 2 ﬁ

Gap Channels Configuration (for measuring ACLR and CACLR)

Absolute Limit Relative Limit

Filte
(YN 2.5 MHz [3.34 MHz | [o.u 0.0 dBm ] ACLR -44.2 dBc
%Y 75mnz || 3.8ammz | 0.22 ' 0.0dem PR -44.2dBc
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For details on MSR signals, see Chapter 6.2.3.4, "Measurement on Multi-Standard
Radio (MSR) Signals", on page 155.

For details on setting up channels, see Chapter 6.2.6.3, "How to Configure an MSR
ACLR Measurement", on page 186.
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Activate Gaps
If enabled, the gap channels are displayed and channel power results are calculated
and displayed in the Result Summary.

Remote command:
[SENSe: ] POWer:ACHannel : AGCHannels on page 668

Minimum gap size to show Gap 1/ Minimum gap size to show Gap 2

If the gap between the sub blocks does not exceed the specified bandwidth, the gap
channels are not displayed in the diagram. The gap channel results are not calculated
in the result summary.

Remote command:
[SENSe: ] POWer:ACHannel : GAP<gap>:MSIZe on page 669

Gap Channel Definition

Between two sub blocks in an MSR signal, two gaps are defined: a lower gap and an
upper gap. Each gap in turn contains two channels, the gap channels. The channels in
the upper gap are identical to those in the lower gap, but inverted. Thus, in the

R&S FPS MSR ACLR measurement, only two gap channels are configured.
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Gap channels are indicated using the following syntax:

® The names of the surrounding sub blocks (e.g. "AB" for the gap between sub
blocks A and B),

® The channel name ( "Gap1" or "Gap2" )

e "L" (for lower) or "U" (for upper)

Gap Channel Spacing < Gap Channel Definition
Gap channel spacings are normally predefined by the MSR standard but can be
changed.

Gap channels are defined using bandwidths and spacings, relative to the outer edges
of the surrounding sub blocks. Since the upper and lower gap channels are identical,
only two channels must be configured. The required spacing can be determined
according to the following formula (indicated for lower channels):

Spacing = [CF of the gap channel] - [left sub block center] + ([RF bandwidth of left sub
block] /2)

(See also Figure 6-25 and Figure 6-26.)

For details, see Chapter 6.2.6.3, "How to Configure an MSR ACLR Measurement",
on page 186.

Remote command:
[SENSe: ] POWer:ACHannel : SPACing:GAP<gap> Onh page 669

Gap Channel Bandwidths < Gap Channel Definition

The gap channel bandwidth is normally predefined by the transmission technology
standard. The correct bandwidth is set automatically for the selected technology. The
bandwidth for each channel is indicated by a colored bar in the display (if the gap is not
too narrow, see "Channel display for MSR signals" on page 158).

Remote command:
[SENSe: ] POWer:ACHannel : BANDwidth:GAP<gap> on page 668

Weighting Filters < Gap Channel Definition

Weighting filters allow you to determine the influence of individual channels on the total
measurement result. For each channel, you can activate or deactivate the use of the
weighting filter and define an individual weighting factor ( "Alpha:" value).

Remote command:
[SENSe: ] POWer:ACHannel :FILTer [ :STATe] : GAP<gap> On page 669
[SENSe: ] POWer:ACHannel :FILTer : ALPHa :GAP<gap> Onh page 668

Limit Checking < Gap Channel Definition

During an ACLR measurement, the power values can be checked whether they
exceed user-defined or standard-defined limits. A relative or absolute limit can be
defined, or both, for each individual gap channel. Both limit types are considered,
regardless whether the measured levels are absolute or relative values. The check of
both limit values can be activated independently. Furthermore, relative limits can be
defined and activated individually for ACLR or CACLR power levels.

If any active limit value is exceeded, the measured value is displayed in red and
marked by a preceding asterisk in the result table.
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Note that in addition to activating limit checking for individual channels, limit checking
must also be activated globally for the MSR ACLR measurement (see " Limit Checking
"on page 174).

Remote command:

CALCulate<n>:LIMit<k>:ACPower [:STATe] on page 656
CALCulate<n>:LIMit<k>:ACPower:GAP<gap>:ABSolute:STATe On page 666
CALCulate<n>:LIMit<k>:ACPower:GAP<gap>:ACLR[:RELative] :STATe

on page 666
CALCulate<n>:LIMit<k>:ACPower:GAP<gap>[:CACLr] [:RELative] :STATe
on page 667
CALCulate<n>:LIMit<k>:ACPower:GAP<gap>:ABSolute on page 665
CALCulate<n>:LIMit<k>:ACPower:GAP<gap>:ACLR[:RELative] on page 666
CALCulate<n>:LIMit<k>:ACPower:GAP<gap>[:CACLr] [:RELative]

on page 667
CALCulate<n>:LIMit<k>:ACPower:GAP<gap>[:CACLr]:RESult? on page 671

6.2.5.5 MSR Channel Names
Access: "Overview" > "Select Measurement" > "Channel Power ACLR" > "CP / ACLR
Standard" > "Standard" : "Multi-Standard Radio" > "CP / ACLR Config" > "Names" tab
Channel names for all TX, adjacent, and alternate channels are user-definable.

In the "Names" tab, you can define a customized name for each channel in each sub
block. Note that the names are not checked for uniqueness.

m_l___.m._'x_l____
MSR General Settings Tx Channels Adjacent Channels Gap Channels Names

Tx Channels Adjacent Channels

SBA SBB Adjacent

PO A:LTE_10M1 LN | Adj Lower |
PPN A:LTE_10M2 Upper [Mj Upper |

(Pl A:WCDMAL J Alternate 1

Tx 4 [n:wcnuu Lower

LB A:WCDMA3Z Upper INtl Upper

FT | A-WCDMA4 Alternate 2

=7 'ﬁ:WCUMAS Lower [ﬁl‘[l Lower |

Tx9 ’}\:WCDM;‘? Alternate 3

- . P s upper 1]

Figure 6-29: Channel name definition for asymmetric adjacent channels
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Remote command:

[SENSe: ] POWer:ACHannel:SBLock<sb>:NAME [ : CHANnel<ch>] on page 670
[SENSe: ] POWer:ACHannel : NAME : ACHannel on page 645

[SENSe: ] POWer:ACHannel :NAME : ALTernate<ch> on page 645

[SENSe: ] POWer:ACHannel : NAME : UACHannel on page 670

[SENSe: ] POWer:ACHannel : NAME : UALTernate<ch> on page 670

How to Perform Channel Power Measurements

The following step-by-step instructions demonstrate the most common tasks when per-
forming channel power measurements.

For remote operation, see Chapter 12.5.3.10, "Programming Examples for Channel
Power Measurements", on page 673.

6.2.6.1

e How to Perform a Standard Channel Power Measurement.........cc.cccccveverinvennnn. 184
e How to Set Up the Channels............uuueiiiiiiiiiiii e 185
e How to Configure an MSR ACLR Measurement........ccccccoeiiiiiiiiiiiieieeieeee e 186
e How to Manage User-Defined Configurations............ccceveiieiiiiiiiieii i, 187
e How to Compare the Tx Channel Power in Successive Measurements............... 188

How to Perform a Standard Channel Power Measurement

Performing a channel power or ACLR measurement according to common standards is
a very easy and straightforward task with the R&S FPS.

1. Press the MEAS key or select "Select Measurement" in the "Overview" .
2. Select "Channel Power ACLR" .

The measurement is started immediately with the default settings.
3. Select the "CP / ACLR Standard" softkey.

4. Select a standard from the list.

The measurement is restarted with the predefined settings for the selected stan-
dard.

5. If necessary, edit the settings for your specific measurement as described in Chap-
ter 6.2.6.2, "How to Set Up the Channels", on page 185, or load a user-defined
configuration (see "To load a user-defined configuration" on page 188).
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How to Set Up the Channels

Channel definition is the basis for measuring power levels in certain frequency ranges.
Usually, the power levels in one or more carrier (Tx) channels and possibly the adja-
cent channels are of interest. Up to 18 carrier channels and up to 12 adjacent channels
can be defined.

When a measurement standard is selected, all settings including the channel band-
widths and channel spacings are set according to the selected standard. Select a stan-
dard in the "Ch Power" menu or the "ACLR Setup" dialog box. You can adjust the set-
tings afterwards.

Channel setup consists of the following settings:

® The number of transmission (Tx) and adjacent channels

® The bandwidth of each channel

® For multicarrier ACLR measurements: which Tx channel is used as a reference
® The spacing between the individual channels

® Optionally: the names of the channels displayed in the diagram and result table

® Optionally: the influence of individual channels on the total measurement result
( "Weighting Filter" )

® Optionally: limits for a limit check on the measured power levels

Changes to an existing standard can be stored as a user-defined standard, see Chap-
ter 6.2.6.4, "How to Manage User-Defined Configurations"”, on page 187.

» To configure the channels in the "Ch Power" dialog box, select "Ch Power" > "CP /
ACLR Config" > "Channel Settings" tab.

In the "Channel Setup" dialog box, you can define the channel settings for all channels,
independent of the defined number of used Tx or adjacent channels.

To define channel spacings
Channel spacings are normally defined by the selected standard but can be changed.

» In the "Channel Settings" tab of the "ACLR Setup" dialog box, select the "Spacing"
subtab.
The value entered for any Tx channel is automatically also defined for all subse-
quent Tx channels. Thus, only enter one value if all Tx channels have the same
spacing.
If the channel spacing for the adjacent or an alternate channel is changed, all
higher alternate channel spacings are multiplied by the same factor (new spacing
value/old spacing value). The lower adjacent-channel spacings remain unchanged.
Only enter one value for equal channel spacing.



R&S®FPS

Measurements and Results

6.2.6.3

Example: Defining channel spacing
In the default setting, the adjacent channels have the following spacing: 20 kHz
("ADJ"), 40 kHz ("ALT1"), 60 kHz ("ALT2"), 80 kHz ("ALT3"), 100 kHz ("ALT4"), ...

Set the spacing of the first adjacent channel ("ADJ") to 40 kHz. For all other adjacent
channels, the spacing is multiplied by factor 2: 80 kHz ("ALT1"), 120 kHz ("ALT2"), 160
kHz ("ALT3"), ...

Starting from the default setting, set the spacing of the fifth adjacent channel ("ALT4")
to 150 kHz. For all higher adjacent channels, the spacing is multiplied by factor 1.5:
180 kHz ("ALT5"), 210 kHz ("ALT6"), 240 kHz ("ALT7"), ...

How to Configure an MSR ACLR Measurement

You configure ACLR measurements on MSR signals in a special configuration dialog
box on the R&S FPS.

1. Press the MEAS key or select "Select Measurement" in the "Overview" .

2. Select "Channel Power ACLR" .

The measurement is started immediately with the default settings.
3. Select the "CP / ACLR Standard" softkey.
4. Select the "Multi-Standard Radio" standard from the list.

5. Select the "CP / ACLR Config" softkey to configure general MSR settings, including
the number of sub blocks (up to 5).
To configure asymmetric adjacent channels, deactivate the "Symmetrical" option in
the general MSR settings.

6. Select the "Tx Channels" tab to configure the sub blocks and transmission chan-
nels.
For each sub block:

a) Define the (center frequency) position and bandwidth of the sub block, as well
as the number of transmission channels it contains.
b) For each transmission channel in the sub block:

Define the center frequency.

Select the technology used for transmission.

Check the bandwidth.

If necessary, define the use of a weighting filter for the channel.

7. Select the "Adjacent Channels" tab to configure the adjacent channels.

8. Define the number of adjacent channels and the settings for each channel:

e The spacing, defined as the distance of the center frequency from the center
frequency of the first transmission channel in the first sub block.
For asymmetrical channels, define the upper adjacent channel spacing as the
distance from the center frequency of the last transmission channel in the last
sub block.

e The bandwidth

HE
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e If necessary, a weighting filter
e Optionally, define and activate relative or absolute limits, or both, against which
the power levels of the channel are to be checked.

9. Select the "Gap Channels" tab to configure the gap channels.

10. Define the following settings for the two (upper or lower) gap channels. Since the
upper and lower channels are identical, it is only necessary to configure two chan-
nels.

e The spacing, defined as the distance of the center frequency from the outer
edge of the sub block to the left or right of the gap. You can determine the
required spacing as follows:

Spacing = [CF of the gap channel] - [left sub block center] + ([RF bandwidth of
left sub block] /2)

The bandwidth

If necessary, a weighting filter

Optionally, define and activate relative or absolute limits, or both, against which
the power levels of the channel are to be checked.

11. If power limits are defined and activated, activate global limit checking for the mea-
surement on the "MSR General Settings" tab.

12. Optionally, store the settings for the MSR ACLR measurement as a user-defined
standard as described in "To store a user-defined configuration” on page 187. Oth-
erwise the configuration is lost when you select a different measurement standard.

6.2.6.4 How to Manage User-Defined Configurations

You can define measurement configurations independently of a predefined standard
and save the current ACLR configuration as a "user standard" in an XML file. You can
then load the file and thus the settings again later.

User-defined standards are not supported for "Fast ACLR" and multicarrier ACLR mea-
surements.

Compatibility to R&S FSP

User standards created on an analyzer of the R&S FSP family are compatible to the
R&S FPS. User standards created on an R&S FPS, however, are not necessarily com-
patible to the analyzers of the R&S FSP family and may not work there.

To store a user-defined configuration

1. In the "Ch Power" menu, select the "CP / ACLR Config" softkey to display the
"ACLR Setup" dialog box.

2. Configure the measurement as required (see also Chapter 6.2.6.2, "How to Set Up
the Channels", on page 185).

3. Inthe "General Settings" tab, select the "Manage User Standards" button to display
the "Manage" dialog box.
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4. Define a filename and storage location for the user standard.
By default, the XML file is stored in C: \R_S\INSTR\acp_ std\.However, you can
define any other storage location.

5. Select "Save" .

To load a user-defined configuration

1. In the "General Settings" tab of the "ACLR Setup" dialog box, select the "Manage
User Standards" button to display the "Manage" dialog box.

2. Select the user standard file.
3. Select "Load" .

The stored settings are automatically set on the R&S FPS and the measurement is
restarted with the new parameters.

6.2.6.5 How to Compare the Tx Channel Power in Successive Measurements

For power measurements with only one Tx channel and no adjacent channels, you can
define a fixed reference power and compare subsequent measurement results to the
stored reference power.

1. Configure a measurement with only one Tx channel and no adjacent channels (see
also Chapter 6.2.6.2, "How to Set Up the Channels", on page 185).
2. Inthe "ACLR Setup" dialog box, select the "Set CP Reference" button.

The channel power currently measured on the Tx channel is stored as a fixed ref-
erence power. The reference value is displayed in the "Reference” field of the
result table (in relative ACLR mode).

3. Start a new measurement.

The resulting power is indicated relative to the fixed reference power.
4. Repeat this for any number of measurements.

5. To start a new measurement without the fixed reference, temporarily define a sec-
ond channel or preset the instrument.

6.2.7 Measurement Examples

The R&S FPS has test routines for simple channel and adjacent channel power mea-
surements. These routines give quick results without any complex or tedious setting
procedures.
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A programming example demonstrating an ACLR measurement in a remote environ-
ment is provided in Chapter 12.5.3.10, "Programming Examples for Channel Power
Measurements", on page 673.

6.2.7.1

e Measurement Example 1 — ACPR Measurement on a CDMA2000 Signal.......... 189
e Measurement Example 3 — Measuring the Intrinsic Noise of the R&S FPS with the
Channel Power FUNCHION........ooiiiieccee et 190

Measurement Example 1 — ACPR Measurement on a CDMA2000 Signal

Test setup:

Signal

B
Generator il

Signal generator settings (e.g. R&S SMW):

Frequency: 850 MHz
Level: 0 dBm
Modulation: CDMA2000
Procedure:

1. Preset the R&S FPS.

Set the center frequency to 850 MHz.

Set the span to 4 MHz.

Set the reference level to +70 dBm.

Press the MEAS key or select "Select Measurement" in the "Overview" .

Select the "Channel Power ACLR" measurement function.

N o o ~ w0 D

Set the "CDMA2000 1X" standard for adjacent channel power measurement in the
"ACLR Setup" dialog box.

The R&S FPS sets the channel configuration according to the 2000 standard with
two adjacent channels above and 2 below the transmit channel. The spectrum is
displayed in the upper part of the screen, the numeric values of the results and the
channel configuration in the lower part of the screen. The various channels are rep-
resented by vertical lines on the graph.
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The frequency span, resolution bandwidth, video bandwidth and detector are
selected automatically to give correct results. To obtain stable results — especially
in the adjacent channels (30 kHz bandwidth) which are narrow in comparison with
the transmission channel bandwidth (1.23 MHz) — the RMS detector is used.

8. Set the optimal reference level and RF attenuation for the applied signal level using
the "Auto Level" function in the AUTO SET menu.

9. Activate "Fast ACLR" mode in the "ACLR Setup" dialog box to increase the repeat-
ability of results.

The R&S FPS sets the optimal RF attenuation and the reference level based on
the transmission channel power to obtain the maximum dynamic range.
The Figure 6-30 shows the result of the measurement.

MultiView Spectrum
Ref Level = RBW
100 ms = VBW 3 Mode Auto
# 1Rm Clrw

h“'" "'If,‘|“|r||lﬂl\|."p ‘il ';|‘|I' '||||I'I||I||ir|ll H"

. m i ‘. ‘ b | "
|'\I\IM' |ﬁ|hl '[I“ l“”’ ||I La i h I| it I I”I‘" |’|\ il |"I iy
1001 pts 419,0 kHz/ n 4,19 MHz
COMA2000
Offset Power
-0.86 dBm
-0.8|6 dBm

-79.59 dB -80. 34 dB
-85.04 dB -83.85 dB

Figure 6-30: Adjacent channel power measurement on a CDMA2000 1x signal

6.2.7.2 Measurement Example 3 — Measuring the Intrinsic Noise of the R&S FPS with the
Channel Power Function

Noise in any bandwidth can be measured with the channel power measurement func-
tions. Thus the noise power in a communication channel can be determined, for exam-
ple.

If the noise spectrum within the channel bandwidth is flat, the noise marker can be
used to determine the noise power in the channel by considering the channel band-
width. However, in the following cases, the channel power measurement method must
be used to obtain correct measurement results:

® |f phase noise and noise that normally increases towards the carrier is dominant in
the channel to be measured

® |f there are discrete spurious signals in the channel

|
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Test setup:
» Leave the RF input of the R&S FPS open-circuited or terminate it with 50 Q.
Procedure:

1. Preset the R&S FPS.
2. Set the center frequency to 7 GHz and the span to 7 MHz.

3. To obtain maximum sensitivity, set RF attenuation to 0 dB and the reference level
to -40 dBm.

4. Select the "Channel Power ACLR" measurement function from the "Select Mea-
surement" dialog box.

5. Inthe "ACLR Setup" dialog box, set up a single Tx channel with the channel band-
width 1.23 MHz.

6. Select the "Adjust Settings" softkey.
The settings for the frequency span, the bandwidth (RBW and VBW) and the
detector are automatically set to the optimum values required for the measure-
ment.

7. Stabilize the measurement result by increasing the "Sweep Time" .
Set the "Sweep Time" to 1 s.

The trace becomes much smoother because of the RMS detector and the channel
power measurement display is much more stable.

MultiView  Spectrum Sweep Timae

Ref Leve - 10s i

® [Rm Clre

ko A~ St o i o, Pl e i

CF 1.0 GHz 1001 pts 250.0 kHz/ Span 2.5 MHz

Offset Power

-90.84 dBm
-90.84 dBm

Figure 6-31: Measurement of the R&S FPS's intrinsic noise power in a 1.23 MHz channel band-
width.
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6.2.8 Optimizing and Troubleshooting the Measurement

If the results do not meet your expectations, or if you want to minimize the measure-
ment duration, try the following methods to optimize the measurement:

® Only activate as many adjacent channels as necessary to minimize the required
span and thus the required measurement time for the measurement.

® |Increase the RBW to minimize the measurement time; however, consider the
requirements of the standard if you need to measure according to standard! The
automatic settings are always according to standard.

® Reduce the "Sweep Time" and thus the amount of data to be captured and calcu-
lated; however, consider the requirements regarding the standard deviation.

® To improve the stability of the measured results, increase the "Sweep Time"
which also leads to more averaging steps.

® Instead of trace averaging, use an RMS detector with a higher "Sweep Time" to
obtain better average power results in less time.

® To determine a channel power level quickly, use the Time Domain Power Mea-
surement (TDP) rather than a Channel Power measurement. The TDP measure-
ment is a zero span measurement where the sweep time determines the measure-
ment time. Due to the FFT measurement, duplicate averaging is performed, provid-
ing very stable results very quickly.
Note, however, that for TDP measurements, channel filters are not available and a
fixed RBW is used. Thus, the measurement may not be according to standard for
some test cases.

6.2.9 Reference: Predefined CP/ACLR Standards

When using predefined standards for ACLR measurement, the test parameters for the
channel and adjacent-channel measurements are configured automatically.

You can select a predefined standard via the "CP / ACLR Standard" softkey in the "Ch
Power" menu or the selection list in the "General Settings" tab of the "ACLR Setup”
dialog box (see " Standard " on page 161).

Table 6-10: Predefined CP / ACLR standards with remote command parameters

Standard Remote parameter
None NONE
Multi-Standard Radio MSR

EUTRA/LTE Square EUTRa
EUTRA/LTE Square/RRC REUTra

W-CDMA 3GPP FWD FW3Gppcdma
W-CDMA 3GPP REV RW3Gppcdma
CDMA IS95A FWD F8CDma

CDMA IS95A REV R8CDma

CDMA IS95C Class 0 FWD*) F1S95c0
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Standard Remote parameter
CDMA IS95C Class 0 REV*) RIS95c0
CDMA J-STD008 FWD F19Cdma
CDMA J-STD008 REV R19Cdma
CDMA IS95C Class 1 FWD*) FIS95c1
CDMA IS95C Class 1 REV*) RIS95¢1
CDMA2000 S2CDma
TD-SCDMA FWD FTCDma
TD-SCDMA REV TRCDma
WLAN 802.11A AWLAN
WLAN 802.11B BWLAN
WIMAX WIMax
WIBRO WIBRo
GSM GSM
RFID 14443 RFID14443
TETRA TETRa
PDC PDC

PHS PHS
CDPD CDPD
APCO-25 P2 PAPCo25
User Standard USER
Customized Standard <string>

i

For the R&S FPS, the channel spacing is defined as the distance between the center
frequency of the adjacent channel and the center frequency of the transmission chan-
nel. The definition of the adjacent-channel spacing in standards IS95C and CDMA
2000 is different. These standards define the adjacent-channel spacing from the center
of the transmission channel to the closest border of the adjacent channel. This defini-
tion is also used by the R&S FPS for the standards marked with an asterisk *).

6.2.10

Reference: Predefined ACLR User Standard XML Files

In addition to the predefined standards, some user standards with specific measure-
ment settings for common ACLR measurements are provided in XML files on the
instrument in the C: \R_S\INSTR\acp std directory.

In particular, a sample file (MSR_ACLRExample.xml) is provided for an MSR ACLR
measurement. It sets up the measurement for the MSR signal generator waveform
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described in the file
C:\R_S\INSTR\USER\waveform\MSRA GSM WCDMA LTE GSM.wv.

Furthermore, the following XML files are provided:

LTE\DL

e |TE\DL\LTE_DL_5MHZ.XML
e LTE\DL\LTE_DL_10MHZ.XML
e |TE\DL\LTE_DL_15MHZ. XML
e LTE\DL\LTE_DL_20MHZ.XML

LTE\UL

e | TE\UL\LTE_UL_S5MHZ.XML
e LTEWUL\LTE_UL_10MHZ.XML
e | TE\UL\LTE_UL_15MHZ. XML
e LTE\WUL\LTE_UL_20MHZ.XML

WLAN

e \WLAN\802_11ac\802_11ac_20MHZ.XML
e \WLAN\802_11ac\802_11ac_40MHZ.XML
e \WLAN\802_11ac\802_11ac_80MHZ.XML
e WLAN\802_11ac\802_11ac_160MHZ.XML

To load a stored measurement configuration, in the "General Settings" tab of the
"ACLR Setup" dialog box, select the "Manage User Standards" button to display the
"Manage" dialog box. Select the user standard file, then "Load" .

The stored settings are automatically set on the R&S FPS and the measurement is
restarted with the new parameters.

For details, see Chapter 6.2.6.4, "How to Manage User-Defined Configurations",
on page 187.

6.3 Carrier-to-Noise Measurements

Measures the carrier-to-noise ratio. C/No measurements normalize the ratio to a 1 Hz

bandwidth.

®  ADOUL the MEASUIEMENT........ue et e e e e e e enaaas 194
0  Carrier-to-NOISE RESUILS.......coieeiie et e e 195
o Carrier-to-Noise Configuration............oocieiiiiiiiiii e 196
e How to Determine the Carrier-to-Noise Ratio........cooouueiiiieiiiieeeieiee e, 197

6.3.1 About the Measurement

The largest signal in the frequency span is the carrier. It is searched when the C/N or
C/Ng function is activated and is marked using a fixed reference marker ( "FXD" ).
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To determine the noise power, a channel with a defined bandwidth at the defined cen-
ter frequency is analyzed. The power within this channel is integrated to obtain the
noise power level. (If the carrier is within this channel, an extra step is required to
determine the correct noise power level, see below.)

The noise power of the channel is subtracted from the maximum carrier signal level,
and in the case of a C/Ny measurement, it is referred to a 1 Hz bandwidth.

The carrier-to-noise measurements are only available in the frequency domain (span
>0).

6 For this measurement, the RMS detector is activated.

Measurement process

Depending on whether the carrier is inside or outside the analyzed channel, the mea-
surement process for the carrier-to-noise ratio varies:

® The carrier is outside the analyzed channel: In this case, it is sufficient to switch on
the desired measurement function and to set the channel bandwidth. The carrier/
noise ratio is displayed on the screen.

® The carrier is inside the analyzed channel: In this case, the measurement must be
performed in two steps:

— First, perform the reference measurement by switching on either the C/N or the
C/Ny measurement and waiting for the end of the next measurement run. The
fixed reference marker is set to the maximum of the measured carrier signal.

— Then, switch off the carrier so that only the noise of the test setup is active in

the channel. The carrier-to-noise ratio is displayed after the subsequent mea-
surement has been completed.

Frequency Span

The frequency span should be set to approximately 4 times the channel bandwidth in
order to measure the carrier-to-noise ratio correctly. This setting is defined automati-
cally by the "Adjust Settings" function.

6.3.2 Carrier-to-Noise Results
As a result of the carrier-to-noise measurement the evaluated bandwidth and the cal-

culated C/N ratio are displayed in the result window. The fixed reference marker is indi-
cated in the diagram.
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6.3.3

@

MultiView  Spectrum

RefLevel (
Att
1C/N

SWT 2.1 ms VBW 2 Mode Auto FFT

v | !
Hz 0 nts 20.0 kHz/

F. Span 2
sult Summary

Bandwidth 14,000 kHz /N 89,44 dBc
3 Marker Table

Type  Ref Stimulus Function Function Result
C 200.0 MHz

200.0 MHz

TFe Response

-5.27 dBm
-5.28 dBm

Remote command:

You can also query the determined carrier-to-noise ratio via the remote command
CALC:MARK:FUNC:POW:RES? CN Or CALC:MARK:FUNC:POW:RES? CNO, see
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:RESult? on page 637.

Carrier-to-Noise Configuration

Access: "Overview" > "Select Measurement" > "C/N" / "C/NQO" > "Carrier Noise Config"

Both a carrier-to-noise ratio (C/N) and a carrier-to-noise ratio in relation to the band-
width (C/Ny) measurement are available.

(8
Channel Bandwidth |[EERINEYY SV

L

Adjust Settings

Carrier-to-noise measurements are not available in zero span mode.

The easiest way to configure a measurement is using the configuration "Overview" ,
see Chapter 7.1, "Configuration Overview", on page 300.

The remote commands required to perform these tasks are described in Chap-
ter 12.5.4, "Measuring the Carrier-to-Noise Ratio", on page 677.
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(071 VT TR TOTTRT 197
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C/N

Switches the measurement of the carrier/noise ratio on or off. If no marker is active,
marker 1 is activated.

The measurement is performed on the trace that marker 1 is assigned to. To shift
marker 1 and measure another trace, use the "Marker To Trace" softkey in the
"Marker" menu (see " Assigning the Marker to a Trace " on page 410).

Remote command:

CALCulate<n>:MARKer<m>:FUNCtion:POWer:SELect on page 639
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:RESult? on page 637
CALCulate<n>:MARKer<m>:FUNCtion:POWer [:STATe] on page 639

C/NO
Switches the measurement of the carrier/noise ratio with reference to a 1 Hz bandwidth
on or off. If no marker is active, marker 1 is activated.

The measurement is performed on the trace that marker 1 is assigned to. To shift
marker 1 and measure another trace, use the "Marker To Trace" softkey in the
"Marker" menu (see " Assigning the Marker to a Trace " on page 410).

Remote command:

CALCulate<n>:MARKer<m>:FUNCtion:POWer:SELect on page 639
CALCulate<n>:MARKer<m>:FUNCtion:POWer<sb>:RESult? on page 637
CALCulate<n>:MARKer<m>:FUNCtion:POWer [:STATe] on page 639

Channel Bandwidth
Defines the channel bandwidth.

The default setting is 14 kHz.

Remote command:
[SENSe: ] POWer:ACHannel : BANDwidth [ : CHANnel<ch>] on page 644

Adjust Settings
Enables the RMS detector and adjusts the span to the selected channel bandwidth
according to:

"4 x channel bandwidth + measurement margin"
The adjustment is performed once; if necessary, the setting can be changed later on.

Remote command:
[SENSe: ] POWer:ACHannel : PRESet on page 640

6.3.4 How to Determine the Carrier-to-Noise Ratio

The following step-by-step instructions demonstrate how to determine the carrier-to-
noise ratio.
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For remote operation, see "Programming example: Measuring the carrier-to-noise
ratio" on page 677.

6.4

6.4.1

1. Press the "C/N", "C/NO" softkey to configure the carrier-to-noise ratio measure-
ment.

2. To change the channel bandwidth to be analyzed, press the "Channel Bandwidth"
softkey.

3. To optimize the settings for the selected channel configuration, press the "Adjust
Settings" softkey.

4. To activate the measurements without reference to the bandwidth, press the "C/N"
softkey.
To activate the measurements with reference to the bandwidth, press the "C/N,"
softkey .

5. If the carrier signal is located within the analyzed channel bandwidth, switch off the
carrier signal so that only the noise is displayed in the channel and perform a sec-
ond measurement.

The carrier-to-noise ratio is displayed after the measurement has been completed.

Occupied Bandwidth Measurement (OBW)

An important characteristic of a modulated signal is its occupied bandwidth, that is: the
bandwidth which must contain a defined percentage of the power. In a radio communi-
cations system, for instance, the occupied bandwidth must be limited to enable distor-
tion-free transmission in adjacent channels.

o About the MeasuremMeNnt... ... 198
®  OBW RESUIS....eiiiiiiiiiiie ittt ettt e e e e et e e e e et ee e e s e nrae e e e e eaneeas 200
@  OBW CoNfigUration..........coieiccciiiiiiiiiee e ettt e e e e e e e e e s ssrnree e e e e e e e e e e e e e snnnnnes 201
e How to Determine the Occupied Bandwidth............ccceveeeeieiiiiiiiiiccieeeeee e 203
o Measurement EXample........cooo oo 204

About the Measurement

The occupied bandwidth is defined as the bandwidth containing a defined percentage
of the total transmitted power. A percentage between 10 % and 99.9 % can be set.

Measurement principle

The bandwidth containing 99% of the signal power is to be determined, for example.
The algorithm first calculates the total power of all displayed points of the trace. In the
next step, the points from the right edge of the trace are summed up until 0.5 % of the
total power is reached. Auxiliary marker 1 is positioned at the corresponding frequency.
Then the points from the left edge of the trace are summed up until 0.5 % of the power
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is reached. Auxiliary marker 2 is positioned at this point. 99 % of the power is now
between the two markers. The distance between the two frequency markers is the
occupied bandwidth which is displayed in the marker field.

OBW within defined search limits - multicarrier OBW measurement in one sweep

The occupied bandwidth of the signal can also be determined within defined search
limits instead of for the entire signal. Thus, only a single sweep is required to determine
the OBW for a multicarrier signal. To do so, search limits are defined for an individual
carrier and the OBW measurement is restricted to the frequency range contained
within those limits. Then the search limits are adapted for the next carrier and the OBW
is automatically recalculated for the new range.
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For step-by-step instructions, see "How to determine the OBW for a multicarrier signal
using search limits" on page 203.

Prerequisites

To ensure correct power measurement, especially for noise signals, and to obtain the
correct occupied bandwidth, the following prerequisites and settings are necessary:

® Only the signal to be measured is displayed in the window, or search limits are
defined to include only one (carrier) signal. An additional signal would falsify the
measurement.

® RBW << occupied bandwidth (approx. 1/20 of occupied bandwidth, for voice com-
munication type: 300 Hz or 1 kHz)

e VBW =3 xRBW
® RMS detector
® Span =2 to 3 x occupied bandwidth

|
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Some of the measurement specifications (e.g. PDC, RCR STD-27B) require measure-
ment of the occupied bandwidth using a peak detector. The detector setting of the
R&S FPS has to be changed accordingly then.

6.4.2 OBW Results

As a result of the OBW measurement the occupied bandwidth ( "Occ Bw" ) is indicated
in the marker results. Furthermore, the marker at the center frequency and the tempo-
rary markers are indicated.

The measurement is performed on the trace with marker 1. In order to evaluate
another trace, marker 1 must be placed on another trace (see Assigning the Marker to
a Trace).

The OBW calculation is repeated if the Search Limits are changed, without performing
a new sweep. Thus, the OBW for a multicarrier signal can be determined using only
one sweep.

Centroid frequency

The centroid frequency is defined as the point in the center of the occupied bandwidth,
calculated using the temporary OBW markers T1 and T2. This frequency is indicated
as a function result ( "Occ Bw Centroid" ) in the marker table.

Frequency offset

The offset of the calculated centroid frequency to the defined center frequency of the
R&S FPS is indicated as a function result ( "Occ Bw Freq Offset" ) in the marker table.

MultiView =2 Spectrum
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|
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Occupied Bandwidth Measurement (OBW)

Remote command:

The determined occupied bandwidth can also be queried using the remote command
CALC:MARK:FUNC:POW:RES? OBW Or CALC:MARK:FUNC:POW:RES? AOBW. While
the oBW parameter returns only the occupied bandwidth, the AOBW parameter also
returns the position and level of the temporary markers T1 and T2 used to calculate the
occupied bandwidth.

CALC:MARK:FUNC:POW:SEL OBW, see CALCulate<n>:MARKer<m>:FUNCtion:
POWer:SELect on page 639

CALCulate<n>:MARKer<m>:FUNCtion:POWer [:STATe] on page 639

CALC:MARK:FUNC:POW:RES? OBW, see CALCulate<n>:MARKer<m>:FUNCtion:
POWer<sb>:RESult? on page 637

CALC:MARK:FUNC:POW:RES? COBW, see CALCulate<n>:MARKer<m>:FUNCtion:
POWer<sb>:RESult? on page 637

OBW Configuration

Access: "Overview" > "Select Measurement" > "OBW" > "OBW Config"

tings

o0 Power Bandwidth [99.0 Oin ]
Channel Bandwidth l 14.0 kHz |

Adjust Settings

rch Limits

Left Limit [U.U Hz ]
Right Limit |26.5 GHz |
Search Limits Off

This measurement is not available in zero span.

i

Configuring search limits for OBW measurement

The OBW measurement uses the same search limits as defined for marker search
(see " Search Limits " on page 415). However, only the left and right limits are consid-
ered.
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The remote commands required to perform these tasks are described in Chap-
ter 12.5.5, "Measuring the Occupied Bandwidth", on page 678.

Y% Power BandWidth ...........ueiiiiiiiiiiei e e e e e e e e e eeaees 202
Channel BandWidth ......... e e e e e e ————— 202
AJUST SEEHINGS ..t 202
Search Limits ( Left / RIGht ). 202
Deactivating All S€arch LimitS .....ceieieeiiiiiicciiiiiieee e e e 203

% Power Bandwidth
Defines the percentage of total power in the displayed frequency range which defines
the occupied bandwidth. Values from 10 % to 99.9 % are allowed.

Remote command:
[SENSe: ] POWer:BANDwidth on page 679

Channel Bandwidth

Defines the channel bandwidth for the transmission channel in single-carrier measure-
ments. This bandwidth is used to optimize the test parameters (for details see " Adjust
Settings " on page 202). The default setting is 14 kHz.

For measurements according to a specific transmission standard, define the bandwidth
specified by the standard for the transmission channel.

For multicarrier measurements, this setting is irrelevant.

Remote command:
[SENSe: ] POWer:ACHannel : BANDwidth [ :CHANnel<ch>] on page 644

Adjust Settings
Optimizes the instrument settings for the measurement of the occupied bandwidth
according to the specified channel bandwidth.

This function is only useful for single carrier measurements.

All instrument settings relevant for power measurement within a specific frequency
range are optimized:

® Frequency span: 3 x channel bandwidth

® RBW < 1/40 of channel bandwidth

e VBW =3 x RBW

® Detector: RMS

The reference level is not affected by "Adjust Settings" . For an optimum dynamic
range,select the reference level such that the signal maximum is close to the reference
level.

(See " Setting the Reference Level Automatically ( Auto Level )" on page 356).

The adjustment is carried out only once. If necessary, the instrument settings can be
changed later.

Remote command:
[SENSe: ] POWer:ACHannel : PRESet on page 640

Search Limits ( Left / Right )

If activated, limit lines are defined and displayed for the search. Only results within the
limited search range are considered.
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For details on limit lines for searches, see "Peak search limits" on page 434.

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 870
CALCulate<n>:MARKer<m>:X:SLIMits:LEFT on page 871
CALCulate<n>:MARKer<m>:X:SLIMits:RIGHt on page 871

Deactivating All Search Limits
Deactivates the search range limits.

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 870
CALCulate<n>:THReshold:STATe on page 873

How to Determine the Occupied Bandwidth

The following step-by-step instructions demonstrate how to determine the occupied
bandwidth.

For remote operation, see Chapter 12.5.5.2, "Programming Example: OBW Measure-
ment", on page 679.

How to determine the OBW for a single signal
1. Press the MEAS key or select "Select Measurement" in the "Overview" .

2. Select the "OBW" measurement function.

The measurement is started immediately with the default settings.

3. Select the "OBW Config" softkey.
The "Occupied Bandwidth" configuration dialog box is displayed.

4. Define the percentage of power ( "% Power Bandwidth" ) that defines the band-
width to be determined.

5. If necessary, change the channel bandwidth for the transmission channel.

6. To optimize the settings for the selected channel configuration, select "Adjust Set-
tings" .

7. Start a sweep.

The result is displayed as OBW in the marker results.

How to determine the OBW for a multicarrier signal using search limits
1. Press the MEAS key or select "Select Measurement" in the "Overview" .
2. Select the "OBW" measurement function.

3. Select the "OBW Config" softkey.



6.4.5

Occupied Bandwidth Measurement (OBW)

Define the percentage of power ( "% Power Bandwidth" ) that defines the band-
width to be determined.

Define search limits so the search area contains only the first carrier signal:

a) Enter values for the left or right limits, or both.
b) Enable the use of the required limits.

Start a sweep.
The result for the first carrier is displayed as OBW in the marker results.

Change the search limits so the search area contains the next carrier signal as
described in step 5.

The OBW is recalculated and the result for the next carrier is displayed. A new
sweep is not necessary!

Continue in this way until all carriers have been measured.

Measurement Example

In the following example, the bandwidth that occupies 99 % of the total power of a PDC
signal at 800 MHz, level 0 dBm is measured.

A programming example demonstrating an OBW measurement in a remote environ-
ment is provided in Chapter 12.5.6.11, "Example: SEM Measurement", on page 712.

—_

© ® N o o ~ w0 DN

Preset the R&S FPS.

Set the "Center Frequency" to 800 MHz.

Set the "Reference Level" to -10 dBm.

Press the MEAS key or select "Select Measurement” in the "Overview" .
Select the "OBW" measurement function.

Select the "OBW Config" softkey.

Set the "% Power Bandwidth" to 99 %.

Set the "Channel Bandwidth" to 27 kHz as specified by the PDC standard.

Optimize the settings for the selected channel configuration by selecting "Adjust
Settings" .

10. Adjust the reference level to the measured total power by selecting "Auto Level" in

11.

the AUTO SET menu.

The PDC standard requires the peak detector for OBW measurement. In the
"Traces" configuration dialog, set the trace detector to "PositivePeak" .
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6.5.1

6.5.2

Spectrum Emission Mask (SEM) Measurement

12. Start a sweep.

The result is displayed as OBW in the marker results.

Spectrum Emission Mask (SEM) Measurement

Spectrum Emission Mask (SEM) measurements monitor compliance with a spectral
mask.

o About the Measurement..... ..o 205
o  Typical APPlICAtIONS. ... .o a e 205
@ SEM RESUIS...ciiiiiiiie ittt et e s e s s eraaa e e e e snaae e e e snanraeeaean 206
L IS 1 I = 2 T o SR 209
@  SEM Configuration.......c..uuueieiiiieii it e e e e e e e e e e e e e e 219
e How to Perform a Spectrum Emission Mask Measurement..............cccccvvvvveeennnn. 235
e Measurement Example: Multi-SEM Measurement............ccccceeeeeeeeeeeeccccnnvvveeennnn. 240
e Reference: SEM File DeSCriptionS.........cuuviuiiiiiiiciiiiiie e 241

About the Measurement

The Spectrum Emission Mask (SEM) measurement defines a measurement that moni-
tors compliance with a spectral mask. The mask is defined with reference to the input
signal power. The R&S FPS allows for a flexible definition of all parameters in the SEM
measurement. The analyzer performs measurements in predefined frequency ranges
with settings that can be specified individually for each of these ranges.

In the basic Spectrum application, spectrum emissions can be measured for multiple
sub blocks of channels, where the sub blocks can include gaps or overlap, and define
separate masks. Radio signals using multiple standards can also be analyzed.

SEM measurement configurations can be saved to an XML file which can then be
exported to another application or loaded on the R&S FPS again later. Some prede-
fined XML files are provided that contain ranges and parameters according to the
selected standard.

To improve the performance of the R&S FPS for spectrum emission mask measure-
ments, a "Fast SEM" mode is available.

A special limit check for SEM measurements allows for monitoring compliance of the
spectrum.

Typical Applications

Spectrum Emission Mask measurements are typically performed to ensure that modu-
lated signals remain within the valid signal level ranges. These ranges are defined by a
particular transmission standard, both in the transmission channel and neighboring
channels. Any violations of the mask can interfere with other transmissions.
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The 3GPP TS 34.122 standard, for example, defines a mask for emissions outside the
transmission channel. This mask is defined relative to the input signal power. Three
frequency ranges to each side of the transmission channel are defined.

6.5.3 SEM Results

As a result of the Spectrum Emission Mask measurement, the following results are dis-
played in a diagram (see also Chapter 6.5.4.2, "Limit Lines in SEM Measurements",

on page 211):

® The measured signal levels

® The result of the limit check (mask monitoring)

® The defined limit lines

® TX channel power "P"

® The used power class

Multi-SEM measurements
Multi-SEM measurements are SEM measurements with more than one sub block. In

these measurements, each sub block has its own power class definitions. In this case,
the power class is not indicated in the graphical result displays.

Example:

For example, in Figure 6-32, "31 < P < 39" is indicated as the used power class is
defined from 31 to 39.

MultiView  Spectrum

1 Spectrum Emission Mask

”.‘||'|I.-""r'“l“ o s b o ""‘Jl'll'-'h "

)
|
!

B P A A

2.1 GHz s 2.55 MHz/

esult Summary
. RBW 1.000 MHz

Fre Power Abs Power Rel ALimit
2.09153 GHz =39.37 dBm -73.11 dB
2.09494 GHz -39.75 dBm -73.48 dB
2.09642 GHz -50.91 dBm -84.65 dB
2.09652 GHz -51.84 dBm -85.57 dB
2.09739 GHz -52.33 dBm -86.07 dB
2.10259 GHz -49.37 dBm -83.11 dB
2.10342 GHz -50.68 dBm -84.42 dB
2.10373 GHz -51.81 dBm -85.55 dB
2.10439 GHz -38.64 dBm =-72.37 dB
2.11026 GHz -39.24 dBm -72.97 dB

Figure 6-32: Spectrum Emission Mask result displays
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In addition to the graphical results of the SEM measurement displayed in the diagram,
a result summary is displayed to evaluate the limit check results (see also Chap-
ter 6.5.4.2, "Limit Lines in SEM Measurements", on page 211).

The following information is provided in the result summary:

Label

Description

General information

"Standard"

Loaded standard settings

"Tx Power"

Power of the reference range

"Tx Bandwidth"

Tx bandwidth used by the reference range

"RBW"

RBW used by the reference range

Range results

"Range Low" Start of the frequency range the peak value was found in
"Range Up" Frequency range end the peak value was found in

"RBW" RBW of the range

"Frequency" Frequency of the peak power level

"Power Abs" Absolute peak power level within the range

"Power Rel" Peak power level within the range, relative to the "Tx Power"
"ALimit" Deviation of the peak power level from the limit line

You can define in which detail the data is displayed in the result summary in the "List
Evaluation" settings (see Chapter 6.5.5.7, "List Evaluation (Results Configuration)",
on page 234). By default, one peak per range is displayed. However, you can change
the settings to display only peaks that exceed a threshold ( "Margin" ).

Detected peaks are not only listed in the Result Summary, they are also indicated by
blue squares in the diagram (optionally, see Show Peaks in the "List Evaluation" set-

tings).
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1 Spectrum Emission Mask

ety

1
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1001 pts

CF 2.1 GHz Span 25.5 MHz

Figure 6-33: Detected peak display in SEM measurement

Furthermore, you can export the results of the result summary to a file which can be
exported to another application for further analysis.

Results for SEM with multiple sub blocks

In the Spectrum application only, spectrum emissions can be measured for multiple
sub blocks of channels (see Chapter 6.5.4.5, "SEM with Multiple Sub Blocks ("Multi-
SEM")", on page 215 for details). Up to three sub blocks (with two gaps) can be
defined. For each sub block and each gap, the results described above are provided

individually in the result summary.

1 Spectrum Emission Mask
PASS

b
M
’
i
1 f
|
Uikl
3001 pts
2 Result Summary
Sub Block A

Center 900.00 MHz

AT g

v

Tx Power

Tx Bandwidth
Frequency

894.16808 MHz

896.14890 MHz

896.65096 MHz

897.39370 MHz

Frequency
902.70196 MHz
902.92839 MHz
903.33976 MHz
903.59774 MHz
903.81543 MHz

Tx Power
Tx Bandwidth

Frequency
909.06283 MHz
909.34691 MHz
910.02776 MHz
911.94088 MHz

II'I'II|‘I'J{‘|'“1 I

o 1Rm Clrw
T ]
i

2.55 MHz/

23.51 dBm
3,840 MHz
Power Abs
-34.44 dBm
-47.37 dBm
-49.41 dBm
-50,91 dBm

RBW 30.000 kHz
MNone
ALimit
-22.94 dB
-22.87 dB
-27.40 dB
-38.41 dB

Power Rel
-57.95 dB
-70.88 dB
-72.92 dB
-74.42 dB

Power Abs
-50.62 dBm
=50.31 dBm
-23.52 dBm
-20.99 dBm
=20.35 dBm

23.03 dBm
3,840 MHz

Power Abs
-15.51 dBm
-19.93 dBm
-49.22 dBm
-33.58 dBm

Power Rel ALimit
-74.13 dB
-73.82 dB
-47.03 dB
-44.,50 dB
-43.86 dB
RBW

Power Rel
-38.54 dB
-42.96 dB
-72.25 dB
-56.61 dB

-22.08 dB

Figure 6-34: SEM results for multiple sub blocks

|
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Retrieving results via remote control

The measurement results of the spectrum emission mask fest can be retrieved using
the CALC:LIM: FAIL? command from a remote computer; see CALCulate<n>:
LIMit<k>:FATL? on page 932 for a detailed description.

The power result for the reference range can be queried using
CALC:MARK:FUNC:POW:RES? CPOW,

The peak power for the reference range can be queried using
CALC:MARK:FUNC:POW:RES? PPOW, see CALCulate<n>:MARKer<m>:FUNCtion:
POWer<sb>:RESult? on page 637.

The measured power frace can be queried using TRAC: DATA? and TRAC : DATA: X?,
see TRACe<n>[:DATA] on page 854 and TRACe<n>[:DATA] : X? on page 856:

The measured peak power list can be queried using TRAC:DATA? LIST, see
TRACe<n>[:DATA] on page 854.

6.5.4 SEM Basics

Some background knowledge on basic terms and principles used in SEM measure-
ments is provided here for a better understanding of the required configuration set-

tings.

e Ranges and Range SettingsS.......ocuiiiiiiiiiiii e 209
o Limit Lines in SEM MeasuremMeNntS..........uciiiiiuiieiiiiiiiee e 21
®  Fast SEM MeEaSUIrEMENTS......cuiiiiuuiiiie ittt e s s e e e 213
e Multi-Standard Radio (MSR) SEM Measurements..........ccceevcveeeeeiiiieeeesisieeneenns 215
e SEM with Multiple Sub Blocks ("MUlti-SEM")........ccoioiiiiiiieeee e 215

6.5.4.1 Ranges and Range Settings

In the Spectrum Emission Mask measurements, a range defines a segment for which
you can define the following parameters separately:
e Start and stop frequency

° RBW

° VBW

® "Sweep Time"

® "Sweep Points"

® Reference level

® Attenuator settings

® Preamplifier settings

® Transducer settings

® Limit values

Via the sweep list, you define the ranges and their settings. For details on settings,
refer to Chapter 6.5.5.1, " Sweep List ", on page 220.
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For details on defining the limits (masks), see Chapter 6.5.4.2, "Limit Lines in SEM
Measurements", on page 211.

For details on defining the limits (masks), see the base unit description "Working with
Lines in SEM".

Range definition

After a preset, the sweep list contains a set of default ranges and parameters. For
each range, you can change the parameters listed above. You can insert or delete
ranges.

The changes of the sweep list are only kept until you load another parameter set (by
pressing PRESET or by loading an XML file). If you want a parameter set to be availa-
ble permanently, create an XML file for this configuration (for details refer to "How to
save a user-defined SEM settings file" on page 239).

If you load one of the provided XML files, the sweep list contains ranges and parame-
ters according to the selected standard.

Reference range

The range containing the center frequency is defined as the reference range for all
other ranges in the sweep list. All range limits are defined in relation to the reference
range. The TX power used as a reference for all power level results in the result sum-
mary is also calculated for this reference range. You can define whether the power
used for reference is the peak power level or the integrated power of the reference
range. In the "Sweep List" , the reference range is highlighted in blue and cannot be
deleted.

Rules

The following rules apply to ranges:

® The minimum span of a range is 20 Hz.

® The individual ranges must not overlap (but can have gaps).
® The maximum number of ranges is 30.

® The minimum number of ranges is 3.

® The reference range cannot be deleted.

® Center the reference range on the center frequency.

® The current "Tx Bandwidth" defines the minimum span of the reference range (see
" Channel Power Settings " on page 227).

® Define frequency values for each range relative to the center frequency.

To change the start frequency of the first range or the stop frequency of the last range,
select the appropriate span with the SPAN key. You can define a span that is smaller
than the combined span of all ranges. In this case, the measurement includes only the
ranges that lie within the defined span and have a minimum span of 20 Hz. The first
and last ranges are adapted to the given span as long as the minimum span of 20 Hz
is not violated.
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6.5.4.2

Sweep points

You can define a minimum number of sweep points for each range. The total number
of available sweep points is then distributed among the ranges in consideration of the
minimum values. If the total number of sweep points is not enough to satisfy the mini-
mum sweep point requirements in all ranges, the R&S FPS adjusts the global number
of Sweep Points accordingly. By default, each range has a minimum of one sweep
point.

This allows you to increase the resolution within a specific range for detailed analysis.
You do not have to increase the overall number of sweep points and thus the measure-
ment time for the SEM measurement.

Symmetrical ranges

You can easily define a sweep list with symmetrical range settings, i.e. the ranges to
the left and right of the reference range are defined symmetrically. When symmetrical
setup is activated, the current sweep list configuration is changed to define a symmetri-
cal setup regarding the reference range. The number of ranges to the left of the refer-
ence range is reflected to the right, i.e. any missing ranges on the right are inserted,
while superfluous ranges are removed. The values in the ranges to the right of the ref-
erence range are adapted symmetrically to those in the left ranges.

Symmetrical ranges fulfill the conditions required for "Fast SEM" mode (see Chap-
ter 6.5.4.3, "Fast SEM Measurements", on page 213).

Power classes

If the signal power level to be monitored varies and the limits vary accordingly, you can
define power classes, which can then be assigned to the frequency ranges. Thus, the
limits for the signal levels can be defined differently for varying input levels. For
instance, for higher input levels a transmission standard can allow for higher power lev-
els in adjacent channels, whereas for lower input levels the allowed deviation can be
stricter. Up to four different power classes can be defined.

Limit Lines in SEM Measurements

For the R&S FPS, the spectrum emission mask is defined using limit lines. Limit lines
allow you to check the measured data (that is, the trace results) against specified limit
values. Generally, it is possible to define limit lines for any measurement in the Spec-
trum application application using the LINES function. For SEM measurements, how-
ever, special limit lines are available via the "Sweep List" , and it is strongly recommen-
ded that you use only these limit line definitions.

In the "Sweep List" , you can define a limit line for each power class that varies its level
according to the specified frequency ranges. Special limit lines are automatically
defined for each power class according to the current "Sweep List" settings every time
the settings change. These limit lines are labeled "_SEM_LINE_<xxx>_ABS<0...3>"
and "_SEM_LINE_<xxx> REL<0...3>", where <xxx> is an index to distinguish limit
lines between different channels.

The limit line defined for the currently used power class is indicated by a red line in the
display. The result of the limit check is indicated at the top of the diagram. Note that

HE
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only "Pass" or "Fail" is indicated; a "Margin" function as for general limit lines is not

available.

MultiView
Ref Level 41.00 dBm

1 Spectrum Emission Mask

2.1 GHz

esult Summary
I wer

Spectrum

Offset 40.0

A
Ju

T« Bandwidth 3.840 MHz
Frequency
2.09053 GHz
2.09268 GHz
2.09647 GHz
2.09652 GHz
2.09728 GHz
2.10270 GHz

2.10355 GHz
2,10725 GHz
2.10911 GHz

= 1Rm Clrw

RBW 1.000 MHz

Power Rel ALimit

=71.22 dB -17.18 dB
-70.67 dB -20.63 dB
-83.14 dB -20.10 dB
-84.84 dB -22.38 dB
-82.05 dB -31.01 dB
-84.67 dB -33.63 dB

Power Abs

=-40.68 dBm
-40.13 dBm
=-52.60 dBm
=-54.30 dBm
-51.51 dBm
-54.13 dBm

-51.94 dBm
=40.01 dBm
-40.28 dBm

-82.48 dB
-70.55 dB
-70.82 dB

-19.44 dB
-20.51 dB
-16.78 dB

The indicated limit line depends on the settings in the "Sweep List" . Several types of
limit checks are possible:

Table 6-11: Limit check types

Limit check type

Pass/fail criteria

Limit line definition

"Absolute"

Absolute power levels must not
exceed limit line

Defined by the "Abs Limit Start" / "Abs Limit
Stop" values for each range

"Relative"

Power deviations relative to the TX
channel power must not exceed limit
line

Defined by the "Rel Limit Start" / "Rel Limit
Stop" values (relative to the TX channel
power), fixed for each range.

"Relative with
function f(x)"

If the power exceeds both the abso-
lute and the relative limits, the check
fails (see Relative limit line functions
below)

Defined by the maximum of the absolute or
relative start and stop limit values for each
range. Thus, the start or stop point of the limit
range, or both, are variable (since the maxi-
mum can vary).

"Abs and Rel"

If the power exceeds both the abso-
lute and the relative limits, the check
fails.

The less strict (higher) limit line is displayed
for each range.

If you use a function to define the relative limit
start or stop value, the signal is checked
against an additional condition: the power
must exceed the absolute limit, as well as the
absolute and relative function values.

"Abs or Rel"

If the power exceeds either the
absolute or the relative limits, the
check fails.

The stricter (lower) limit line is displayed for
each range.

If you use a function to define the relative limit
start or stop value, the signal is checked
against an additional condition: if the power
exceeds the absolute limit, or the higher of the
absolute and relative function values, the
check fails.
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Relative limit line functions

A new function allows you to define limit lines whose start or end points (or both) are
variable, depending on the carrier power. Thus, the resulting limit line can change its
slope within the range, depending on the carrier power. Common relative limit lines are
calculated once for the defined start and end points and maintain a constant slope.

If the relative limit value function is used in combination with the "Abs and Rel" or "Abs
or Rel" limit check types, an additional condition is considered for the limit check (see
Table 6-11).

Limit check results in the result summary

For each range, the peak measured value and the deviation of these values from the
limit line are displayed in the result summary. If the limit check is passed for the range,
the deviation represents the closest value to the limit line. If the limit check is passed
for the range, the deviation represents the closest value to the limit line. If the limit
check for the range fails, the deviation represents the maximum violation against the
limit line. Furthermore, the absolute power levels and the relative deviation of the
peaks from the TX channel power are displayed. Values that exceed the limit are indi-
cated in red and by an asterisk (*).

Although a margin functionality is not available for the limit check, a margin (threshold)
for the peak values to be displayed in the Result Summary can be defined. (In the "List
Evaluation" settings, see Chapter 6.5.5.7, "List Evaluation (Results Configuration)”,

on page 234).

6.5.4.3

Fast SEM Measurements

To improve the performance of the R&S FPS for spectrum emission mask measure-
ments, a "Fast SEM" mode is available. If this mode is activated, several consecutive
ranges with identical sweep settings are combined to one sweep internally, which
makes the measurement considerably faster. The displayed results remain unchanged
and still consist of several ranges. Thus, measurement settings that apply only to the
results, such as limits, can nevertheless be defined individually for each range.

Prerequisites

"Fast SEM" mode is available if the following criteria apply:
® The frequency ranges are consecutive, without frequency gaps
® The following sweep settings are identical (for details see Chapter 6.5.5.1, " Sweep
List ", on page 220):
"Filter Type"
"RBW"
"vBW"

HE
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— "Sweep Time Mode"

— "Reference Level"

— "RF Attenuation Mode"
— "RF Attenuation"

— "Preamplifier”

Activating Fast SEM mode

"Fast SEM" mode is activated in the sweep list (see Chapter 6.5.5.1, " Sweep List ",
on page 220) or using a remote command. Activating the mode for one range auto-
matically activates it for all ranges in the sweep list.

Remote command:

[SENSe:]ESPectrum<sb>:HighSPeed on page 684

6 Fast SEM not supported for multiple sub blocks

For SEM with multiple sub blocks, fast SEM is not available. If more than one sub
block is defined and a standard is loaded which contains an active fast SEM setting,
this setting is disabled.

For more information on multi-SEM measurements, see Chapter 6.5.4.5, "SEM with
Multiple Sub Blocks ("Multi-SEM")", on page 215.

Consequences

When the "Fast SEM" mode is activated, the ranges for which these criteria apply are
displayed as one single range. The sweep time is defined as the sum of the individual
sweep times, initially, but can be changed.

If "Symmetrical Setup" mode is active when "Fast SEM" mode is activated, not all
sweep list settings can be configured symmetrically automatically (see also " Symmet-
rical Setup " on page 225).

Any other changes to the sweep settings of the combined range are applied to each
included range and remain changed even after deactivating "Fast SEM" mode.
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Example

Range 1 | Range
-18.25 GHz -12.75 MH.

-12.75 MHz -2.515 MH

on on

Normal{3...
3 MHz

3 MHz

27.5ms
0 dBm == 0 dBm

Auto - Auto
RF Attenuator 10 dB 10 dB8

Transducer { None None None MNone None

Limit Check 1 | Relative Relative Relative Relative Relative
Abs Limit Start 1 13 dBm 13 dBm 13 dBm 13 dBm 13 dém
Abs Limit Stop 1 | 13 dBm 13 dBm 13 dBém 13 dBm 13 dBm

Rel Limit Start 1 | -50 dBc -50 dBc 300 dBC =50 dBc -50 dBc

Rel Limit Stop 1 -50 dBe -50 dBc  [EELLRE -50 dBe -50 dbe

Symetrical Setup

Figure 6-35: Sweep list using Fast SEM mode

In Figure 6-35, a sweep list is shown for which Fast SEM is activated. The formerly five
separately defined ranges are combined to two sweep ranges internally.

6.5.4.4 Multi-Standard Radio (MSR) SEM Measurements

Multi-standard radio (MSR) measurements allow you to perform SEM tests on signals
with multiple carriers using different digital standards. MSR measurements are descri-
bed in the specification 3GPP TS 37.141. Various typical combinations of standards for
base station tests are described, e.g. LTE FDD and W-CDMA carriers. By performing
an MSR SEM measurement you can determine if or how the different carriers affect
each other, i.e. if unwanted emissions occur. On the R&S FPS, the MSR SEM mea-
surement is a standard measurement as for single carriers. The MSR settings merely
provide a convenient way of configuring the sweep list for all required ranges according
to the specification quickly.

Refined settings allow the R&S FPS to calculate the SEM limits according to standard
3GPP 37.141 V12.2.0, which distinguishes between base station configurations and
power values.

6.5.4.5 SEM with Multiple Sub Blocks ("Multi-SEM")

In the Spectrum application application only, spectrum emissions can be measured for
multiple sub blocks of channels (also referred to as a "Multi-SEM" measurement). Sub
blocks are a set of multiple ranges around a defined center frequency (carrier). Multiple
sub blocks can include gaps or overlap, and each sub block defines a separate mask.
In the overlapping masks, multi-limit lines are calculated. Up to three sub blocks (with
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two gaps) can be defined. For each sub block, the familiar configuration settings con-
cerning ranges, limit lines etc. can be defined individually.

Comparison to "traditional” SEM measurement

The default SEM measurement is simply a special case of "Multi-SEM" - consisting of
one single block. Only if the number of sub blocks in the basic SEM configuration is
larger than 1, multiple sub blocks are inserted in the configuration settings and result
tables.

Particular features of configuring multiple sub blocks

The sub blocks are independent of the global start, stop, center and span frequencies
for the complete SEM measurement. Thus, there can be gaps that can even include
other carrier ranges, but are not configured for the SEM measurement.

For each sub block, you define:

® The center frequency of the reference range of the sub block; center frequencies
must be defined in ascending order for sub blocks A,B,C

® The reference range; note that although individual ranges of different sub blocks
can overlap, reference ranges for different sub blocks cannot; they must define dis-
tinct frequency ranges

® The sweep list, including the limit lines

® Optionally: a standard file or MSR settings to be used for measurement (if one is
selected, the other is disabled)

For SEM with multiple sub blocks, fast SEM is not available. If more than one sub
block is defined and a standard is loaded which contains an active fast SEM setting,
this setting is disabled.

@ Fast SEM not supported for multiple sub blocks

Absolute vs relative frequencies

In the default configuration with only one sub block, frequencies are defined relative to
the center frequency; this is the familiar configuration.

For setups with more than one sub block, frequencies are defined relative to the center
frequency of the reference ranges for the individual sub blocks. However, in the result
summary, frequencies are indicated as absolute values. Relative frequencies that refer
to different reference ranges would be inconvenient and difficult to analyze.

Limit check behavior for overlapping masks

Since spectrum emission masks are defined individually for each sub block, and sub
blocks can overlap, the question arises what happens during the limit check in the
overlapping regions? To answer this question, we must distinguish the following cases:

® For the reference range, no limit checking is performed, as the reference range
contains the carrier

® For other ranges, only the limit lines defined for ranges between the carriers, that is
the reference ranges to either side, are significant. In other words: if a limit line def-
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inition covers the frequency area of several carriers, only the limit lines for ranges
between the corresponding reference range and the next closest reference range
are significant.

ignificant

51' g-‘ \:'I.EI'I.C-
ant

Figure 6-36: Behavior for overlapping masks

® For the ranges in which multiple limit lines are significant, a range-specific function
determines the behavior of the limit check

Limit calculation for individual ranges
For each range a function can be defined that determines the behavior of the limit
check if there are multiple limit lines:

® "NONE" : In reference ranges no limit check is performed;
Reference ranges always use the function "NONE" .
For other ranges, see the combinations for overlapping ranges below.

e "SUM" : sum of the two limit lines (calculated for linear powers) is used
e "MAX" : maximum of the two limit lines is used

This leads to the following combinations for overlapping ranges:

e "MAX" + "MAX" : maximum of the two limit lines is used

e "MAX" + "SUM" : maximum of the two limit lines is used

e "SUM" + "SUM" : sum of the two limit lines (calculated for linear powers) is used

® "NONE" + "MAX" / "NONE" + "SUM" : limit line (and parameters) of the "NONE"
range are ignored

e "NONE" + "NONE" : depends on the position of the overlapping ranges in relation
to the mid-frequency between the two neighboring sub blocks:

— Overlap is completely below the mid-frequency: limits and parameters of the
left sub block are used

— Overlap is completely above the mid-frequency: limits and parameters of the
right sub block are used

— Overlap crosses the mid-frequency: new subranges are created: one to the left
of the mid-frequency, one to the right of the mid-frequency. The left subrange
uses the limits and parameters of the left sub block, the right subrange uses
the limits and parameters of the right sub block.
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6 Different RBWs in overlapping ranges

If different RBWs are defined for the overlapping ranges, the following parameters from
the range with the smaller RBW are considered for both ranges:

e RBW

° VBW

® Attenuation

® Reference level

® Transducer

® Filter type

® (proportional) sweep time

In the range with the higher RBW, the following offset is applied to the limit line:
-10"109(RBWarge / RBW;mar)

Table 6-12: Limit lines in overlapping ranges crossing the mid-frequency

Mid-frequency Mid-frequency
Sub . 5B1-SB2  Sub . SB1-5B2  Sub
block 1 iblock 2 iblock 2
! i S
TX1 TX2 TX1 TX2

\\\E

e

Initial situation: overlapping ranges Result: Subranges 4a and 5a are created left and right of the
mid-frequency;

0
.

Range 4 ("None") + Range 5 ("None") overlap and cross the
mid-frequency between sub blocks 1 and 2 For subrange 4a: limit line and parameters of range 4 apply

For subrange 5a: limit line and parameters of range 5 apply

Global SEM limit check

For the complete SEM measurement, which can consist of multiple sub blocks, only
one single limit check is performed. A single limit line is calculated according to the
individual range limit lines and the defined functions for overlapping ranges. The mea-
sured values are then compared with this single limit line. If the limit is exceeded in any
range, the result of the limit check is . " failed!"
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1 Spectrum Emission Mask
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CF 903,25 MHz 3001 pts 2.55 MHz/ Span 25.5 MHz

Figure 6-37: Summarized limit line for multiple sub blocks

6.5.5 SEM Configuration

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask"
The SEM measurement is started immediately with the default settings.

The remote commands required to perform these tasks are described in Chap-
ter 12.5.6, "Measuring the Spectrum Emission Mask", on page 680.

Global span settings
The span of the signal to be monitored is configured in the general span settings (see

Chapter 7.3.2, "Frequency and Span Settings", on page 345). Only ranges within this
global span are considered for the SEM measurement.

Multi-SEM configuration
In the Spectrum application application only, spectrum emissions can be measured for

multiple sub blocks of channels (see Chapter 6.5.4.5, "SEM with Multiple Sub Blocks
("Multi-SEM")", on page 215). Up to three sub blocks (with two gaps) can be defined.
For each sub block, the familiar configuration settings concerning ranges, limit lines
etc. can be defined in individual tabs. In addition, settings on the sub blocks them-
selves must be configured in the "Sub Block" tab of the "Spectrum Emission Mask"
configuration dialog box (see Chapter 6.5.5.2, "Multi-SEM (Sub Block) Settings ",

on page 225).

The following settings are available in individual tabs of the "Spectrum Emission Mask"
configuration dialog box.

@ SWEEP LSt oot ———— 220
e  Multi-SEM (Sub Block) Settings .....ccccueviiiiiiiieeee e 225
®  RefereNCe RANGE. ....ciiiiiiiiiii e 226
®  POWET ClASSES....eiiiiiiiiiee ittt e e e e 227
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L I V0] T~ 11 T [ EUPPRT 229
®  StANAArd FIleS. ... e 232
e List Evaluation (Results Configuration)...........ccooiiiiiiiiiiiiiiiiee e, 234

6.5.5.1 Sweep List

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "Sweep
List"

If you edit the sweep list, always follow the rules and consider the limitations described
in Chapter 6.5.4.1, "Ranges and Range Settings", on page 209.

Sweep List Subblocks Reference Range Power Classes MSR Settings

Range 3
Block A 4 3.515 MHz

Pl 12.75 MHz
Sub

M Mormal(3...
Block B

30 kHz
Siib 3 3 MHz
Block C Auto Auto

140 ps 140 ps
o dBm

Auto

i0 di

orr
None
NONE

Relative

300 db

Range Start / RANGE STOP ...uuuiiiiiiieii ittt e e e e e e 221
= TS B =1 1Y ST 221
1= A 1Y/ o= USSR 221
L= SRR 221
LY SRR 221
SWEEP TIME MOME ...ttt e e e e e e e e s e e e e e e e e e e e s e eannennes 222
SWEEP TIME ittt ettt e e e e e e s e et ar et eeeaeeessssaaeannsreeeeeeaaaeeeesaaannnrenes 222
REF LEVE .ttt ettt e e s st e e s e e e e e anneee s 222
L N 1Y/ Yo [P PPPRRR 222
L N 1 (=Y a1 F= 1 i) o N 222
TranSAUCET FACTON ....ceeiiiiiieicccce e s e e e e e e e e e e e e e e e e e e eeeeeeeeeens 222
Limit CheCK SN> et e e e e e e e e e e e e e e e e e e e e e eeeeeeeeeeaanaanas 223
Abs Limit Start / STOP SN> ... 223
Rel Limit Start / STOP SN> ..t 223
MUlti-Limit CalC SN> L.eeiiiiiiiiiee et e e st e e e s senbee e e e s sbeeeeeeeans 224
Min SWEEP POINES ...t e e e e e e e e e e e e e e e e e e e seennns 224
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Insert before Range / Insert after RaNge .......oocveeiiiiiiiiiii e 224
Delete RANGE ... 224
SYMMELHCAl SELUP oo e 225

Range Start / Range Stop
Sets the start frequency/stop frequency of the selected range.

To change the start/stop frequency of the first or last range, respectively, select the
appropriate span in the SPAN configuration dialog. You can set a span that is smaller
than the overall span of the ranges. In this case, the measurement includes only the
ranges that lie within the defined span and have a minimum span of 20 Hz. The first
and last ranges are adapted to the given span as long as the minimum span of 20 Hz
is not violated.

Define frequency values for each range relative to the center frequency. Center the ref-
erence range on the center frequency. The current "Tx Bandwidth" defines the mini-
mum span of the reference range (see " Channel Power Settings " on page 227).

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>[:FREQuency] : STARt on page 687
[SENSe: ]ESPectrum<sb>:RANGe<range>[:FREQuency] : STOP on page 687

Fast SEM

Activates "Fast SEM" mode for all ranges in the sweep list. For details, see Chap-
ter 6.5.4.3, "Fast SEM Measurements", on page 213.

Note: If you deactivate "Fast SEM" mode while "Symmetrical Setup" mode is on,
"Symmetrical Setup" mode is automatically also deactivated.

If you activate "Fast SEM" mode while "Symmetrical Setup” mode is on, not all range
settings can be configured symmetrically automatically.

Remote command:

[SENSe: ]ESPectrum<sb>:HighSPeed on page 684

Filter Type
Sets the filter type for this range.

For details on filter types, see Chapter 7.5.1.6, "Which Data May Pass: Filter Types",
on page 364.

Remote command:
[SENSe: ]| ESPectrum<sb>:RANGe<range>:FILTer:TYPE on page 686

RBW
Sets the resolution bandwidth for this range.

For details on the RBW, see Chapter 7.5.1.1, "Separating Signals by Selecting an
Appropriate Resolution Bandwidth", on page 361.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:BANDwidth:RESolution

on page 685

VBW
Sets the video bandwidth for this range.
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For details on the VBW, see Chapter 7.5.1.2, "Smoothing the Trace Using the Video
Bandwidth", on page 362.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:BANDwidth:VIDeo on page 685

Sweep Time Mode
Activates or deactivates the auto mode for the sweep time.

For details on the sweep time mode, see Chapter 7.5.1.7, "How Long the Data is Mea-
sured: Sweep Time ", on page 365

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:SWEep:TIME:AUTO on page 697

Sweep Time
Sets the sweep time value for the range.

For details on the sweep time, see Chapter 7.5.1.7, "How Long the Data is Measured:
Sweep Time ", on page 365

Remote command:
[SENSe:]ESPectrum<sb>:RANGe<range>:SWEep:TIME on page 696

Ref Level
Sets the reference level for the range.

For details on the reference level, see Chapter 7.4.1.1, "Reference Level",
on page 352.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:RLEVel on page 696

RF Att Mode
Activates or deactivates the auto mode for RF attenuation.

For details on attenuation, see Chapter 7.4.1.2, "RF Attenuation", on page 353.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:INPut:ATTenuation:AUTO
on page 688

RF Attenuation
Sets the attenuation value for the range.
For details on attenuation, see Chapter 7.4.1.3, "Scaling", on page 354.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:INPut:ATTenuation on page 688

Transducer Factor
Sets a transducer for the specified range. You can only choose a transducer that fulfills
the following conditions:

® The transducer overlaps or equals the span of the range.
® The x-axis is linear.
® The unitis dB.
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For details on transducers, see Chapter 10.3.1, "Basics on Transducer Factors",
on page 546.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:TRANsducer on page 697

Limit Check <n>
Sets the type of limit check for the n-th power class in the range. Up to four limits are
possible.

For details on limit checks, see Chapter 6.5.4.2, "Limit Lines in SEM Measurements",
on page 211.

The limit state affects the availability of all limit settings.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:LIMit<PClass>:STATe on page 694
CALCulate<n>:LIMit<k>:FATL? on page 932

Abs Limit Start / Stop <n>

Sets an absolute limit value for the n-th power class at the start or stop frequency of
the range [dBm].

Remote command:

[SENSe: ]ESPectrum<sb>:RANGe<range>:LIMit<PClass>:ABSolute:STARt
on page 689

[SENSe: ]ESPectrum<sb>:RANGe<range>:LIMit<PClass>:ABSolute:STOP
on page 690

Rel Limit Start / Stop <n>

Sets a relative limit value for the n-th power class at the start or stop frequency of the
range [dBc].

By default, this value is a fixed relative limit, i.e. no function is defined. To define a
function for the relative limit, select the input field for "Rel Limit Start" or "Rel Limit
Stop" and then the "f(x)" icon that appears.

Rel Limit Start 1 -50 dBCl% Function for Limitpoint [ }=|

Rel Limit Stop 1 -50 dBc

[-50.0 dBc

If the function is set to "Max" , you can define a relative and an absolute limit level. In
this case, the maximum of the two values is used as the limit level.

For more information, see "Relative limit line functions" on page 213.
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Remote command:

[SENSe: ]ESPectrum<sb>:RANGe<range>:LIMit<PClass>:RELative:STARt
on page 690

[SENSe: ]ESPectrum<sb>:RANGe<range>:LIMit<PClass>:RELative:STOP
on page 692

[SENSe: ]ESPectrum<sb>:RANGe<range>:LIMit<PClass>:RELative:STARt:
FUNCtion on page 692

[SENSe: ]ESPectrum<sb>:RANGe<range>:LIMit<PClass>:RELative:STOP:
FUNCtion on page 694

[SENSe: ]ESPectrum<sb>:RANGe<range>:LIMit<PClass>:RELative:STARt:
ABS on page 691

[SENSe: ]ESPectrum<sb>:RANGe<range>:LIMit<PClass>:RELative:STOP:
ABS on page 693

Multi-Limit Calc <n>

Defines the function used to calculate the limit line for the n-th power class for overlap-
ping ranges in Multi-SEM measurements. For details, see "Limit calculation for individ-
ual ranges" on page 217.

"NONE" (reference ranges only:) the limit of the reference range is used
"SUM" Sum of the two limit lines (calculated for linear powers) is used
"MAX" Maximum of the two limit lines is used

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:MLCalc on page 695

Min Sweep Points
Defines the minimum number of sweep points for the range.

If necessary to fulfill all minimum sweep point requirements in all ranges, the global
Sweep Points setting is increased. By default, each range is supplied with a minimum
of one sweep point.

For details, see "Sweep points" on page 211

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:POINts:MINimum/[:VALue]
on page 695

Insert before Range / Insert after Range

Inserts a new range to the left (before) or to the right (after) of the range in which the
cursor is currently displayed. The range numbers of the currently focused range and all
higher ranges are increased accordingly. The maximum number of ranges is 30.

Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:INSert on page 689

Delete Range

Deletes the currently focused range, if possible. (The reference range cannot be
deleted. A minimum of three ranges is required.) The range numbers are updated
accordingly.
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Remote command:
[SENSe: ]ESPectrum<sb>:RANGe<range>:DELete on page 686

Symmetrical Setup
Any changes to the range settings in active "Symmetrical Setup" mode lead to sym-
metrical changes in the other ranges (where possible). In particular, this means:

® |[nserting ranges: a symmetrical range is inserted on the other side of the reference
range

® Deleting ranges: the symmetrical range on the other side of the reference range is
also deleted

® Editing range settings: the settings in the symmetrical range are adapted accord-
ingly

Note: If "Fast SEM" mode is deactivated while "Symmetrical Setup" mode is on, "Sym

Setup" mode is automatically also deactivated.

If "Fast SEM" mode is activated while "Symmetrical Setup" mode is on, not all range

settings can be set automatically.

Multi-SEM (Sub Block) Settings

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "Sub
Blocks"

In the Spectrum application application only, spectrum emissions can be measured for
multiple sub blocks of channels (see Chapter 6.5.4.5, "SEM with Multiple Sub Blocks
("Multi-SEM")", on page 215). Sub blocks are a set of multiple ranges around a defined
center frequency (carrier).

By default, a single sub block is assumed. If more than one sub blocks are defined,
additional tabs are inserted for each sub block in the individual tabs of the "Spectrum
Emission Mask" configuration dialog box.

Sweep List Subblocks Reference Range Power Classes MSR Settings

| ,

Subblock [ Center Freq Standard Swaep List

(T T - T T

I T - T TS
I T - T TS

S T0] o 0 =1 o Yo | @011 o | SRR 225
10| o =1 o Yo (A O =T 1 (=) gl =Y [ PRRRT 226
Standard / MSR SettiNgS ..o 226
Edit SWEEP LSt e ——————— 226

Sub Block Count
Defines the number of sub blocks. By default, the familiar SEM measurement with just
one single block of ranges is configured.

HE
User Manual 1176.8445.02 — 09 225



R&S®FPS Measurements and Results
|

Remote command:
[SENSe: |ESPectrum<sb>:SCOunt on page 683

Sub Block / Center Freq
Defines the center frequency for an individual sub block. The center frequency deter-
mines the reference range used for each block.

For measurements with only one sub block, this setting corresponds to the global set-
ting in the "Frequency" settings (see Center Frequency ).

Remote command:
[SENSe: ] ESPectrum<sb>:SCENter on page 683

Standard / MSR Settings

Defines the use of a standard settings file or a multi-standard radio configuration for a
particular sub block. For details, see Chapter 6.5.5.6, "Standard Files", on page 232
and Chapter 6.5.5.5, "MSR Settings", on page 229.

Note that either a standard or an MSR setting can be selected; if one is selected, the
other is disabled.

Remote command:
[SENSe: ]ESPectrum<sb>:PRESet [:STANdard] on page 681

Edit Sweep List

Switches to the "Sweep List" tab of the "Spectrum Emission Mask" dialog box to con-
figure the individual frequency ranges and mask limits for the corresponding sub block.
See Chapter 6.5.5.1, " Sweep List ", on page 220.

6.5.5.3 Reference Range
Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "Refer-
ence Range"

The range around the center frequency is defined as the reference range for all other
ranges in the sweep list.

Sweep List Reference Range Power Classes Standard Files

Pow

. Channel Power | Peak Power

Channel Po

TxBandwidth 3.84 MHz

RRC FilterState [ Off

Alpha 0.22
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Power Reference TYPE ..ottt e e e e e 227
Channel POWEr SEHNGS ....coii it 227
L TX BANAWIALN 1.vocvoceieeeece ettt 227
L RRC Fller STALE ..vuvuvueeeeceeeereieiseeseseseenessessese st ssssessess e ssesssseseseenes 227
L AP ettt ettt n et et n et eeaene 227

Power Reference Type
Defines how the reference power is calculated.

"Channel Power"
Measures the channel power within the reference range using the
integration bandwidth method. Additional settings can be configured
for this method.
(See also "IBW method" on page 149)

"Peak Power"
Determines the peak power within the reference range.

Remote command:
[SENSe: ]ESPectrum<sb>:RTYPe on page 699

Channel Power Settings
If the "Power Reference Type:" "Channel Power" was selected, additional parameters
can be configured.

Tx Bandwidth < Channel Power Settings
Defines the bandwidth used for measuring the channel power, with:

Minimum span < "Tx Bandwidth" < of reference range

Remote command:
[SENSe: ]ESPectrum<sb>:BWID on page 698

RRC Filter State — Channel Power Settings
Activates or deactivates the use of an RRC filter.

Remote command:
[SENSe: ]ESPectrum<sb>:FILTer [:RRC] [:STATe] on page 698

Alpha: — Channel Power Settings
Sets the alpha value of the RRC filter (if activated).

Remote command:
[SENSe: ]ESPectrum<sb>:FILTer [ :RRC] :ALPHa on page 698

Power Classes
Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "Power
Classes"

You can configure power classes which you can then assign to sweep list ranges. For
details, see "Power classes" on page 211.
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Sweep List Reference Range Power Classes Standard Files

Power Class PMin <=P< PMax

e — =\
Power Class 1 { ‘ +INF
—

USEd POWET ClaSSES: ..iiiiiiiiiiiieiie ettt ettt e et e e e e e e e e e e e e e eeeees 228
Y T I /- SRR 228
RS CTCT oJ 229
Adding or Removing @ POWET Class ....cccoiiuuiiiiiiiiiie ettt 229

Used Power Classes:

Defines which power classes are considered for the SEM measurement. Limits can be
defined only for used power classes. It is only possible to select either one specific
power class or all the defined power classes.

If "All" is selected, the power class that corresponds to the currently measured power
in the reference range is used for monitoring. The limits assigned to that power class
are applied (see " Abs Limit Start / Stop <n> " on page 223 and " Rel Limit Start / Stop
<n>"on page 223).

Remote command:
CALCulate<n>:LIMit<k>:ESPectrum<sb>:PCLass<PClass>[:EXCLusive]
on page 702

To define all limits in one step:
CALCulate<n>:LIMit<k>:ESPectrum<sb>:PCLass<PClass>:LIMit[:STATe]
on page 702

PMin / PMax

Defines the power limits for each power class. The first range always starts at -200
dBm (-INF) and the last range always stops at 200 dBm (+INF). These fields cannot be
modified. If more than one power class is defined, the value of "PMin" must be equal to
the value of "PMax" of the previous power class and vice versa.

Note that the power level can be equal to the lower limit(s), but must be lower than the
upper limit(s):

|:’min§P<Pmax

Otherwise the ranges are corrected automatically.

HE
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Remote command:
CALCulate<n>:LIMit<k>:ESPectrum<sb>:PCLass<PClass>:MINimum
on page 703
CALCulate<n>:LIMit<k>:ESPectrum<sb>:PCLass<PClass>:MAXimum
on page 703

Sweep List

Switches to the "Sweep List" tab of the "Spectrum Emission Mask" dialog box and
focuses the "Limit Check" setting for the corresponding power class (1-4) in the refer-
ence range (see " Limit Check <n>" on page 223).

Adding or Removing a Power Class

Adds a new power class at the end of the list or removes the last power class. After
adding or removing, the last power class is adapted to end at "+INF" . Note that a max-
imum of four power classes are available.

Remote command:
CALCulate<n>:LIMit<k>:ESPectrum<sb>:PCLass:COUNt on page 701

6.5.5.5 MSR Settings

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "MSR
Settings"

Multi-standard radio (MSR) measurements allow you to perform SEM tests on multiple
carriers using different digital standards.

For details, see Chapter 6.5.4.4, "Multi-Standard Radio (MSR) SEM Measurements",
on page 215.
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Sweep List Sub Blocks Reference Range Power Classes MSR Settings

Sub Common Settings

Block A
Band Category BC2

Base Station Class Wide Area
BS Max Output Power

Bands >3 GHz

Base Station RF Bandwidth | 10.0 MHz ]

Carrier Adjacent to RF Bandwidth Edge
GSM/Edge Present

Power Gsm Carrier

LTE FDD 1.4MHz /3MHz Present

Apply to SEM

S F T ale [ O= 1 (=T o] oY TSP PRR 230
Base Station ClassS ......uuiiiiiiieiiiiiieiciiee e e e e e e e e e e e e e e 230
Base Station Maximum OQUIPUL POWET ... 231
= o £ USSP 231
Base Station RF Bandwidth ... 231
Carrier Adjacent to RF Bandwidth EAQe .......uuuiceiiiiiiiiiiiie 231
POWEE GSIM CAITIEF ...eniiieie i e e e e e e e e e e e e e e e e e e e e e e e eeeeeeee s eabaaanaaaaaans 231
Y o] 0] VAR (o TS T = SR 232

Band Category
Defines the band category for MSR measurements, i.e. the combination of available
carriers to measure.

"BC1" LTE FDD and W-CDMA
"BC2" LTE FDD, W-CDMA and GSM/EDGE
"BC3" LTE TDD and TD-SCDMA

Remote command:
[SENSe: ] ESPectrum<sb>:MSR:BCATegory on page 705

Base Station Class
Defines the class of the base station according to its sending range.

This setting is required to calculate the SEM limits according to standard 3GPP 37.141
V12.2.0.

Remote command:
[SENSe: ]ESPectrum<sb>:MSR:CLASs on page 706
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Base Station Maximum Output Power
Defines the maximum output power of the base station. Possible values are from
0 dBm to 100 dBm in 1 dB steps.

This setting is only available for base stations with a medium range Base Station
Class .

This value is required to calculate the SEM limits according to standard 3GPP 37.141
V12.2.0.

Remote command:
[SENSe: ]ESPectrum<sb>:MSR:MPOWer on page 709

Bands
Defines the frequency range of the bands used by the base station.

This setting is only available for Band Category 1 or 3.

This setting is required to calculate the SEM limits according to standard 3GPP 37.141
V12.2.0.

Remote command:
[SENSe: ]ESPectrum<sb>:MSR:BAND on page 705

Base Station RF Bandwidth
Defines the relevant RF bandwidth (span) required to measure all available carriers in
MSR SEM measurements.

Remote command:
[SENSe:]ESPectrum<sb>:MSR:REFBWidth on page 709

Carrier Adjacent to RF Bandwidth Edge
For particular measurement setups, the specification demands specific limits for the
SEM ranges.

These settings are only available for Band Category 2.

"GSM/Edge Present"
A GSM/EDGE carrier is located at the edge of the RF band.
In this case, the power of the GSM carrier must be specified (see "
Power Gsm Carrier " on page 231).

"LTE FDD 1.4MHz/3MHz Present"
An LTE FDD 1.4 MHz or 3 MHz carrier is located at the edge of the
RF band.

Remote command:
[SENSe: ]ESPectrum<sb>:MSR:GSM:CPResent on page 708
[SENSe: ]ESPectrum<sb>:MSR:LTE:CPResent on page 708

Power Gsm Carrier
Defines the power of the GSM carrier (if available, see " Carrier Adjacent to RF Band-
width Edge " on page 231). Possible values are from 0 dBm to 100 dBm in 1 dB steps.

This setting is only available for Band Category 2.

This setting is required to calculate the SEM limits according to standard 3GPP 37.141
V12.2.0.
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Remote command:
[SENSe: ]ESPectrum<sb>:MSR:GSM:CARRier on page 707

Apply to SEM
Configures the SEM sweep list according to the specified MSR settings.

Remote command:
[SENSe: ] ESPectrum<sb>:MSR:APPLy on page 704

6.5.5.6 Standard Files

Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "Stan-
dard Files"

You can save the current measurement settings as a user-defined standard (XML file),
or load stored measurement settings. Furthermore, you can delete an existing settings
file.

. Sweep List Reference Range Power Classes MSR Settings Standard Files

Drive: CATUH | DL (C:f FSW/FSW_1.80_27 fsem_std /WCDMA/3GPP/DL)

B PowerClass_31_39.xml

L] PowerClass_43_INF.xml
1 PowerClass_negINF_31.oml

CH powerClass 31 39l |

For details, see Chapter 6.5.6.1, "How to Manage SEM Settings Files", on page 238.

@ Standard files for sub blocks (Multi-SEM measurements)

If more than one sub blocks are defined, the "Standard Files" tab and softkey are not
available. To load a standard file for an individual sub block, use the Standard / MSR
Settings setting in the "Sub Blocks" tab.

Selecting Storage Location - Drive/ Path/ Files.........ccooiiiiieeee e 233
FIlE INGME <. e e e 233
[ T=To IS =T g Lo =T o OSSO P SRR 233
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S Eo YRR =1 a1 F= (o [T 233
Delete STANAArd ......c..eiiieeee e e e 233
REStOre Standard FIlES ......oeue i et e e e e e e e e 234

Selecting Storage Location - Drive/ Path/ Files
Select the storage location of the file on the instrument or an external drive.

The default storage location for the SEM settings files is: C: \R_S\INSTR\sem std.

Note: Saving instrument settings in secure user mode.

In secure user mode, settings that are stored on the instrument are stored to volatile
memory, which is restricted to 256 MB. Thus, a "memory limit reached" error can occur
although the hard disk indicates that storage space is still available.

To store data permanently, select an external storage location such as a USB memory
device.

For details, see Chapter 4.1.6, "Protecting Data Using the Secure User Mode",
on page 33.

Remote command:
MMEMory:CATalog? on page 937

File Name
Contains the name of the data file without the path or extension.

By default, the name of a user file consists of a base name followed by an underscore.
Multiple files with the same base name are extended by three numbers, e.g.
limit lines 005.

For details on the filename and location, see Chapter 9.3.2.2, "Storage Location and
Filename", on page 507.

Load Standard
Loads the selected measurement settings file.

Remote command:
[SENSe: ]ESPectrum<sb>:PRESet [:STANdard] on page 681

Save Standard
Saves the current measurement settings for a specific standard as a file with the
defined name.

Remote command:
[SENSe: | ESPectrum<sb>:PRESet:STORe on page 681

Delete Standard

Deletes the selected standard. Standards predefined by Rohde & Schwarz can also be
deleted. A confirmation query is displayed to avoid unintentional deletion of the stan-
dard.

Note: Restoring predefined standard files. The standards predefined by Rohde &
Schwarz available at the time of delivery can be restored using the "Restore Standard
Files" function (see " Restore Standard Files " on page 234).
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Restore Standard Files

Restores the standards predefined by Rohde & Schwarz available at the time of deliv-
ery.

The XML files from the C: \R_S\INSTR\sem backup folder are copied to the
C:\R_S\INSTR\sem std folder.

Note that this function will overwrite customized standards that have the same name
as predefined standards.

Remote command:
[SENSe: ]ESPectrum<sb>:PRESet:RESTore on page 681

6.5.5.7 List Evaluation (Results Configuration)
Access: "Overview" > "Select Measurement" > "Spectrum Emission Mask" > "List
Evaluation”

In the "List Evaluation" dialog box, you configure the contents and display of the SEM
results.

List Evaluation State

Settings

Show Peaks Off

Margin 200.0 dB

= tion List

Decimal Seperator POINT mﬂm

List Evaluation State (Result SUMMArY)........ccuiiiiiiiiiie e 234
SOW PEAKS ...ttt e e e e e e e e e s e e e e e e e e e e s nnannranee 234
/= o [ SRR 235
Saving the Result Summary (Evaluation List) to a File ..........cccceeeveeiiiiiiiiiiiiiieee. 235

List Evaluation State (Result Summary)
Activates or deactivates the Result Summary.

Remote command:
CALCulate<n>:ESPectrum:PEAKsearch:AUTO on page 710
TRACe<n>[:DATA] on page 854

Show Peaks
If activated, all peaks that have been detected during an active SEM measurement are
marked with blue squares in the Spectrum diagram.
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Remote command:
CALCulate<n>:ESPectrum:PEAKsearch:PSHow on page 711

Margin

Although a margin functionality is not available for the limit check, you can define a
margin (or: threshold) for the peak values to be displayed in the result summary. Only
peaks that exceed the margin value are displayed (also in the diagram, if activated).

Remote command:
CALCulate<n>:ESPectrum:PEAKsearch:MARGin on page 711

Saving the Result Summary (Evaluation List) to a File

Exports the Result Summary of the SEM measurement to an ASCI! file for evaluation
in an external application. If necessary, change the decimal separator for evaluation in
other languages.

Define the filename and storage location in the file selection dialog box that is dis-
played when you select the "Save" function.

For details, see Chapter 6.5.8.2, "ASCII File Export Format (Spectrum Emission
Mask)", on page 247.

Remote command:
MMEMory : STORe<n>:LIST on page 963
FORMat :DEXPort:DSEParator on page 937

How to Perform a Spectrum Emission Mask Measurement

SEM measurements can be performed according to a specific standard or freely con-
figured. Configuration for signals with a regular channel definition can be configured
quickly and easily. Selecting the SEM measurement is a prerequisite for all other tasks.

For signals with multiple carriers, also in non-contiguous ranges, an SEM measure-
ment with multiple sub blocks can be configured.

For multi-standard radio SEM measurements, configuration for specified scenarios can
be done automatically.

The following tasks are described:

® '"To select an SEM measurement" on page 235

® "To perform an SEM measurement according to a standard" on page 236
® "To configure a user-defined SEM measurement" on page 236

® "To perform an MSR SEM measurement" on page 237

® "To perform a Multi-SEM measurement" on page 238

For remote operation, see Chapter 12.5.6.11, "Example: SEM Measurement",
on page 712.

To select an SEM measurement

» Press the MEAS key, then select the "Spectrum Emission Mask" measurement.
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To perform an SEM measurement according to a standard

> Load the settings file as described in "How to load an SEM settings file"

on page 238 and start a measurement.

To configure a user-defined SEM measurement

1.
2.

Define the span of the signal you want to monitor in the general span settings.

Split the frequency span of the measurement into ranges for signal parts with simi-
lar characteristics.

Starting from the center frequency, determine which sections of the signal to the
left and right can be swept and monitored using the same parameters. Criteria for
such a range definition may be, for example:

The signal power level

The required resolution bandwidth or sweep time

Transducer factors

Permitted deviation from the defined signal level, i.e. the required limit values
for monitoring

If the signal consists of a transmission channel and adjacent channels, the channel
ranges can usually be used for the range definition.

If the signal power level to be monitored varies and the limits vary, define power
classes. For each range of levels that can be monitored in the same way, define a
power class.

a) Select the "Overview" softkey.

b) Select the "SEM Setup" button.

c) Switch to the "Power Classes" tab.

d) To add a power class, select the "Add" button.

e) Enter the start and stop power levels to define the class.

f) Select the power classes to be used for the current measurement:

e a specific class
e all classes, to have the required class selected automatically according to
the input level measured in the reference range

Select the "Sweep List" tab of the "Spectrum Emission Mask" dialog box.

Insert the required ranges using the "Insert before Range" and "Insert after Range"
buttons, which refer to the currently selected range (the reference range by
default).

If the signal trace is symmetric to the center frequency, activate the "Sym Setup"
option to make setup easier and quicker.

Define the measurement parameters for each range as required. If symmetrical
setup is activated, you only have to configure the ranges to one side of the center
range.

In particular, define the limits for each range of the signal, i.e. the area in which the
signal level can deviate without failing the limit check. If several power classes
were defined (see step 3), define limits for each power class.

HE
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a) Define the type of limit check, i.e. whether absolute values or relative values
are checked, or both. The type of limit check is identical for all power classes.
b) Define the limit start and stop values.

7. If the sweep list settings - other than the limit and transducer values - are identical
for several adjacent ranges, activate "Fast SEM" mode to speed up the measure-
ment. You only have to activate the mode for one range, the others are adapted
automatically.

8. If necessary, change the settings for the reference power to which all SEM results
refer in the "Reference Range" tab.

9. To indicate the determined peaks in the display during an SEM measurement,
select "Overview" > "Analysis" > "Show Peaks" .

10. To save the current SEM measurement settings to a file to re-use them later, save
a settings file as described in "How to save a user-defined SEM settings file"
on page 239.

11. Start a sweep.

The determined powers and limit deviations for each range are indicated in the
Result Summary. If activated, the peak power levels for each range are also indica-
ted in the Spectrum diagram.

12. To save the Result Summary, export the results to a file as described in Chap-
ter 6.5.6.2, "How to Save SEM Result Files", on page 239.

To perform an MSR SEM measurement
1. Select the "MSR Config" softkey.

2. Select the band category that determines the digital standards used in the mea-
surement setup (see " Band Category " on page 230).

3. Define the bandwidth that contains all relevant carrier signals to be measured.

4. For measurements with GSM/EDGE, LTE FDD and W-CDMA carriers (BC2),
define whether a GSM/EDGE or an LTE FDD carrier, or both, are located at the
edge of the bandwidth.

5. Select the "Apply to SEM" button.

The sweep list is configured according to the MSR specification, with the required
number of ranges and defined limits.

6. Start a sweep.

The determined powers and limit deviations for each range are indicated in the
Result Summary. If activated, the peak power levels for each range are also indica-
ted in the Spectrum diagram.

7. To save the Result Summary, export the results to a file as described in Chap-
ter 6.5.6.2, "How to Save SEM Result Files", on page 239.
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To perform a Multi-SEM measurement

1. Define the span of the signal to be monitored in the general span settings.
2. Select the "Multi-SEM Config" softkey.

3. Define the number of sub blocks (up to 3) that contain the relevant carriers.
4

For each sub block, define the center frequency, that is, the frequency of the TX
carrier or a frequency in the dedicated reference range.

5. For each sub block, do one of the following:

Select a standard settings file to be used.
Select the "MSR Settings" button and define the MSR configuration as descri-
bed in "To perform an MSR SEM measurement" on page 237.

e Select the "Edit" button and configure the sweep list manually as defined in "To
configure a user-defined SEM measurement"” on page 236. Be sure to select
the correct vertical tab for the corresponding sub block within each subtab of
the "Spectrum Emission Mask" configuration dialog.

Define a function to be used for overlapping ranges in the "Multi-Limit Calc"
field of the sweep list.

6. Start a sweep.

The determined powers and limit deviations for each sub block, each gap, and
each range are indicated in the Result Summary. If activated, the peak power lev-
els for each range are also indicated in the Spectrum diagram.

7. To save the Result Summary, export the results to a file as described in Chap-
ter 6.5.6.2, "How to Save SEM Result Files", on page 239.

How to Manage SEM Settings Files

SEM measurement settings can be saved to an XML file which can then be exported to
another application or loaded on the R&S FPS again later. Some predefined XML files
are provided that contain ranges and parameters according to the selected standard.
All XML files are stored under C: \R_S\INSTR\sem std.

For details on the file format of the SEM settings file, see Chapter 6.5.8.1, "Format
Description of SEM XML Files", on page 241.

SEM settings or standard files are managed in the "Standard" tab of the "Spectrum
Emission Mask" dialog box. To display this dialog box, select the "Overview" softkey
and then the "SEM Setup" button.

How to load an SEM settings file

1. From the file selection dialog box, select the settings file (with a .xm1 extension).

2. Select the "Load" button.

The settings from the selected file are restored to the R&S FPS and you can repeat
the SEM measurement with the stored settings.



6.5.6.2

Spectrum Emission Mask (SEM) Measurement

How to save a user-defined SEM settings file

1. Configure the SEM measurement as required (see Chapter 6.5.6, "How to Perform
a Spectrum Emission Mask Measurement”, on page 235).

2. In the "Standard Files" tab of the "Spectrum Emission Mask" dialog box, define a
filename and storage location for the settings file.

3. Select the "Save" button.

The settings are stored to a file with the extension . xm1 as specified.

How to delete an SEM settings file

1. In the "Standard Files" tab of the "Spectrum Emission Mask" dialog box, select the
file you want to delete.

2. Select the "Delete" button.
3. Confirm the message.

The settings file is removed from the R&S FPS.

How to restore default SEM settings files

The R&S FPS is delivered with predefined settings files which can be edited and over-
written. However, you can restore the original files.

» In the "Standard Files" tab of the "Spectrum Emission Mask" dialog box, select the
"Restore Standard Files" button.

The original predefined settings files are available for selection on the R&S FPS.

How to Save SEM Result Files

The Result Summary from an SEM measurement can be saved to a file, which can be

exported to another application for further analysis, for example.

For details on the file format of the SEM export file, see Chapter 6.5.8.2, "ASCII File

Export Format (Spectrum Emission Mask)", on page 247.

1. Configure and perform an SEM measurement as described in Chapter 6.5.6, "How
to Perform a Spectrum Emission Mask Measurement", on page 235.

2. Inthe "Overview" , select the "Analysis" button.

3. If necessary, change the "Decimal Separator" to "COMMA" for evaluation in other
languages.

4. Select the "Save" button.

5. In the file selection dialog box, select a storage location and filename for the result
file.
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6. Select the "Save" button.

The file with the specified name and the extension .dat is stored in the defined
storage location.
6.5.7 Measurement Example: Multi-SEM Measurement

The following measurement example demonstrates an SEM measurement for a signal
with multiple sub blocks.

A programming example demonstrating a SEM measurement in a remote environment
is provided in Chapter 12.5.6.11, "Example: SEM Measurement", on page 712.

Test setup:
Signal
Generator 1 l
Coupler Spectrum
.
[- 6 dB| Analyzer
Signal T
Generator 2
Signal generator settings (e.g. R&S FPS SMW):
Device Standard Center frequency Level Test model
SigGen 1 3GPP/FDD 900 MHz 0dBm 1-16
SigGen 2 EUTRAILTE 906.5 MHz 0dBm 1_1_5MHz

Setting up the measurement

1. Preset the R&S FPS.

Set the center frequency to 903.25 MHz.

Set the reference level to 10 dBm with an offset of to 30 dB.

Press the MEAS key or select "Select Measurement" in the "Overview" .

Select the "SEM" measurement function.

o g M w b

Select the "Sub Blocks" softkey and enter "Sub Block Count" of 2.
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7. For "Sub Block A", define the settings for the 3GPP/FDD signal:

Set the "Center Frequency" to 900 MHz

Select "MSR Settings" .

Set the "Base Station RF Bandwidth" to 5 MHz.
Select "Apply to SEM" .

8. For "Sub Block B", define the settings for the EUTRA/LTE signal:

Set the "Center Frequency" to 906.5 MHz
Select "MSR Settings" .

Set the "Base Station RF Bandwidth" to 5 MHz.
Select "Apply to SEM" .

9. Select RUN SINGLE to perform a measurement with the new settings.

The results of the measurement for each sub block are displayed in the Result
Summary. The summarized limit line is indicated in the Spectrum graph.

1 Spectrum Emission Mask o 1Rm Clrw
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il
F 3001 pts 2.55 MHz/ Span 25.5 MHz
Summary
Sub Block A Center 900.00 MHz Tx Power 23.51 dBm RBW 30.000 kHz -
Tx Bandwidth 3.840 MHz None
Frequency Power Abs Power Rel ALimit
894.16808 MHz -34.44 dBm -57.95 dB -22.94 dB
896.14890 MHz -47.37 dBm -70.88 dB -22.87 dB
896.65096 MHz -49.41 dBm -72.92 dB -27.40dB
897.39370 MHz -50.91 dBm -74.42 dB -38.41dB

Frequency Power Abs Power Rel ALimit
902.70196 MHz -50.62 dBm =74.13 dB -38.38 dB
902.92839 MHz -50.31 dBm -73.82 dB -35.18 dB
903.33976 MHz -23.52 dBm -47.03 dB -6.24 dB
503.59774 MHz -20.99 dBm -44.50 dB -6.21 dB
Hz 903.81543 MHz -20.35 dBm -43.86 dB -8.11 dB
Sub Block B Center 906,50 MHz Tx Power 23,03 dBm RBW 30,000 kHz

Tos Bt anchaddih 2 040 AL Klnra

Figure 6-38: Multi-SEM measurement: results of the measurement for each sub block

6.5.8 Reference: SEM File Descriptions

This reference provides details on the format of the SEM settings and result files.

e Format Description of SEM XML Fil€S......cccoiiiiiiiiiiiiiiiciicieie e eeeeeeeans 241
ASCII File Export Format (Spectrum Emission Mask)...........cooeevviiiiiiiiiccccennnnnn. 247

6.5.8.1 Format Description of SEM XML Files

The SEM XML files offer a quick way to change the measurement settings. A set of
predefined XML files for different standards is already provided. You can also create
and use your own XML files. Alternatively, edit the settings directly in the "Spectrum
Emission Mask" dialog box and save the XML file afterwards. This way, you do not
have to modify the XML file itself.
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In addition to saving the current settings to a file, settings files can also be created
independently of the R&S FPS, in an external application. When creating your own
XML files, be sure to comply with the following conventions because the R&S FPS can
only interpret XML files of a known structure. For sample files, see the
C:\R_S\INSTR\sem std directory of the R&S FPS.

To load a settings file, use the "Load" function in the "Standard Files" tab of the "Spec-
trum Emission Mask" dialog box (see "How to load an SEM settings file" on page 238).
All XML files are stored under C:\R_S\INSTR\sem std.

The files for importing range settings obey the rules of the XML standard. The child
nodes, attributes, and structure defined for the data import are described here.

Be sure to follow the structure exactly as shown below or else the R&S FPS is not able
to interpret the XML file and error messages are shown on the screen. It is recommen-
ded that you make a copy of an existing file and edit the copy of the file.

Basically, the file consists of three elements that can be defined:

® The BaseFormat element
® The PowerClass element

® The Range element

The "BaseFormat" element

It carries information about basic settings. In this element, only the ReferencePower
child node has any effects on the measurement itself. The other attributes and child
nodes are used to display information about the Spectrum Emission Mask standard on
the measurement screen. The child nodes and attributes of this element are shown in
Table 6-13.

Example:

In the sample file PowerClass 39 43.xml under
C:\R_S\INSTR\sem std\WCDMA\3GPP, these attributes are defined as follows:

e Standard="W-CDMA 3GPP"
® LinkDirection="DL"
PowerClass="(39,43)dBm"

The "PowerClass" element

It is embedded in the BaseFormat element and contains settings information about
the power classes. Up to four different power classes can be defined. For details, refer
to Chapter 6.5.5.4, "Power Classes", on page 227. The child nodes and attributes of
this element are shown in Table 6-14.

The "Range" element

This element is embedded in the PowerClass element. It contains the settings infor-
mation of the range. There have to be at least three defined ranges: one reference
range and at least one range to either side of the reference range. The maximum num-
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ber of ranges is 30. Note that the R&S FPS uses the same ranges in each power
class. Therefore, the contents of the ranges of each defined power class have to be
identical to the first power class. The start and Stop values of the two Limit nodes
that are used to determine the power class are an exception. Note also that you must
define two limit nodes: one that defines the limit in absolute values and one in relative
values. Make sure units for the Start and Stop nodes are identical for each Limit
node.

For details, refer to Chapter 6.5.5.1, " Sweep List ", on page 220. The child nodes and
attributes of this element are shown in Table 6-15.

The following tables show the child nodes and attributes of each element and show if a
child node or attribute is mandatory for the R&S FPS to interpret the file or not. The
hierarchy of the XML cannot be seen in the tables. View one of the predefined files
already stored on the R&S FPS in the "C:\R_S\INSTR\sem std" directory, or check
the structure as shown below.

Below, a basic example of the structure of the file is shown, containing all mandatory
attributes and child nodes. Note that the PowerClass element and the Range element
are themselves elements of the BaseFormat element. They must be inserted where
noted. They are separated here simply to provide a better overview. Also, no example
values are given here to allow a quick reference to the tables above. Italic font shows
the placeholders for the values.

® The BaseFormat element is structured as follows:

— <RS_SEM_ACP_FileFormat Version="1.0.0.0">
<Name>"Standard"</Name>
<Instrument>
<Type>"Instrument Type"</Type>
<Application>"Application"</Application>
</Instrument>
<LinkDirection Name="Name">
<ReferencePower>
<Method>"Method"</Method>
</ReferencePower>
<PowerClass Index="n">
<!I-- For contents of the PowerClass node, see Table 6-14 -->
<!-- Define up to four PowerClass nodes -->
</PowerClass>
</LinkDirection>
</RS_SEM_ACP_File>

® The "PowerClass" element is structured as follows:

— <PowerClass Index="n">
<StartPower Unit="dBm" InclusiveFlag="true" Value="StartPowerValue"/>
<StopPower Unit="dBm" InclusiveFlag="false" Value="StopPowerValue"/>
<DefaultLimitFailMode>"Limit Fail Mode"</DefaultLimitFailMode>
<Range Index="n">
<!-- For contents of the Range node, see Table 6-15 -->
<!-- Define up to twenty Range nodes -->
</Range>
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</PowerClass>
® The "Range" element is structured as follows:

— <Range Index="n">
<Name="Name">
<ChannelType>"Channel Type"</Channel Type>
<WeightingFilter>
<Type>"FilterType"</Type>
<RollOffFactor>"Factor"</RollOffFactor>
<Bandwith>"Bandwidth"</Bandwidth>
</WeightingFilter>
<FrequencyRange>
<Start>"RangeStart"</Start>
<Stop>"RangeStop"</Stop>
</FrequencyRange>
<Limit>
<Start Unit="Unit" Value="Value"/>
<Stop Unit="Unit" Value="Value"/>
</Limit>
<Limit>
<Start Unit="Unit" Value="Value"/>
<Stop Unit="Unit" Value="Value"/>
</Limit>
<RBW Bandwidth="Bandwidth" Type="FilterType"/>
<VBW Bandwidth="Bandwidth"/>
<Detector>"Detector"</Detector>
<Sweep Mode="SweepMode" Time="SweepTime"/>
<Amplitude>
<ReferencelLevel Unit="dBm" Value="Value"/>
<RFAttenuation Mode="Auto" Unit="dB" Value="Value"/>
<Preamplifier State="State"/>
</Amplitude>
<MeasPointsMin>1</MeasPointsMin>
<CalcRuleMulti>Sum</CalcRuleMulti>
</Range>

Table 6-13: Attributes and child nodes of the BaseFormat element

Child Node Attribute Value Parameter Description Mand.
FileFormatVersion 1.0.0.0 Yes
Date YYYY-MM-DD Date in ISO 8601 format No
HH:MM:SS
Name <string> Name of the standard Yes
Instrument Type FSL Name of the instrument No
Application SA | K72 | K82 Name of the application No
LinkDirection Name Downlink | Uplink | Yes
None
ShortName DL | UL No
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Child Node Attribute Value Parameter Description Mand.
Reference- Yes
Power
Method TX Channel Power | Yes
TX Channel Peak
Power
Reference- <string> No
Channel

Table 6-14: Attributes and child nodes of the PowerClass element

Child Node Attribute Value Parameter description Mand.

StartPower Value <power in dBm> The start power must be equal | Yes
to the stop power of the previ-
ous power class. The Start-

Power value of the first range

is -200
Unit dBm Yes
InclusiveFlag true Yes
StopPower Value <power in dBm> The stop power must be equal | Yes

to the start power of the next
power class. The StopPower
value of the last range is 200

Unit dBm
InclusiveFlag false Yes
DefaultLimitFailMode Absolute | Relative Yes

| Absolute and Rel-
ative | Absolute or
Relative

Table 6-15: Attributes and child nodes of the Range element (normal ranges)

Child node Attribute | Value Parameter description Mand.

Index 0...19 Indices are continuous and | Yes
have to start with 0

Name <string> Name of the range Only if Referen-
ceChannel con-
tains a name and
the range is the
reference range

Short- <string> Short name of the range No
Name
ChannelType TX | Adjacent Yes
WeightingFilter Only if Referen-
cePower method
is TX Channel

Power and the
range is the ref-
erence range
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Child node Attribute | Value Parameter description Mand.
Type RRC | CFilter Type of the weighting filter | Yes
Roll Off Factor 0...1 Excess bandwidth of the fil- | Only if the filter
ter type is RRC
Bandwidth <bandwidth in Hz> | Filter bandwidth Only if the filter
type is RRC
FrequencyRange Yes
Start <frequency in Hz> | Start value of the range Yes
Stop <frequency in Hz> | Stop value of the range Yes
Limit dBm/Hz | dBm | A Range must contain Yes
dBc | dBr | dB exactly two limit nodes; one
of the limit nodes has to
have a relative unit (e.g.
dBc), the other one must
have an absolute unit (e.g.
dBm)
Start Value <numeric_value> Power limit at start fre- Yes
quency
Unit dBm/Hz | dBm | Sets the unit of the start
dBc | dBr | dB value
Stop Value <numeric_value> Power limit at stop fre-
quency
Unit dBm/Hz | dBm | Sets the unit of the stop
dBc | dBr | dB value
LimitFailMode Absolute | Relative | If used, it has to be identical | No
| Absolute and Rel- | to DefaultLimitFailMode
ative | Absolute or
Relative
RBW Bandwidth | <bandwidth in Hz> | " RBW " on page 221 Yes
Type NORM | PULS | No
CFIL | RRC
VBW Bandwidth | <bandwidth in Hz> | " VBW " on page 221 Yes
Detector NEG | POS | If used, it has to be identical | No
SAMP | RMS | in all ranges.
AVER | QUAS
Sweep Mode Manual | Auto " Sweep Time Mode " Yes
on page 222
Time <time in sec> " Sweep Time " No
on page 222
Amplitude No
ReferencelLevel Value <power in dBm> " Ref Level " on page 222 Yes, if the Refer-
encelevel child
node is used




Spectrum Emission Mask (SEM) Measurement

Child node Attribute | Value Parameter description Mand.

Unit dBm Defines dBm as unit Yes, if the Refer-
encelevel node
is used

RFAttenuation Mode Manual | Auto " RF Att Mode " Yes, if the Refer-
on page 222 encelevel child
node is used

6.5.8.2 ASCII File Export Format (Spectrum Emission Mask)

When trace data from an SEM measurement is exported, the data is stored in ASCII
format as described below. The first part of the file lists information about the signal
analyzer and the general setup.

File contents Explanation
File header

Model
Version;1.00; Firmware version
Date;31.Mar 17; Storage date of data set
Mode;ANALYZER;SEM; Operating mode and measurement function
Center Freq;13250000000.000000;Hz X-axis settings

Freq Offset;0.000000;Hz

Span;25500000.000000;Hz

x-Axis;LIN;

Start;13237250000.000000;Hz

Stop;13262750000.000000;Hz

Level Offset;0.000000;dB Y-axis settings

Ref Position;100.000000;%

y-Axis;LOG;

Level Range;100.000000;dB

Trace settings

Trace Mode;CLR/WRITE;

Detector;RMS;

Sweep Count;0;

Trace 1:;

x-Unit;Hz;

y-Unit;dBm;

List evaluation settings
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6.6.1

Spurious Emissions Measurement

File contents Explanation

Margin;200; Peak List margin

Reference range settings

RefType; CPOWER; Reference power type

TxBandwidth;3840000;;Hz Channel power settings

Filter State; ON;

Alpha;0.22;
PeaksPerRange;1; Max. number of peaks per range to be detected
Values;2; Number of detected peaks

File data section

0;-12750000;-2515000;30000;13242367500;-43.844 | Measured peak values:
722747802734;-0.33028793334960938;49.6697120
66650391;FAIL;

<range number>;

<start frequency>;

2;2515000;12750000;30000;13257632500;-43.8447

22747802734;-0.33028793334960938;49.66971206
6650391;FAIL; <resolution bandwidth of range>;

<stop frequency>;

<frequency of peak>;
<absolute power in dBm of peak>;

<relative power in dBc of peak>; (related to the
channel power)

<distance to the limit line in dB>; (positive value
means above the limit)

<limit fail (pass = 0, fail =1)>;

Spurious Emissions Measurement

Spurious Emissions measurements monitor unwanted RF products outside the
assigned frequency band generated by an amplifier.

AboUt the MeasUIremMENt...........uuiiiiii e 248
Spurious Emissions Measurement ReSUILS. ... 249
SpUrioUS EMISSIONS BASICS....uuuueeiiiiiieieiieiieiiieeiiee e e e e eee e e e e e e e e 250
Spurious Emissions Measurement Configuration...........cccocceiiiieiininnc e, 252
How to Perform a Spurious Emissions Measurement...........cccccceveeeiieccevvveneennnn. 258
Reference: ASCII Export File Format (Spurious).........ccccccvviiieeeieeieee i, 259

About the Measurement

The Spurious Emissions measurement monitors unwanted RF products outside the

assigned frequency band generated by an amplifier. The spurious emissions are usu-
ally measured across a wide frequency range. The Spurious Emissions measurement
allows a flexible definition of all parameters. A result table indicates the largest devia-
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tions of the absolute power from the limit line for each range, and the results can be
checked against defined limits automatically.

MultiView  Spectrum

Ref Level 0.00 dBm

1 Spurious Emissions ©1AP Clrw

z 68704 pts 1.27 GHz/
2 Result Summary
Range Low Frequency Power Abs ALimit
Hz 136.62411 kHz -61.33 dBm -48.33 dB
& 0.0 202.94301 kHz -73.53 dBm -60.53 dB
230.76857 MHz =75.90 dBm -62.90 dB
1.71948 GHz -72.30 dBm -59.30 dB

6.6.2 Spurious Emissions Measurement Results

The measured signal, including any spurious emissions, and optionally the detected
peaks are displayed in the Spurious Emissions measurement diagram. If defined, the
limit lines and the limit check results are also indicated. In addition to the graphical
results, a result table can be displayed to evaluate the measured powers and limit
check results (see also Chapter 6.6.3.2, "Limit Lines in Spurious Measurements",

on page 251). The details of the evaluation list can be configured.

Summary
e Low LANGE EUEN Poawer Abs ALTmiE

=61.33 dBm -48.33 dB

-73.53 dBm -60.53 dB
230.76857 MHz -75.90 dBm -62.90 dB
1.71948 GHz =72.30 dBm -59.30 dB

The following information is provided in the evaluation list for each range:

Column Description

Range Low Frequency range start for the range the peak value belongs to

Range Up Frequency range end for the range the peak value belongs to

RBW RBW of the range

Frequency Frequency at the peak value

Power Abs Absolute power level at the peak value

ALimit Deviation of the absolute power level from the defined limit for the peak
value

By default, one peak per range is displayed. However, you can change the settings to:

User Manual 1176.8445.02 — 09 249
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6.6.3

6.6.3.1

® Display all peaks

® Display a certain number of peaks per range

® Display only peaks that exceed a threshold ( "Margin" )

® Display detected peaks as blue squares in the diagram, as well as in the peak list

1 Spurious Emissions

Stop 12,75 GHz

Furthermore, you can save the evaluation list to a file.

Retrieving Results via Remote Control

The measured spurious values of the displayed trace can be retrieved using the
TRAC:DATA? SPUR command (see TRACe<n>[:DATA] on page 854).

Spurious Emissions Basics

Some background knowledge on basic terms and principles used in Spurious Emis-
sions measurements is provided here for a better understanding of the required config-
uration settings.

e Ranges and RaNge SettiNgS. .. .. uueiriiiiiiiieiieicieeee e 250
e Limit Lines in Spurious Measurements............ceeeeeeieieieiieiieeeeeeeeeeeeeeeeeeeeveeaaees 251

Ranges and Range Settings

Conditions for ranges
The following rules apply to ranges:

® The minimum span of a range is 20 Hz.

® The individual ranges must not overlap (but can have gaps).

® The maximum number of ranges is 30

® The maximum number of sweep points in all ranges is limited to 100001.

You can define a span that is smaller than the combined span of the ranges. In this

case, the measurement includes only the ranges that lie within the defined span and
have a minimum span of 20 Hz.

User Manual 1176.8445.02 — 09 250



R&S®FPS

Measurements and Results

R\ Defining ranges by remote control

6.6.3.2

/In Spurious Emissions measurements, there are no remote commands to insert new

ranges between existing ranges directly. However, you can delete or redefine the exist-
ing ranges to create the required order.

A remote command example for defining parameters and ranges in Spurious Emis-
sions measurements is described in Chapter 12.5.7.6, "Programming Example: Spuri-
ous Emissions Measurement”, on page 726.

Limit Lines in Spurious Measurements

Limit lines allow you to check the measured data against specified limit values. Gener-
ally, it is possible to define limit lines for any measurement in the Spectrum application
using the LINES key. For Spurious measurements, however, a special limit line is
available via the "Sweep List" , and it is strongly recommended that you use only this
limit line definition.

In the "Sweep List" , you can define a limit line that varies its level according to the
specified frequency ranges. A distinguished limit line is automatically defined according
to the current "Sweep List" settings every time the settings change. This limit line is
labeled "_SPURIOUS_LINE_ABS <xxx>", where <xxx> is an index to distinguish limit
lines between different channels.

If a limit check is activated in the "Sweep List" , the "_SPURIOUS_LINE_ABS_<xxx>"
limit line is indicated by a red line in the display. The result of the limit check is indica-
ted at the top of the diagram. Note that only "Pass" or "Fail" is indicated; a margin func-
tion as for general limit lines is not available. Also, only absolute limits can be checked,
not relative ones.

1 Spurious Emissions o 1AP Clrw

Start 9.0 kHz 68704 pts 1.27 GHz/ Stop 12.75 GHz

RBW Frequency Power Abs ALimit
1.000 kHz 136.82525 kHz -62.09 dBm -49.09 dB
] 3 302.94301 kHz -72.49 dBm -59.49 dB

1.08023 GHz -52.14 dBm -39.14 dB

As for general limit lines, the results of each limit line check are displayed (here:
" SPURIOUS_LINE_ABS <xxx>"), as well as the combined result for all defined limit
lines ( "Limit Check" ).

|
User Manual 1176.8445.02 — 09 251
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The limit check is considered to be " failed!" if any signal level outside the absolute lim-
its is measured.

If the limit check is activated, the limit line values for each range are displayed in the
evaluation list. Furthermore, the largest deviations of the absolute power from the limit
line for each range are displayed. Values that exceed the limit are indicated in red and
by an asterisk (*).

Although a margin functionality is not available for the limit check, a margin (threshold)

@ for the peak values to be displayed in the evaluation list can be defined. Furthermore,
you can define how many peaks per range are listed. For details, see Chapter 6.6.4.3,
"List Evaluation", on page 256.

6.6.4 Spurious Emissions Measurement Configuration

Access: "Overview" > "Select Measurement" > "Spurious Emissions"
The spurious emissions measurement is started immediately with the default settings.

The remote commands required to perform these tasks are described in Chap-
ter 12.5.7, "Measuring Spurious Emissions", on page 715.

@ SWEEP LISt .t 252
e Adjusting the X-Axis to the Range Definitions.........cccevviiiiiiiiiieee e, 256
® LISt EVAIUGLION. ... e 256

6.6.4.1 Sweep List

Access: "Overview" > "Select Measurement" > "Spurious Emissions" > "Sweep List"

For Spurious Emissions measurements, the input signal is split into several frequency
ranges which are swept individually and for which different limitations apply.

If you edit the sweep list, always follow the rules and consider the limitations described
in Chapter 6.6.3.1, "Ranges and Range Settings", on page 250.
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Range 1 Range? |Range3 [Range4 |
9 kHz 150 kHz 30 MHz 1 GHz
150 kHz 30 MHz 16Hz | 1275 Ghz
Normal{ 2... | Normal(3... .Normaf{ ... ENormd(S...
1 kHz 10 kHz 100kHz | 1 MHz

3 kHz 30 kHz 300 kHz 2 MHz
Auto Auto Auto Auto

4.19 ms 837 s 2.64 ms 707 ps
RMS RMS RMS RMS
0 dBm 0 dBm 0 dBm 0 dBm

Auto Auto Auto Auto

10 dB 10 dB 10 dB 10 dB
701 4001 22001
off off off

MNoene None None
Absolute Absolute Absolute
-13 dBém -13 dBm -13 dBm E

-13 dBm -12 dBm -13 dBm

Range Start / RANGE STOP ..uuuuuiiiciiiiiii e se e e e e e e e e e e e e e e e e e eeaees 253
11 (=T S Y o= P PP PPPPPP PR 253
L= SR 254
VBV et e e e e e et — e e e e e —e e e e e e taeeeeeaareeaeeanntaeeaeaanraes 254
SWEEP TIME MOUE ....evviiieiieeee ettt e e e e e e s e s sseae e eeeereaaaeessasannrnnes 254
SWEEP TIME ittt et e e e e e e s e et ae et eeaaaaessesaaasnsraaeeeeaaaasessaaannnrnnes 254
[ (=Tex (o] PP 254
RefErenCe LEVEI ... 254
RF Attenuation MOAe .......ooooiiie et 255
L N £ (=T a1 E= 1 1 o] o RS 255
SWEEP POINES.....eiiiiiiiii e e e e e e e 255
S (o] o AN 1 L= V=YY o SRR 255
LI =1 ST L Lo PSP 255
T3 O =Y o SRR 255
Abs Limit Start / Abs Limit STOP ceeeeiiiiii e 256
Insert before Range / Insert after RaNge ........ccueeeiiiiiiiiiii e 256
Delete RANGE ... 256

Range Start / Range Stop
Sets the start frequency/stop frequency of the selected range.

You can define a span that is smaller than the overall span of the ranges. In this case,
the measurement includes only the ranges that lie within the defined span and have a
minimum span of 20 Hz.

Remote command:
[SENSe:]LIST:RANGe<range>[:FREQuency] : STARt on page 719
[SENSe:]LIST:RANGe<range> [ :FREQuency] : STOP on page 719

Filter Type
Sets the filter type for this range.
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For details on filter types, see Chapter 7.5.1.6, "Which Data May Pass: Filter Types",
on page 364.

Remote command:
[SENSe:]LIST:RANGe<range>:FILTer:TYPE on page 718

RBW
Sets the RBW value for this range.

For details on the RBW, see Chapter 7.5.1.1, "Separating Signals by Selecting an
Appropriate Resolution Bandwidth", on page 361.

Remote command:
[SENSe:]LIST:RANGe<range>:BANDwidth:RESolution on page 716

VBW
Sets the VBW value for this range.

For details on the VBW, see Chapter 7.5.1.2, "Smoothing the Trace Using the Video
Bandwidth", on page 362.

Remote command:
[SENSe:]LIST:RANGe<range>:BANDwidth:VIDeo on page 717

Sweep Time Mode
Activates or deactivates the auto mode for the sweep time.

For details on the sweep time mode, see Chapter 7.5.1.7, "How Long the Data is Mea-
sured: Sweep Time ", on page 365

Remote command:
[SENSe:]LIST:RANGe<range>:SWEep:TIME:AUTO on page 722

Sweep Time
Sets the sweep time value for the range.

For details on the sweep time, see Chapter 7.5.1.7, "How Long the Data is Measured:
Sweep Time ", on page 365

Remote command:
[SENSe:]LIST:RANGe<range>:SWEep:TIME on page 722

Detector
Sets the detector for the range.

For details, refer to "Mapping Samples to sweep Points with the Trace Detector"”
on page 459.

Remote command:
[SENSe:]LIST:RANGe<range>:DETector on page 718

Reference Level
Sets the reference level for the range.

For details on the reference level, see Chapter 7.4.1.1, "Reference Level",
on page 352.
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Remote command:
[SENSe: ] LIST:RANGe<range>:RLEVel on page 722

RF Attenuation Mode
Activates or deactivates the auto mode for RF attenuation.

For details on attenuation, see Chapter 7.4.1.2, "RF Attenuation”, on page 353.

Remote command:
[SENSe:]LIST:RANGe<range>:INPut:ATTenuation:AUTO on page 720

RF Attenuation
Sets the attenuation value for that range.

For details on attenuation, see Chapter 7.4.1.2, "RF Attenuation”, on page 353.

Remote command:
[SENSe:]LIST:RANGe<range>:INPut:ATTenuation on page 720

Sweep Points
Sets the number of sweep points for the specified range.

For details on sweep points, see Chapter 7.5.1.8, "How Much Data is Measured:
Sweep Points and Sweep Count", on page 365.

Remote command:
[SENSe:]LIST:RANGe<range>:POINts on page 721

Stop After Sweep
This command configures the sweep behavior.

"On" The R&S FPS stops after one range is swept and continues only if
you confirm (a message box is displayed).
"Off" The R&S FPS sweeps all ranges in one go.

Remote command:
[SENSe:]LIST:RANGe<range>:BREak on page 717

Transducer
Sets a transducer for the specified range. You can only choose a transducer that fulfills
the following conditions:

® The transducer overlaps or equals the span of the range.
® The x-axis is linear.
® The unitis dB.

For details on transducers, see Chapter 10.3.1, "Basics on Transducer Factors",
on page 546.

Remote command:
[SENSe:]LIST:RANGe<range>:TRANsducer on page 723

Limit Check
Activates or deactivates the limit check for all ranges.

For details on limit checks, see Chapter 6.6.3.2, "Limit Lines in Spurious Measure-
ments", on page 251.
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"ABSOLUTE" Signal is checked against absolute limit values
"NONE" No limit check is performed.
Remote command:

[SENSe: ] LIST:RANGe<range>:LIMit:STATe on page 721
CALCulate<n>:LIMit<k>:FATL? on page 932

Abs Limit Start / Abs Limit Stop
Sets an absolute limit value at the start or stop frequency of the range [dBm].

Remote command:
[SENSe:]LIST:RANGe<range>:LIMit:STARt on page 720
[SENSe:]LIST:RANGe<range>:LIMit:STOP on page 721

Insert before Range / Insert after Range

Inserts a new range to the left of the currently focused range (before) or to the right
(after). The range numbers of the currently focused range and all higher ranges are
increased accordingly. The maximum number of ranges is 30.

Delete Range
Deletes the currently focused range. The range numbers are updated accordingly.

6.6.4.2 Adjusting the X-Axis to the Range Definitions

Access: "Overview" > "Select Measurement" > "Spurious Emissions" > "Adjust X-Axis"

The frequency axis of the measurement diagram can be adjusted automatically so that
the span of all sweep list ranges corresponds to the displayed span. Thus, the x-axis
range is set from the start frequency of the first sweep range to the stop frequency of
the last sweep range.

6.6.4.3 List Evaluation

Access: "Overview" > "Select Measurement" > "Spurious Emissions" > "List Evalua-
tion"

Configure the contents and display of the result list.



Spurious Emissions Measurement

List Evaluation State Off

S

Settings
Show Peaks Off
Margin 200.0 dB

Details Off

tion List

Decimal Seperator SOl COMMA

Save

List EValuation STate ........oooeiiiiiiiiiiiieccee e 257
] AT LA oY= 257
1V E= o 11 O PP PP PP PRSPPI 257
(D= = 11N 257
Peaks Per RaANGE ........ooiiiiiiii e e 258
Save Evaluation LiSt .....ccoooiiieiiiiiiiiceeeeeee et 258

List Evaluation State
Activates or deactivates the list evaluation.

Remote command:
CALCulate<n>:ESPectrum:PEAKsearch:AUTO on page 710
TRACe<n>[:DATA] on page 854

Show Peaks
If activated, all peaks that have been detected during an active list evaluation are
marked with blue squares in the diagram.

Remote command:
CALCulate<n>:ESPectrum:PEAKsearch:PSHow on page 711

Margin

A margin functionality is not available for the limit check. However, you can define a
margin (=threshold) for the peak values to be displayed in the evaluation list. Only
peaks that exceed the margin value are displayed (also in the diagram, if activated).

Remote command:
CALCulate<n>:ESPectrum:PEAKsearch:MARGin on page 711

Details
Configures how detailed the list in the Result Summary is.
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On Includes all detected peaks (up to a maximum defined by "Peaks per Range" ).

Off Includes only one peak per range.

Remote command:
CALCulate<n>:ESPectrum:PEAKsearch:DETails on page 724

Peaks per Range

Defines the maximum number of peaks per range that are stored in the list. Once the
selected number of peaks has been reached, the peak search is stopped in the current
range and continued in the next range. The maximum value is 50.

Remote command:
CALCulate<n>:PEAKsearch:SUBRanges oOnh page 725

Save Evaluation List

Exports the evaluation list of the Spurious Emissions measurement to an ASCII file for
evaluation in an external application. If necessary, change the decimal separator for
evaluation in other languages.

Define the file name and storage location in the file selection dialog box that is dis-
played when you select the "Save" function.

For details, see "How to Save the Spurious Emissions Evaluation List" on page 259.

Remote command:
MMEMory : STORe<n>:LIST on page 963
FORMat : DEXPort:DSEParator on page 937

How to Perform a Spurious Emissions Measurement

The following step-by-step instructions demonstrate how to perform spurious emis-
sions measurements.

For remote operation, see Chapter 12.5.7.6, "Programming Example: Spurious Emis-
sions Measurement", on page 726.

1. Press the MEAS key, then select the "Spurious Emissions" measurement.
2. Define the span of the signal to be monitored in the general span settings.

3. Select the "Overview" softkey, then select the "Spurious Setup" button.

The "Spurious Emissions" dialog box is displayed.

4. Split the frequency span of the measurement into ranges for signal parts with simi-
lar characteristics.
Define the required ranges in the "Sweep List" using the "Insert before Range" and
"Insert after Range" buttons, which refer to the currently selected range.

5. Define the measurement parameters for each range as required.

6. Optionally, define a limit check.
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a) Activate the limit check by setting "Limit Check" to "ABSOLUTE" . The limit
check is always activated or deactivated for all ranges simultaneously.

b) Define the limit line's start and stop values for each range of the signal. If a sig-
nal level higher than the defined limit is measured, the limit check fails, which
may indicate a spurious emission.

7. Configure the peak detection during a Spurious Emissions measurement: select
the "Evaluations” button in the "Overview" .

e To indicate the determined peaks in the display, activate the "Show Peaks"
option.

e To restrict peak detection, define a "Margin" . Only peaks that exceed this
value are detected.

e To allow for more peaks per range to be detected than the default 1, increase
the "Peaks per Range" value and set "Details" to "On" .

8. Start a sweep.

The determined powers and limit deviations for each range are indicated in the
evaluation list. If activated, the peak power levels for each range are also indicated
in the diagram.

9. To save the evaluation list, export the results to a file as described in "How to Save
the Spurious Emissions Evaluation List" on page 259.
How to Save the Spurious Emissions Evaluation List

The evaluation list from a Spurious Emissions measurement can be saved to a file,
which can be exported to another application for further analysis, for example.

1. Configure and perform a Spurious Emissions measurement as described in Chap-
ter 6.6.5, "How to Perform a Spurious Emissions Measurement", on page 258.

2. Select the "Evaluations" button in the "Overview" .

3. If necessary, change the "Decimal Separator" to "COMMA" for evaluation in other
languages.

4. Select the "Save" button.

5. In the file selection dialog box, select a storage location and file name for the result
file.

6. Select the "Save" button.

The file with the specified name and the extension . dat is stored in the defined
storage location.

6.6.6 Reference: ASCII Export File Format (Spurious)
The file has a header containing important parameters for scaling, several data sec-

tions containing the sweep settings per range, and a data section containing the peak
list.
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The header data is made up of three columns, separated by ';', with the syntax:

Parameter name; numeric value; basic unit

File contents Explanation

File header

Type;FPS-13; Model

Version;1.00; Firmware version

Date;31.Mar 11; Storage date of data set
Mode;ANALYZER; SPURIOUS; Operating mode and measurement function
Center Freq;13250000000.000000;Hz X-axis settings

Freq Offset;0.000000;Hz

Span;26499982000.000000;Hz

x-Axis;LIN;

Start;9000.000000;Hz
Stop;8000000000.000000;Hz

Level Offset;0.000000;dB Y-axis settings

Ref Position;100.000000;%

y-Axis;LOG;

Level Range;100.000000;dB

Trace settings

Trace Mode;CLR/WRITE;

Sweep Count;1;

TRACE 1:

Trace Mode;CLR/WRITE;

x-Unit;Hz;

y-Unit;dBm;

List evaluation settings

Margin;6.000000;s Peak List margin
PeaksPerRange;25; Max. number of peaks per range to be detected
Values;3; Number of detected peaks




Statistical Measurements (APD, CCDF)

File contents Explanation

File data section

0;9000;150000;1000;79500;-25.006643295288086;- | Measured peak values:
12.006643295288086;PASS;

0;9000;150000;1000;101022.11126961483;-47.075
111389160156;-34.075111389160156;PASS;

0:9000;150000;1000;58380.171184022824;-47.079 . .
341888427734;-34.079341888427734;PASS; <resolution bandwidth of range>;

<frequency of peak>;

<range number>;
<start frequency>;

<stop frequency>;

<absolute power in dBm of peak>;

<distance to the limit line in dB>; (positive value
means above the limit)

<limit fail (pass = 0, fail =1)>;

6.7 Statistical Measurements (APD, CCDF)

To measure the amplitude distribution, the R&S FPS has simple measurement func-
tions to determine both the Amplitude Probability Distribution (APD) and the Comple-
mentary Cumulative Distribution Function (CCDF). Only one of the signal statistic func-
tions can be switched on at a time.

o  AbOUL the MEaSUIEMENES....c..ci it 261
o Typical APPIICAtIONS......ccvvieiiiiiiicceie e e e e e e e e e e e e e e 262
® APD and CCDF RESUILS.....coiiiiieeieee et e e e 262
e APD and CCDF Basics - Gated Triggering.......uuuueiccceiieieieeeee e a e 265
o APD and CCDF Configuration.........cc.ueeuiiiieiiie it 266
e How to Perform an APD or CCDF Measurement........cccoccveeieiniiieieeinnieeee e 272
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6.7.1 About the Measurements

The probability of amplitude values can be measured with the Amplitude Probability
Distribution function (APD). During a selectable measurement time all occurring ampli-
tude values are assigned to an amplitude range. The number of amplitude values in
the individual ranges is counted and the result is displayed as a histogram.

Alternatively, the Complementary Cumulative Distribution Function (CCDF) can be dis-
played. It shows the probability that the mean signal power amplitude will be exceeded
in percent.

Only one of the signal statistic functions can be switched on at a time. When a statistic
function is switched on, the R&S FPS is set into zero span mode automatically. The
R&S FPS measures the statistics of the signal applied to the RF input with the defined
analysis bandwidth. To avoid affecting the peak amplitudes the video bandwidth is
automatically set to 10 times the analysis bandwidth. The sample detector is used for
detecting the video voltage.
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Statistic measurements on pulsed signals can be performed using a gated trigger. For
details see Chapter 6.7.4, "APD and CCDF Basics - Gated Triggering", on page 265.

6.7.2 Typical Applications

Digital modulated signals are similar to white noise within the transmit channel, but are
different in their amplitude distribution. In order to transmit the modulated signal without
distortion, all amplitudes of the signal have to be transmitted linearly from the output
power amplifier. Most critical are the peak amplitude values. Degradation in transmit
quality caused by a transmitter two port network is dependent on the amplitude of the
peak values as well as on their probability.

If modulation types are used that do not have a constant envelope in zero span, the
transmitter has to handle peak amplitudes that are greater than the average power.
This includes all modulation types that involve amplitude modulation, QPSK for exam-
ple. CDMA transmission modes in particular may have power peaks that are large
compared to the average power.

For signals of this kind, the transmitter must provide large reserves for the peak power
to prevent signal compression and thus an increase of the bit error rate at the receiver.
The peak power or the crest factor of a signal is therefore an important transmitter
design criterion. The crest factor is defined as the peak power to mean power ratio or,
logarithmically, as the peak level minus the average level of the signal. To reduce
power consumption and cut costs, transmitters are not designed for the largest power
that could ever occur, but for a power that has a specified probability of being excee-
ded (e.g. 0.01 %).

The statistical functions provide information on such signal criteria.

6.7.3 APD and CCDF Results

Amplitude Probability Distribution (APD)

As a result of the Amplitude Probability Distribution (APD) function, the probability of
measured amplitude values is displayed. During a selectable measurement time all
measured amplitude values are assigned to an amplitude range (bin). The number of
amplitude values in the individual ranges is counted and the result is displayed as a
histogram. Each bar of the histogram represents the percentage of measured ampli-
tudes within the specific amplitude range. The x-axis represents the amplitude values
and is scaled in absolute values (dBm).

The size of each amplitude range (bin) determines the resolution of the histogram and
is indicated in the channel bar, for example /0.70 dB. In this case, a single bar in the
histogram represents an amplitude range of 0.10 dB.

HE
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MultiView 22 Spectrum
J 0.10 dB = AnBW 40 MHz

9 dE  Meas Time 12.5ms
*153 Clrw

CF 100,0 MHz Ref -0.50 dBm

2 Result Summary — Samples: 500000
Mean Crest

Trace 1 -7.27 dBm 10.58 dB

In addition to the histogram, a result table is displayed containing the following informa-
tion:
® Number of samples used for calculation
® For each displayed trace:
— Mean amplitude
— Peak amplitude

— Crest factor
The crest factor is defined as the peak power to mean power ratio or, logarith-
mically, as the peak level minus the average level of the signal.

Complementary Cumulative Distribution Function (CCDF)

The Complementary Cumulative Distribution Function (CCDF) shows the probability
that the mean signal power amplitude will be exceeded in percent. The level above the
mean power is plotted along the x-axis of the graph. The origin of the axis corresponds
to the mean power level. The probability that a level will be exceeded is plotted along
the y-axis.

|
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MultiView 22 Spectrum

Ref Level -0.50 1 = AnNBW 40 MHz
At S d8  Meas Time 12 3

1 CCDF

Mean Pwr
Samples: 500000
Peak Crest
Trace 1 -7.22 dBm 3.34 dBm 10.56 dB

A red line indicates the ideal Gaussian distribution for the measured amplitude range.

The displayed amplitude range is indicated as "Mean Pwr" + "<x dB>"

In addition to the histogram, a result table is displayed containing the following informa-
tion:

® Number of samples used for calculation
® For each displayed trace:

Mean Mean power

Peak Peak power

Crest Crest factor (peak power — mean power)

10 % Level values over 10 % above mean power
1% Level values over 1 % above mean power
0,1% Level values over 0,1 % above mean power
0,01 % Level values over 0,01 % above mean power

Percent marker

In addition to the results for specific percentages in the table, a percent marker can be
activated for a freely selectable percentage. This marker indicates how many level val-
ues are over <x> % above the mean power.
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Percent marker
As all markers, the percent marker can be moved simply by selecting it with a finger or
mouse cursor and dragging it to the desired position.

Diagram Scaling

The scaling for both the x-axis and y-axis of the statistics diagram can be configured.
In particular, you can restrict the range of amplitudes to be evaluated and the probabili-
ties to be displayed.

Remote commands:

CALCulate<n>:STATistics:CCDF:X<t>? on page 735

CALCulate<n>:STATistics:RESult<t>? on page 736

6.7.4 APD and CCDF Basics - Gated Triggering
Statistic measurements on pulsed signals can be performed using a gated trigger. An
external frame trigger is required as a time (frame) reference.

The gate ranges define the part of the measured data taken into account for the statis-
tics calculation. These ranges are defined relative to a reference point T=0. The gate
interval is repeated for each period until the end of the capture buffer.

The reference point T=0 is defined by the external trigger event and the instrument's
trigger offset.

For each trace you can define up to 3 separate ranges of a single period to be traced.
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Input
Signal

Ext Trigger r‘

Tri:gger : Period : Period g Period
Offget

T=0 Range1 Range 2
Start Stop Start Stop

6.7.5 APD and CCDF Configuration

Configuration consists of the following settings:

®  BasiC SetliNgS....ccc i —————————————— 266
e Gate Range Definition for APD and CCDF..........uuiiviieeiiii e 268
e Scaling for Statistics Diagrams

6.7.5.1 Basic Settings

Access: "Overview" > "Select Measurement" > "APD" / "CCDF" > "APD Config" /
"CCDF Config"
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The remote commands required to perform these tasks are described in Chap-
ter 12.5.8, "Analyzing Statistics (APD, CCDF)", on page 728.

Both dialog boxes are identical except for the "Percent Marker" setting, which is only
available for CCDF measurements.

Percent Marker (CCDF ONIY)...uuuiiiiiiiee ittt e e e e e e e e aree e e e aaae s 267
Analysis Bandwidth ..........ooo i —————— 267
NUmMber of SAMPIES ... e e 267
(€ T= ) C=To I I o o =T PO PUTUTPPPR 268
Edit Gate RANGES ...ooiiiiiiiiiie e 268
AJUST SEEHINGS .. e 268

Percent Marker (CCDF only)

Defines a probability value. Thus, the power which is exceeded with a given probability
can be determined very easily. If marker 1 is deactivated, it is switched on automati-
cally.

Remote command:
CALCulate<n>:MARKer<m>:Y:PERCent on page 729

Analysis Bandwidth
Defines the analysis bandwidth.

For correct measurement of the signal statistics, the analysis bandwidth has to be
wider than the signal bandwidth in order to measure the peaks of the signal amplitude
correctly. To avoid influencing the peak amplitudes, the video bandwidth is automati-
cally set to 10 MHz. The sample detector is used for detecting the video voltage.

The calculated measurement time is displayed for reference only.

Remote command:
[SENSe: ] BANDwidth[:RESolution] on page 785

Number of Samples

Defines the number of power measurements that are taken into account for the statis-
tics.
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For statistics measurements with the R&S FPS, the number of samples to be mea-
sured is defined instead of the sweep time. Since only statistically independent sam-
ples contribute to statistics, the sweep or measurement time is calculated automatically
and displayed in the channel bar ( "Meas Time" ). The samples are statistically inde-
pendent if the time difference is at least 1/RBW. The measurement time is, therefore,
expressed as follows:

Meas Time = Ngampies/ RBW

Remote command:
CALCulate<n>:STATistics:NSAMples on page 729

Gated Trigger

Activates and deactivates gating for statistics functions for the ACP and the CCDF
measurements. If activated, the trigger source is changed to "External Trigger 1" . The
gate ranges are defined using the Edit Gate Ranges function.

Remote command:
[SENSe: ] SWEep:EGATe: TRACe<t>[:STATe<range>] on page 731

Edit Gate Ranges
Opens a dialog box to configure up to 3 gate ranges for each trace. For details see
Chapter 6.7.5.2, "Gate Range Definition for APD and CCDF", on page 268.

Adjust Settings

Adjusts the level settings according to the measured difference between peak and min-
imum power for APD measurement or peak and mean power for CCDF measurement
in order to obtain maximum power resolution. Adjusts the reference level to the current
input signal.

Remote command:

CALCulate<n>:STATistics:SCALe:AUTO ONCE on page 733

6.7.5.2 Gate Range Definition for APD and CCDF
Access: "Overview" > "Select Measurement" > "APD" / "CCDF" > "APD Config" /
"CCDF Config" > "Edit Gate Ranges"
You can configure gate ranges for gated triggering in statistical measurements.

For background information on defining gate ranges see Chapter 6.7.4, "APD and
CCDF Basics - Gated Triggering", on page 265.

The remote commands required to perform these tasks are described in Chap-
ter 12.5.8.3, "Using Gate Ranges for Statistical Measurements", on page 730.
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Trace 1

Range 1 Use
Range 1 Start
Range 1 Stop
Range 2 Use
Range 2 Start
Range 2 Stop

Range 3 Use

Range 3 Start

Range 3 Stop

Up to three ranges can be defined for each of the six available traces.

(070100100 1=T 0 | EUT TP PRSP 269
=Y T T S 269
RANGE SXZ USE ..ottt e ettt a e s e s e e e e e e aaaaaaaaeeaaeaees 269
RaNge <X> Start/STOP ..oveeeiiiiiiiie i aa e e 269
Comment

An optional comment can be defined for the gate range settings of each trace.

Remote command:
[SENSe: ] SWEep:EGATe: TRACe<t>:COMMent on page 730

Period
Length of the period to be traced. The period is the same for all traces. If you change
the period for one trace, it is automatically changed for all traces.

Make sure the defined period is not longer than the total measurement time of the cur-
rent measurement. Keep in mind that the measurement time depends on the band-
width and the number of samples (see " Number of Samples " on page 267). The cur-
rent measurement time is indicated as "Meas Time" in the channel bar.

Remote command:
[SENSe: ] SWEep:EGATe: TRACe: PERiod on page 730

Range <x> Use
Activates tracing of the defined range during a gated measurement.

Remote command:
[SENSe: ] SWEep:EGATe: TRACe<t>[:STATe<range>] on page 731

Range <x> Start/Stop
Defines the start and stop points of the range within the tracing period. Make sure the
value for the stopping time is smaller than the length of the period.

Note: You can define the time values with a greater numerical resolution than is dis-
played; the values are only rounded for display.

HE
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Remote command:
[SENSe: ] SWEep:EGATe: TRACe<t>:STARt<range> on page 730
[SENSe: ] SWEep:EGATe: TRACe<t>:STOP<range> on page 731

6.7.5.3 Scaling for Statistics Diagrams

Access: "Overview" > "Amplitude" > "Scale" tab
Or: AMPT > "Scale Config"
For statistics displays, scale settings are available for both the y-axis and the x-axis.

The remote commands required to perform these tasks are described in Chap-
ter 12.5.8.4, "Scaling the Diagram", on page 732.

Amplitude Scale

Range 20 dB ¥-Unit Pct
REVERSVER 0.0 dBm Y-Max [l

Otfset 0.0 dB ¥-Min

Adjust Settings Default Settings

Figure 6-39: Scale settings for CCDF diagram

In statistical diagrams, the x-axis displays the signal level values (= y-axis in standard
display), while the y-axis displays the probability of the values.

i

D SRS 271
L REF LEVEI oueieieeeieee ettt ettt 271
L Yo 1= RO 271
L Shifting the Display ( OffSEt ).......cvveieereeeeeeeeeeeeee st 271
B N SRS 271
L Y oUNIE 1ottt sttt 271
L Y-MAX T Y-MIN oottt 271
D= F= UL 7= 1 oo [T 271
o [0S S 1= ] e 1= U SUPRPRPPN 272
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X-Axis
Defines the scaling settings for signal level values.

Ref Level < X-Axis

Defines the reference level for the signal levels in the currently active unit (dBm, dBuV,
etc.).

For the APD function this value corresponds to the right diagram border. For the CCDF
function there is no direct representation of this value on the diagram as the x-axis is
scaled relatively to the measured mean power.

Remote command:
CALCulate<n>:STATistics:SCALe:X:RLEVel on page 733

Range — X-Axis
Defines the level range in dB to be evaluated by the statistics measurement.

Remote command:
CALCulate<n>:STATistics:SCALe:X:RANGe on page 733

Shifting the Display ( Offset ) «— X-Axis

Defines an arithmetic level offset. This offset is added to the measured level irrespec-
tive of the selected unit. The scaling of the x-axis is changed accordingly. The setting
range is £200 dB in 0.1 dB steps.

Remote command:
DISPlay[:WINDow<n>] :TRACe<t>:Y[:SCALe] :RLEVel:OFFSet on page 793

Y-Axis
Defines the scaling settings for the probability distribution.

Y-Unit — Y-Axis
Defines the scaling type of the y-axis as either percentage or absolute. The default
value is absolute scaling.

Remote command:
CALCulate<n>:STATistics:SCALe:Y:UNIT on page 734

Y-Max / Y-Min < Y-Axis

Defines the upper (max) and lower (min) limit of the displayed probability range. Values
on the y-axis are normalized which means that the maximum value is 1.0. The mini-
mum value must be in the range:

1E-9 < Y-Min < 0.1

The distance between "Y-Max" and "Y-Min" must be at least one decade.

Remote command:

CALCulate<n>:STATistics:SCALe:Y:UPPer on page 734
CALCulate<n>:STATistics:SCALe:Y:LOWer on page 734

Default Settings
Resets the x- and y-axis scalings to their preset values.
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X-axis ref level: -10 dBm
X-axis range APD: 100 dB
X-axis range CCDF: 20 dB
Y-axis upper limit: 1.0
Y-axis lower limit: 1E-6

Remote command:
CALCulate<n>:STATistics:PRESet on page 732

Adjust Settings

Adjusts the level settings according to the measured difference between peak and min-
imum power for APD measurement or peak and mean power for CCDF measurement
in order to obtain maximum power resolution. Adjusts the reference level to the current
input signal.

Remote command:

CALCulate<n>:STATistics:SCALe:AUTO ONCE on page 733

How to Perform an APD or CCDF Measurement

The following step-by-step instructions demonstrate how to perform basic statistic
measurements.

For remote operation, see Chapter 12.5.8.7, "Programming Example: Measuring Sta-
tistics", on page 736.

To start a basic statistic measurement

1. Press the MEAS key, then select the "APD" or "CCDF" measurement.

2. Start a sweep.
As soon as the defined number of samples have been measured, the statistical
evaluation is displayed.

To perform a statistic measurement using gate ranges

For pulsed signals, the transmission intervals should not be included in the statistical
evaluation. Thus, you must define gate ranges to be included in the measurement.

1. Press the MEAS CONFIG key, then select the "APD Config" or "CCDF Config"
softkey.

The "APD" "APD" or "CCDF" dialog box is displayed.
2. Select the "Edit Gate Ranges" button.

3. Define the time period for which the input signal is to be analyzed, for example the
duration of 3 signal pulses.
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4. For each active trace, define up to three ranges within the time period to be mea-
sured. In the example covering 3 pulses, you could define one range for each
pulse.

a) Assuming the external trigger determines T=0 as the start of the first pulse,
define the start time of range 1 at 0 s.

b) Define the stop time of range 1 at the duration of the first pulse.

c) Activate range 1 by setting "Range 1 Use" to On.

d) Define the start time of range 2 as (duration of pulse 1 + duration of interval)

e) Define the stop time of range 2 as (start time of range 2 + duration of pulse 2)

f) Activate range 2 by setting "Range 2 Use" to On.

g) Define the third range in the same way.

5. Start a sweep.

As soon as the defined number of samples have been measured, the statistical
evaluation is displayed. Only the signal levels within the pulse periods are consid-
ered.

6.7.7 Examples

6.7.7.1 Configuration Example: Gated Statistics

A statistics evaluation has to be done over the useful part of the signal between t3 and
t4. The period of the GSM signal is 4.61536 ms.

Ext I—‘

Trigger-
t1 2 13 1415

t1: External positive trigger slope

t2: Begin of burst (after 25 us)

t3: Begin of useful part, to be used for statistics (after 40 us)

t4: End of useful part, to be used for statistics (after 578 ps)
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t5: End of burst (after 602 ps)

The instrument has to be configured as follows:

Trigger Offset t2-t1=25ps now the gate ranges are relative to t2
Range1 Start t3-t2=15ps start of range 1 relative to t2
Range1 End t4 —t2 =553 ps end of range 1 relative to t2

6.7.7.2 Measurement Example — Measuring the APD and CCDF of White Noise Gener-
ated by the R&S FPS

Setting the RBW

0 When the amplitude distribution is measured, the analysis bandwidth must be set so
that the complete spectrum of the signal to be measured falls within the bandwidth.
This is the only way of ensuring that all the amplitudes will pass through the IF filter
without being distorted. If the selected bandwidth is too small for a digitally modulated
signal, the amplitude distribution at the output of the IF filter becomes a Gaussian dis-
tribution according to the central limit theorem and thus corresponds to a white noise
signal. The true amplitude distribution of the signal therefore cannot be determined.

A programming example demonstrating a statistics measurement in a remote environ-
ment is provided in Chapter 12.5.8.7, "Programming Example: Measuring Statistics",
on page 736.

1. Preset the R&S FPS.

2. Set the reference level to -60 dBm.

The R&S FPS's intrinsic noise is displayed at the top of the screen.

3. Select the "APD" measurement function from the "Select Measurement" dialog
box.

The R&S FPS sets the frequency span to 0 Hz and measures the amplitude proba-
bility distribution (APD). The number of uncorrelated level measurements used for
the measurement is 100000. The mean power and the peak power are displayed in
dBm. The crest factor (peak power — mean power) is output as well.
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MultiView  Spectrum
= RBW 3 MHz
AQT 1.5 ms

.2 Ref -60.00 dBm
ult Summary — Samples: 100000

Mean Peak Crest
Trace 1 -88.68 dBm -77.57 dBm 11.10 dB

Figure 6-40: Amplitude probability distribution of white noise

4. Now select the "CCDF" measurement function from the "Select Measurement" dia-
log box.

MultiView Spectrum

Ref Level 3 REW 3 MHz
Att ¢

1 CCDF

.25 GHz Mean Pwr + 20,00 dB

ult Summary arm 100000
Mean Peak
Trace 1 -88.65 dBm -78.87 dBm

Figure 6-41: CCDF of white noise

The CCDF trace indicates the probability that a level will exceed the mean power.
The level above the mean power is plotted along the x-axis of the graph. The origin
of the axis corresponds to the mean power level. The probability that a level will be
exceeded is plotted along the y-axis.
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6.7.8 Optimizing and Troubleshooting the Measurement

If the results do not meet your expectations, try the following methods to optimize the
measurement:

® Make sure the defined bandwidth is wide enough for the signal bandwidth of the
device under test to be fully analyzed (see " Analysis Bandwidth " on page 267).

® |f the complete signal is be measured, increase the number of samples so that the
resulting measurement time is longer than one period of a bursted signal.

® |[f only parts of the signal are to be examined, define a trigger source and a gate.

6.8 Time Domain Power Measurement

The Time Domain Power measurement determines the power of a signal in the time
domain.

A time domain power measurement is only possible for zero span.

o  About the MeasuremMeNt...........cuii i 276
o Time Domain POWer RESUILS..........coiiiiiiiiiie e 276
e Time Domain Power Basics - Range Definition Using Limit Lines........................ 277
e Time Domain Power Configuration............ccocuueiiiiiiiiiiii e 278
e How to Measure Powers in the Time Domain............cccoeeiiiiiiiiiiiiieiieen, 279
e Measurement EXample.........ccuueiiiiiiiiiiii e 279

6.8.1 About the Measurement

Using the Time Domain Power measurement function, the R&S FPS determines the
power of the signal in zero span by summing up the power at the individual measure-
ment points and dividing the result by the number of measurement points. Thus it is
possible to measure the power of TDMA signals during transmission, for example, or
during the muting phase. Both the mean power and the RMS power can be measured.

For this measurement, the sample detector is activated.

6.8.2 Time Domain Power Results

Several different power results can be determined simultaneously:

Mode Description

Peak Peak value from the points of the displayed trace or a segment
thereof.

RMS RMS value from the points of the displayed trace or a segment
thereof.
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Mode Description

Mean Mean value from the points of the displayed trace or a segment
thereof. The linear mean value of the equivalent voltages is calcula-
ted.

For example to measure the mean power during a GSM burst

Std Dev The standard deviation of the measurement points from the mean
value.

The result is displayed in the marker results, indicated by "Power" and the selected
power mode, e.g. "RMS" . The measured values are updated after each sweep or
averaged over a user-defined number of sweeps (trace averaging).

MultiView Spectrum

Ref Level 0.00 dBm e RBW 100 kHz
Att 1048 = SWT 640 ps VBW 100 kHz
TRG:IFP
1 Time Domain Power

1061+ pts 64.0 pus,/

Stimulus Response i Function Result
591.6 ps -102.34 dBm -11.02 dBm
-12.89 dBm
-13.03 dBm
1.62 dB

The results can also be queried using the remote commands described in Chap-
ter 12.5.9, "Measuring the Time Domain Power", on page 738.

6.8.3 Time Domain Power Basics - Range Definition Using Limit Lines

The range of the measured signal to be evaluated for the power measurement can be
restricted using limit lines. The left and right limit lines (S1, S2) define the evaluation
range and are indicated by vertical red lines in the diagram. If activated, the power
results are only calculated from the levels within the limit lines.

For example, if both the on and off phase of a burst signal are displayed, the measure-
ment range can be limited to the transmission or to the muting phase. The ratio
between signal and noise power of a TDMA signal for instance can be measured by
using a measurement as a reference value and then varying the measurement range.

In order to get stable measurement results for a limited evaluation range, usually a trig-
ger is required.
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6.8.4 Time Domain Power Configuration
Access: "Overview" > "Select Measurement" > "Time Domain Power" > "Time Dom
Power Config"

The remote commands required to perform these tasks are described in Chap-
ter 12.5.9, "Measuring the Time Domain Power", on page 738.

RESUIES .ottt e ettt e e e e et s e e e s e et e e e e s aaba e e e s eebaaeeaerenes 278
[N L1 RS 7= (YT 278
Left Limit / RIght LIMit .....oooriiiiier et e s e e e e snnnee s 278
Results

Activates the power results to be evaluated from the displayed trace or a limited area
of the trace.

"Peak" Peak power over several measurements (uses trace averaging, Max
Hold)

"RMS" RMS value from the points of the displayed trace or a segment
thereof.

"Mean" Mean value from the points of the displayed trace or a segment
thereof. The linear mean value of the equivalent voltages is calcula-
ted.

"Std Dev" The standard deviation of the measurement points from the mean
value.

The measurement of the mean power is automatically switched on at
the same time.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:PPEak[:STATe] on page 741
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:PPEak:RESult? on page 744
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:RMS[:STATe] on page 741
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:RMS:RESult? on page 745
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:MEAN[:STATe] on page 740
CALCulate<n>:MARKer<m>:FUNCtion:SUMMary:MEAN:RESult? on page 743

Limit State

Switches the limitation of the evaluation range on or off. Default setting is off.

If deactivated, the entire sweep time is evaluated. If switched on, the evaluation range
is defined by the left and right limit. If only one limit is set, it corresponds to the left limit
and the right limit is defined by the stop frequency. If the second limit is also set, it
defines the right limit.

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 870

Left Limit / Right Limit
Defines a power level limit for line S1 (left) or S2 (right).

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits:LEFT on page 871
CALCulate<n>:MARKer<m>:X:SLIMits:RIGHt on page 871
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6.8.5 How to Measure Powers in the Time Domain

The step-by-step procedure to measure powers in the time domain is described here in
detail.

For remote operation, see Chapter 12.5.9.4, "Programming Example: Time Domain
Power", on page 747.

To measure the power in the time domain

1. Select the "Time Domain Power" measurement function from the "Select Measure-
ment" dialog box.

2. Select the type of power measurement results to be determined by selecting the
corresponding softkeys.

3. To restrict the power evaluation range, define limits:

a) Select the "Time Dom Power Config" softkey to display the "Time Domain
Power" configuration dialog box.

b) Switch on the limits by setting the "Limit State" to "On" .
The limit lines S1 and S2 are displayed.

c) Define the left limit (limit line S1), the right limit (S2), or both.

4. Start a sweep.

The measured powers are displayed in the marker results.

6.8.6 Measurement Example

This measurement example demonstrates the time domain power calculation for a
GSM burst.

Test setup:

Signal Signal
Genarator > Analyzer

Signal generator settings (e.g. R&S FPS SMW):

Frequency: 1.8 GHz
Level: -10 dBm
Modulation: GSM/EDGE
Procedure:

1. Preset the R&S FPS.
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Set the center frequency to 1.8 GHz.
Set the RBW to 100 kHz.

Set the sweep time to 640 us.

Set the trigger source to "IF Power" .

Define a trigger offset of -50 us.

N o g &~ w DN

Select the "Time Domain Power" measurement function from the "Select Measure-
ment" dialog box.

®

In the Time Domain Power configuration dialog box, set all four results to "On" .
9. Set the "Limit State" to "On" .

10. Define the left limit at 326 us and the right limit at 538 us.
This range corresponds to the useful part of the GSM burst.

The mean power of the useful part of the GSM burst is calculated to be -13 dBm.

MultiView  Spectrum
Ref Level 0.00 dBm = RBW 100 kHz
Att dB = SWT 640 ps  VBW 100 kHz
TRG:IFP
1 Time Domain Power

1000 pts

Stimulus Response L 0 Function Result
591.6 ps -102.34 dBm T -11.02 dBm
T -12.89 dBm
-13.03 dBm
1.62 dB

6.9 Harmonic Distortion Measurement

The "Harmonic Distortion" measurement measures harmonics and their distortion,
including the total harmonic distortion.
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e Harmonic Distortion Configuration..............uuecceciiiiiii e 284
e How to Determine the Harmonic Distortion...........ccooeviviiiieiiiiiiiiicieeeeeeecee e, 286
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6.9.1 About the Measurement

With this measurement it is possible to measure the harmonics easily, for example
from a VCO. In addition, the total harmonic distortion (THD) is calculated.

For measurements in the frequency domain, the Harmonic Distortion measurement
starts with an automatic search for the first harmonic (= peak) within the set frequency
range. The center frequency is set to this frequency and the reference level is adjusted
accordingly.

For measurements in zero span, the center frequency remains unchanged.

The Harmonic Distortion measurement then performs zero span sweeps at the center
frequency and at each harmonic, i.e. at frequencies that are a multiple of the center
frequency.

As a result, the zero span sweeps on all harmonics are shown, as well as the RMS
values and the total harmonic distortion (THD).

An application note discussing harmonics measurement is available from the Rohde &
Schwarz website:

1EF78: Measurement of Harmonics using Spectrum Analyzers

6.9.2 Harmonic Distortion Basics

Measuring the harmonics of a signal is a frequent problem which can be solved best
using a signal analyzer. In general, every signal contains harmonics. Harmonics are
generated by nonlinear characteristics, which add frequencies to a pure sinewave.
They can often be reduced by low pass filters. Since the signal analyzer itself has a
nonlinear characteristic, for example in its first mixer, measures must be taken to
ensure that harmonics produced in the signal analyzer do not cause spurious results. If
necessary, the fundamental wave must be attenuated selectively with respect to the
other harmonics with a high pass filter. Harmonics are particularly critical regarding
high-power transmitters such as transceivers because large harmonics can interfere
with other radio services.

Harmonic distortion can be determined as the level of the individual components, or as
the root mean square of all components together, the total harmonic distortion (THD).
The THD is set in relation to the power of the fundamental frequency (= center fre-
quency).

Obtainable dynamic range

When harmonics are being measured, the obtainable dynamic range depends on the
second harmonic intercept of the signal analyzer. The second harmonic intercept is the
virtual input level at the RF input mixer at which the level of the 2nd harmonic becomes
equal to the level of the fundamental wave. In practice, however, applying a level of
this magnitude would damage the mixer. Nevertheless the available dynamic range for
measuring the harmonic distance of a DUT can be calculated relatively easily using the
second harmonic intercept.

HE
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Harmonic Distortion Measurement

As shown in Figure 6-42, the level of the 2"¢ harmonic drops by 20 dB if the level of the
fundamental wave is reduced by 10 dB.
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Figure 6-42: Extrapolation of the 1st and 2nd harmonics to the 2nd harmonic intercept at 40 dBm

The following formula for the obtainable harmonic distortion d, in dB is derived from the
straight-line equations and the given intercept point:

dz =S.H.l- P| (1)

where:
d, = harmonic distortion
S.H.I. = second harmonic intercept
Py = mixer level/dBm

6 The mixer level is the RF level applied to the RF input minus the set RF attenuation.

The formula for the internally generated level P, at the 2" harmonic in dBm is:
P,=2*P,—-S.H.l. (2)

The lower measurement limit for the harmonic is the noise floor of the signal analyzer.
The harmonic of the measured DUT should — if sufficiently averaged by means of a
video filter — be at least 4 dB above the noise floor so that the measurement error due
to the input noise is less than 1 dB.

Rules for measuring high harmonic ratios

The following rules for measuring high harmonic ratios can be derived:

® Select the smallest possible IF bandwidth for a minimal noise floor.
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® Select an RF attenuation which is high enough to measure the harmonic ratio only.

The maximum harmonic distortion is obtained if the level of the harmonic equals the
intrinsic noise level of the receiver. The level applied to the mixer, according to (2), is:

P, = Lo

!

! dBm + P2
2

At a resolution bandwidth of 10 Hz (noise level -143 dBm, S.H.l. = 40 dBm), the opti-
mum mixer level is — 51.5 dBm. According to (1) a maximum measurable harmonic dis-
tortion of 91.5 dB minus a minimum S/N ratio of 4 dB is obtained.

Detecting the origin of harmonics

If the harmonic emerges from noise sufficiently (approx. >15 dB), it is easy to check (by
changing the RF attenuation) whether the harmonics originate from the DUT or are
generated internally by the signal analyzer. If a harmonic originates from the DUT, its
level remains constant if the RF attenuation is increased by 10 dB. Only the displayed
noise is increased by 10 dB due to the additional attenuation. If the harmonic is exclu-
sively generated by the signal analyzer, the level of the harmonic is reduced by 20 dB
or is lost in noise. If both — the DUT and the signal analyzer — contribute to the har-
monic, the reduction in the harmonic level is correspondingly smaller.

6.9.3

High-sensitivity harmonics measurements

If harmonics have very small levels, the resolution bandwidth required to measure
them must be reduced considerably. The sweep time is, therefore, also increased con-
siderably. In this case, the measurement of individual harmonics is carried out with the
R&S FPS set to a small span. Only the frequency range around the harmonics will then
be measured with a small resolution bandwidth.

Required measurement time

During the harmonics measurement, zero span sweeps are performed at the center
frequency and at each harmonic. The duration of each sweep ( "Harmonic Sweep
Time" , SWT) and the "Number of Harmonics" (n) are defined in the "Harmonic Distor-
tion" configuration dialog box. Thus, the required measurement time for the harmonic
distortion measurement (Cumulated Measurement Time, CMT) is:

CMT =n*SWT

The required measurement time is indicated as "CMT" in the channel bar.

Harmonic Distortion Results

As a result of the harmonics distortion measurement, the zero span sweeps of all
detected harmonics are shown in the diagram, separated by red display lines. This pro-
vides a very good overview of the measurement.
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|

Multiview  Spectrum

ReflLevel 1
ALt
1 Harmonic Distortion * 1AP Clrw

106¢pts

MHz

Power 2
12.35 dBm ; G 1 z -64.70 dBc
-43.91 dBc -65.12 dBc
-57.16 dBc -65.98 dBc
-65.47 dBc ] 1 -65.26 dBc
-66.08 dBc 10 6.0000 10 z -64.40 dBc

In addition, a result table is displayed providing the following information:

® First harmonic frequency
® THD (total harmonic distortion), relative and absolute values
® For each detected harmonic:

— Frequency

- RBW

—  Power

Remote commands
The results can also be queried using remote commands.

The first harmonic frequency can be read out via the general center frequency com-
mand [SENSe: ] FREQuency:CENTer on page 777.

THD: cALCulate<n>:MARKer<m>:FUNCtion:HARMonics:DISTortion?
on page 750

List of harmonics: CAL.Culate<n>:MARKer<m>:FUNCtion:HARMonics:LIST?
on page 750
6.9.4 Harmonic Distortion Configuration

Access: "Overview" > "Select Measurement" > "Harmonic Distortion" > "Harmonic Dis-
tortion Config"
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Number of Harmonics |l

Harmonic Sweep Time |[ERINS

Harmonic RBW Auto Off

Adjust Settings

The remote commands required to perform these tasks are described in Chap-
ter 12.5.10, "Measuring the Harmonic Distortion", on page 748.
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AJUST SEEHINGS ..t s 285

Number of Harmonics
Defines the number of harmonics to be measured. The range is from 1 to 26. Default is
10.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:HARMonics:NHARmonics on page 749

Harmonic Sweep Time

Defines the sweep time for the zero span measurement on each harmonic frequency.
This setting is identical to the normal sweep time for zero span, see also " Sweep Time
"on page 368.

Remote command:
[SENSe: ] SWEep: TIME: AUTO on page 790

Harmonic RBW Auto
Enables/disables the automatic adjustment of the resolution bandwidth for Normal
(3dB) (Gaussian) and 5-Pole filter types.

The automatic adjustment is carried out according to:
"RBW, = RBW, * n"

If RBW,, is not available, the next higher value is used.
Remote command:

CALCulate<n>:MARKer<m>:FUNCtion:HARMonics:BANDwidth:AUTO
on page 749

Adjust Settings

If harmonic measurement was performed in the frequency domain, a new peak search
is started in the frequency range that was set before starting the harmonic measure-
ment. The center frequency is set to this frequency and the reference level is adjusted
accordingly.
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If harmonic measurement was performed in the time domain, this function adjusts the
reference level only.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:HARMonics:PRESet on page 749

6.9.5 How to Determine the Harmonic Distortion

In Chapter 8.3.6, "Measurement Example: Measuring Harmonics Using Marker Func-

@ tions", on page 439, measuring harmonics was described using marker functions. This
task can be performed much simpler using the Harmonic Distortion measurement, as
described in the following procedure.

For remote operation, see Chapter 12.5.10.5, "Example: Measuring the Harmonic Dis-
tortion", on page 751.

1. Select the "Harmonic Distortion" measurement function from the "Select Measure-
ment" dialog box.

2. Define the number of harmonics to be determined using the "Number of Harmon-
ics" softkey.

3. Perform a sweep.

The trace for the determined harmonics are displayed in the diagram, separated by
red display lines. The measured power for each harmonic in relation to the funda-
mental is indicated in the result table.

4. If the signal changes significantly during or after the harmonics measurement, use
the "Adjust Settings" function to adjust the settings automatically and restart the
measurement.

6.10 Third Order Intercept (TOl) Measurement

The third order intercept point of the R&S FPS can be determined if a two-tone signal
with equal carrier levels is applied to the input.

CALCulate<n>:MARKer<m>:FUNCtion:TOI:RESult? on page 753

o About the TOI MeasuremMeEnt........occuuiiiiiiiiiiie et e e e 287
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6.10.1 About the TOl Measurement

If several signals are applied to a transmission two-port device with nonlinear charac-
teristic, intermodulation products appear at its output at the sums and differences of
the signals. The nonlinear characteristic produces harmonics of the useful signals
which intermodulate at the characteristic. The intermodulation products of lower order
have a special effect since their level is largest and they are near the useful signals.
The intermodulation product of third order causes the highest interference. It is the
intermodulation product generated from one of the useful signals and the 2nd harmonic
of the second useful signal in case of two-tone modulation.

In order to measure the third order intercept point (TOIl), a two-tone signal with equal
carrier levels is expected at the R&S FPS input. Marker 1 and marker 2 (both normal
markers) are set to the maximum of the two signals. Marker 3 and marker 4 are placed
on the intermodulation products.

The R&S FPS calculates the third order intercept point from the level difference
between the first 2 markers and the markers 3 and 4 and displays it in the marker
table.

6.10.2 TOI Basics

If several signals are applied to a transmission two-port device with nonlinear charac-
teristic, intermodulation products appear at its output at the sums and differences of
the signals. The nonlinear characteristic produces harmonics of the useful signals
which intermodulate at the characteristic.

The frequencies of the intermodulation products are above and below the useful sig-
nals. The Figure 6-43 shows intermodulation products Pg4 and Pg, generated by the
two useful signals Py, and Py,.
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Level
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Figure 6-43: Intermodulation products Ps1 and Ps2
The intermodulation product at f;; is generated by mixing the 2nd harmonic of useful
signal Py, and signal Py;.

Tthe intermodulation product at f;; is generated by mixing the 2nd harmonic of useful
signal Py4 and signal Py,.

fir =2 xf, —f, (1)
fio =2 xf, -1, (2)

Dependency on level of useful signals

The level of the intermodulation products depends on the level of the useful signals. If
the two useful signals are increased by 1 dB, the level of the intermodulation products
increases by 3 dB, which means that the spacing ap; between intermodulation signals
and useful signals is reduced by 2 dB. This is illustrated in Figure 6-44.
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Figure 6-44: Dependency of intermodulation products on level of useful signals

The useful signals at the two-port output increase proportionally with the input level as
long as the two-port is in the linear range. A level change of 1 dB at the input causes a
level change of 1 dB at the output. Beyond a certain input level, the two-port goes into
compression and the output level stops increasing. The intermodulation products of the
third order increase three times as quickly as the useful signals. The intercept point is
the fictitious level where the two lines intersect. It cannot be measured directly since
the useful level is previously limited by the maximum two-port output power.

Calculation method

However, the intercept point can be calculated from the known line slopes and the
measured spacing ap; at a given level according to the following formula:

P3=503 4 p,
2

The third order intercept point (TOI), for example, is calculated for an intermodulation
of 60 dB and an input level P, of -20 dBm according to the following formula:

IP3 = ? +(=20dBm) = 10dBm
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Intermodulation-free dynamic range

The "Intermodulation-free dynamic range", i.e. the level range in which no internal
intermodulation products are generated if two-tone signals are measured, is deter-
mined by the third order intercept point, the phase noise and the thermal noise of the
signal analyzer. At high signal levels, the range is determined by intermodulation prod-
ucts. At low signal levels, intermodulation products disappear below the noise floor, i.e.
the noise floor and the phase noise of the signal analyzer determine the range. The
noise floor and the phase noise depend on the resolution bandwidth that has been
selected. At the smallest resolution bandwidth, the noise floor and phase noise are at a
minimum and so the maximum range is obtained. However, a large increase in sweep
time is required for small resolution bandwidths. It is therefore best to select the largest
resolution bandwidth possible to obtain the range that is required. Since phase noise
decreases as the carrier-offset increases, its influence decreases with increasing fre-
quency offset from the useful signals.

The following diagrams illustrate the intermodulation-free dynamic range as a function
of the selected bandwidth and of the level at the input mixer (= signal level — set RF
attenuation) at different useful signal offsets.

Distortion free Dynamic Range

Dyn range / {1 MHz carrier offset)
dB
-40
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Figure 6-45: Intermodulation-free range as a function of level at the input mixer and the set resolution
bandwidth

(Useful signal offset = 1 MHz, DANL = -145 dBm/Hz, TOI = 15 dBm; typical values at 2
GHz)

The optimum mixer level, i.e. the level at which the intermodulation distance is at its
maximum, depends on the bandwidth. At a resolution bandwidth of 10 Hz, it is approx.
-35 dBm and at 1 kHz increases to approx. -30 dBm.

Phase noise has a considerable influence on the intermodulation-free range at carrier
offsets between 10 and 100 kHz ( see Figure 6-46). At greater bandwidths, the influ-
ence of the phase noise is greater than it would be with small bandwidths. The opti-
mum mixer level at the bandwidths under consideration becomes almost independent
of bandwidth and is approx. -40 dBm.
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Distortion free Dynamic Range

Dyn. range /dB (10 to 100 kHz carrier offset)
T-ﬂ.o
50 J
=
ao T BB 1 RHz d
60 ] ‘--h.__.____‘ /"F'l
70 L [RBW o T0bHE /‘f
- -
- 1
50 b=l RBWirpel s
""--n...,____- - L~ Therm IN:!E
- | + Fhase Npisd |
=
=100
L~
=110
e
=120
50 50 -40 30 ol

Mixer level /[dBm

Figure 6-46: Intermodulation-free dynamic range as a function of level at the input mixer and of the
selected resolution bandwidth

(Useful signal offset = 10 to 100 kHz, DANL = -145 dBm/Hz, TOI = 15 dBm); typical val-
ues at 2 GHz).

If the intermodulation products of a DUT with a very high dynamic range are to be

6 measured and the resolution bandwidth to be used is therefore very small, it is best to
measure the levels of the useful signals and those of the intermodulation products sep-
arately using a small span. The measurement time will be reduced, in particular if the
offset of the useful signals is large. To find signals reliably when frequency span is
small, it is best to synchronize the signal sources and the R&S FPS.

6.10.3 TOI Results

As a result of the TOI measurement, the following values are displayed in the marker
area of the diagram:

Label Description

TOI Third-order intercept point

M1 Maximum of first useful signal
M2 Maximum of second useful signal
M3 First intermodulation product

M4 Second intermodulation product
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MultiView Spectrum

dBm
OdB  SWT 42 s

: 1 I
1001 pts 2.0 MHz /
Table
Ref C Stimulus Response Function Function Result
1 2.199001 GHz -3.97 dBm
2.200999 GHz -3.96 dBm TOI 25.617 dBm
2.197003 GHz -64.67 dBm
2.202997 GHz -62.00 dBm

Remote command

The TOI can also be queried using the remote command CALCulate<n>:
MARKer<m>:FUNCtion:TOTI:RESult? on page 753.

6.10.4 TOI Configuration

Access: "Overview" > "Select Measurement" > "Third Order Intercept" > "TOI Config"

j " Third Order Intercept
Third Order Intercept

Marker 1

Marker 2

Marker 3

Marker 4

Search Signals

The remote commands required to perform these tasks are described in Chap-
ter 12.5.11, "Measuring the Third Order Intercept Point", on page 752.

Marker 1/ Marker 2 / Marker 3/ Marker 4 ...t 293
SEANCH SIGNAIS ... 293
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Third Order Intercept (TOI) Measurement

Marker 1 / Marker 2 / Marker 3 / Marker 4
Indicates the detected characteristic values as determined by the TOl measurement
(see Chapter 6.10.3, "TOI Results", on page 291).

The marker positions can be edited; the TOl is then recalculated according to the new
marker values.

To reset all marker positions automatically, use the Search Signals function.

Remote command:

CALCulate<n>:MARKer<m>:X on page 867
CALCulate<n>:DELTamarker<m>:X on page 865
CALCulate<n>:DELTamarker<m>:X:RELative? on page 880

Search Signals
Performs a new search on the input signals and recalculates the TOI according to the
measured values.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:TOI:SEARchsignal ONCE on page 753

How to Determine the Third Order Intercept

The precise TOI for the R&S FPS in relation to the input signals is provided in the data
sheet.

For remote operation, see Chapter 12.5.11.2, "Programming Example: Measuring the
TOI", on page 753.

6.10.6

1. Apply a two-tone signal with equal carrier levels to the R&S FPS input.
2. Onthe R&S FPS, press the MEAS key.

3. Select the "Third Order Intercept" measurement function from the "Select Measure-
ment" dialog box.

The calculated TOl is indicated in the marker information. The markers required for
calculation are displayed in the marker table.

4. If the signal changes significantly during or after the TOl measurement, use the
"Search Signals" function to start a new signal search automatically and restart the
calculation of the TOI.

Measurement Example — Measuring the R&S FPS's Intrinsic Inter-
modulation

@

A programming example demonstrating a TOl measurement in a remote environment
is provided in Chapter 12.5.11.2, "Programming Example: Measuring the TOI",
on page 753.
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Test setup:
Signal
Generator 1 l
Coupler Spectrum
EE—
[- &6 dB] Analyzer
Signal T
Generator 2
Signal generator settings (e.g. R&S FPS SMW):
Device Level Frequency
Signal generator 1 -4 dBm 799.6 MHz
Signal generator 2 -4 dBm 800.4 MHz

Setting up the measurement

1. Preset the R&S FPS.

2. Set the center frequency to 800 MHz and the frequency span to 3 MHz.
3. Set the reference level to -10 dBm and RF attenuation to 0 dB.
4

Set the resolution bandwidth to 70 kHz.
The noise is reduced, the trace is smoothed further and the intermodulation prod-
ucts can be seen clearly.

5. Setthe VBW to 1 kHz.

Measuring intermodulation using the Third Order Intercept (TOI) measurement
function

1. Press the MEAS key and select the "Third Order Intercept” measurement function
from the "Select Measurement" dialog box.

The R&S FPS activates four markers to measure the intermodulation distance.
Two markers are positioned on the useful signals and two on the intermodulation
products. The TOl is calculated from the level difference between the useful sig-
nals and the intermodulation products. It is then displayed on the screen:
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MultiView  Spectrum

RefLevel -10.00 dBm = RBW 10 kHz
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CF 800,00 MHz 10 300.0 kHz/ Span 3.0 MHz
2 Marker Table
Type Ref Tre Stimulus Response Function Function Result
1 799.6004 MHz -11.15 dBm
800.3996 MHz -10.87 dBm TOL 25.3632 dBm
798.8012 MHz -81.23 dBm
801.1988 MHz -90.48 dBm

The third order intercept (TOI) is displayed in the marker information.

2. The level of a signal analyzer's intrinsic intermodulation products depends on the
RF level of the useful signals at the input mixer. When the RF attenuation is added,
the mixer level is reduced and the intermodulation distance is increased. With an
additional RF attenuation of 10 dB, the levels of the intermodulation products are
reduced by 20 dB. The noise level is, however, increased by 10 dB.

Increase the RF attenuation to 20 dB to reduce intermodulation products.

The R&S FPS's intrinsic intermodulation products disappear below the noise floor.

Multiview  Spectrum Attenuation

Ref Level - = RBW 10 kHz x
= Att SWT 419us ® VBW 1 kHz  Mode Auto FFT
1701 * 1AP Clrw

pwnwmwwmmmwmmmmmwmwwmwwmwwwmm

CF 800,0 MHz 1001 pts 300.0 kHz / Span 3.0 MHz

Stimulus Response Function Function Result
799.6004 MHz -11.20 dBm
800.3996 MHz -10.92 dBm TOI 22.682 dBm
798.8012 MHz -77.68 dBm
801.1988 MHz -79.58 dBm
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6.11 AM Modulation Depth Measurement

This measurement determines the AM modulation depth of an AM-modulated carrier.

o  About the MeasuremMeNnt........cooi e 296
o AM Modulation Depth ReSUIES.......cooiiiieiee e 296
e AM Modulation Depth Configuration.............ccccuiiiiieiiieee e 297
e Optimizing and Troubleshooting the Measurement...............coceccciivieeeeeeee e, 298
e How to Determine the AM Modulation Depth.............coooiiiriirre, 299

6.11.1 About the Measurement

The AM modulation depth, also known as a modulation index, indicates how much the
modulated signal varies around the carrier amplitude. It is defined as:

Mpeptn = Peak signal amplitude / unmodulated carrier amplitude

So for Mpepin = 0.5, for example, the carrier amplitude varies by 50% above and below
its unmodulated level, and for Mpgy, = 1.0 it varies by 100%.

When this measurement is activated, marker 1 is set to the peak level, which is consid-
ered to be the carrier level. Delta markers 2 and 3 are automatically set symmetrically
to the carrier on the adjacent peak values of the trace. The markers can be adjusted
manually, if necessary.

The R&S FPS calculates the power at the marker positions from the measured levels.
The AM modulation depth is calculated as the ratio between the power values at the
reference marker and at the delta markers. If the powers of the two AM side bands are
unequal, the mean value of the two power values is used for AM modulation depth cal-
culation.

6.11.2 AM Modulation Depth Results

As a result of the AM Modulation Depth measurement, the following values are dis-
played in the marker area of the diagram:

Label Description

MDepth AM modulation depth in percent

M1 Maximum of the signal (= carrier level)

D2 Offset of next peak to the right of the carrier
D3 Offset of the next peak to the left of the carrier
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6.11.3

Measurements and Results

1 AM Mod Depth

1001 pis 100.0 kHz/ Span 1.0 MHz
Stmulus
225.0 MHz
279.7 kHz
=279.7 kHz

Response
-4.29 dBm
-10.51 dB
-10.49 dB

Function Function Result

59.718 %

Remote command:

The AM modulation depth can also be queried using the remote command
CALCulate<n>:MARKer<m>:FUNCtion:MDEPth:RESult? on page 755.

AM Modulation Depth Configuration

Access: "Overview" > "Select Measurement" > "AM Modulation Depth" > "AM Mod
Depth Config"

W8 AM Modulation Dep

i —

.
1R EE| 20.0 MHZz
.

(8
11 GV 39.98 MHZ
.

Marker 3

(8
19.98002 kHz
=

Search Signals

The remote commands required to perform these tasks are described in Chap-
ter 12.5.12, "Measuring the AM Modulation Depth", on page 754.
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Marker 1 / Marker 2 / Marker 3
Indicates the detected characteristic values as determined by the AM Modulation
Depth measurement:
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Marker Description

M1 Maximum of the signal (= carrier level)

D2 Offset of next peak to the right of the carrier
D3 Offset of the next peak to the left of the carrier

The marker positions can be edited; the modulation depth is then recalculated accord-
ing to the new marker values.

To reset all marker positions automatically, use the Search Signals function.

Note: Moving the marker positions manually. When the position of delta marker 2 is
changed, delta marker 3 is moved symmetrically with respect to the reference marker
1.

Delta marker 3, on the other hand, can be moved for fine adjustment independently of
marker 2.

Marker 1 can also be moved manually for re-adjustment without affecting the position
of the delta markers.

Remote command:

CALCulate<n>:MARKer<m>:X on page 867
CALCulate<n>:DELTamarker<m>:X on page 865
CALCulate<n>:DELTamarker<m>:X:RELative? on page 880

Search Signals
Performs a new search on the input signal and recalculates the AM Modulation Depth
according to the measured values.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:MDEPth:SEARchsignal ONCE
on page 755

6.11.4 Optimizing and Troubleshooting the Measurement

If the results do not meet your expectations, try the following methods to optimize the
measurement:

® Set the center frequency to the frequency of the device under test.

® Adjust the span so the peaks to the left and right of the carrier, produced by the AM
modulated signal, are clearly visible.
If the span is too wide, these signals may fall together with the carrier and the mea-
surement can not be performed.
If the span is too narrow, theses signals are outside of the measured span and the
delta markers can not find these peaks.
The rule of thumb is to set the span to three times the value of the AM modulation
frequency.
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6.11.5 How to Determine the AM Modulation Depth

The following step-by-step instructions demonstrate how to determine the AM modula-
tion depth.

For remote operation, see Chapter 12.5.12.2, "Example: Measuring the AM Modulation
Depth", on page 755.

1. Apply a modulated carrier signal to the R&S FPS input.

2. On the R&S FPS, press the MEAS key.

3. Select the "AM Modulation Depth" measurement function from the "Select Mea-
surement" dialog box.
The calculated AM Modulation Depth is indicated in the marker information. The

markers required for calculation are displayed in the marker table.

4. If the signal changes significantly during or after the AM Modulation Depth mea-
surement, use the "Search Signals" function to start a new peak search automati-
cally and restart the calculation of the AM Modulation Depth.
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Overview

Common Measurement Settings

Common Measurement Settings

Basic measurement settings that are common to many measurement tasks, regardless
of the application or operating mode, are described here. If you are performing a spe-
cific measurement task, using an operating mode other than Signal and Spectrum Ana-
lyzer mode, or an application other than the Spectrum application, be sure to check the
specific application or mode description for settings that may deviate from these com-
mon settings.

o ConfIgUuration OVEIVIEW.........uuiiiiiiiiiie et 300
e Data Input and OUIPUL......eiieee i e e 302
e Frequency and Span Configuration...........cceceviiiiiiii i 343
o Amplitude and Vertical Axis Configuration............cccceveiiiiieiii e, 351
e Bandwidth, Filter and Sweep Configuration.............cccccoiiiiiieiiii e, 360
o Trigger and Gate Configuration...........ccueeiii i 375
e Adjusting Settings Automatically..........c..oeeiiriiiii e 389

Configuration Overview

Access: all menus

Each channel provides an overview of the most important currently defined settings
and access to the most important configuration dialog boxes for the particular mea-
surement. This overview is available via the "Overview" icon, which is displayed in all
menus.

S RBY =—— — e
105 SWT Ems  VBW Mode . (= - |—‘

[ =
! Frequency Sweep

Ref Level Center Source

Input Level Dffset Span Lewvel

Power Sensor ALt Freq Offset Gated Trigger

= = =
Input Amplitude Frequency Trigger/Gate

(] (&)
Bandwidth Analysis Display Config

Dy
Marker 1
Limits

Lines

Select Measurement

Using this overview, you can easily configure an entire channel from input over pro-
cessing to output and analysis by stepping through the dialog boxes as indicated.

In particular, the "Overview" provides quick access to the following configuration dialog
boxes (listed in the recommended order of processing):
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1. "Select Measurement"
See Chapter 6, "Measurements and Results", on page 123

2. Input
See Chapter 7.2.2, "Input Source Settings", on page 303

3. Amplitude
See Chapter 7.4, "Amplitude and Vertical Axis Configuration", on page 351

4. Frequency
See Chapter 7.3, "Frequency and Span Configuration”, on page 343

5. (Optionally:) Trigger/Gate
See Chapter 7.6, "Trigger and Gate Configuration", on page 375

6. Bandwidth
See Chapter 7.5.2, "Bandwidth, Filter and Sweep Settings", on page 366
(For SEM measurements: SEM Setup, see Chapter 6.5.5, "SEM Configuration",
on page 219)
(For Spurious measurements: Spurious Setup, see Chapter 6.6.4, "Spurious Emis-
sions Measurement Configuration”, on page 252)

7. (Optionally:) Outputs
See Chapter 7.2.5, "Output Settings", on page 338

8. Analysis
See Chapter 8, "Common Analysis and Display Functions", on page 393

9. Display
See Chapter 8.1, "Result Display Configuration", on page 393

To configure settings

» Select any button to open the corresponding dialog box.
Select a setting in the channel bar (at the top of the channel tab) to change a spe-
cific setting.

Preset Channel
Select the "Preset Channel" button in the lower left-hand corner of the "Overview" to
restore all measurement settings in the current channel to their default values.

Do not confuse the "Preset Channel" button with the PRESET key, which restores the
entire instrument to its default values and thus closes all channels on the R&S FPS
(except for the default channel)!

Remote command:
SYSTem:PRESet :CHANnel [ :EXEC] on page 951
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7.2 Data Input and Output

7.21

7211

The R&S FPS can analyze signals from different input sources and provide various
types of output (such as video or trigger signals).

e Receiving Data Input and Providing Data Output.........ccccceveeeiiiiicciiiiiieecce e 302
@ INPUL SOUICE SEINGS..eiiiiiiiiii i e e e e e e e e e e e e 303
L I oY=t G T=Y o Yo = S PUUTRRR 305
o External Generator CONrOl........ ..o 314
O OULPUL SEEtINGS. ...t 338
o Trigger Input/Output SEettiNgS.......coiiiiiiiiiiii e 340
e How to Output @ Trigger SigNal.........uueeeiiiieeiiiiiieciiiee e e e e e e 342

Receiving Data Input and Providing Data Output

The R&S FPS can analyze signals from different input sources and provide various
types of output (such as noise or trigger signals).

Receiving and Providing Trigger Signals

Using one of the TRG IN / AUX connectors of the R&S FPS, the R&S FPS can use a
signal from an external device as a trigger to capture data. Alternatively, the internal
trigger signal used by the R&S FPS can be output for use by other connected devices.
Using the same trigger on several devices is useful to synchronize the transmitted and
received signals within a measurement.

For details on the connectors see the R&S FPS "Getting Started" manual.

External trigger as input

If the trigger signal for the R&S FPS is provided by an external device, the trigger sig-
nal source must be connected to the R&S FPS and the trigger source must be defined
as "External" in the R&S FPS.

Trigger output

The R&S FPS can provide output to another device either to pass on the internal trig-
ger signal, or to indicate that the R&S FPS itself is ready to trigger.

The trigger signal can be output by the R&S FPS automatically, or manually by the
user. If it is provided automatically, a high signal is output when the R&S FPS has trig-
gered due to a sweep start ( "Device Triggered" ), or when the R&S FPS is ready to
receive a trigger signal after a sweep start ( "Trigger Armed" ).

Manual triggering

If the trigger output signal is initiated manually, the length and level (high/low) of the
trigger pulse is also user-definable. Note, however, that the trigger pulse level is
always opposite to the constant signal level defined by the output "Level" setting, e.g.
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for "Level" = "High", a constant high signal is output to the connector until the "Send
Trigger" button is selected. Then, a low pulse is provided.

\ V

trigger trigger
5 < 5 1 -
i S [l
low-level constant, high-level constant,
high-level trigger low-level trigger

7.2.1.2 IF and Video Signal Output
The measured IF signal or displayed video signal (i.e. the filtered and detected IF sig-
nal) can be provided at the IF/VIDEO output connector of the R&S FPS.

The video output is a signal of 1 V. It can be used, for example, to control demodula-
ted audio frequencies.

The IF output is a signal of the measured level at a specified frequency.

Restrictions
Note the following restrictions for data output:
® |F and video output is only available in the time domain (zero span).

If the hardware option R&S FPS-B160 for bandwidth extension is installed and acti-
vated (i.e. for bandwidths > 40 MHz), the IF output is not available at the IF/VIDEO out-
put connector.

7.2.2 Input Source Settings

Access: "Overview" > "Input" > "Input Source"
The input source determines which data the R&S FPS will analyze.

The default input source for the R&S FPS is "Radio Frequency" , i.e. the signal at the
RF INPUT connector of the R&S FPS. If no additional options are installed, this is the
only available input source.

o Radio FrequenCy INPUL.......oo e 303

7.2.21 Radio Frequency Input

Access: "Overview" > "Input/Frontend" > "Input Source" > "Radio Frequency"
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Frequency

Input Coupling

Digital IQ

Impedance

YIG-Preselector

Radio FrequenCy State .........cooi i 304
10T 018 87 010 o] 11 T PSP 304
T g] 0 =Te F= g o7 = R ESUPURR 304
R = TY=1 1= o1 (o] P 305

Radio Frequency State
Activates input from the RF INPUT connector.

Remote command:
INPut:SELect on page 814

Input Coupling
The RF input of the R&S FPS can be coupled by alternating current (AC) or direct cur-
rent (DC).

AC coupling blocks any DC voltage from the input signal. This is the default setting to
prevent damage to the instrument. Very low frequencies in the input signal may be dis-
torted.

However, some specifications require DC coupling. In this case, you must protect the
instrument from damaging DC input voltages manually. For details, refer to the data
sheet.

Remote command:
INPut:COUPling on page 812

Impedance

The R&S FPS has an internal impedance of 50 Q. However, some applications use
other impedance values. In order to match the impedance of an external application to
the impedance of the R&S FPS, an impedance matching pad can be inserted at the
input. If the type and impedance value of the used matching pad is known to the

R&S FPS, it can convert the measured units accordingly so that the results are calcula-
ted correctly.

(See " Reference Level " on page 355).

This function is not available for input from the optional Digital Baseband Interface. Not
all settings are supported by all R&S FPS applications.

The impedance conversion does not affect the level of the output signals (such as IF,
video, demod, digital I/Q output)

"50Q" (Default:) no conversion takes place
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"75Q" The 50 Q input impedance is transformed to a higher impedance
using a 75 Q adapter of the selected "Pad Type": "Series-R" (default)
or "MLP" (Minimum Loss Pad)

"User" The 50 Q input impedance is transformed to a user-defined impe-
dance value according to the selected "Pad Type": "Series-R"
(default) or "MLP" (Minimum Loss Pad)

Remote command:
INPut:IMPedance on page 813
INPut:IMPedance:PTYPe on page 813

YIG-Preselector
Activates or deactivates the YIG-preselector, if available on the R&S FPS.

An internal YIG-preselector at the input of the R&S FPS ensures that image frequen-
cies are rejected. However, this is only possible for a restricted bandwidth. To use the
maximum bandwidth for signal analysis you can deactivate the YIG-preselector at the
input of the R&S FPS, which can lead to image-frequency display.

Note that the YIG-preselector is active only on frequencies greater than 8 GHz. There-
fore, switching the YIG-preselector on or off has no effect if the frequency is below that
value.

Note:

For the following measurements, the YIG-Preselector is off by default (if available).
® |/Q Analyzer (and thus in all slave applications in MSRA operating mode)

e GSM

°® VSA

Remote command:
INPut:FILTer:YIG[:STATe] on page 813

Power Sensors

The R&S FPS can also analyze data from a connected power sensor.

® BasiCS 0N POWEE SENSOIS........uuuiiiiiiiiieee et e e 305
®  POWeEr SENSOr SEttiNgS....oueeiiiii i 307
o How to Work With @ POWEr SENSOF........uuuieiiiieieiieeceeeeeeeeeeeeeeeeeeeee e 312
e How to Configure a Power Sensor as an External Trigger........cccccvveeeeieeeeerinnnnne 314

Basics on Power Sensors

For precise power measurement, up to 4 power sensors can be connected to the
instrument via the USB interfaces. Both manual operation and remote control are sup-
ported.

For a detailed list of supported sensors, see the data sheet.




R&S®FPS Common Measurement Settings
________________________________________________________________________________________________________________________________________________________|

As the R&S FPS does not provide an explicit POWER SENSOR connector, an
R&S®NRP-Z3/-Z4/ or -Z5 adaptor is required to connect the power sensor to one of
the USB connectors on the R&S FPS.

Power sensors can also be used to trigger a measurement at a specified power level,
e.g. from a signal generator (see "Using a Power Sensor as an External Power Trig-
ger" on page 306).

Signal Power R&S NRP-Z3/-Z4/-Z5 R&S™
- -
source sensor adaptor FPS

Figure 7-1: Power sensor support — standard test setup

Using the power sensor with several applications

The power sensor cannot be used from the R&S FPS firmware and the R&S Power
Viewer Plus (virtual power meter for displaying results of the R&S NRP power sensors)
simultaneously.

Result display

The results of the power sensor measurements are displayed in the marker table. For
each power sensor, a row is inserted. The sensor index is indicated in the "Type" col-
umn.

Multiview Spectrum
Ref Level 0.00 dBm RBW 3 MHz
Att iIDdE SWT 40.8ms VBW 3 MHz Mode Au
1 Frequency Sweep o AP Clrw

[ oy LT i d 1, Ll
1001 pts 1.36 GHz/ Span 13.6 GHz

Stimulus Response Function Function Result
=72.20 dBm PWR100057 NRP-Z11
-60.79 dBm PWR100393 NRP-Z81

Using a Power Sensor as an External Power Trigger

Power sensors can be used to trigger a measurement at a specified power level, e.g.
from a signal generator. For a list of supported power sensors see the data sheet.
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With the R&S FPS, the power sensor requires a special USB adaptor which must be
connected to the instrument. In addition, the power sensor must be connected to the
R&S FPS's external trigger port.

USB Ext. trigger

- I‘Di‘_ _rh

- 0000GE.

Figure 7-2: Connecting a power sensor for use as an external trigger

The R&S FPS receives an external trigger signal when the defined trigger level is mea-
sured by the power sensor. Power measurement results are provided as usual.

these sensors merely reflects the instant the level is first exceeded, rather than a time
period. However, only time periods can be used for gating in level mode. Thus, the trig-
ger impulse from the sensors is not long enough for a fully gated measurement; the
measurement cannot be completed. For details on gating see Chapter 7.6.2.1, "Gated
Measurements", on page 385.

6 The "Gate Mode" Level is not supported for R&S power sensors. The signal sent by

For details see Chapter 7.2.3.4, "How to Configure a Power Sensor as an External
Trigger", on page 314.

7.2.3.2 Power Sensor Settings

Access: "Overview" > "Input" > "Power Sensor" tab

Each sensor is configured on a separate tab.
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o ey Spedt

Input Source Power Sensor

State . m Continuous Update off

Sensorl Select

Sensor2
Zeroing Power Sensor Meas - Ref

Sensor3
Frequency Manual Reference Value |—6}'.19 dBm

Sensord —
n Frequency Coupling Use Ref Level Offset
Unit/Scale _ Number of Readings
Meas Time /Average Duty Cycle

External Power Trigger External Trigger Level

Hysteresis '0.0dB | Dropout Time
| )

—
Holdoff Time 0.0s | Slope Rising Falling
| )
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MeEas TIME/AVEIAGE .....eeeiiiiiiieie ettt et e e s be e e s abe e e e s aanreeee s 310
Setting the Reference Level from the Measurement Meas -> Ref ......coovvveiiiiiiiinnn, 310
REFEIENCE VAIUE ...ttt e e e e e e e e e e e e e e e e e anennns 310
UsSE Ref LEVEI OFfSEE ..eiiiiiiiiiiie ettt st e e s e e 310
Average Count ( Number of ReadiNgS ).....ccceviviiiiiiiiiiiiiiiccceie e e e e e e e ee e eeeeeeeens 311
10§V O Yo = R 311
Using the power sensor as an external trigger .........cceveiiiiieii e 311
L External TrGQer LEVE ........ocucueucueeeeeeeeeeeeeeeeeeeeeeeeeetete e 311
L HYSEEIESIS w.evveveeeeeeeeeeeee e ettt et s e e ee e sa ettt et e et en s e s nanananeneeeas 311
O WAoo L= gl 11 o OO 312
L DIrOP-OUL TIME .ttt et e et e s 312
L S0P ettt ettt ettt n et s e reaaas 312
State

Switches the power measurement for all power sensors on or off. Note that in addition

to this general setting, each power sensor can be activated or deactivated individually

by the Select setting on each tab. However, the general setting overrides the individual
settings.

Remote command:
[SENSe: ] PMETer<p>[:STATe] on page 830
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Continuous Value Update
If activated, the power sensor data is updated continuously during a sweep with a long
sweep time, and even after a single sweep has completed.

This function cannot be activated for individual sensors.

If the power sensor is being used as a trigger (see " Using the power sensor as an
external trigger " on page 311), continuous update is not possible; this setting is
ignored.

Remote command:
[SENSe: ]| PMETer<p>:UPDate[:STATe] on page 831

Select
Selects the individual power sensor for usage if power measurement is generally acti-
vated ( State function).

The detected serial numbers of the power sensors connected to the instrument are
provided in a selection list. For each of the four available power sensor indexes

( "Power Sensor 1" ... "Power Sensor 4" ), which correspond to the tabs in the configu-
ration dialog, one of the detected serial numbers can be assigned. The physical sensor
is thus assigned to the configuration setting for the selected power sensor index.

By default, serial numbers not yet assigned are automatically assigned to the next free
power sensor index for which "Auto Assignment" is selected.

Alternatively, you can assign the sensors manually by deactivating the "Auto" option
and selecting a serial number from the list.

Remote command:

[SENSe: ] PMETer<p>[:STATe] on page 830
SYSTem:COMMunicate:RDEVice:PMETer<p>:DEFine on page 824
SYSTem:COMMunicate:RDEVice:PMETer<p>:CONFigure:AUTO[ :STATe]
on page 824

SYSTem:COMMunicate:RDEVice:PMETer : COUNt? on page 824

Zeroing Power Sensor
Starts zeroing of the power sensor.

For details on the zeroing process refer to "How to Zero the Power Sensor"
on page 313.

Remote command:
CALibration:PMETer<p>:ZER0O:AUTO ONCE on page 825

Frequency Manual

Defines the frequency of the signal to be measured. The power sensor has a memory
with frequency-dependent correction factors. This allows extreme accuracy for signals
of a known frequency.

Remote command:
[SENSe: ] PMETer<p>:FREQuency on page 828

Frequency Coupling

Selects the coupling option. The frequency can be coupled automatically to the center
frequency of the instrument or to the frequency of marker 1.
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Remote command:
[SENSe: ] PMETer<p>:FREQuency:LINK on page 828

Unit/Scale
Selects the unit with which the measured power is to be displayed. Available units are
dBm, dB, W and %.

If dB or % is selected, the display is relative to the reference value that is defined with
either the "Meas -> Ref" setting or the "Reference Value" setting.

Remote command:
UNIT<n>:PMETer<p>:POWer on page 831
UNIT<n>:PMETer<p>:POWer:RATio on page 831

Meas Time/Average

Selects the measurement time or switches to manual averaging mode. In general,
results are more precise with longer measurement times. The following settings are
recommended for different signal types to obtain stable and precise results:

"Short" Stationary signals with high power (> -40dBm), because they require
only a short measurement time and short measurement time provides
the highest repetition rates.

"Normal" Signals with lower power or modulated signals

"Long" Signals at the lower end of the measurement range (<-50 dBm) or
Signals with lower power to minimize the influence of noise

"Manual” Manual averaging mode. The average count is set with the Average
Count ( Number of Readings ) setting.

Remote command:
[SENSe: ] PMETer<p>:MTIMe on page 829
[SENSe: ] PMETer<p>:MTIMe:AVERage [:STATe] on page 829

Setting the Reference Level from the Measurement Meas -> Ref
Sets the currently measured power as a reference value for the relative display. The
reference value can also be set manually via the Reference Value setting.

Remote command:
CALCulate<n>:PMETer<p>:RELative[:MAGNitude] : AUTO ONCE on page 826

Reference Value
Defines the reference value for relative measurements in the unit dBm.

Remote command:
CALCulate<n>:PMETer<p>:RELative[:MAGNitude] on page 826

Use Ref Level Offset
If activated, takes the reference level offset defined for the analyzer into account for the
measured power (see " Shifting the Display ( Offset )" on page 355).

If deactivated, takes no offset into account.

Remote command:
[SENSe: ] PMETer<p>:ROFFset [:STATe] on page 830
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Average Count ( Number of Readings )

Defines the number of readings (averages) to be performed after a single sweep has
been started. This setting is only available if manual averaging is selected ( Meas
Time/Average setting).

The values for the average count range from 0 to 256 in binary steps (1, 2, 4, 8, ...).
For average count = 0 or 1, one reading is performed. The general averaging and
sweep count for the trace are independent from this setting.

Results become more stable with extended average, particularly if signals with low
power are measured. This setting can be used to minimize the influence of noise in the
power sensor measurement.

Remote command:
[SENSe: ] PMETer<p>:MTIMe:AVERage: COUNt on page 829

Duty Cycle

Sets the duty cycle to a percent value for the correction of pulse-modulated signals and
activates the duty cycle correction. With the correction activated, the sensor calculates
the signal pulse power from this value and the mean power.

Remote command:
[SENSe: ] PMETer<p>:DCYCle[:STATe] on page 827
[SENSe: ]| PMETer<p>:DCYCle:VALue on page 827

Using the power sensor as an external trigger

If activated, the power sensor creates a trigger signal when a power higher than the
defined "External Trigger Level" is measured. This trigger signal can be used as an
external power trigger by the R&S FPS.

This setting is only available in conjunction with a compatible power sensor.

For details on using a power sensor as an external trigger, see "Using a Power Sensor
as an External Power Trigger" on page 306.

Remote command:
[SENSe: ] PMETer<p>:TRIGger [: STATe] on page 834
TRIG:SOUR EXT, see TRIGger [:SEQuence] : SOURce on page 803

External Trigger Level — Using the power sensor as an external trigger
Defines the trigger level for the power sensor trigger.

For details on supported trigger levels, see the data sheet.

Remote command:
[SENSe: ] PMETer<p>:TRIGger:LEVel on page 833

Hysteresis < Using the power sensor as an external trigger

Defines the distance in dB to the trigger level that the trigger source must exceed
before a trigger event occurs. Setting a hysteresis avoids unwanted trigger events
caused by noise oscillation around the trigger level.

Remote command:
[SENSe: ] PMETer<p>:TRIGger:HYSTeresis on page 832
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Trigger Holdoff — Using the power sensor as an external trigger
Defines the minimum time (in seconds) that must pass between two trigger events.
Trigger events that occur during the holdoff time are ignored.

Remote command:
[SENSe: ] PMETer<p>:TRIGger:HOLDoff on page 832

Drop-Out Time < Using the power sensor as an external trigger
Defines the time the input signal must stay below the trigger level before triggering
again.

Slope — Using the power sensor as an external trigger
Defines whether triggering occurs when the signal rises to the trigger level or falls
down to it.

Remote command:
[SENSe: ] PMETer<p>:TRIGger : SLOPe on page 833

How to Work With a Power Sensor

The following step-by-step instructions demonstrate how to set up a power sensor. For
details on individual functions and settings see Chapter 7.2.3.2, "Power Sensor Set-
tings", on page 307.

The remote commands required to perform these tasks are described in Chap-
ter 12.7.6.3, "Working with Power Sensors", on page 823.

Power sensors can also be used to trigger a measurement at a specified power level,
e.g. from a signal generator.

This is described in Chapter 7.2.3.4, "How to Configure a Power Sensor as an External
Trigger", on page 314.

How to Set Up a Power Sensor

Up to 4 external power sensors can be configured separately and used for precise
power measurement. All power sensors can be activated and deactivated individually.

The following procedure describes in detail how to configure and activate power sen-
sors.

1. To display the "Power Sensor" tab of the "Input" dialog box, do one of the following:

e Select "Input" from the "Overview" .
e Select the INPUT/OUTPUT key and then the "Power Sensor Config" softkey.

2. Select the tab for the power sensor index you want to configure, e.g. "Power Sen-
sor 1" .

3. Press "Select" to analyze the power sensor data according to the current configura-
tion when power measurement is activated.

4. From the selection list with serial numbers of connected power sensors, select the
sensor you want to configure.
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11.

To have newly connected power sensors assigned to a tab automatically (default),
select "Auto" .

Define the frequency of the signal whose power you want to measure.

a) To define the frequency manually, select "Frequency Manual" and enter a fre-
quency.

b) To determine the frequency automatically, select "Frequency Coupling" and
then either "Center" , to use the center frequency, or "Marker" , to use the fre-
quency defined by marker 1.

Select the unit for the power result display.

Select the measurement time for which the average is calculated, or define the
number of readings to average. To define the number of readings to be taken into
account manually, select "Manual" and enter the number in the "Number of Read-
ings" field.

To activate the duty cycle correction, select "DutyCycle" and enter a percentage as
the correction value.

If you selected "dB" or "%" as units (relative display), define a reference value:

a) To set the currently measured power as a reference value, press the "Meas ->
Ref" button.

b) Alternatively, enter a value manually in the "Reference Value" field.

c) Optionally, select the "Use Ref Level Offset" option to take the reference level
offset set for the analyzer into account for the measured power.

If necessary, repeat steps 3-10 for another power sensor.

Set the "Power Sensor State" at the top of the "Power Sensor" tab to "On" to acti-
vate power measurement for the selected power sensors.

The results of the power measurement are displayed in the marker table (Function:
"Sensor <1...4>").

How to Zero the Power Sensor

To display the "Power Sensor" tab of the "Input" dialog box, do one of the following:

e Select "Input" from the "Overview" .
e Select the INPUT/OUTPUT key and then the "Power Sensor Config" softkey.

Select the tab that is assigned to the power sensor you want to zero.

Press the "Zeroing Power Sensor" button.
A dialog box is displayed that prompts you to disconnect all signals from the input
of the power sensor.

Disconnect all signals sending input to the power sensor and press ENTER to con-
tinue.

Wait until zeroing is complete.

HE
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A corresponding message is displayed.

7.2.3.4 How to Configure a Power Sensor as an External Trigger

The following step-by-step instructions demonstrate how to configure a power sensor
to be used as an external power sensor trigger.

To configure a power sensor as an external trigger

1. Connect a compatible power sensor to one of the USB interfaces on the rear panel
of the R&S FPS. (For details on supported sensors see "Using a Power Sensor as
an External Power Trigger" on page 306).

2. Set up the power sensor as described in "How to Set Up a Power Sensor"
on page 312.

3. Inthe "Power Sensor" tab of the "Input" dialog box, select the "External Power Trig-
ger" option.

4. Enter the power level at which a trigger signal is to be generated ( "External Trigger
Level" ) and the other trigger settings for the power sensor trigger.

5. Press the TRIG key and then select "Trigger/ Gate Config" .
6. Inthe "Trigger And Gate" dialog box, select "Signal Source" = External Trigger 1/2.
The R&S FPS is configured to trigger when the defined conditions for the power

Sensor occur.
7.2.4 External Generator Control

You can operate various commercially available generators as an external generator
with the R&S FPS. Thus, scalar network analysis with the R&S FPS is possible.

e About External Generator Control............cceeeiiiiiiiiiiiieee e 314
e Basics on External Generator Control..............uuuucieiiiiiiiiiiiiiieeeeeeeeeeeeeeeeee, 315
e External Generator Control SettingsS........ccooeccciviiiiiiiii e 323
e How to Work With External Generator CONtrol...........cceveveeeiieicccciiiiieeeee e 330
e Measurement Example: Calibration with an External Generator.......................... 333

7.2.4.1 About External Generator Control

A common measurement setup includes a signal generator, a device under test (DUT),
and a signal and spectrum analyzer, for example the R&S FPS. In this setup, the sig-
nal analyzer can control which signal the generator is to send, which is in turn mea-
sured by the analyzer. This process is referred to as external generator control. The
generator in this setup is referred to as a tracking generator.

A measurement with a tracking generator is useful to measure any effects on the
power level caused by the cables and connectors from the signal generator and the
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signal analyzer in advance. The known effects can then be removed from the mea-
surement results in order to obtain accurate information on the DUT.

Basics on External Generator Control

Some background knowledge on basic terms and principles used for external genera-
tor control is provided here for a better understanding of the required configuration set-
tings.

External generator control is only available in the following applications.
® Spectrum Analyzer

® 1/Q Analyzer

® Analog Demodulation

® Noise Figure Measurements

o External Generator CONNECIONS. .......uuuuuieiiiieieiee e 315
e Overview of Supported GENErators........ccccuviiiiiiiieeee e e e 316
®  Generator SEIUP FilES......uuuuiiii i a e 317
o Calibration MEChaNISM..........cooiiiiiiiieeeeeeeeeee e e 317
L N[ 1 g P11 4= | (o] TR 318
e Reference Trace, Reference Line and Reference Level.........ccccevvvviviicceeiiennnnnn. 319
o  Coupling the FreqUENCIES. .....cccoi i 320
e Displayed Information and EITOrS.........cccccuviiiiiiiieeee e e 322

External Generator Connections
The external generator is controlled via a LAN connection.

For more information on configuring interfaces see Chapter 4.4.1, "Remote Control
Interfaces and Protocols”, on page 51.

Transmission Measurement

This measurement yields the transmission characteristics of a two-port network. The
external generator is used as a signal source. It is connected to the input connector of
the DUT. The input of the R&S FPS is fed from the output of the DUT. A calibration can
be carried out to compensate for the effects of the test setup (e.g. frequency response
of connecting cables).

GEM QUTPUT ————— DUT  —— RF INPUT

Figure 7-3: Test setup for transmission measurement

Reflection Measurement

Scalar reflection measurements can be carried out using a reflection-coefficient mea-
surement bridge.
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GEM OUTPUT

Bridge RF INPUT

ouT

Figure 7-4: Test setup for reflection measurement

Generated signal input

In order to use the functions of the external generator, an appropriate generator must
be connected and configured correctly. In particular, the generator output must be con-
nected to the RF input of the R&S FPS.

External reference frequency

In order to enhance measurement accuracy, a common reference frequency should be
used for both the R&S FPS and the generator. If no independent 10 MHz reference fre-
quency is available, it is recommended that you connect the reference output of the
generator with the reference input of the R&S FPS and that you enable usage of the
external reference on the R&S FPS via "SETUP" > "Reference" > "External Refer-
ence".

For more information on external references see Chapter 10.4, "Reference Frequency
Settings", on page 558.
Connection errors

If no external generator is connected, if the connection address is not correct, or the
generator is not ready for operation, an error message is displayed (e.g."Ext. Genera-
tor TCPIP Handshake Error!", see "Displayed Information and Errors" on page 322).

Overview of Supported Generators

Generator type Generator type
SGS100A12 SMF100A
SGS100A6 SMF22
SGT100A3% SMF22B2
SGT100A6% SMF43
SMAO1A " SMF43B2
SMA100A3 " SMJ03

1) Requires firmware version V2.10.x or higher on the signal generator
2) Requires firmware version V1.10.x or higher on the signal generator
3) only for R&S FPS version 1.21 and higher
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Generator type Generator type
SMA100A6 " SMJ06
SMB100A1 SMuU02 2
SMB100A12 SMU02B31 2
SMB100A2 SMU03 ?
SMB100A20 SMU03B31 2
SMB100A3 SMU04 2
SMB100A40 SMU04B31 2
SMB100A6 SMU06 2
SMBV100A3 SMU06B31 2
SMBV100A6 SMWO03
SMC100A1 SMWO06
SMC100A3

1) Requires firmware version V2.10.x or higher on the signal generator
2) Requires firmware version V1.10.x or higher on the signal generator
3) only for R&S FPS version 1.21 and higher

Generator Setup Files

For each signal generator type to be controlled by the R&S FPS a generator setup file
must be configured and stored on the R&S FPS. The setup file defines the frequency
and power ranges supported by the generator, as well as information required for com-
munication. For the signal generators listed in "Overview of Supported Generators"

on page 316, default setup files are provided. If necessary, these files can be edited or
duplicated for varying measurement setups or other instruments.

The existing setup files can be displayed in an editor in read-only mode directly from
the "External Generator" configuration dialog box. From there, they can be edited and
stored under a different name, and are then available on the R&S FPS.

(For details see "To define a new generator setup file" on page 332).

Calibration Mechanism

A common measurement setup includes a signal generator, a device under test (DUT),
and a signal and spectrum analyzer. Therefore, it is useful to measure the attenuation
or gain caused by the cables and connectors from the signal generator and the signal
analyzer in advance. The known level offsets can then be removed from the measure-
ment results in order to obtain accurate information on the DUT.

Calculating the difference between the currently measured power and a reference
trace is referred to as calibration. Thus, the measurement results from the controlled
external generator - including the inherent distortions - can be used as a reference
trace to calibrate the measurement setup.
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The inherent frequency and power level distortions can be determined by connecting
the R&S FPS to the signal generator. The R&S FPS sends a predefined list of frequen-
cies to the signal generator (see also "Coupling the Frequencies" on page 320). The
signal generator then sends a signal with the specified level at each frequency in the
predefined list. The R&S FPS measures the signal and determines the level offsets to
the expected values.

Saving calibration results

A reference dataset for the calibration results is stored internally as a table of value
pairs (frequency/level), one for each sweep point. The measured offsets can then be
used as calibration factors for subsequent measurement results.

The calibration can be performed using either transmission or reflection measure-
ments. The selected type of measurement used to determine the reference trace is
included in the reference dataset.

Normalization

Once the measurement setup has been calibrated and the reference trace is available,
subsequent measurement results can be corrected according to the calibration factors,
if necessary. This is done by subtracting the reference trace from the measurement
results. This process is referred to as normalization and can be activated or deactiva-
ted as required. If normalization is activated, "NOR" is displayed in the channel bar,
next to the indication that an external generator is being used ("Ext.Gen").The normal-
ized trace from the calibration sweep is a constant 0 dB line, as <calibration trace> -
<reference trace> = 0.

As long as the same settings are used for measurement as for calibration, the normal-
ized measurement results should not contain any inherent frequency or power distor-
tions. Thus, the measured DUT values are very accurate.

Approximate normalization

As soon as any of the calibration measurement settings are changed, the stored refer-
ence trace will no longer be identical to the new measurement results. However, if the
measurement settings do not deviate too much, the measurement results can still be
normalized approximately using the stored reference trace. This is indicated by the
"APX" label in the channel bar (instead of "NOR").

This is the case if one or more of the following values deviate from the calibration set-

tings:

® Coupling (RBW, VBW, SWT)

e Reference level, RF attenuation

e Start or stop frequency

® Qutput level of external generator

® Detector (max. peak, min. peak, sample, etc.)

® Frequency deviation at a maximum of 1001 points within the set sweep limits (cor-
responds to a doubling of the span)

Differences in level settings between the reference trace and the current instrument
settings are taken into account automatically. If the span is reduced, a linear interpola-
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tion of the intermediate values is applied. If the span increases, the values at the left or
right border of the reference dataset are extrapolated to the current start or stop fre-
quency, i.e. the reference dataset is extended by constant values.

Thus, the instrument settings can be changed in a wide area without giving up normali-
zation. This reduces the necessity to carry out a new normalization to a minimum.

If approximation becomes too poor, however, normalization is aborted and an error
message is displayed (see "Displayed Information and Errors" on page 322).

The normalized trace in the display

The normalized reference trace is also displayed in the spectrum diagram, by default at
the top of the diagram (= 100% of the window height). It is indicated by a red line
labeled "NOR", followed by the current reference value. However, it can be shifted ver-
tically to reflect an attenuation or gain caused by the measured DUT (see also "Shifting
the reference line (and normalized trace)" on page 320).

Restoring the calibration settings

If the measurement settings no longer match the instrument settings with which the
calibration was performed (indicated by the "APX" or no label next to "Ext.TG" in the
channel bar), you can restore the calibration settings, which are stored with the refer-
ence dataset on the R&S FPS.

Storing the normalized reference trace as a transducer factor

The (inverse) normalized reference trace can also be stored as a transducer factor for
use in other R&S FPS applications that do not support external generator control. The
normalized trace data is converted to a transducer with unit dB and stored in a file with
the specified name and the suffix . trd under c:\r_s\instr\trd. The frequency
points are allocated in equidistant steps between the start and stop frequency.

This is useful, for example, to determine the effects of a particular device component
and then remove these effects from a subsequent measurement which includes this
component.

For an example see "How to Remove the Effects of a Particular Component from Mea-
surement Results Using Calibration" on page 332.

Thus, if you store the normalized trace directly after calibration, without changing any
settings, the transducer factor will be 0 dB for the entire span (by definition of the nor-
malized trace).

6 Note that the normalized measurement data is stored, not the original reference trace!

Reference Trace, Reference Line and Reference Level
Reference trace

The calibration results are stored internally on the R&S FPS as a reference trace. For
each measured sweep point the offset to the expected values is determined. If normali-
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zation is activated, the offsets in the reference trace are removed from the current
measurement results to compensate for the inherent distortions.

Reference line

The reference line is defined by the Reference Value and Reference Position in the
"External Generator" > "Source Calibration" settings. It is similar to the Reference
Level defined in the "Amplitude" settings. However, as opposed to the reference level,
this reference line only affects the y-axis scaling in the diagram, it has no effect on the
expected input power level or the hardware settings.

The reference line determines the range and the scaling of the y-axis, just as the refer
ence level does.

The normalized reference trace (0 dB directly after calibration) is displayed on this ref-
erence line, indicated by a red line in the diagram. By default, the reference line is dis-
played at the top of the diagram. If you shift the reference line, the normalized trace is
shifted, as well.

Shifting the reference line (and normalized trace)

You can shift the reference line - and thus the normalized trace - in the result display
by changing the Reference Position or the Reference Value .

RBW 2 MHz
WT 3ms  VBW 2MHz Mode Suto Sweep

100,10 MHZ 20,0 MHz /

Figure 7-5: Shifted reference line

If the DUT inserts a gain or an attenuation in the measurement, this effect can be
reflected in the result display on the R&S FPS. To reflect a power offset in the mea-
surement trace, change the Reference Value .

For a detailed example see Chapter 7.2.4.5, "Measurement Example: Calibration with
an External Generator", on page 333.
Coupling the Frequencies

As described in "Normalization" on page 318, normalized measurement results are
very accurate as long as the same settings are used as for calibration. Although

User Manual 1176.8445.02 — 09 320



Data Input and Output

approximate normalization is possible, it is important to consider the required frequen-
cies for calibration in advance. The frequencies and levels supported by the connected
signal generator are provided for reference with the interface configuration.

Two different methods are available to define the frequencies for calibration, that is to
couple the frequencies of the R&S FPS with those of the signal generator:
® Manual coupling: a single frequency is defined

e Automatic coupling: a series of frequencies is defined (one for each sweep
point), based on the current frequency at the RF input of the R&S FPS; the RF fre-
quency range covers the currently defined span of the R&S FPS (unless limited by
the range of the signal generator)

Automatic coupling

If automatic coupling is used, the output frequency of the generator (source frequency)
is calculated as follows:

Numerator
Denomin ator

F Generator — F Analyzer * +F Offset

Equation 7-1: Output frequency of the generator

Where:

F cenerator = OUtput frequency of the generator

Fanayzer = current frequency at the RF input of the R&S FPS
Numerator = multiplication factor for F anayyzer

Denominator = division factor for Fanaiyzer

Fofset = frequency offset for Fanayyzer, for example for frequency-converting measure-
ments or harmonics measurements

The value range for the offset depends on the selected generator. The default setting
is 0 Hz. Offsets other than 0 Hz are indicated by the "FRQ" label in the channel bar
(see also "Displayed Information and Errors" on page 322).

Swept frequency range

The Fanayzer Values for the calibration sweep start with the start frequency and end with
the stop frequency defined in the "Frequency" settings of the R&S FPS. The resulting
output frequencies ( Result Frequency Start and Result Frequency Stop ) are dis-
played in "External Generator" > "Measurement Configuration" for reference.

If the resulting frequency range exceeds the allowed ranges of the signal generator, an
error message is displayed (see "Displayed Information and Errors" on page 322) and
the Result Frequency Start and Result Frequency Stop values are corrected to comply
with the range limits.

The calibration sweep nevertheless covers the entire span defined by the R&S FPS;
however, no input is received from the generator outside the generator's defined limits.




Data Input and Output

Reverse sweep

The frequency offset for automatic coupling can be used to sweep in the reverse direc-
tion. To do so, define a negative offset in the external generator measurement configu-
ration. (Note that the frequency is defined as the unsigned value of the equation, thus a
negative frequency is not possible.)

Example: Example for reverse sweep
Fanalyzerstart™ 100 MHz

F analyzerstop = 200 MHz

Foftset = -300 MHZz

Numerator = Denominator = 1
_’FGeneratorStart =200 MHz

_’FGeneratorStop =100 MHz

If the offset is adjusted so that the sweep of the generator crosses the minimum gener-
ator frequency, a message is displayed in the status bar ("Reverse Sweep via min. Ext.
Generator Frequency!").

Example: Example for reverse sweep via minimum frequency
F Analyzerstar= 100 MHz

F Analyzersiop = 200 MHz

Foftset = -150 MHz

Fmin = 20 MHz

Numerator = Denominator = 1

~F Generatorstart = 50 MHz

_’FGeneratorStop =50 MHz via I:min

Displayed Information and Errors

Channel bar

If external generator control is active, some additional information is displayed in the

channel bar.
Label Description
EXT TG: <source power> External generator active; signal sent with <source power> level
LVL Power Offset (see " Source Offset " on page 326
FRQ Frequency Offset (see "(Automatic) Source Frequency (Numerator/Denomi-
nator/Offset)" on page 327
NOR Normalization on;
No difference between reference setting and measurement
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Label Description

APX (approximation) Normalization on;

Deviation from the reference setting occurs

- Aborted normalization or no calibration performed yet

Error and status messages

The following status and error messages may occur during external generator control.

Message Description

"Ext. Generator TCPIP Handshake Error!" / Connection to the generator is not possible, e.g. due to a
cable damage or loose connection or wrong address.

"Ext. Generator Limits Exceeded!" The allowed frequency or power ranges for the generator
were exceeded.

"Reverse Sweep via min. Ext. Generator Fre- Reverse sweep is performed; frequencies are reduced to
quency!" the minimum frequency, then increased again; see
"Reverse sweep" on page 322

"Ext. Generator File Syntax Error!" Syntax error in the generator setup file (see "Generator
Setup Files" on page 317

"Ext. Generator Command Error!" Missing or wrong command in the generator setup file
(see "Generator Setup Files" on page 317

"Ext. Generator Visa Error!" Error with Visa driver provided with installation (very
unlikely)

Overloading

At a reference level of -10 dBm and at an external generator output level of the same
value, the R&S FPS operates without overrange reserve. That means the R&S FPS is
in danger of being overloaded if a signal is applied whose amplitude is higher than the
reference line. In this case, either the message "RF OVLD" for overload or "IF OVLD"
for exceeded display range (clipping of the trace at the upper diagram border = over-
range) is displayed in the status line.

Overloading can be avoided as follows:

® Reducing the output level of the external generator (" Source Power " on page 326
in "External Generator > Measurement Configuration")

® |ncreasing the reference level ( Reference Level in the "Amplitude"” menu)

7.2.4.3 External Generator Control Settings

Access: INPUT/OUPUT > "External Generator Config"

The "External Generator" settings are available if the R&S FPS External Generator
Control option is installed. For each measurement channel, you can configure one
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external generator. To switch between different configurations, define multiple mea-
surement channels.

For more information on external generator control, see Chapter 7.2.4.2, "Basics on
External Generator Control", on page 315.

o Interface Configuration SettingsS. ........ueeiiiiiiiiiiiii e 324
o Measurement SettiNgsS. .. ..o 325
o Source Calibration FUNCONS.......ccoiiiiiiiiiiiiie e 328

Interface Configuration Settings

Access: INPUT/OUPUT > "External Generator Config" > "Interface Configuration” tab

! Input Source External Generator

Measurement Interface Settings Source Capabilities

Cenfiguration | ..o ator Type [t T Frequency Min

Interface Interface PCle Frequency Max
Configuration

Serial Number 28 Level Min

Source

Calibration Reference Level Max

Edit Generator Setup File

For more information on configuring interfaces, see Chapter 4.4.1, "Remote Control
Interfaces and Protocols", on page 51.

(1=l oL = (o] Y/ o= SO POT PUUTP PP 324
1 (=T =T SO 324
TCPIP Address / Computer NAaME .......cocoiiiiiiiiiiiie et 325
REFEIEINCE ..t e e s s ee e e s e nbee s 325
Edit Generator SEtUP File ... 325
Frequency Min / FreqUENCY MaX ........ccccuiiiiiiiiiiee ettt 325
LeVel MIiN / LEVEI IMIAX ...ttt e e e e e e e e e e e e e e e e eennns 325

Generator Type
Selects the generator type and thus defines the generator setup file to use.

For an overview of supported generators, see "Overview of Supported Generators"
on page 316. For information on generator setup files, see "Generator Setup Files"
on page 317.

Remote command:
SYSTem:COMMunicate:RDEVice:GENerator: TYPE on page 818

Interface
Type of interface connection used. The following interfaces are currently supported:

® TCP/IP (not by all generators)

For details on which signal generators support which interfaces, see the documenta-
tion of the corresponding signal generator.
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Remote command:
SYSTem:COMMunicate:RDEVice:GENerator:INTerface on page 818

TCPIP Address / Computer Name
For LAN connections only: TCP/IP address of the signal generator

Remote command:
SYSTem:COMMunicate:TCPip:RDEVice:GENerator:ADDRess on page 818

Reference
Selects the internal R&S FPS or an external frequency reference to synchronize the
R&S FPS with the generator (default: internal).

Remote command:
SOURce:EXTernal :ROSCillator[:SOURce] on page 817

Edit Generator Setup File
Displays the setup file for the currently selected Generator Type in read-only mode in
an editor.

Although the existing setup files are displayed in read-only mode in the editor, they can
be saved under a different name (using "File > SaveAs").

Be careful, however, to adhere to the required syntax and commands. Errors are only
detected and displayed when you try to use the new generator (see also "Displayed
Information and Errors" on page 322).

For details, see "Generator Setup Files" on page 317.

Frequency Min / Frequency Max
For reference only: Lower and upper frequency limit for the generator.

Level Min / Level Max
For reference only: Lower and upper power limit for the generator.
Measurement Settings

Access: INPUT/OUPUT > "External Generator Config" > "Measurement Configuration”
tab



R&S®FPS Common Measurement Settings

TInput.

Input Source Power Sensor External Generator

Measurement
Configuration | Source State

Interface Source Power -20.0 dBm

Configuration
Source Offset
Source

Calibration Frequency Coupling

Coupling State Manual

Numerator |§i

SorceFreq <RF* oMt

Denominator ||}
Result Frequency Start

Result Frequency Stop

SOUICE STALE .eiviiiiiiii e e e e e e e e e e e e aaaa s 326
SOUMCE POWET ...ttt ettt e e e sttt e e s et e e e s e nbe e e e s e eabeeeeeeenreeas 326
SOUICE OFfSEL .. e e e e e e e e 326
Source Frequency CoupliNg.........cooiiiiiiiiiiiiiiiccrerse e e e e e e e e 327
(Manual) SOUICE FrEqQUENCY......cciii ittt e e 327
(Automatic) Source Frequency (Numerator/Denominator/Offset).........ccccoeeeeeinnnnen. 327
Result FrequeNnCy Start ... 328
TS0 L =Y (0= ooy VS ) o] o SRR 328

Source State
Activates or deactivates control of an external generator.

Remote command:
SOURce:EXTernal [:STATe] on page 817

Source Power
The output power of the external generator. The default output power is -20 dBm. The
range is specified in the data sheet.

Remote command:
SOURce:EXTernal : POWer [ : LEVel] on page 816

Source Offset

Constant level offset for the external generator. Values from -200 dB to +200 dB in 1
dB steps are allowed. The default setting is 0 dB. Offsets are indicated by the "LVL"
label in the channel bar (see also "Displayed Information and Errors" on page 322).

Using this offset, attenuators or amplifiers at the output connector of the external gen-
erator can be taken into account. This is useful, for example, for the displayed output
power values on screen or during data entry. Positive offsets apply to an amplifier,
while negative offsets apply to an attenuator after the external generator.
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Remote command:
SOURce:POWer [:LEVel] [:IMMediate] : OFFSet on page 817

Source Frequency Coupling
Defines the frequency coupling mode between the R&S FPS and the generator.

For more information on coupling frequencies, see "Coupling the Frequencies"
on page 320.

"Auto” Default setting: a series of frequencies is defined (one for each
sweep point), based on the current frequency at the RF input of the
R&S FPS (see "(Automatic) Source Frequency (Numerator/Denomi-
nator/Offset)" on page 327). The RF frequency range covers the cur-
rently defined span of the R&S FPS (unless limited by the range of
the signal generator).

"Manual" The generator uses a single fixed frequency, defined by (Manual)
Source Frequency which is displayed when you select "Manual" cou-
pling.

Remote command:

SOURce:EXTernal : FREQuency:COUPling[:STATe] on page 815

(Manual) Source Frequency
Defines the fixed frequency to be used by the generator.

Remote command:
SOURce:EXTernal : FREQuency on page 814

(Automatic) Source Frequency (Numerator/Denominator/Offset)
With automatic frequency coupling, a series of frequencies is defined (one for each
sweep point), based on the current frequency at the RF input of the R&S FPS.

However, the frequency used by the generator may differ from the input from the
R&S FPS. The RF frequency can be multiplied by a specified factor, or a frequency off-
set can be added, or both.

Note: The input for the generator frequency is not validated, i.e. you can enter any val-
ues. However, if the allowed frequency ranges of the generator are exceeded, an error
message is displayed on the R&S FPS. The values for Result Frequency Start and
Result Frequency Stop are corrected to comply with the range limits.

The value range for the offset depends on the selected generator. The default setting
is 0 Hz. Offsets <> 0 Hz are indicated by the "FRQ" label in the channel bar. Negative
offsets can be used to define reverse sweeps.

For more information on coupling frequencies and reverse sweeps, see "Coupling the
Frequencies" on page 320. For more information on error messages and the channel
bar, see "Displayed Information and Errors" on page 322.

Remote command:

SOURce:EXTernal : FREQuency [ :FACTor] : DENominator on page 815
SOURce:EXTernal : FREQuency [ :FACTor] :NUMerator on page 816
SOURce:EXTernal : FREQuency: OFFSet on page 816
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Result Frequency Start
For reference only: The start frequency for the generator, calculated from the config-
ured generator frequency and the start value defined for the R&S FPS.

Result Frequency Stop
For reference only: The stop frequency for the generator, calculated from the config-
ured generator frequency and the stop value defined for the R&S FPS.

Source Calibration Functions

Access: INPUT/OUPUT > "External Generator Config" > "Source Calibration" tab

The calibration functions of the external generator are available only if external genera-
tor control is active (see " Source State " on page 326).

[Imput Spectrum !

A ¥
i| Input Source Power Sensor Tracking Generator

|
Maasurement
Configuration

Interface Reflection Sha
Configuration Ao onn

| |Source
Calibration

(OF=11] o = 1 I I = 10 ST 0 0] 571 (o o FO PR 328
(OF= 1] o = 1 (S R [STe o] IR o o] o 329
(07111 0] ¢=1 (3 2= [T ox 1o T @ o =T o 329
Source Calibration NOrmMaliZE ......c.euueiiiiiiiieee e 329
= Tor1 | U RUPPPRRTNE 329
Y= LT TR I o B o= (o (o] PP 329
RefErenCe POSITION .....ccoeiiieeeeeeee ettt e e e e ee e e e eaees 330
RETEIENCE VAIUE ... .ottt e e e e e e eeaaaas 330

Calibrate Transmission
Starts a transmission type measurement to determine a reference trace. This trace is
used to calculate the difference for the normalized values.

For details, see "Calibration Mechanism" on page 317.

Remote command:
[SENSe: ] CORRection:METHod on page 820

HE
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Calibrate Reflection Short
Starts a short-circuit reflection type measurement to determine a reference trace for
calibration.

If both calibrations (open circuit, short circuit) are carried out, the calibration trace is
calculated by averaging the two measurements. The order of the two calibration mea-
surements is irrelevant.

Remote command:

[SENSe: ] CORRection:METHod on page 820

Selects the reflection method.
[SENSe:]CORRection:COLLect [:ACQuire] on page 819
Starts the sweep for short-circuit calibration.

Calibrate Reflection Open
Starts an open-circuit reflection type measurement to determine a reference trace for
calibration.

If both reflection-type calibrations (open circuit, short circuit) are carried out, the refer-
ence trace is calculated by averaging the two measurements. The order of the two cali-
bration measurements is irrelevant.

Remote command:

[SENSe: ] CORRection:METHod on page 820

Selects the reflection method.
[SENSe:]CORRection:COLLect [:ACQuire] on page 819
Starts the sweep for open-circuit calibration.

Source Calibration Normalize

Switches the normalization of measurement results on or off. This function is only
available if the memory contains a reference trace, that is, after a calibration has been
performed.

For details on normalization, see "Normalization" on page 318.

Remote command:
[SENSe:]CORRection[:STATe] on page 821

Recall

Restores the settings that were used during source calibration. This can be useful if
instrument settings were changed after calibration (e.g. center frequency, frequency
deviation, reference level, etc.).

Remote command:
[SENSe:]CORRection:RECall on page 821

Save as Trd Factor

Uses the normalized measurement data to generate a transducer factor. The trace
data is converted to a transducer with unit dB and stored in a file with the specified
name and the suffix . trd under "C:\R_S\INSTR\trd". The frequency points are
allocated in equidistant steps between start and stop frequency. The generated trans-
ducer factor can be further adapted using the "Transducer" softkey in the SETUP
menu.



Data Input and Output

For more information on transducers, see Chapter 10.3.1, "Basics on Transducer Fac-
tors", on page 546.

This function is only available if Source Calibration Normalize is switched on.

Note: Note that the normalized measurement data is used, not the reference trace!
Thus, if you store the normalized trace directly after calibration, without changing any
settings, the transducer factor will be 0 dB for the entire span (by definition of the nor-
malized trace).

Remote command:
[SENSe:]CORRection:TRANsducer:GENerate on page 821

Reference Position

Defines the position of the Result Frequency Stop in percent of the total y-axis range.
The top of the diagram is 100%, the bottom is 0%. By default, the 0 dB line is displayed
at the top of the diagram (100%).

This setting is only available if normalization is on (see " Source Calibration Normalize
"on page 329).

The reference line defined by the reference value and reference position is similar to
the Reference Level defined in the "Amplitude" settings. However, this reference line
only affects the y-axis scaling in the diagram, it has no effect on the expected input
power level or the hardware settings.

The normalized trace (0 dB directly after calibration) is displayed on this reference line,
indicated by a red line in the diagram. If you shift the reference line, the normalized
trace is shifted, as well.

Remote command:
DISPlay[:WINDow<n>] :TRACe<t>:Y[:SCALe] :RPOSition on page 798

Reference Value
Defines the reference value to be displayed at the specified Result Frequency Start .

This setting can be used to shift the reference line and thus the normalized trace, simi-
lar to the Shifting the Display ( Offset ) defined in the "Amplitude” settings shifts the ref-
erence level in the display.

Shifting the normalized trace is useful, for example, to reflect an attenuation or gain
caused by the measured DUT. If you then zoom into the diagram around the normal-
ized trace, the measured trace still remains fully visible.

Remote command:
DISPlay[:WINDow<n>] :TRACe<t>:Y[:SCALe] :RVALue on page 819

7.2.4.4 How to Work With External Generator Control

The following step-by-step instructions demonstrate how to work with the optional
External Generator Control.

For remote operation, see "Programming Example for External Generator Control"
on page 822.
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How to Calibrate a Measurement Setup using an External Generator................. 331
How to Remove the Effects of a Particular Component from Measurement Results

USING Calibration........coii i e 332
How to Compensate for Additional Gain or Attenuation after Calibration............. 333

How to Calibrate a Measurement Setup using an External Generator

10.
11.

12.

13.
14.

15.

Connect the signal generator's LAN interface connector to the LAN connector on
the rear panel of the R&S FPS.

Connect the signal generator output to the RF INPUT connector of the R&S FPS.

If the measurement setup does not require the full span of the R&S FPS, change
the "Frequency Start" and "Frequency Stop" values (FREQ key > "Frequency Con-
fig" softkey).

Press the INPUT/OUTPUT key and select "External Generator Config".

In the "Interface Configuration" subtab, select the "Generator Type" connected to
the R&S FPS.

If the required generator type is not available, define a new setup file as described
in "To define a new generator setup file" on page 332.

Select the type of interface and the address used to connect the generator to the
R&S FPS.

Select "Reference: External" to synchronize the analyzer with the generator.
Switch to the "Measurement Configuration" subtab.

Set the "Source State" to "On".

Define the generator output level as the "Source Power".

Optionally, to define a constant level offset for the external generator, define a
"Source Offset".

The default frequency list for the calibration sweep contains 1001 values, divided in
equi-distant frequencies between the R&S FPS's start and stop frequency. For
most cases, this automatic coupling should be correct. Check the "Result Fre-
quency Start" and "Result Frequency Stop" values to make sure the required mea-
surement span is covered. If necessary, change the frequency settings on the
R&S FPS (FREQ key > "Frequency Config" softkey), or use a different generator

type.
Switch to the "Source Calibration" subtab.

Select the "Source Calibration Type": "Transmission" to perform a calibration
sweep and store a reference trace for the measurement setup.

Select "Source Calibration Normalize": "On".
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16. Optionally, shift the reference line further down in the result display by descreasing
the "Reference": "Position".

The measurement setup is now calibrated. Subsequent measurement results are
normalized, so that any unwanted effects from the cables and connectors are
removed.

To define a new generator setup file
1. Press the INPUT/OUTPUT key and select "External Generator Config".

2. In the "Interface Configuration" subtab, select a generator type that has similar
characteristics (frequency and power ranges).

3. Select "Edit Generator Setup File".
The configuration file for the selected generator type is displayed (read-only) in an
editor.

4. Edit the configuration values according to your generator. Be sure not to change
the syntax of the file - only change the values of the parameters.
Errors will only be detected and displayed when you try to use the new generator
(see also "Displayed Information and Errors" on page 322).

5. Save the file under a different name with the extension . gen:

a) In the editor, select "File > SaveAs".
b) Select "Save as type: All Files (*.*)".
c) Specify a name with the extension . gen.

6. Inthe R&S FPS firmware, close the "External Generator Config" dialog and re-
open it.

Now you can select the new generator type from the selection list on the "Interface
Configuration" tab.

How to Remove the Effects of a Particular Component from Measurement
Results Using Calibration

1. Set up the measurement, including the component, and perform a calibration as
described in "How to Calibrate a Measurement Setup using an External Generator"
on page 331.

2. After setting "Source Calibration Normalize": "On", select "Save as Trd Factor" to
store the normalized reference trace as a transducer factor.

3. If necessary, switch to another measurement channel for a different R&S FPS
application.

4. Press the SETUP key, then select the "Transducer" softkey.

5. Select the stored transducer in the list of available transducers and select the
"Active" setting for it.
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6. Perform any measurement with the setup that contains the calibrated component.

The measurement results do not include the effects from the component.

How to Compensate for Additional Gain or Attenuation after Calibration

If a gain or an attenuation is inserted in the measurement after calibration, this effect
can be reflected in the display of the normalized trace on the R&S FPS. Thus, the
measured trace and the normalized trace are not so far apart in the display, so that you
can zoom into the normalized trace without cropping the measurement trace.

Prerequisite: a calibration has been performed for the original measurement setup,
except for the component causing an additional gain or attenuation (as described in
"How to Calibrate a Measurement Setup using an External Generator" on page 331)

1. Insert the additional component in the calibrated measurement setup and perform
a new measurement.

2. Press the INPUT/OUTPUT key and select "External Generator Config".
3. Switch to the "Source Calibration" subtab.

4. With active normalization, set the "Reference":"Value" to the same value as the
gain or attenuation the inserted component causes.

5. Optionally, shift the reference line further down in the result display by decreasing
the "Reference": "Position".

The normalized reference trace moves to the position of the measured trace.

6. Optionally, zoom into the measured trace by changing the y-axis scaling (or the
range: "AMPT > Scale Config > Range").

The measured trace is still fully visible, and the absolute values are still valid.

7.2.4.5 Measurement Example: Calibration with an External Generator
The following measurement example demonstrates the most common functions using
an external generator. This example requires the External Generator Control option.

The example assumes an SMW100A generator is connected to the R&S FPS via
TCP/IP. A band elimination filter is the device under test. After calibration, an additional
attenuator is inserted between the DUT and the R&S FPS.

The following procedures are described:

e "Calibrating the measurement setup" on page 333

® "Measuring the effects of the DUT" on page 335

® "Compensating the effects of additional attenuation after calibration" on page 337
Calibrating the measurement setup

1. Connect the signal generator to the R&S FPS using a LAN cable.
2. Connect the signal generator output to the RF INPUT connector of the R&S FPS.
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Adapt the measurement range of the R&S FPS to the filter to be tested. In this
measurement, define the following settings:

a) Pressthe FREQ key, select "Frequency Config" and enter "Frequency Start":
100 MHz.
b) Enter "Frequency Stop": 300 MHz

Press the INPUT/OUTPUT key and select "External Generator Config".

In the "Interface Configuration" sub-tab, select "Generator Type":"SMWO06".

4
5
6. Enter the TCP/IP address of the signal generator: 130.094.122.195
7. Select "Reference: External" to synchronize the analyzer with the generator.
8. Switch to the "Measurement Configuration" sub-tab.

9. Set the "Source State" to "On".

10. Define the generator output level as the "Source Power": -20 dBm.

11. Set the "Coupling State" to "Auto".

The "Result Frequency Start" value for the generator is indicated as 700.0 MHz.
The "Result Frequency Stop" value is indicated as 300.0 MHz.

12. Switch to the "Source Calibration" sub-tab.

13. Select the "Source Calibration Type": "Transmission" to perform a calibration
sweep and store a reference trace for the measurement setup.

Multiview 22 Spectrum !

RBW 2 MHz
Sms VBW 2MHz Mode Suto

= 15a Clrw

100.0 MHz 1001 pts 20.0 MHz/ 300.0 MHz

Figure 7-6: Measurement results from generator, analyzer and connecting cables

14. Select "Source Calibration Normalize": "On" to set the measurement results for the
current setup to 0, thus eliminating all effects from the generator, the analyzer and
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the connecting cables from subsequent measurements with the band elimination
filter.

The reference line is displayed at 0 dB at the top of the diagram (100%).

MultiView Spectrum !

RBW 2 MHz
VBW 2 MHz Mode futo Swieep

1000 MHz 1001 pts 20,0 MHz / 300.0 MHz

Figure 7-7: Normalized measurement results after calibration

Measuring the effects of the DUT

After calibration we can insert the band elimination filter (our DUT) in the measurement
setup.

1. Connect the signal generator output to the band elimination filter.

2. Connect the band elimination filter output to the RF INPUT connector of the
R&S FPS.

|
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Multiview 32 Spectrum !

RBW 2 MHz
WT Zms VBW 2 MHz

100.0 MHz 1001 pts 20,0 MHz/ 300,00 MHz

Figure 7-8: Band elimination filter results

3. Shift the reference line from the top of the diagram to the middle of the diagram by
changing the position of the reference point 0.0 dB to 50 %.
In the "Source Calibration" tab, enter "Position": 50 %.

At the same time, the range of the displayed y-axis moves from [-100.0 dB to 0 dB]
to [-50 dB to +50 dB].

Multiview 32 Spectrum !

RBW 2 MHz
s VBW 2 MHz

= 158 Clrw

1000 MHz 1001 prs 20.0 MHz / 300, 0 MHZ

Figure 7-9: Reference line shifted to middle of diagram (50%)

[
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Compensating the effects of additional attenuation after calibration

After calibration, an additional attenuator is inserted between the DUT and the

R&S FPS. This may be necessary, for example, to protect the analyzer's input connec-
tor. Nevertheless, we are only interested in the effects of the DUT, not those of the
additional protective attenuator. Thus, we will compensate these effects in the result
display on the R&S FPS by moving the reference line.

1. Connect a 3 dB attenuator between the band elimination filter output and the RF
INPUT connector on the R&S FPS.

The measurement results are now 3 dB lower.

Multiview 22 Spectrum ! #

RBW 2 MHz
VBW 2 MHz Mode Suto Sweep

100,0 MHz 1001 pts 20,0 M |,._r|,-" 200.0 MHz

Figure 7-10: Measurement results with additional attenuator

2. Inthe "Source Calibration" tab, enter "Reference Value":-3 dB.

The reference line is shifted down by 3 dB so that the measurement trace is dis-
played on the reference line again.

At the same time, the scaling of the y-axis is changed: -3 dB are now shown at
50% of the diagram; the range is [-563 dB to +47 dB].
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Multiview 32 Spectrum ! #

RBW 2 MHz
3ms WVBW 2MHz Mode futo Sweep

100.0 MHz 1001 pts 20,0 Mt I,-_'I,-" 300.0 MHz

Figure 7-11: Reference line with an offset of -3 dB and shifted to middle of diagram (50%)

3. After the reference trace has been shifted, you can zoom into the measured trace
to determine the offsets to the reference line, which represent the effects of the
band elimination filter in the measurement setup.

Change the y-axis scaling to 1 dB/div (or the range to 10 dB).

a) Press the AMPT key, then select "Scale Config" > "Range".
b) Enter 70 dB.

RBYY 2 MHz
3ms  WBW 2MHz  Moda Auto

& {53 Clrw

100.0 MHz 1001 pts 20.0 MHz / 300,00 MHz

Figure 7-12: Reference line with measurement results using larger scale

7.2.5 Output Settings

Access: INPUT/OUTPUT > "Output"

[
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The R&S FPS can provide output to special connectors for other devices.

For details on connectors, refer to the R&S FPS Getting Started manual, "Front / Rear
Panel View" chapters.

Providing trigger signals as output is described in Chapter 7.2.7, "How to Output a Trig-
ger Signal", on page 342.

Output Digital IQ

IF/Video Output

IF Out Frequency

Trigger 2

1AV ATo =T @ 1V 1 11| SRR 339
| @ 10 o =T U =Y oV 339
NOISE SOUIMCE CONIOL...... it r e e e e e s aa e e e e e e baaaass 340

IF/Video Output
Defines the type of signal available at the IF/VIDEO output on the rear panel of the
R&S FPS.

For restrictions and additional information, see Chapter 7.2.1.2, "IF and Video Signal
Output", on page 303.

For restrictions and additional information, see the R&S FPS 1/Q Analyzer and 1/Q
Input User Manual.

"IF" The measured IF value is available at the IF/VIDEO output connector.

"Video" The displayed video signal (i.e. the filtered and detected IF signal) is
available at the IF/VIDEO output connector.
This setting is required to provide demodulated audio frequencies at
the output.

Remote command:
OUTPut:IF[:S0URce] on page 835

IF Out Frequency
Defines or indicates the frequency at which the IF signal level is provided at the IF/
VIDEO connector if IF/Video Output is set to "IF" .

For more information, see Chapter 7.2.1.2, "IF and Video Signal Output", on page 303.
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Noise Source Control

The R&S FPS provides a connector (NOISE SOURCE CONTROL) with a 28 V voltage
supply for an external noise source. By switching the supply voltage for an external
noise source on or off in the firmware, you can activate or deactivate the device as
required.

External noise sources are useful when you are measuring power levels that fall below
the noise floor of the R&S FPS itself, for example when measuring the noise level of an
amplifier.

In this case, you can first connect an external noise source (whose noise power level is
known in advance) to the R&S FPS and measure the total noise power. From this
value you can determine the noise power of the R&S FPS. Then when you measure
the power level of the actual DUT, you can deduct the known noise level from the total
power to obtain the power level of the DUT.

Remote command:
DIAGnostic:SERVice:NSOurce on page 834

7.2.6 Trigger Input/Output Settings

Access: "Overview" > "Trigger" > "Trigger In/Out"
Or: TRIG > "Trigger Config" > "Trigger In/Out"

The R&S FPS can use a signal from an external device as a trigger to capture data.
Alternatively, the internal trigger signal used by the R&S FPS can be output for use by
other connected devices.

Providing trigger signals as output is described in detail in Chapter 7.2.1.1, "Receiving
and Providing Trigger Signals", on page 302 and Chapter 7.2.7, "How to Output a Trig-
ger Signal", on page 342.

Trigger 2

Output Type User Defined 4 Level Low m

Pulse Length Send Trigger

Trigger 3
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Trigger 2

Trigger Source Trigger In/Out

Trigger 2

Output Type User Defined Level Low
Pulse Length Send Trigger Ant

Trigger 3 Output

Defines the usage of the variable TRIGGER AUX connector on the rear panel.
(Trigger 1 is INPUT only.)

"Input” The signal at the connector is used as an external trigger source by
the R&S FPS. Trigger input parameters are available in the "Trigger"
dialog box.

"Output” The R&S FPS sends a trigger signal to the output connector to be

used by connected devices.
Further trigger parameters are available for the connector.

Remote command:
OUTPut:TRIGger<port>:DIRection on page 807

Output Type — Trigger 2
Type of signal to be sent to the output

"Device Trig- (Default) Sends a trigger when the R&S FPS triggers.

gered"
"Trigger Sends a (high level) trigger when the R&S FPS is in "Ready for trig-
Armed" ger" state.
This state is indicated by a status bit in the STATus : OPERation reg-
ister (bit 5).

For details, see "STATus:OPERation Register" on page 592 and the
R&S FPS Getting Started manual.

"User Defined" Sends a trigger when you select the "Send Trigger" button.
In this case, further parameters are available for the output signal.

Remote command:
OUTPut : TRIGger<port>:0TYPe on page 808

Level < Output Type « Trigger 2
Defines whether a high (1) or low (0) constant signal is sent to the trigger output con-
nector.
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The trigger pulse level is always opposite to the constant signal level defined here. For
example, for "Level = High", a constant high signal is output to the connector until you
select the Send Trigger function. Then, a low pulse is provided.

v v

trigger trigger
5 < s 7
b, s,
low-level constant, high-level constant,
high-level trigger low-level trigger

Remote command:
OUTPut:TRIGger<port>:LEVel on page 807

Pulse Length < Output Type < Trigger 2
Defines the duration of the pulse (pulse width) sent as a trigger to the output connec-
tor.

Remote command:
OUTPut :TRIGger<port>:PULSe:LENGth on page 808

Send Trigger «— Output Type < Trigger 2
Sends a user-defined trigger to the output connector immediately.

Note that the trigger pulse level is always opposite to the constant signal level defined
by the output Level setting. For example, for "Level" = "High", a constant high signal is
output to the connector until you select the "Send Trigger" function. Then, a low pulse
is sent.

Which pulse level will be sent is indicated by a graphic on the button.

Remote command:
OUTPut:TRIGger<port>:PULSe: IMMediate on page 808

How to Output a Trigger Signal

Using the variable TRG AUX connector of the R&S FPS, the internal trigger signal can
be output for use by other connected devices. For details on the connectors see the
R&S FPS "Getting Started" manual.

To output a trigger to a connected device

1. Select TRIGGER > "Trigger Config".

2. Switch to the "Trigger In/Out" tab of the "Trigger and Gate".
3. Set the trigger to be used to "Output".
4

Define whether the trigger signal is to be output automatically ("Output Type" =
"Device triggered" or "Trigger Armed") or whether you want to start output manually
("Output Type" = "User-defined").
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5. For manual output: Specify the constant signal level and the length of the trigger
pulse to be output. Note that the level of the trigger pulse is opposite to the con-
stant output "Level" setting (compare the graphic on the "Send Trigger" button).

6. Connect a device that will receive the trigger signal to the configured TRG AUX
connector.

7. Start a measurement and wait for an internal trigger, or select the "Send Trigger"
button.

The configured trigger is output to the connector.

7.3 Frequency and Span Configuration

7.31

7311

The frequency and span settings define the scope of the signal and spectrum to be
analyzed with the R&S FPS.

e Impact of the Frequency and Span SettingsS.........ccccccveviciiieiieiiieie e, 343
o Frequency and Span SettingS.....cccuueiiiiiiiiiiii e 345
o Keeping the Center Frequency Stable - Signal Tracking.........ccccccevviverieniieeenen. 349
e How To Define the Frequency Range.........ccoooiiiiiiiiiiiiiiiie e 350
e How to Move the Center Frequency through the Frequency Range.................... 351

Impact of the Frequency and Span Settings

Some background knowledge on the impact of the described settings is provided here
for a better understanding of the required configuration.

e Defining the Scope of the Measurement - Frequency Range.........ccccocvvveveeeeennn. 343
e Stepping Through the Frequency Range - Center Frequency Stepsize............... 344
e Coping with Large Frequency Ranges - Logarithmic Scaling........cccccccccoeevennnnns 344

Defining the Scope of the Measurement - Frequency Range

The frequency range defines the scope of the signal and spectrum to be analyzed. It
can either be defined as a span around a center frequency, or as a range from a start
to a stop frequency. Furthermore, the full span comprising the entire possible fre-
quency range can be selected, or a zero span. The full span option allows you to per-
form an overview measurement over the entire span. Using the "Last Span" function
you can easily switch back to the detailed measurement of a specific frequency range.

For sinusoidal signals, the center frequency can be defined automatically by the
R&S FPS as the highest frequency level in the frequency span (see " Adjusting the
Center Frequency Automatically ( Auto Frequency )" on page 390).
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7.3.1.2 Stepping Through the Frequency Range - Center Frequency Stepsize

Using the arrow keys you can move the center frequency in discrete steps through the
available frequency range. The step size by which the center frequency is increased or
decreased is defined by the "Center Frequency Stepsize" .

The "Center Frequency Stepsize" also defines the step size by which the value is

6 increased or decreased when you use the rotary knob to change the center frequency;
however, the rotary knob moves in steps of only 1/10 of the "Center Frequency
Stepsize" to allow for a more precise setting.

By default, the step size is set in relation to the selected span or resolution bandwidth
(for zero span measurements). In some cases, however, it may be useful to set the
step size to other values.

For example, to analyze signal harmonics, you can define the step size to be equal to

@ the center frequency. In this case, each stroke of the arrow key selects the center fre-
quency of another harmonic. Similarly, you can define the step size to be equal to the
current marker frequency.

7.3.1.3 Coping with Large Frequency Ranges - Logarithmic Scaling

In a linear display, the frequencies are distributed linearly across the x-axis. That
means the entire frequency range is divided by the number of sweep points, and the
distance between sweep points is equal. Linear scaling is useful to determine precise
frequencies within a small range.

Figure 7-13: Linear x-axis scaling: the distance between the sweep points is equal, e.g. 200 kHz

However, if high and low frequencies appear in the same display, it is difficult to deter-
mine individual frequencies precisely or to distinguish frequencies that are close
together.

In a logarithmic display, lower frequencies are distributed among a much larger area of
the display, while high frequencies are condensed to a smaller area. Now it is much
easier to distinguish several lower frequencies, as they are spread over a wider area.
Logarithmic scaling is useful for overview measurements when a large frequency
range must be displayed in one diagram.

However, with logarithmic scaling, the frequency resolution between two sweep points
deteriorates with higher frequencies.
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Figure 7-14: Logarithmic x-axis scaling: the distance between sweep points is variable

In the spectrum from 10 Hz to 100 Hz, the distance is a few Hz. Between 100 MHz and
1 GHz, the distance is several MHz.

Thus, for logarithmic x-axis scaling, the number of sweep points must be sufficiently
high in order to distinguish high frequencies precisely. The resolution bandwidth should
cover at least one sweep point (that means: the distance between two sweep points
should not exceed the RBW). If this condition is not met, signals or interferers could be
missed, especially narrowband interferers.

Insufficient measurement points - Resolution filter bandwidth Resolution filter bandwidth covers
Filter may miss a signal covers one measurement point several measurement points

7.3.2 Frequency and Span Settings

Access: "Overview" > "Frequency"

For more information see Chapter 7.3.4, "How To Define the Frequency Range”,
on page 350.
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Frequency Signal Tracking

Frequency/Span
s T

Center Full Span

Span Zero Span

Start Last Span

Stop

Axis
Center Frequency Stepsize
ST 0.1 * Span

Frequency Offset

Value 0.0 Hz

‘ Frequency Signal Tracking

Tracking Bandwidth

Tracking Threshold

Signal Track Trace
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Center Frequency
Defines the center frequency of the signal in Hertz.

The allowed range of values for the center frequency depends on the frequency span.
span > 0: spanmin/2 < feenter < fmax — SPANMi/2

zero span: 0 Hz < fgnier < finax

fmax @nd span,,, depend on the instrument and are specified in the data sheet.

Remote command:
[SENSe: ] FREQuency:CENTer on page 777

Span
Defines the frequency span. The center frequency is kept constant. The following
range is allowed:

span =0: 0 Hz

span >0:

spaNnmin < f span < f max

fax @nd span,, are specified in the data sheet.

For more information see Chapter 7.3.1.1, "Defining the Scope of the Measurement -
Frequency Range", on page 343.

Remote command:
[SENSe: ] FREQuency: SPAN on page 779

Start / Stop
Defines the start and stop frequencies.

The following range of values is allowed:

frnin < fstart < fnax — SP@NMin

frin + SP@Nmin < ftop < frnax

frmin» Tmax @nd spany,;, are specified in the data sheet.

Remote command:
[SENSe: ] FREQuency: STARt on page 780
[SENSe: ] FREQuency:STOP on page 780

Frequency Axis Scaling
Switches between linear and logarithmic scaling for the frequency axis.

By default, the frequency axis has linear scaling. Logarithmic scaling of the frequency
axis, however, is common for measurements over large frequency ranges as it enhan-
ces the resolution of the lower frequencies. On the other hand, high frequencies get
more crowded and become harder to distinguish.
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For more information see Chapter 7.3.1.3, "Coping with Large Frequency Ranges -
Logarithmic Scaling”, on page 344.

Remote command:
DISPlay[:WINDow<n>]:TRACe:X:SPACing on page 777

Full Span
Sets the span to the full frequency range of the R&S FPS specified in the data sheet.
This setting is useful for overview measurements.

Remote command:
[SENSe: ] FREQuency:SPAN:FULL on page 780

Zero Span
Sets the span to 0 Hz (zero span). The x-axis becomes the time axis with the grid lines
corresponding to 1/10 of the current sweep time ( "SWT" ).

For details see Chapter 6.1, "Basic Measurements", on page 124.

Remote command:
FREQ:SPAN OHz, see [SENSe: ] FREQuency: SPAN on page 779

Last Span
Sets the span to the previous value. With this function you can switch between an
overview measurement and a detailed measurement quickly.

Remote command:
[SENSe: ] FREQuency: SPAN on page 779

Center Frequency Stepsize

Defines the step size by which the center frequency is increased or decreased when
the arrow keys are pressed. When you use the rotary knob the center frequency
changes in steps of only 1/10 of the span.

The step size can be coupled to the span (span > 0) or the resolution bandwidth (span
= 0), or it can be manually set to a fixed value.

For more details see Chapter 7.3.1.2, "Stepping Through the Frequency Range - Cen-
ter Frequency Stepsize", on page 344.

"0.1* Span"/  Sets the step size for the center frequency to 10 % of the span /
"0.1 * RBW" RBW.
This is the default setting.

"0.5* Span"/  Sets the step size for the center frequency to 50 % of the span /
"0.5 * RBW" RBW.

"X * Span"/ Sets the step size for the center frequency to a manually defined fac-
"x * RBW" tor of the span / RBW. The "X-Factor" defines the percentage of the
span / RBW.

Values between 1 and 100 % in steps of 1 % are allowed. The default
setting is 10 %.

"= Center" Sets the step size to the value of the center frequency and removes
the coupling of the step size to span or resolution bandwidth. The
used value is indicated in the "Value" field.
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"= Marker" This setting is only available if a marker is active.
Sets the step size to the value of the current marker and removes the
coupling of the step size to span or resolution bandwidth. The used
value is indicated in the "Value" field.

"Manual" Defines a fixed step size for the center frequency. Enter the step size
in the "Value" field.

Remote command:

[SENSe: ] FREQuency:CENTer:STEP: LINK on page 778

[SENSe: ] FREQuency:CENTer:STEP: LINK: FACTor on page 779
[SENSe: ] FREQuency:CENTer:STEP on page 777

Frequency Offset
Shifts the displayed frequency range along the x-axis by the defined offset.

This parameter has no effect on the instrument's hardware, or on the captured data or
on data processing. It is simply a manipulation of the final results in which absolute fre-
quency values are displayed. Thus, the x-axis of a spectrum display is shifted by a
constant offset if it shows absolute frequencies, but not if it shows frequencies relative
to the signal's center frequency.

A frequency offset can be used to correct the display of a signal that is slightly distorted
by the measurement setup, for example.

The allowed values range from -100 GHz to 100 GHz. The default setting is 0 Hz.

Remote command:
[SENSe: ] FREQuency:0FFSet on page 779

7.3.3 Keeping the Center Frequency Stable - Signal Tracking

If the signal drifts on the display but you want to keep the center frequency on the sig-
nal peak, the center frequency can be adjusted automatically using signal tracking. In
this case, the signal trace is surveyed in a specified bandwidth around the expected
center frequency. After each sweep, the center frequency is set to the maximum signal
found within the searched bandwidth. If no maximum signal above a defined threshold
value is found in the searched bandwidth, the center frequency remains unchanged.
The search bandwidth and the threshold value are shown in the diagram by red lines
which are labeled as "TRK" .
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Frequency Signal Tracking

State off |

Tracking'Bandwidth M
e RO -l -37.0 dBm

Signal Tracking

Access: "Overview" > "Frequency" > "Signal Tracking" tab

Defines the settings for signal tracking. These settings are only available for spans > 0.
For more details see Chapter 7.3.3, "Keeping the Center Frequency Stable - Signal
Tracking", on page 349.

If activated, after each sweep, the center frequency is set to the maximum level of the
specified "Signal Track Trace" found within the searched "Tracking Bandwidth" .

If the signal level does not pass the "Tracking Threshold" , the center frequency is not
changed.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:STRack[:STATe] on page 784
CALCulate<n>:MARKer<m>:FUNCtion:STRack:BANDwidth on page 784
CALCulate<n>:MARKer<m>:FUNCtion:STRack:THReshold on page 784
CALCulate<n>:MARKer<m>:FUNCtion:STRack:TRACe on page 785

7.3.4 How To Define the Frequency Range

The following step-by-step instructions demonstrate how to configure the frequency
and span settings. For details on individual functions and settings see Chapter 7.3.2,
"Frequency and Span Settings", on page 345.

The remote commands required to perform these tasks are described in Chap-
ter 12.7.1, "Defining the Frequency and Span", on page 776.
To configure the frequency and span

Frequency and span settings can be configured via the "Frequency" dialog box. Signal
tracking is configured in the "Signal Tracking" tab of this dialog box.

1. To display the "Frequency" dialog box, do one of the following:

e Select "Frequency" from the "Overview" .
e Select the FREQ key and then the "Frequency Config" softkey.

|
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e Select the SPAN key and then the "Frequency Config" softkey.

2. Define the frequency range using one of the following methods:

Define the "Center Frequency" and "Span" .
Define the "Start Frequency" and "Stop Frequency" .
To perform a measurement in the time domain, define the "Center Frequency"
and select the "Zero Span" button.

e To perform a measurement over the entire available frequency range, select
the "Full Span" button.

e To return to the previously set frequency range, select the "Last Span" button.

7.3.5 How to Move the Center Frequency through the Frequency Range

In some cases it may be useful to move the center frequency through a larger fre-
quency range, for example from one harmonic to another.

1. In the "Frequency" dialog box, define the "Center Frequency Stepsize" . This is the
size by which the center frequency is to be increased or decreased in each step.
Enter a manual or relative value, or set the step size to the current center fre-
quency or marker value. To move from one harmonic to the next, use the center
frequency or marker value.

2. Select the "Center Frequency" dialog field.

3. Use the arrow keys to move the center frequency in discrete steps through the
available frequency range.

7.4 Amplitude and Vertical Axis Configuration

In the Spectrum application, measurement results usually consist of the measured sig-
nal levels (amplitudes) displayed on the vertical (y-)axis for the determined frequency
spectrum or for the measurement time (horizontal, x-axis). The settings for the vertical
axis, regarding amplitude and scaling, are described here.

o Impact of the Vertical AXis Settings......c.ueeviiiiiiiiiii e 351
@  AMPIItUAE SELNGS..ciiiiiiii i e e e e e e e e e e e 354
O  SCAlING T Y- AXIS. ittt e e e e e e e e e e 358
e How to Optimize the Amplitude DiSplay.....ccccoueeiiiiiiiiiiiieee e 359

7.4.1 Impact of the Vertical Axis Settings

Some background knowledge on the impact of the described settings is provided here
for a better understanding of the required configuration.

O REEIENCE LBVEL. ..o et e et e et e e e e e e e na e 352
L N £ (=) g 1V F= 1 (o] o TP 353
L IS T~ 11T TR PSSR 354
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Reference Level

The reference level value is the maximum value the AD converter can handle without
distortion of the measured value. Signal levels above this value will not be measured
correctly, which is indicated by the "IF Overload" status display.

Internally, the reference level is also used to determine the optimum hardware settings
for the R&S FPS. The defined reference level should correspond with the maximum
expected RF input level.

When determining the expected input level, consider that the power from all input sig-
nals contribute to the total power. The reference level must be higher than the total
power from all signals.

The optimum reference level for the current measurement settings can be set automat-
ically by the R&S FPS (see " Reference Level " on page 355).

The reference level determines the amplitude represented by the topmost grid line in
the display. When you change the reference level, the measurement is not restarted;
the results are merely shifted in the display. Only if the reference level changes due to
a coupled RF attenuation (see " Attenuation Mode / Value " on page 356), the mea-
surement is restarted.

In general, the R&S FPS measures the signal voltage at the RF input. The level display
is calibrated in RMS values of an unmodulated sine wave signal. In the default state,
the level is displayed at a power of 1 mW (= dBm). Via the known input impedance,
conversion to other units is possible.

See " Impedance " on page 304.

Reference level offset

If the signal is attenuated or amplified before it is fed into the R&S FPS, you can define
an (arithmetic) offset to the reference level so the application shows correct power
results. All displayed power level results are shifted by this value, and the scaling of the
y-axis is changed accordingly.

To determine the required offset, consider the external attenuation or gain applied to
the input signal. For attenuation, define a positive offset so the R&S FPS increases the
displayed power values.

If an external gain is applied, define a negative offset so the R&S FPS decreases the
displayed power values.

Note, however, that the internal reference level (used to adjust the hardware settings to
the expected signal optimally) ignores any "Reference Level Offset" . Thus, it is impor-
tant to keep in mind the actual power level the R&S FPS must handle, and not to rely
on the displayed reference level.

internal reference level = displayed reference level - offset

Example

1. The initial reference level is 2 dBm with no offset.
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Both the displayed reference level and the internal reference level are 2 dBm.

2. An offset of 3 dB is defined.

The displayed reference level is adjusted to 5 dBm.
The internal reference level remains at 2 dBm.
(5 dBm (displayed ref level) - 3 dB (offset) = 2 dBm)

3. Now the user decreases the reference level to 1 dBm.

The displayed reference level is adjusted to 1 dBm.
The internal reference level is adjusted to:
1 dBm (displayed ref level) - 3 dB (offset) = -2 dBm.

7.4.1.2 RF Attenuation

The attenuation is meant to protect the input mixer from high RF input levels. The level
at the input mixer is determined by the set RF attenuation according to the formula:

"levelyixer = leveli,, — RF attenuation”
The maximum mixer level allowed is 0 dBm.

Mixer levels above this value may lead to incorrect measurement results, which is indi-
cated by the "RF Overload" status display. Furthermore, higher input levels may dam-
age the instrument. Therefore, the required RF attenuation is determined automatically
according to the reference level by default.

High attenuation levels also avoid intermodulation. On the other hand, attenuation
must be compensated for by re-amplifying the signal levels after the mixer. Thus, high
attenuation values cause the inherent noise (i.e the noise floor) to rise and the sensitiv-
ity of the analyzer decreases.

The sensitivity of a signal analyzer is directly influenced by the selected RF attenua-
tion. The highest sensitivity is obtained at an RF attenuation of 0 dB. Each additional
10 dB step reduces the sensitivity by 10 dB, i.e. the displayed noise is increased by 10
dB. To measure a signal with an improved signal-to-noise ratio, decrease the RF
attenuation.

6 For ideal sinusoidal signals, the displayed signal level is independent of the RF attenu-
ation.

Depending on the type of measurement you must find a compromise between a low
noise floor and high intermodulation levels, and protecting the instrument from high
input levels. You achieve this best by letting the R&S FPS determine the optimum level
automatically (see " Attenuation Mode / Value " on page 356).
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Electronic attenuation

If the optional electronic attenuation hardware is installed on the R&S FPS, you can
also activate an electronic attenuator. For details, see " Using Electronic Attenuation "
on page 356.

7.41.3 Scaling

In a linear display, the measurement values are distributed linearly throughout the grid.
That means the entire range of measured values is divided by the number of rows in
the grid (10) and each row corresponds to 1/10 of the total range. Linear scaling is use-
ful to determine precise levels for a small range of values. However, if large and small
values appear in the same display, it is difficult to determine individual values precisely
or to distinguish values that are close together.

In a logarithmic display, smaller values are distributed among a much larger area of the
display, while large values are condensed to a smaller area. Now it is much easier to
distinguish several lower values, as they are spread over a wider area. Logarithmic
scaling is useful when large ranges of values must be combined in one display. Loga-
rithmic scaling is best applied to measurement values in logarithmic units (dB, dBm
etc.).

In addition to linear or logarithmic scaling, the vertical axis can be set to display either
absolute or relative values. Absolute values show the measured levels, while relative
values show the difference between the measured level and the defined reference
level. Relative values are indicated in percent for linear scaling, and in dB for logarith-
mic scaling.

7.4.2 Amplitude Settings

Access: "Overview" > "Amplitude”

Amplitude settings determine how the R&S FPS must process or display the expected
input power levels.

The remote commands required to define these settings are described in Chap-
ter 12.7.3.1, "Amplitude Settings", on page 792.

REFEIENCE LEVE .ceiiiiiiiiee ettt e e e saneee e s 355
L Shifting the DiSplay ( OffSEt )......cciveueeeieeeeeeeeeeeseeee e eee e ees e ee e 355
LUt e 355
L Setting the Reference Level Automatically ( Auto Level ).............cccccueee..... 356
L N A (=T a1 E= 1 o] o SRR 356
L Attenuation Mode / VAIUE ........c.cueveveveveeeeeeeeeeeceeeeeeteeseseeseeessesesesaesseesesenes 356
Using Electronic AHENUALION .......ccoiiiiiieeeec e e 356
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Reference Level
Defines the expected maximum reference level. Signal levels above this value may not
be measured correctly. This is indicated by an "IF Overload" status display.

The reference level can also be used to scale power diagrams; the reference level is
then used as the maximum on the y-axis.

Since the hardware of the R&S FPS is adapted according to this value, it is recommen-
ded that you set the reference level close above the expected maximum signal level.
Thus you ensure an optimum measurement (no compression, good signal-to-noise
ratio).

For details, see Chapter 7.4.1.1, "Reference Level", on page 352.

Remote command:
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe] :RLEVel on page 793

Shifting the Display ( Offset ) — Reference Level
Defines an arithmetic level offset. This offset is added to the measured level. In some
result displays, the scaling of the y-axis is changed accordingly.

Define an offset if the signal is attenuated or amplified before it is fed into the R&S FPS
so the application shows correct power results. All displayed power level results are
shifted by this value.

The setting range is £200 dB in 0.01 dB steps.

Note, however, that the internal reference level (used to adjust the hardware settings to
the expected signal) ignores any "Reference Level Offset" . Thus, it is important to
keep in mind the actual power level the R&S FPS must handle. Do not rely on the dis-
played reference level (internal reference level = displayed reference level - offset).

For details, see "Reference level offset" on page 352.

Remote command:
DISPlay[:WINDow<n>] :TRACe<t>:Y[:SCALe] :RLEVel:OFFSet on page 793

Unit — Reference Level
The R&S FPS measures the signal voltage at the RF input.

In the default state, the level is displayed at a power level of 1 mW (= dBm). Via the
known input impedance (50 Q or 75 Q, see " Impedance " on page 304), conversion to
other units is possible.

The following units are available and directly convertible:
dBm

dBmV

dBpVv

dBpA

dBpW

Volt

Ampere

Watt

Remote command:
INPut: IMPedance on page 813
CALCulate<n>:UNIT:POWer on page 793
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Setting the Reference Level Automatically ( Auto Level ) — Reference Level
Automatically determines a reference level which ensures that no overload occurs at
the R&S FPS for the current input data. At the same time, the internal attenuators are
adjusted so the signal-to-noise ratio is optimized, while signal compression and clip-
ping are minimized.

To determine the required reference level, a level measurement is performed on the
R&S FPS.

If necessary, you can optimize the reference level further. Decrease the attenuation
level manually to the lowest possible value before an overload occurs, then decrease
the reference level in the same way.

You can change the measurement time for the level measurement if necessary (see "
Changing the Automatic Measurement Time ( Meastime Manual )" on page 391).

Remote command:
[SENSe:]ADJust:LEVel on page 783

RF Attenuation
Defines the attenuation applied to the RF input of the R&S FPS.

Attenuation Mode / Value — RF Attenuation

The RF attenuation can be set automatically as a function of the selected reference
level (Auto mode). This ensures that no overload occurs at the RF INPUT connector
for the current reference level. It is the default setting.

By default and when no (optional) electronic attenuation is available, mechanical
attenuation is applied.

In "Manual" mode, you can set the RF attenuation in 1 dB steps (down to 0 dB). Other
entries are rounded to the next integer value. The range is specified in the data sheet.
If the defined reference level cannot be set for the defined RF attenuation, the refer-
ence level is adjusted accordingly and the warning "limit reached" is displayed.

NOTICE! Risk of hardware damage due to high power levels. When decreasing the
attenuation manually, ensure that the power level does not exceed the maximum level
allowed at the RF input, as an overload may lead to hardware damage.

For details, see Chapter 7.4.1.2, "RF Attenuation”, on page 353.

Remote command:
INPut:ATTenuation on page 794
INPut:ATTenuation:AUTO on page 795

Using Electronic Attenuation
If the (optional) Electronic Attenuation hardware is installed on the R&S FPS, you can
also activate an electronic attenuator.

In "Auto" mode, the settings are defined automatically; in "Manual" mode, you can
define the mechanical and electronic attenuation separately.

Note: Electronic attenuation is not available for stop frequencies (or center frequencies
in zero span) above 7 GHz.

In "Auto" mode, RF attenuation is provided by the electronic attenuator as much as
possible to reduce the amount of mechanical switching required. Mechanical attenua-
tion may provide a better signal-to-noise ratio, however.

User Manual 1176.8445.02 — 09 356
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When you switch off electronic attenuation, the RF attenuation is automatically set to
the same mode (auto/manual) as the electronic attenuation was set to. Thus, the RF
attenuation can be set to automatic mode, and the full attenuation is provided by the
mechanical attenuator, if possible.

The electronic attenuation can be varied in 1 dB steps. If the electronic attenuation is
on, the mechanical attenuation can be varied in 5 dB steps. Other entries are rounded
to the next lower integer value.

If the defined reference level cannot be set for the given attenuation, the reference
level is adjusted accordingly and the warning "limit reached" is displayed in the status
bar.

Remote command:

INPut :EATT:STATe on page 796
INPut:EATT:AUTO on page 796
INPut:EATT on page 795

Input Settings
Some input settings affect the measured amplitude of the signal, as well.

The parameters "Input Coupling" and "Impedance" are identical to those in the "Input”
settings.

See Chapter 7.2.2, "Input Source Settings", on page 303.

Preamplifier (option B22/B24) «— Input Settings
Switches the preamplifier on and off. If activated, the input signal is amplified by 20 dB.

If option R&S FPS-B22 is installed, the preamplifier is only active below 7 GHz.
If option R&S FPS-B24 is installed, the preamplifier is active for all frequencies.

When measuring Spurious Emissions, using this softkey automatically opens the
"Sweep List" dialog, see Chapter 6.6.4.1, "Sweep List", on page 252.

Remote command:
INPut:GAIN:STATe on page 796

Noise Cancellation
The R&S FPS can correct the results by removing the inherent noise of the analyzer,
which increases the dynamic range.

In this case, a reference measurement of the inherent noise of the analyzer is carried
out. The measured noise power is then subtracted from the power in the channel that
is being analyzed (first active trace only).

The inherent noise of the instrument depends on the selected center frequency, resolu-
tion bandwidth and level setting. Therefore, the correction function is disabled when-
ever one of these parameters is changed. A disable message is displayed on the
screen. To enable the correction function after changing one of these settings, activate
it again. A new reference measurement is carried out.

Noise cancellation is also available in zero span.

Currently, noise cancellation is only available for the following trace detectors (see "
Detector " on page 467):

® RMS
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® Average
Sample
® Positive peak

Remote command:
[SENSe: ] POWer:NCORrection on page 794

7.4.3 Scaling the Y-Axis

The individual scaling settings that affect the vertical axis are described here.
Access: "Overview" > "Amplitude" > "Scale" tab
Or: AMPT > "Scale Config"

The remote commands required to define these settings are described in Chap-
ter 12.7.3, "Configuring the Vertical Axis (Amplitude, Scaling)", on page 792.

Amplitude Scale
=t ] Scaling

O Logarithmic
Range 100 dB ~

Linear Percent

Ref Level Position |0 ; : :
. Linear with Unit

= o TSRt 358
(R I =YL= e X=T1 (o] o I 359
XU L (oS or=1 (SO o Lo TN 359
R To=1 1 0o [ PR PTPPRP 359
Range

Defines the displayed y-axis range in dB.
The default value is 100 dB.

Remote command:
DISPlay[:WINDow<n>] :TRACe<t>:Y[:SCALe] on page 797

HE
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Ref Level Position

Defines the reference level position, i.e. the position of the maximum AD converter
value on the level axis in %, where 0 % corresponds to the lower and 100 % to the
upper limit of the diagram.

For spectrograms, this value defines the position of the reference level value within the
span covered by the color map. In this case, the value is given in %, where 0 % corre-
sponds to the maximum (right end) and 100 % to the minimum (left end) of the color
map.

Remote command:

DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe] :RPOSition on page 798

Auto Scale Once
Automatically determines the optimal range and reference level position to be dis-
played for the current measurement settings.

The display is only set once; it is not adapted further if the measurement settings are
changed again.

Remote command:
DISPlay[:WINDow<n>]:TRACe<t>:Y[:SCALe] :AUTO ONCE on page 797

Scaling
Defines the scaling method for the y-axis.

For more information see Chapter 7.4.1.3, "Scaling", on page 354.
"Logarithmic" Logarithmic scaling (only available for logarithmic units - dB..., and A,

V, Watt)

"Linear with Linear scaling in the unit of the measured signal

Unit"

"Linear Per- Linear scaling in percentages from 0 to 100

cent"

"Absolute" The labeling of the level lines refers to the absolute value of the refer-
ence level (not available for "Linear Percent" )

"Relative" The scaling is in dB, relative to the reference level (only available for
logarithmic units - dB...). The upper line of the grid (reference level) is
always at 0 dB.

Remote command:
DISPlay[:WINDow<n>]:TRACe<t>:Y:SPACing on page 799
DISPlay[:WINDow<n>] :TRACe<t>:Y[:SCALe] :MODE on page 798

How to Optimize the Amplitude Display

This section gives you some advice on how to optimize the display of the measured
signal amplitudes depending on the required evaluation.

1. Perform a measurement with the default settings to get an impression of the values
to be expected.



Bandwidth, Filter and Sweep Configuration

2. Use the "Auto Level" function (AUTO menu) to optimize the reference level.
3. Use the "AF Auto Scale" function (AUTO menu) to optimize the scaling.

4. To determine a precise level at a specific point in the signal:

e Reduce the "Range" of the y-axis to a small area around the required level. If
necessary, change the "Ref Level Position" so the required range remains visi-
ble.

e Select "Linear with Unit" scaling.

Now you can set a marker at the point in question and read the result.

5. To detect a spurious signal close to the noise floor:

e Set the "RF Attenuation" to "Manual" mode and reduce the "Value" to lower the
noise floor.
e Select "Relative" - "Logarithmic" scaling.

Now you can determine if any spurious levels of a certain size are visible.

7.5 Bandwidth, Filter and Sweep Configuration

The basic bandwidth, filter and sweep settings that apply to most measurements are
described here. These parameters define how the data is measured: how much data is
collected internally and which filters are used.

e Impact of the Bandwidth, Filter and Sweep Settings........cccceeeeiiiiiiiiiiiiiiiiee, 360
e Bandwidth, Filter and Sweep Settings....cc.ouuiiiiiiiiiii e 366
e Reference: List of Available RRC and Channel Filters...........ceeeeviiiiiiieeeeeeiennnn. 373

7.5.1 Impact of the Bandwidth, Filter and Sweep Settings

The bandwidth, filter and sweep settings are closely related and interdependent. The
values available for resolution bandwidth and video bandwidth depend on the selected
filter type. In addition, these settings have an impact on other measurement parame-
ters. The following equation shows the interdependency of these settings:

Tuin = K*Span/RBW?
where K = Filter constant

By default, a Gaussian filter is used. The resolution bandwidth, the video bandwidth
and the "Sweep Time" are set automatically according to the set span, and default cou-
pling is used. Thus, the following settings are applied:

RBW = 100 * Span
VBW = RBW = 100 * Span
"Sweep Time" = T, for set Span, RBW, VBW
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When defining the bandwidth and filter settings, consider the impact of the individual
settings on the other settings and the measurement result, as described in more detail
in the following sections.

e Separating Signals by Selecting an Appropriate Resolution Bandwidth............... 361
e Smoothing the Trace Using the Video Bandwidth........c.coccociiiiiiiiiniie 362
o Coupling VBW and RBW.........uuiiiiiiiiieie ettt sveeee e 362
e Coupling Span and RBW. ...ttt e e e e e e e e e e e s e snnnnes 363
e How Data is Measured: the SWeep TYPE....ccceeieiiieiiiiiieee e 363
e Which Data May Pass: Filter TYPES......ccco oo eeeeeens 364
e How Long the Data is Measured: Sweep TimMe ... 365
e How Much Data is Measured: Sweep Points and Sweep Count.......................... 365
e How Often Data is Measured: Sweep MOde..........cccccviiiiiiiieeeee e 366

7.5.1.1 Separating Signals by Selecting an Appropriate Resolution Bandwidth

The resolution bandwidth defines the 3 dB bandwidth of the resolution filter to be used.
An RF sinusoidal signal is displayed according to the passband characteristic of the
resolution filter (RBW), i.e. the signal display reflects the shape of the filter.

A basic feature of a signal analyzer is being able to separate the spectral components
of a mixture of signals. The resolution at which the individual components can be sepa-
rated is determined by the resolution bandwidth. Selecting a resolution bandwidth that
is too large may make it impossible to distinguish between spectral components, i.e.
they are displayed as a single component. Smaller resolution bandwidths, however,
increase the required "Sweep Time" .

Two signals with the same amplitude can be resolved if the resolution bandwidth is
smaller than or equal to the frequency spacing of the signal. If the resolution bandwidth
is equal to the frequency spacing, the spectrum display screen shows a level drop of 3
dB precisely in the center of the two signals. Decreasing the resolution bandwidth
makes the level drop larger, which thus makes the individual signals clearer.

The highest sensitivity is obtained at the smallest bandwidth (1 Hz). If the bandwidth is
increased, the reduction in sensitivity is proportional to the change in bandwidth.
Increasing the bandwidth by a factor of 3 increases the displayed noise by approx. 5
dB (4.77 dB precisely). If the bandwidth is increased by a factor of 10, the displayed
noise increases by a factor of 10, i.e. 10 dB.

If there are large level differences between signals, the resolution is determined by
selectivity as well as by the resolution bandwidth that has been selected. The measure
of selectivity used for signal analyzers is the ratio of the 60 dB bandwidth to the 3 dB
bandwidth (= shape factor).

For the R&S FPS, the shape factor for bandwidths is < 5, i.e. the 60 dB bandwidth of
the 30 kHz filter is <150 kHz.

The higher spectral resolution with smaller bandwidths is won by longer "Sweep Time"
s for the same span. The "Sweep Time" has to allow the resolution filters to settle dur-
ing a sweep at all signal levels and frequencies to be displayed.

If the RBW is too large, signal parts that are very far away (e.g. from a different signal)
are considered in the measurement and distort the results. The noise increases.

User Manual 1176.8445.02 — 09 361
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If the RBW is too small, parts of the signal are lost. As the displayed signal always
reflects the shape of the filter, select a bandwidth large enough so the displayed signal
reflects the entire shape of the filter.

7.5.1.2 Smoothing the Trace Using the Video Bandwidth

The video filters are responsible for smoothing the displayed trace. Using video band-
widths that are small compared to the resolution bandwidth, only the signal average is
displayed and noise peaks and pulsed signals are repressed. If pulsed signals are to
be measured, it is advisable to use a video bandwidth that is large compared to the
resolution bandwidth (VBW = 10 x RBW) for the amplitudes of pulses to be measured
correctly.

The level of a sine wave signal is not influenced by the video bandwidth. A sine wave
signal can therefore be freed from noise by using a video bandwidth that is small com-
pared with the resolution bandwidth, and thus be measured more accurately.

6 RMS/Average detector and VBW

If an RMS or average detector is used, the video bandwidth in the hardware is
bypassed. Thus, duplicate trace averaging with small VBWs and RMS or average
detector no longer occurs. However, the VBW is still considered when calculating the
"Sweep Time" . This leads to a longer "Sweep Time" for small VBW values. Thus, you
can reduce the VBW value to achieve more stable trace curves even when using an
RMS or average detector. Normally, if the RMS or average detector is used the
"Sweep Time" should be increased to get more stable traces.

7.5.1.3 Coupling VBW and RBW

The video bandwidth can be coupled to the resolution bandwidth automatically. In this
case, if the resolution bandwidth is changed, the video bandwidth is automatically
adjusted.

Coupling is recommended if a minimum "Sweep Time" is required for a selected reso-
lution bandwidth. Narrow video bandwidths require longer "Sweep Time" s due to the
longer settling time. Wide bandwidths reduce the signal/noise ratio.

Table 7-1: Overview of RBW/VBW ratios and recommendations for use

Ratio RBW/VBW Recommendation for use

171 Recommended for sinusoidal signals

This is the default setting for automatic coupling.

0.1 Recommended when the amplitudes of pulsed signals are to be measured
correctly. The IF filter is exclusively responsible for the pulse shape. No
additional evaluation is performed by the video filter.

10 Recommended to suppress noise and pulsed signals in the video domain.

Manually set (0.001 to 1000) | Recommended for other measurement requirements
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Coupling Span and RBW

The resolution bandwidth can be coupled to the span setting, either by a manually
defined factor or automatically. If the span is changed, the resolution bandwidth is
automatically adjusted. The automatic coupling adapts the resolution bandwidth to the
currently set frequency span/100.

With a span/RBW ratio of 100 and a screen resolution of 1000 pixels, each frequency
in the spectrum is displayed by 10 pixels. A span/RBW ratio of 1000 provides the high-
est resolution.

A higher span/RBW ratio (i.e. low RBW values and large frequency spans), however,
results in large amounts of data.

How Data is Measured: the Sweep Type

In a standard analog frequency sweep, the local oscillator of the analyzer sweeps the
applied signal quasi analog from the start to the stop frequency to determine the fre-
quency spectrum.

Alternatively, the analyzer can sample signal levels over time at a defined frequency
and transform the data to a spectrum by Fast Fourier Transformation (FFT). Although
this measurement method requires additional calculations, it can provide results much
faster than the frequency sweep, in particular for small RBWs.

Which sweep mode is appropriate for the current measurement depends on the span,
RBW, VBW and "Sweep Time" settings. By default ( "Auto" sweep type), the R&S FPS
automatically uses the sweep type with the highest sweep rate depending on these
measurement settings.

Restrictions for FFT mode

FFT mode is not available when using 5-Pole filters, Channel filters or RRC filters. In
this case, sweep mode is used.

The same applies when an external generator is active (with the optional External Gen-
erator Control).

Optimization

In FFT mode, FFT analysis is performed to determine a spectrum of frequencies. Sev-
eral analysis steps are required to cover the entire span. The partial span which is cov-
ered by one FFT analysis depends on the RBW. The partial span cannot be defined
directly, but it can be optimized according to measurement requirements.

Narrow partial spans provide a higher dynamic range, and also allow you to perform
measurements near a carrier with a reduced reference level. With a wide partial span,
the carrier and the useful signal are likely to be measured at the same time, in which
case the powers of both signals are summarized, so the reference level must be high
enough to consider this factor. With a narrow partial span, this is less likely to happen,
so the reference level can be reduced.
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For an optimal dynamic range, the narrowest possible partial span (depending on
the RBW) is used.

On the other hand, the narrower the partial span, the more steps are required to cover
the entire span, thus increasing analysis and calculation time. To optimize the sweep
rate, the widest possible partial span (depending on the RBW) is used.

For an optimal sweep rate, it is recommended that you set the "Sweep Time" to
"Auto" , as well.

7.5.1.6

For general purpose measurements, an "Auto" mode is available, which provides a
compromise between a large dynamic range and a fast sweep. In this case, a
medium-sized partial span is used.

Optimization for zero span sweeps

For normal sweeps in the time domain (zero span), the optimization mode determines
the selection of the A/D converter prefilter, which depends on the RBW.

In "Dynamic" mode, the narrowest possible prefilter is used.
In "Speed"” mode, the widest possible prefilter is used.

In "Auto™ mode, a medium-sized prefilter is used.

Which Data May Pass: Filter Types

While the filter is irrelevant when measuring individual narrowband signals (as long as
the signal remains within the RBW), the measurement result for broadband signals is
very dependant on the selected filter type and its shape. If the filter is too narrow, the
signal is distorted by the filter. If the filter is too wide, multiple signals can no longer be
distinguished. Generally, the smaller the filter width and the steeper its edges, the lon-
ger the settling time and thus the longer the "Sweep Time" must be.

All resolution bandwidths are realized with digital filters. Normal (3dB) Gaussian filters
are set by default. Some communication standards require different filters.

For a list of available filter types, see Chapter 7.5.3, "Reference: List of Available RRC
and Channel Filters", on page 373.
Normal (3 dB) Gaussian filters

Gaussian filters provide a good compromise between steep edges and a short settling
time. This filter is suitable for most measurement tasks and is used by default.

The available Gaussian (3 dB) filters are listed in the R&S FPS data sheet.

Channel filters

Channel filters are fairly steep but require a long settling time; they are useful for pulse
measurements in the time domain.
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RRC filters

Root raised cosine filters are similar in shape to channel filters and are required by
some measurement standards.

5-Pole filters

5-Pole filters are very broad and allow for a large bandwidth to pass.

7.5.1.7 How Long the Data is Measured: Sweep Time

Each filter has a settling time that must be awaited in order to obtain correct results.
Since the resolution bandwidth and video bandwidth define the filter, the smaller of the
two determines the minimum "Sweep Time" required for the measurement. Allowed
values depend on the ratio of span to RBW and RBW to VBW.

If the selected "Sweep Time" is too short for the selected bandwidth and span, level
measurement errors will occur. In this case, the R&S FPS displays the error message
"Sweep time too low" and marks the indicated "Sweep Time" with a red bullet. Further-
more, a status bit indicates an error.

(For more information see "STATus:QUEStionable: TIMe Register" on page 599.)

The "Sweep Time" can be coupled to the span (not zero span), video bandwidth
(VBW) and resolution bandwidth (RBW) automatically. If the span, resolution band-
width or video bandwidth is changed, the "Sweep Time" is automatically adjusted.

7.5.1.8 How Much Data is Measured: Sweep Points and Sweep Count

By default, 1001 data points are determined in a single sweep. During the next sweep,
1001 new data points are collected, and so on. The number of sweep points defines
how much of the entire span is covered by a single data point. By increasing the num-
ber of sweep points you can increase the reliability of the individual data points and
thus the accuracy of the analyzed results. However, these data points are all stored on
the instrument, occupying a large amount of memory, and each sweep point increases
the overall measurement time.

The number of sweeps to be performed in single sweep mode is defined by the
"Sweep Count". Values from 0 to 200000 are allowed. If the values 0 or 1 are set, one
sweep is performed. The sweep count is applied to all the traces in a diagram.

If the trace configurations "Average" , "Max Hold" or "Min Hold" are set, the "Sweep/
Average Count" also determines the number of averaging or maximum search proce-
dures (see "Analyzing Several Traces - Trace Mode" on page 462).

For details on how the number of sweep points and the sweep count affect the trace
results on the screen, see "Mapping Samples to sweep Points with the Trace Detector”
on page 459.
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7.5.1.9

7.5.2

How Often Data is Measured: Sweep Mode

How often the spectrum is swept depends on the sweep mode. Either a certain number
of sweeps can be defined ("Sweep Count") which are performed in "Single Sweep"
mode, or the sweep is repeated continuously ( "Continuous Sweep" mode).

By default, the data is collected for the specified number of sweeps and the corre-
sponding trace is displayed. When the next sweep is started, the previous trace is
deleted.

However, the data from a single sweep run can also be retained and displayed
together with the new data ( "Continue Single Sweep" mode). This is particularly of
interest when using the trace configurations "Average" or "Max Hold" to take previously
recorded measurements into account for averaging/maximum search (see "Analyzing
Several Traces - Trace Mode" on page 462).

Bandwidth, Filter and Sweep Settings

Access: "Overview" > "Bandwidth"

The remote commands required to define these settings are described in Chap-
ter 12.7.2, "Configuring Bandwidth and Sweep Settings", on page 785.

How to perform a basic sweep measurement is described in Chapter 6.1.2, "How to
Perform a Basic Sweep Measurement”, on page 125.

Bandwidth Sweep

Manual Manual Manual
3.0 MHz 37.8ms
Filter Type

Auto[100] Sine[1/1] : Normal(3dB)

100 1.0

Coupling Default

Figure 7-15: Bandwidth dialog box for RF measurements
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Bandwidth Sweep

Sweep Time Sweep/Average Count Sweep Points

Sweep Type Optimization
m[ FFT ][ Sweep ] m[D\mamic][ Speed ]

Spectrogram Frames

79.5 ms

Select Frame 0

Continue Frame [

Frame Count

Spectrogram Clear

Figure 7-16: Sweep dialog box for spectrogram display
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RBW
Defines the resolution bandwidth. The available resolution bandwidths are specified in
the data sheet. Numeric input is always rounded to the nearest possible bandwidth.

If "Auto" is selected, the resolution bandwidth is coupled to the selected span (for span
> 0). If the span is changed, the resolution bandwidth is automatically adjusted.

If the resolution bandwidth is defined manually, a green bullet is displayed next to the
"RBW" display in the channel bar.

For more information see Chapter 7.5.1.1, "Separating Signals by Selecting an Appro-
priate Resolution Bandwidth", on page 361.

For measurements on I/Q data in the frequency domain, the maximum RBW is 1 MHz.

Remote command:
[SENSe: ]BANDwidth[:RESolution] on page 785
[SENSe: ] BANDwidth[:RESolution] :AUTO on page 786

VBW
Defines the video bandwidth automatically or manually.

For more information see Chapter 7.5.1.2, "Smoothing the Trace Using the Video
Bandwidth", on page 362.

"Auto" The video bandwidth is coupled to the resolution bandwidth. If the
resolution bandwidth is changed, the video bandwidth is automatically
adjusted.

"Manual" For manual mode, define the bandwidth value. The available video

bandwidths are specified in the data sheet. Numeric input is always
rounded to the nearest possible bandwidth.

If the video bandwidth is defined manually, a green bullet is displayed
next to the "VBW" display in the channel bar.

Remote command:
[SENSe: ] BANDwidth:VIDeo:AUTO on page 787
[SENSe: | BANDwidth:VIDeo on page 787

Sweep Time
Defines the duration of a single sweep, during which the defined number of sweep
points are measured. The "Sweep Time" can be defined automatically or manually.

The allowed "Sweep Time" s depend on the device model; refer to the data sheet.

For more information see Chapter 7.5.1.7, "How Long the Data is Measured: Sweep
Time ", on page 365.

Note: The "Sweep Time" only indicates how long data is captured; the time required to
process the captured data may be considerably longer, in particular for FFT mode. For
FFT mode, an estimated duration is indicated behind the "Sweep Time" in the channel
bar (for RF measurements only).

"Auto" The "Sweep Time" is coupled to the span (not zero span), video
bandwidth (VBW) and resolution bandwidth (RBW). If the span, reso-
lution bandwidth or video bandwidth is changed, the "Sweep Time" is
automatically adjusted.
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"Manual” For manual mode, define the "Sweep Time" . Allowed values depend
on the ratio of span to RBW and RBW to VBW. For details refer to the
data sheet. Numeric input is always rounded to the nearest possible
"Sweep Time" .

Remote command:

[SENSe: ] SWEep: TIME:AUTO on page 790

[SENSe: ] SWEep: TIME on page 790

Span/RBW
Sets the coupling ratio if RBW is set to auto mode.

For more information see Chapter 7.5.1.4, "Coupling Span and RBW", on page 363.

"Auto[100]" "Resolution Bandwidth" = "Span/100"
This coupling ratio is the default setting of the R&S FPS.

"Manual" The coupling ratio is defined manually.
The span/resolution bandwidth ratio can be set in the range from 1 to
10000.

Remote command:
[SENSe: ]BANDwidth[:RESolution] :RATio on page 786

RBW/VBW
Sets the coupling ratio between the resolution bandwidth and the video bandwidth.

This setting is only effective if VBW is set to auto mode.
For more information see Chapter 7.5.1.3, "Coupling VBW and RBW", on page 362.

"Sine[1/1]" "Video Bandwidth" = "Resolution Bandwidth"
This is the default setting for the coupling ratio RBW/VBW and is rec-
ommended if sinusoidal signals are to be measured.

"Pulse[0.1]" "Video Bandwidth" = 10 x "Resolution Bandwidth"
or
"Video Bandwidth" = "10 MHZz" (= max. VBW)
Recommended for pulse signals

"Noise[10]" "Video Bandwidth" = "Resolution Bandwidth/10"
Recommended for noise measurements

"Manual" The coupling ratio is defined manually.
The RBW/VBW ratio can be set in the range of 0.001 to 1000.

Remote command:
[SENSe: | BANDwidth:VIDeo:AUTO on page 787
[SENSe: ] BANDwidth:VIDeo:RATio on page 787

Filter Type
Defines the filter type.

The following filter types are available:

Normal (3dB)

Channel

RRC

5-Pole (not available for sweep type "FFT" )
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For more information see Chapter 7.5.1.6, "Which Data May Pass: Filter Types",
on page 364.

Remote command:
[SENSe: ] BANDwidth[:RESolution] :TYPE on page 786

Default Coupling
Sets all coupled functions to the default state ( "Auto" ). In addition, the ratio "RBW/
VBW" is set to "Sine[1/1]" and the ratio "Span/RBW" to 100.

For more information see Chapter 7.5.1.3, "Coupling VBW and RBW", on page 362.

Remote command:

[SENSe: ]BANDwidth[:RESolution] :AUTO on page 786
[SENSe: | BANDwidth:VIDeo:AUTO on page 787

[SENSe: ] SWEep: TIME:AUTO on page 790

Sweep/Average Count
Defines the number of sweep s to be performed in the single sweep mode. Values
from 0 to 200000 are allowed. If the values 0 or 1 are set, one sweep is performed.

The sweep count is applied to all the traces in all diagrams.

If the trace modes "Average" , "Max Hold" or "Min Hold" are set, this value also deter-
mines the number of averaging or maximum search procedures.

In continuous sweep mode, if "Sweep Count" = 0 (default), averaging is performed
over 10 sweep s. For "Sweep Count" =1, no averaging, maxhold or minhold operations
are performed.

For more information, see Chapter 7.5.1.8, "How Much Data is Measured: Sweep
Points and Sweep Count", on page 365.

For spectrogram displays, the sweep count determines how many sweep s are com-
bined in one frame in the spectrogram; that is: how many sweep s the R&S FPS per-
forms to plot one trace in the spectrogram result display. For more details, see "Time
Frames" on page 472.

Remote command:
[SENSe: ] SWEep:COUNt on page 789
[SENSe: ] AVERage<n>:COUNt on page 841

Sweep Points
Defines the number of measured values to be collected during one sweep.

For details see Chapter 7.5.1.8, "How Much Data is Measured: Sweep Points and
Sweep Count", on page 365.

All values from 101 to 32001 can be set. The default value is 1001 sweep points.

Remote command:
[SENSe: ] SWEep:POINts on page 790

Optimization

In FFT mode, several FFT analysis steps are required to cover the entire measurement
span. The span which is covered by one FFT analysis step is called partial span. The
partial span cannot be defined directly, but it can be optimized according to measure-
ment requirements.



Bandwidth, Filter and Sweep Configuration

Table 7-2: Optimization parameters in FFT mode

Optimization mode | Description

Dynamic Optimizes the dynamic range by using the narrowest possible partial span (depend-
ing on the RBW).

Speed Optimizes the sweep rate by using the widest possible partial span (depending on
the RBW).

It is recommended that you set the Sweep Time to "Auto" to optimize the sweep
rate.

Auto Uses a medium-sized partial span to obtain a compromise between a large dynamic
range and a fast sweep rate.

Remote command:
[SENSe: ] SWEep:0PTimize on page 789

Sweep Type
Defines the sweep type.

"Sweep" In the standard sweep mode, the local oscillator is set to provide the
spectrum quasi analog from the start to the stop frequency.

"Auto" Automatically sets the fastest available sweep type for the current
measurement (Frequency or FFT). Auto mode is set by default.

"FFT" The FFT sweep samples on a defined frequency value and trans-
forms it to the spectrum by fast Fourier transformation (FFT) (see
also Chapter 7.5.1.5, "How Data is Measured: the Sweep Type",
on page 363).

FFT is not available in the following cases:
® when using 5-Pole filters, Channel filters or RRC filters
In these cases, frequency sweep is used.

Remote command:
[SENSe: ] SWEep:TYPE on page 791

Single Sweep / Run Single
After triggering, starts the number of sweeps set in "Sweep Count". The measurement
stops after the defined number of sweeps has been performed.

While the measurement is running, the "Single Sweep" softkey and the RUN SINGLE
key are highlighted. The running measurement can be aborted by selecting the high-
lighted softkey or key again.

Remote command:
INITiate<n>[:IMMediate] on page 636
CALCulate<n>:SPECtrogram:CONTinuous on page 845

Continuous Sweep / Run Cont
After triggering, starts the measurement and repeats it continuously until stopped.

While the measurement is running, the "Continuous Sweep" softkey and the RUN
CONT key are highlighted. The running measurement can be aborted by selecting the
highlighted softkey or key again. The results are not deleted until a new measurement
is started.
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Note: Sequencer. If the Sequencer is active, the "Continuous Sweep" softkey only
controls the sweep mode for the currently selected channel. However, the sweep mode
only takes effect the next time the Sequencer activates that channel, and only for a
channel-defined sequence. In this case, a channel in continuous sweep mode is swept
repeatedly.

Furthermore, the RUN CONT key controls the Sequencer, not individual sweeps. RUN
CONT starts the Sequencer in continuous mode.

For details on the Sequencer, see Chapter 5.4.1, "The Sequencer Concept",
on page 119.

Remote command:
INITiate<n>:CONTinuous on page 635

Continue Single Sweep
After triggering, repeats the number of sweeps set in "Sweep Count", without deleting
the trace of the last measurement.

While the measurement is running, the "Continue Single Sweep" softkey and the RUN
SINGLE key are highlighted. The running measurement can be aborted by selecting
the highlighted softkey or key again.

Remote command:
INITiate<n>:CONMeas on page 634

Spectrogram Frames
These settings are only available if spectrogram display is active.

For more information see Chapter 8.5.2.3, "How to Display and Configure a Spectro-
gram"”, on page 482.

Select Frame < Spectrogram Frames
Selects a specific frame, loads the corresponding trace from the memory, and displays
it in the Spectrum window.

Note that activating a marker or changing the position of the active marker automati-
cally selects the frame that belongs to that marker.

This function is only available in single sweep mode or if the sweep is stopped, and
only if a spectrogram is selected.

The most recent frame is number 0, all previous frames have a negative number.
For more details see "Time Frames" on page 472.

Remote command:
CALCulate<n>:SPECtrogram:FRAMe: SELect on page 846

Continue Frame — Spectrogram Frames
Determines whether the results of the previous sweeps are included in the analysis of
the next sweeps for trace modes "Max Hold" , "Min Hold" , and "Average" .

This function is available in single sweep mode only.

® On
When the average or peak values are determined for the new sweep, the results of
the previous sweeps in the spectrogram are also taken into account.

o Off
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The average or peak values are determined from the results of the newly swept
frames only.

Remote command:
CALCulate<n>:SPECtrogram:CONTinuous on page 845

Frame Count — Spectrogram Frames

Determines how many frames are plotted during a single sweep (as opposed to a con-
tinuous sweep). The maximum number of possible frames depends on the history
depth (see " History Depth " on page 479).

For more details see "Time Frames" on page 472.

Remote command:
CALCulate<n>:SPECtrogram:FRAMe : COUNt on page 845

Clear Spectrogram « Spectrogram Frames
Resets the spectrogram result display and clears the history buffer.

This function is only available if a spectrogram is selected.

Remote command:
CALCulate<n>:SPECtrogram:CLEar[:IMMediate] on page 844

Reference: List of Available RRC and Channel Filters

For power measurement a number of especially steep-edged channel filters are availa-
ble (see the following table). The indicated filter bandwidth is the 3 dB bandwidth.

For RRC filters, the fixed roll-off factor (a) is also indicated.

The available Gaussian 3 dB sweep filters are listed in the R&S FPS data sheet.

Table 7-3: Filter types

Filter Bandwidth Filter Type Application
100 Hz CFlLter

200 Hz CFlLter

300 Hz CFlLter

500 Hz CFlLter

1 kHz CFlLter

1.5 kHz CFlLter

2 kHz CFlLter

2.4 kHz CFILter SSB

2.7 kHz CFlLter
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Filter Bandwidth Filter Type Application

3 kHz CFlLter

3.4 kHz CFlLter

4 kHz CFILter DAB, Satellite

4.5 kHz CFlLter

5 kHz CFlLter

6 kHz CFlLter

6 kHz, a=0.2 RRC APCO

8.5 kHz CFlLter ETS300 113 (12.5 kHz channels)
9 kHz CFlLter AM Radio

10 kHz CFlLter

12.5 kHz CFlLter CDMAone

14 kHz CFILter ETS300 113 (20 kHz channels)
15 kHz CFlLter

16 kHz CFlLter ETS300 113 (25 kHz channels)
18 kHz, a=0.35 RRC TETRA

20 kHz CFlLter

21 kHz CFlLter PDC

24.3 kHz, a=0.35 RRC IS 136

25 kHz CFlLter APCO 25-P2

30 kHz CFlLter CDPD, CDMAone

50 kHz CFlLter

100 kHz CFlLter

150 kHz CFlLter FM Radio

192 kHz CFlLter PHS

200 kHz CFlLter GSM

300 kHz CFlLter

500 kHz CFlLter J.83 (8-VSB DVB, USA); RF ID 14333
1 MHz CFlLter CDMAone

1.228 MHz CFlLter CDMAone

1.28 MHz, a=0.22 RRC TD-SCDMA
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Filter Bandwidth Filter Type Application

1.5 MHz CFILter DAB

2 MHz CFlLter

3 MHz CFlLter

3.75 MHz CFlLter

3.84 MHz, a=0.22 RRC W-CDMA 3GPP
4.096 MHz, a=0.22 RRC W-CDMA NTT DOCoMo
5 MHz CFlLter

20 MHz *) CFlLter

28 MHz *) CFlLter

40 MHz *) CFlLter

Filters larger than 28 MHz require an appropriate bandwidth extension option.

7.6 Trigger and Gate Configuration

7.6.1

7.6.1.1

Triggering means to capture the interesting part of the signal. Choosing the right trigger
type and configuring all trigger settings correctly allows you to detect various incidents
in your signals.

Gating allows you to restrict measurement analysis to the important part or parts of the
signal, for example bursts.

L I 8y o o =Y 1oV RSP 375
L I T 1] o SRR 385
Triggering

Triggered Measurements

In a basic measurement with default settings, the sweep is started immediately. How-
ever, sometimes you want the measurement to start only when a specific condition is
fulfilled, for example a signal level is exceeded, or in certain time intervals. For these

cases you can define a trigger for the measurement. In FFT sweep mode, the trigger

defines when the data acquisition starts for the FFT conversion.

An "Offset" can be defined to delay the measurement after the trigger event, or to
include data before the actual trigger event in time domain measurements (pre-trigger
offset).

For complex tasks, advanced trigger settings are available:

® Hysteresis to avoid unwanted trigger events caused by noise
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® Holdoff to define exactly which trigger event will cause the trigger in a jittering sig-

nal
O TTIQQEI SOUICE. .. .eeiiiiii i e s 376
O Trigger OffSet.... .o e 376
®  Trigger HYSIEreSIS. . .ouiiiiee e 376
®  Trigger Drop-Out TIME.......cuiiieieiiee et 377
®  Trigger HOIAOM ... .eiiii e e 378

Trigger Source

The trigger source defines which source must fulfill the condition that triggers the mea-
surement. Basically, this can be:

® Power: an input signal is checked for a defined power level
The trigger signal can be any of the following:

— The input signal at one of various stages in the signal analysis process - before
or after the input mixer, after the video filter etc.

— A signal from an external device via one of the TRG IN / AUX connectors on
the instrument

For details on the available trigger sources see " Trigger Source " on page 381.

Trigger Offset

An offset can be defined to delay the measurement after the trigger event, or to include
data before the actual trigger event in time domain measurements (pre-trigger offset).
Pre-trigger offsets are possible because the R&S FPS captures data continuously in
the time domain, even before the trigger occurs.

See " Trigger Offset " on page 383.

Trigger Hysteresis

Setting a hysteresis for the trigger helps avoid unwanted trigger events caused by
noise, for example. The hysteresis is a threshold to the trigger level that the signal
must fall below on a rising slope or rise above on a falling slope before another trigger
event occurs.
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Example:

In the following example, the second possible trigger event is ignored as the signal
does not exceed the hysteresis (threshold) before it reaches the trigger level again on
the rising edge. On the falling edge, however, two trigger events occur as the signal
exceeds the hysteresis before it falls to the trigger level the second time.

*

Trigger level

Figure 7-17: Effects of the trigger hysteresis

See " Hysteresis " on page 383

Trigger Drop-Out Time

If a modulated signal is instable and produces occasional "drop-outs" during a burst,
you can define a minimum duration that the input signal must stay below the trigger
level before triggering again. This is called the "drop-out" time. Defining a dropout time
helps you stabilize triggering when the analyzer is triggering on undesired events.

T

_/ N

|

Drop-Out
Figure 7-18: Effect of the trigger drop-out time

See " Drop-Out Time " on page 383.
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Drop-out times for falling edge triggers

If a trigger is set to a falling edge ( "Slope" = "Falling" , see " Slope " on page 384) the

measurement is to start when the power level falls below a certain level. This is useful,
for example, to trigger at the end of a burst, similar to triggering on the rising edge for

the beginning of a burst.

If a drop-out time is defined, the power level must remain below the trigger level at
least for the duration of the drop-out time (as defined above). However, if a drop-out
time is defined that is longer than the pulse width, this condition cannot be met before
the final pulse, so a trigger event will not occur until the pulsed signal is over!

T

ANL
JUC

Drop-Out

Figure 7-19: Trigger drop-out time for falling edge trigger

For gated measurements, a combination of a falling edge trigger and a drop-out time is
generally not allowed.

Trigger Holdoff

The trigger holdoff defines a waiting period before the next trigger after the current one
will be recognized.

Frame 1 Frame 2

nn_NAan
NRIATANNATATAN

< l >

Holdoff

T

v

Figure 7-20: Effect of the trigger holdoff

See " Trigger Holdoff " on page 383.
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7.6.1.2 Trigger Settings

Access: "Overview" > "Trigger/Gate"

Settings

—_
Frequency |BkiiReiard |
jooeowne
- =
RBW |120.0 MHz -
sweep Time U "[_‘r“" Ll
| J :

Trigger Source Trigger In/Out

Trigoer Source IF Power =
_ e

Gated Trigger on

. Gate Mode (NSNSl " Edoe
Trigger Level |—20.0 dBm Drop-0Out Time - i =

Slope Gl Faling Gate Delay

Hysteresis |.3.0 dB Holdoff Gate Length

Trigger Offset

External triggers from one of the TRG IN / AUX connectors on the R&S FPS are con-
figured in a separate tab of the dialog box.

Trigger Source Trigger In/Out

Trigger 2 Input

Qutput Type User Defined Level Low

Pulse Length Send Trigger Il

Trigger 3

For step-by-step instructions on configuring triggered measurements, see Chap-
ter 7.6.1.4, "How to Configure a Triggered Measurement", on page 384.
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Preview

The preview mode allows you to try out trigger and gate settings before actually apply-
ing them to the current measurement.

The preview diagram displays a zero span measurement at the center frequency with
the defined RBW and sweep time. This is useful to analyze bursts, for example, to
determine the required gate settings.

The trigger and gate settings are applied to the measurement when the dialog box is
closed.

Note: The zero span settings refer only to the preview diagram. The main diagram
remains unchanged.

If preview mode is switched off, any changes to the settings in this dialog box are
applied to the measurement diagram directly. In this case, the zero span settings for
the preview diagram are not displayed.

For information on the zero span settings see:
® " Center Frequency " on page 347

e "RBW "on page 368

® "Sweep Time " on page 368

Frequency < Preview
Defines the center frequency.

Remote command:
[SENSe: ] FREQuency:CENTer on page 777

RBW «— Preview
Defines the bandwidth value. The available resolution bandwidths are specified in the
data sheet. Numeric input is always rounded to the nearest possible bandwidth.

Remote command:
[SENSe: ] BANDwidth[:RESolution] on page 785

Sweep Time «— Preview

Defines the sweep time. Allowed values depend on the ratio of span to RBW and RBW
to VBW. For details refer to the data sheet. Numeric input is always rounded to the
nearest possible sweep time.

Remote command:
[SENSe: ] SWEep: TIME on page 790
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Trigger Source
Selects the trigger source. If a trigger source other than "Free Run" is set, "TRG" is dis-
played in the channel bar and the trigger source is indicated.

For gated measurements, this setting also selects the gating source.
For more information see "Trigger Source" on page 376.

Remote command:
TRIGger [:SEQuence] : SOURce on page 803
[SENSe: | SWEep:EGATe : SOURce on page 806

Free Run — Trigger Source
No trigger source is considered. Data acquisition is started manually or automatically
and continues until stopped explicitly.

In the Spectrum application, this is the default setting.

Remote command:
TRIG:SOUR IMM, see TRIGger [:SEQuence] : SOURce on page 803

External Trigger 1/2 < Trigger Source
Data acquisition starts when the TTL signal fed into the specified input connector
meets or exceeds the specified trigger level.

(See " Trigger Level " on page 382).

Note: The "External Trigger 1" softkey automatically selects the trigger signal from the
TRG IN connector.

For details, see the "Instrument Tour" chapter in the R&S FPS Getting Started manual.

"External Trigger 1"
Trigger signal from the TRG IN connector.

"External Trigger 2"
Trigger signal from the TRG AUX connector.
Note: Connector must be configured for "Input" in the "Output" config-
uration

Remote command:

TRIG:SOUR EXT, TRIG:SOUR EXT2

See TRIGger [ : SEQuence] : SOURce on page 803

SWE : EGAT: SOUR EXT for gated triggering, see [SENSe: | SiiEep:EGATe : SOURce
on page 806

Video — Trigger Source
Defines triggering by the video signal, i.e. the filtered and detected version of the input
signal (the envelope of the IF signal), as displayed on the screen.

Define a trigger level from 0 % to 100 % of the diagram height. The absolute trigger
level is indicated by a horizontal trigger line in the diagram, which you can also move
graphically to change the trigger level.

Video mode is only available in the time domain, and not for I/Q-based data.



R&S®FPS Common Measurement Settings
________________________________________________________________________________________________________________________________________________________|

Remote command:

TRIG:SOUR VID, see TRIGger [:SEQuence] : SOURce on page 803

SWE : EGAT : SOUR VID for gated triggering, see [SENSe: ] SWEep:EGATe : SOURce
on page 806

IF Power «— Trigger Source
The R&S FPS starts capturing data as soon as the trigger level is exceeded around the
third intermediate frequency.

For frequency sweeps, the third IF represents the start frequency. The trigger band-
width at the third IF depends on the RBW and sweep type.

For measurements on a fixed frequency (e.g. zero span or I/Q measurements), the
third IF represents the center frequency.

This trigger source is only available for RF input.

The available trigger levels depend on the RF attenuation and preamplification. A refer-
ence level offset, if defined, is also considered.

For details on available trigger levels and trigger bandwidths, see the data sheet.

Note: Be aware that in auto sweep type mode, due to a possible change in sweep
types, the trigger bandwidth can vary considerably for the same RBW setting.

Remote command:

TRIG:SOUR IFP, see TRIGger [:SEQuence] : SOURce on page 803

SWE : EGAT: SOUR IFP for gated triggering, see [SENSe: | SiEep:EGATe: SOURce
on page 806

RF Power < Trigger Source
Defines triggering of the measurement via signals which are outside the displayed
measurement range.

For this purpose, the instrument uses a level detector at the first intermediate fre-
quency.
The input signal must be in the frequency range between 500 MHz and 7 GHz.

The resulting trigger level at the RF input depends on the RF attenuation and preampli-
fication. For details on available trigger levels, see the instrument's data sheet.

Note: If the input signal contains frequencies outside of this range (e.g. for fullspan
measurements), the sweep may be aborted. A message indicating the allowed input
frequencies is displayed in the status bar.

A "Trigger Offset" , "Trigger Polarity" and "Trigger Holdoff" (to improve the trigger sta-
bility) can be defined for the RF trigger, but no "Hysteresis" .

Remote command:

TRIG:SOUR RFP, see TRIGger [:SEQuence] : SOURce on page 803

SWE : EGAT : SOUR RFP for gated triggering, see [SENSe: ] SWEep:EGATe : SOURce
on page 806

Trigger Level
Defines the trigger level for the specified trigger source.

For gated measurements, this setting also defines the gate level.
For details on supported trigger levels, see the data sheet.

HE
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Remote command:

TRIGger [:SEQuence] : LEVel: IFPower on page 802

]
TRIGger [:SEQuence] : LEVel:IQPower on page 802
TRIGger[:SEQuence] :LEVel [ :EXTernal<port>] on page 801
TRIGger [ :SEQuence] : LEVel:VIDeo on page 803
TRIGger [:SEQuence] : LEVel :RFPower on page 802

Drop-Out Time
Defines the time the input signal must stay below the trigger level before triggering
again.

For more information on the drop-out time, see "Trigger Drop-Out Time" on page 377.

Remote command:
TRIGger [:SEQuence] : DTIMe on page 800

Trigger Offset
Defines the time offset between the trigger event and the start of the sweep .

For more information, see "Trigger Offset" on page 376.

Offset > 0: Start of the sweep is delayed

Offset < 0: Sweep starts earlier (pretrigger)
Only possible for zero span (e.g. I/Q Analyzer application) and gated trigger switched off
Maximum allowed range limited by the sweep time:

Pretrigger.x = sweep time ..

Remote command:
TRIGger [:SEQuence] :HOLDoff [ : TIME] on page 800

Hysteresis

Defines the distance in dB to the trigger level that the trigger source must exceed
before a trigger event occurs. Setting a hysteresis avoids unwanted trigger events
caused by noise oscillation around the trigger level.

This setting is only available for "IF Power" trigger sources. The range of the value is
between 3 dB and 50 dB with a step width of 1 dB.

For more information, see "Trigger Hysteresis" on page 376.

Remote command:
TRIGger[:SEQuence] : IFPower:HYSTeresis on page 801

Trigger Holdoff
Defines the minimum time (in seconds) that must pass between two trigger events.
Trigger events that occur during the holdoff time are ignored.

For more information, see "Trigger Holdoff" on page 378.

Remote command:
TRIGger [:SEQuence] : IFPower :HOLDoff on page 801
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7.6.1.4

Trigger and Gate Configuration

Slope
For all trigger sources except time, you can define whether triggering occurs when the
signal rises to the trigger level or falls down to it.

For gated measurements in "Edge" mode, the slope also defines whether the gate
starts on a falling or rising edge.

Remote command:
TRIGger [ :SEQuence] : SLOPe on page 803
[SENSe: ] SWEep:EGATe: POLarity on page 805

How to Determine the Required Trigger/Gate Parameters

1. In the "Trigger And Gate" dialog box, switch on "Show Preview" .

A zero span measurement for the currently defined center frequency is displayed.

2. Setthe "Frequency" , "RBW" and "Sweep Time" such that the relevant part of the
signal is displayed, for example a complete burst.

3. Determine the parameters you want to use to define the trigger and gate conditions
from the preview diagram, for example:

the length of a burst or slot

the upper or lower power level of a pulse

the maximum noise level

the power level or time at which a certain incident occurs

4. Try out different trigger and gate settings as described in How to Configure a Trig-
gered Measurement and How to Configure a Gated Measurement, then select
"Update Main Diagram" to see the effect of the current settings on the main mea-
surement in the background.

5. If the results are as expected, close the dialog box to keep the changes perma-
nently. Otherwise, correct the settings as necessary.

How to Configure a Triggered Measurement

To define an external trigger:

1. Connect an external device that will provide the trigger signal to one of the TRG
IN / AUX connectors on the R&S FPS (for details see the R&S FPS "Getting Star-
ted" manual).

2. Inthe "Trigger And Gate" dialog box, define the "Trigger Source" = "External" .

3. If you are using the variable TRG AUX connector, you must define its use as an
input connector. In the "Trigger In/Out" tab of the "Trigger And Gate" dialog box,
set the corresponding trigger to "Input" .

4. Configure the external trigger as described for the other power triggers.
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7.6.2

7.6.2.1

To define a power trigger:

1. Inthe "Trigger And Gate" dialog box, define the "Trigger Source" = "IF Power" .
Alternatively, define "Trigger Source" = "Video" . The video signal corresponds to
the envelope of the IF signal: it has been processed by the resolution and video
filters and the selected detector.

2. Define the "Trigger Level" : the power level at which the measurement will start.
For a "Video" trigger source you can move the level line graphically to define the
level. If you define the value numerically, you must enter a percentage of the full
diagram height as the level.

3. Define whether the signal must cross the trigger level on a falling or on a rising
edge ( "Slope" ) to trigger the measurement.

4. To start the measurement with a time delay, define a "Trigger Offset" .

5. To reject triggers due to noise or jittering in the signal, define a "Hysteresis" that is
larger than the expected noise or jittering. After the previous trigger, the signal
must exceed this threshold before the next level crossing triggers a new measure-
ment.

6. To skip multiple triggers in a burst, define a "Holdoff" time that must pass between
two triggers. The holdoff time should be slightly larger than the burst.

Gating

o  Gated MeasUrEmMENTS..........uiiiiiiiiiiie et e e 385
O Gate SetliNGS. .o e e e e e e e e e aaaeas 388
e How to Configure a Gated Measurement...........c.ccoooiiiiiiiiiiieiie e 389

Gated Measurements

Like a gate provides an opening in a fence, a gated measurement lets data from the
input signal pass in defined areas only. The gate controls exactly when data is included
in the measurement results and when not. The gate is opened by the trigger source,
which is also the gate source. Gates can be used in two different modes:

® Level: The gate opens and the measurement starts when a defined level in the
gate source is exceeded and stops when the gate source drops below the "Gate
Level" .
Using a pulsed gate signal in level mode, the following behavior can be achieved:
When the gate source signal is active, the input signal data is collected; when the
gate signal is inactive, the input signal is ignored.

® Edge: The gate opens and the measurement starts when a defined level in the
gate source is exceeded and stops when the defined "Gate Length" is reached.

Additionally, a delay time can be defined so that the first few measurement points after
the gate opening are ignored.

HE
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Gate Mode LEVEL Gate Mode EDGE
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Delay Delay Length

Figure 7-21: Effects of Gate mode, Gate delay and Gate length
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Example:

By using a gate in sweep mode and stopping the measurement while the gate signal is
inactive, the spectrum for pulsed RF carriers can be displayed without the superposi-
tion of frequency components generated during switching. Similarly, the spectrum can
also be analyzed for an inactive carrier. The sweep can be controlled by an external
gate or by the internal power trigger.

Multiview  Spectrum

Ref Level O B = RBW
Att dB = SWT 10ms  VBW z  Mode futo FFT

TRG:EXT1
1 Frequency Sweep

® 1AP Clrw

CF 900,0 MHz 1001 pts 200.0 kHz/ Span 2.0 MHz

Figure 7-22: GSM signal with GATE OFF

Multiview Spectrum
n = RBW z
VBW 30 kHz Mode Auto FFT

* 1AP Clrw

CF 900.0 MHz 1001 pts 200.0 kHz/ Span 2.0 MHz

Figure 7-23: GSM signal with GATE ON

Gated sweep operation is also possible for zero span measurements. This allows you
to display level variations of individual slots, for instance in burst signals, versus time.

|
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To indicate that a gate is used for the sweep, "GAT" and the gate source is displayed
in the channel bar.

7.6.2.2 Gate Settings

Gate settings define one or more extracts of the signal to be measured.

6 Gating is not available for measurements on I/Q-based data.

(CT= ) C=To I N g e o =T PP T PP PSPPI 388
L= 1 (=1 o T [ R 388
GAte DIAY .....eeeiiiiiiieeee e e e e aabee e e e e aaee 388
L= 1 (= =Y g T | o SRR 389
Gated Trigger

Switches gated triggering on or off.

If the gate is switched on, a gate signal applied to one of the TRIGGER INPUT connec-
tors or the internal IF power detector controls the sweep .

Gate Mode
Sets the gate mode.

For more information see Chapter 7.6.2.1, "Gated Measurements", on page 385

"Edge" The trigger event for the gate to open is the detection of the signal
edge.
After the gate signal has been detected, the gate remains open until
the gate length is over.

"Level" The trigger event for the gate to open is a particular power level.
After the gate signal has been detected, the gate remains open until
the signal disappears.

Note: If you perform gated measurements in combination with the IF
Power trigger, the R&S FPS ignores the holding time for frequency
sweep, FFT sweep, zero span and I/Q mode measurements.

Remote command:
[SENSe: ] SWEep:EGATe: TYPE on page 806

Gate Delay
Defines the delay time between the gate signal and the continuation of the measure-
ment.

The delay position on the time axis in relation to the sweep is indicated by a line
labeled "GD" .

For more information see Chapter 7.6.2.1, "Gated Measurements", on page 385

Remote command:
[SENSe: ] SWEep:EGATe:HOLDof f on page 805
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1.7

Adjusting Settings Automatically

Gate Length

Defines how long the gate is open when it is triggered. The gate length can only be set
in the edge-triggered gate mode. In the level-triggered mode the gate length depends
on the level of the gate signal.

The gate length in relation to the sweep is indicated by a line labeled "GL" .

For more information see Chapter 7.6.2.1, "Gated Measurements", on page 385

Remote command:
[SENSe: ] SWEep:EGATe: LENGth on page 805

How to Configure a Gated Measurement

A gated measurement records data only while the gate conditions are fulfilled. These
step-by-step instructions demonstrate how to configure a gated measurement man-
ually.

To configure a common gated measurement

1. Determine the required parameters as described in Chapter 7.6.1.3, "How to Deter-
mine the Required Trigger/Gate Parameters", on page 384.

2. The gate is opened by a trigger event, which must be based on a power source.
Define the trigger as described in Chapter 7.6.1.4, "How to Configure a Triggered
Measurement”, on page 384. As the "Trigger Source" , use "IF Power" , "Video" or
"External" .

3. Define how long the gate is to remain open:
To measure the signal as long as the trigger level is exceeded, for example for one
or more pulses, define "Gate Mode" = "Level" .
To measure the signal for a certain time after a level is exceeded, for example dur-
ing a burst:

a) Define "Gate Mode" = "Edge" .
b) Define the time to measure for each gate: "Gate Length" .

4. To open the gate with a time delay, for example to ignore an overshoot, define a
"Gate Delay" .

5. Select "Gated Trigger" = "On" .

Adjusting Settings Automatically

Access: AUTO SET

Some settings can be adjusted by the R&S FPS automatically according to the current
measurement settings. In order to do so, a measurement is performed. The duration of
this measurement can be defined automatically or manually.
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MSRA operating mode
In MSRA operating mode, settings related to data acquisition can only be adjusted
automatically for the MSRA Master, not the applications.

Adjusting settings automatically during triggered measurements

O

When you select an auto adjust function a measurement is performed to determine the
optimal settings. If you select an auto adjust function for a triggered measurement, you
are asked how the R&S FPS should behave:

® (default:) The measurement for adjustment waits for the next trigger

® The measurement for adjustment is performed without waiting for a trigger.
The trigger source is temporarily set to "Free Run" . After the measurement is com-
pleted, the original trigger source is restored. The trigger level is adjusted as fol-
lows:

— For IF Power and RF Power triggers:
Trigger Level = Reference Level - 15 dB

— For Video trigger:
Trigger Level = 85 %
Remote command:
[SENSe:]ADJust:CONFigure: TRIGger on page 783

Adjusting all Determinable Settings Automatically ( Auto All ).......ccceeeeeiiiiiieniniiinennn. 390
Adjusting the Center Frequency Automatically ( Auto Frequency )......cccccceveeeeiiicnnnns 390
Setting the Reference Level Automatically ( Auto Level )......cccveeveeveeeeiiiiicciiiiieeeeen. 391
Resetting the Automatic Measurement Time ( Meastime AUtO ).......ccccevvevveeeevcineenn, 391
Changing the Automatic Measurement Time ( Meastime Manual )..........cccccceeeenneen. 391
Upper Level HYSIEIrESIS ... . e a e 391
Lower Level HYSIEreSIS ...t 392

Adjusting all Determinable Settings Automatically ( Auto All)
Activates all automatic adjustment functions for the current measurement settings.

This includes:

® Auto Frequency
® Auto Level

Note: MSRA operating modes. In MSRA operating mode, this function is only available
for the MSRA Master, not the applications.

Remote command:
[SENSe:]ADJust:ALL on page 781

Adjusting the Center Frequency Automatically ( Auto Frequency )
The R&S FPS adjusts the center frequency automatically.

The optimum center frequency is the frequency with the highest S/N ratio in the fre-
quency span. As this function uses the signal counter, it is intended for use with sinus-
oidal signals.
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At the same time, the optimal reference level is also set (see " Setting the Reference
Level Automatically ( Auto Level )" on page 356).

Remote command:
[SENSe: ]ADJust : FREQuency on page 783

Setting the Reference Level Automatically ( Auto Level )

Automatically determines a reference level which ensures that no overload occurs at
the R&S FPS for the current input data. At the same time, the internal attenuators are
adjusted so the signal-to-noise ratio is optimized, while signal compression and clip-
ping are minimized.

To determine the required reference level, a level measurement is performed on the
R&S FPS.

If necessary, you can optimize the reference level further. Decrease the attenuation
level manually to the lowest possible value before an overload occurs, then decrease
the reference level in the same way.

You can change the measurement time for the level measurement if necessary (see "
Changing the Automatic Measurement Time ( Meastime Manual )" on page 391).

Remote command:
[SENSe:]ADJust:LEVel on page 783

Resetting the Automatic Measurement Time ( Meastime Auto )
Resets the measurement duration for automatic settings to the default value.

(Spectrum application: 1 ms)

Remote command:
[SENSe:]ADJust:CONFigure[:LEVel] :DURation:MODE on page 781

Changing the Automatic Measurement Time ( Meastime Manual )
This function allows you to change the measurement duration for automatic setting
adjustments. Enter the value in seconds.

Remote command:
[SENSe:]ADJust:CONFigure[:LEVel] :DURation:MODE on page 781
[SENSe:]ADJust:CONFigure[:LEVel] :DURation on page 781

Upper Level Hysteresis

When the reference level is adjusted automatically using the Auto Level function, the
internal attenuators and the preampilifier are also adjusted. To avoid frequent adapta-
tion due to small changes in the input signal, you can define a hysteresis. This setting
defines an upper threshold the signal must exceed (compared to the last measure-
ment) before the reference level is adapted automatically.

Remote command:
[SENSe:]ADJust:CONFigure:HYSTeresis:UPPer on page 782
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Lower Level Hysteresis

When the reference level is adjusted automatically using the Auto Level function, the
internal attenuators and the preamplifier are also adjusted. To avoid frequent adapta-
tion due to small changes in the input signal, you can define a hysteresis. This setting
defines a lower threshold the signal must fall below (compared to the last measure-
ment) before the reference level is adapted automatically.

Remote command:
[SENSe:]ADJust:CONFigure:HYSTeresis:LOWer on page 782
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8 Common Analysis and Display Functions

8.1

8.11

Access: "Overview" > "Analysis"

General methods and basic settings to display and analyze measurements, regardless
of the operating mode, are described here. If you are performing a specific measure-
ment task, using an operating mode other than Signal and Spectrum Analyzer mode,
or an application other than the Spectrum application, be sure to check the specific
application or mode description for settings and functions that may deviate from these
common settings.

e Result Display Configuration............ ..o 393
L J 4o o0 1= I D 1< o] F= V£ S 400
L I V= T = g U= T 1 404
o Display and Limit LINES......c.uueiiiiiiiieie et 441
®  Trace CoNfIQUIatioN........coiueiiiii it e s e e e e e e 459
e Importing and Exporting Measurement Results for Evaluation.............ccccccce...... 488

Result Display Configuration

Measurement results can be evaluated in many different ways, for example graphi-
cally, as summary tables, statistical evaluations etc. Thus, the result display is highly
configurable to suit your specific requirements and optimize analysis. Here you can
find out how to optimize the display for your measurement results.

Basic operations concerning the R&S FPS display, for example how to use the Smart-
Grid, are described in the R&S FPS Getting Started manual.

General display settings that are usually configured during initial instrument setup,
independently of the current measurement, e.g. which items or colors are displayed on
the screen, are described in Chapter 10.2, "Display Settings", on page 535.

e Basic Evaluation Methods...........ouuiiiiiiiiiieieeie e 393
e Laying out the Result Display with the SmartGrid............cccoovvvvciiiiiieee e, 395

Basic Evaluation Methods

Measurement results can be displayed and evaluated using various different methods,
also at the same time. Depending on the currently selected measurement, in particular
when using optional firmware applications, not all evaluation methods are available.

The evaluation methods described here are available for most measurements in the
Spectrum application.
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Diagram

Displays a basic level vs. frequency or level vs. time diagram of the measured data to
evaluate the results graphically. This is the default evaluation method. Which data is
displayed in the diagram depends on the "Trace" settings. Scaling for the y-axis can be
configured.

See Chapter 8.5, "Trace Configuration”, on page 459 and Chapter 7.4.3, "Scaling the
Y-Axis", on page 358.

® 1Rm Clrw

T Y S S T WM AR, oty e A
95 GHz 1001 pts

Remote command:

LAY:ADD? '1',RIGH, DIAG, see LAYout:ADD[:WINDow]? on page 767
Results:

TRACe<n>[:DATA] on page 854

Marker Table
Displays a table with the current marker values for the active markers.

This table is displayed automatically if configured accordingly (see " Marker Table Dis-
play " on page 412).
2 Marker

l'ype He lrc STmils | Hespo ur Function Hes
1 E H > =1 13 1c

Remote command:

LAY:ADD? '1l',RIGH, MTAB, see LAYout:ADD[:WINDow]? on page 767
Results:

CALCulate<n>:MARKer<m>:X on page 867
CALCulate<n>:MARKer<m>:Y? on page 881

Marker Peak List

The marker peak list determines the frequencies and levels of peaks in the spectrum or
time domain. How many peaks are displayed can be defined, as well as the sort order.
In addition, the detected peaks can be indicated in the diagram. The peak list can also
be exported to a file for analysis in an external application.

You can define search and sort criteria to influence the results of the analysis.
(See Chapter 8.3.3.1, "Marker Search Settings", on page 413).
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8.1.2

2 Marker Peak Lis
Mo

00~ O P L0 RO

Remote command:

LAY:ADD? '1l',RIGH, PEAK, see LAYout:ADD[:WINDow]? on page 767
Results:

CALCulate<n>:MARKer<m>:X on page 867
CALCulate<n>:MARKer<m>:Y? on page 881

Result Summary

Result summaries provide the results of specific measurement functions in a table for
numerical evaluation. The contents of the result summary vary depending on the
selected measurement function. See the description of the individual measurement
functions for details.

2 Result Summary
annel

Channe Jandwid Power
2 -0.86 dBm

-0.86 dBm
Lower
-79.59 dB -80.34 dB
-85.04 dB -83.85 dB

Ugper

Remote command:
LAY:ADD? '1',RIGH, RSUM, see LAYout:ADD[:WINDow]? on page 767

Spectrogram

A spectrogram shows how the spectral density of a signal varies over time. The x-axis
shows the frequency or sweep time, the y-axis shows the measurement time. A third
dimension, the power level, is indicated by different colors. Thus you can see how the
strength of the signal varies over time for different frequencies.

The spectrogram display consists of two diagrams: the standard spectrum result dis-
play (upper diagram) and the spectrogram result display (lower diagram).

For details see Chapter 8.5.2.1, "Working with Spectrograms", on page 471.

Remote command:
LAY:ADD? '1l',RIGH, SGR,see LAYout:ADD[:WINDow]? on page 767

Laying out the Result Display with the SmartGrid

Measurement results can be evaluated in many different ways, for example graphi-
cally, as summary tables, statistical evaluations etc. Each type of evaluation is dis-
played in a separate window in the channel tab. Up to 16 individual windows can be
displayed per channel (i.e. per tab). To arrange the diagrams and tables on the screen,
the Rohde & Schwarz SmartGrid function helps you find the target position simply and
quickly.

|
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Principally, the layout of the windows on the screen is based on an underlying grid, the
SmartGrid. However, the SmartGrid is dynamic and flexible, allowing for many different
layout possibilities. The SmartGrid functionality provides the following basic features:

® Windows can be arranged in columns or in rows, or in a combination of both.
® Windows can be arranged in up to four rows and four columns.

® Windows are moved simply by dragging them to a new position on the screen, pos-
sibly changing the layout of the other windows, as well.

® All evaluation methods available for the currently selected measurement are dis-
played as icons in the evaluation bar. If the evaluation bar contains more icons
than can be displayed at once on the screen, it can be scrolled vertically. The
same evaluation method can be displayed in multiple windows simultaneously.

® New windows are added by dragging an evaluation icon from the evaluation bar to
the screen. The position of each new window depends on where you drop the eval-
uation icon in relation to the existing windows.

e All display configuration actions are only possible in SmartGrid mode. When Smart-
Grid mode is activated, the evaluation bar replaces the current softkey menu dis-
play. When the SmartGrid mode is deactivated again, the previous softkey menu
display is restored.

e Background Information: The SmartGrid Principle..........ccccooeeeeeieeiiiiiicciiiieeeee. 396
o How to Activate SmartGrid Mode..........coooiiiiiii e 398
o How to Add a New Result WINAOW.......cooiiiiiiiiiieiieeeee e 398
o How to Close a ReSUIt WINAOW........oiiiiiiieiiei i 399
o How to Arrange the Result WINAOWS..........uiiiiiiiiiiii e 399

8.1.2.1 Background Information: The SmartGrid Principle

SmartGrid display

During any positioning action, the underlying SmartGrid is displayed. Different colors
and frames indicate the possible new positions. The position in the SmartGrid where
you drop the window determines its position on the screen.
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Figure 8-1: Moving a window in SmartGrid mode

The brown area indicates the possible "drop area" for the window, i.e. the area in
which the window can be placed. A blue area indicates the (approximate) layout of the
window as it would be if the icon were dropped at the current position. The frames indi-
cate the possible destinations of the new window with respect to the existing windows:
above/below, right/left or replacement (as illustrated in Figure 4-8). If an existing win-
dow would be replaced, the drop area is highlighted in a darker color shade.

Positioning the window

The screen can be divided into up to four rows. Each row can be split into up to four
columns, where each row can have a different number of columns. However, rows
always span the entire width of the screen and may not be interrupted by a column. A
single row is available as the drop area for the window in the SmartGrid. The row can
be split into columns, or a new row can be inserted above or below the existing row (if
the maximum of 4 has not yet been reached).

Figure 8-2: SmartGrid window positions

1 = Insert row above or below the existing row
2 = Create a new column in the existing row
3 = Replace a window in the existing row
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SmartGrid functions

Once the evaluation icon has been dropped, icons in each window provide delete and
move functions.

The "Move" icon allows you to move the position of the window, possibly changing the
size and position of the other displayed windows.

The "Delete" icon allows you to close the window, enlarging the display of the remain-
ing windows.

8.1.2.2 How to Activate SmartGrid Mode

All display configuration actions are only possible in SmartGrid mode. In SmartGrid
mode the evaluation bar replaces the current softkey menu display. When the Smart-
Grid mode is deactivated again, the previous softkey menu display is restored.

» To activate SmartGrid mode, do one of the following:
=
Select the "SmartGrid" icon from the toolbar.

e Select the "Display Config" button in the configuration "Overview" .
e Select the "Display Config" softkey from the MEAS CONFIG menu.

The SmartGrid functions and the evaluation bar are displayed.

To close the SmartGrid mode and restore the previous softkey menu select the "Close"
icon in the right-hand corner of the toolbar, or press any key.

8.1.2.3 How to Add a New Result Window

Each type of evaluation is displayed in a separate window. Up to 16 individual windows
can be displayed per channel (i.e. per tab).

1. Activate SmartGrid mode.

All evaluation methods available for the currently selected measurement are dis-
played as icons in the evaluation bar.

2. Select the icon for the required evaluation method from the evaluation bar.
If the evaluation bar contains more icons than can be displayed at once on the
screen, it can be scrolled vertically. Set the mouse pointer in the evaluation bar
between the icons and move it up or down until the required icon appears.

3. Drag the required icon from the evaluation bar to the SmartGrid, which is displayed
in the diagram area, and drop it at the required position. (See "How to Arrange the
Result Windows" on page 105 for more information on positioning the window).



8.1.24

8.1.2.5

Result Display Configuration

Remote command:

LAYout :ADD[ :WINDow] ? on page 767 / LAYout :WINDow<n>:ADD? on page 771

How to Close a Result Window

» To close a window, activate SmartGrid mode and select the "Delete" icon for the
window.

Remote command:

LAYout :REMove [ :WINDow] on page 769/ LAYout : WINDow<n>:REMove
on page 772

How to Arrange the Result Windows

1. Select an icon from the evaluation bar or the "Move" icon for an existing evaluation
window.

2. Drag the evaluation over the SmartGrid.
A blue area shows where the window will be placed.

F.

3. Move the window until a suitable area is indicated in blue.

4. Drop the window in the target area.

The windows are rearranged to the selected layout, and "Delete" and "Move" icons
are displayed in each window.

5. To close a window, select the corresponding "Delete" icon.

Remote command:

LAYout:REPLace [ :WINDow] on page 769 / LAYout : WINDow<n>:REPLace
on page 772
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8.2 Zoomed Displays

You can zoom into the diagram to visualize the measurement results in greater detail.
Using a mouse pointer you can easily define the area to be enlarged.

Zoom and the number of sweep points

Note that zooming is merely a visual tool, it does not change any measurement set-
tings, such as the number of sweep points!

You should increase the number of sweep points before zooming, as otherwise the

function has no real effect (see Chapter 7.5.1.8, "How Much Data is Measured: Sweep
Points and Sweep Count", on page 365).

e Single Zoom Versus Multiple ZOOM..........uuuiiiiiiiiiiiiiieie e 400
L J4 o o o N U ] o3 1T 1= OSSR 401
e How to Zoom INt0 @ Diagram........ceeeeieeerieiiecccieiiiieeee e e e e er e e e e e e e e 402

8.2.1 Single Zoom Versus Multiple Zoom

Two different (graphical) zoom modes are available: single zoom and multiple zoom. A
single zoom replaces the current diagram by a new diagram which displays an
enlarged extract of the trace. This function can be used repetitively until the required
details are visible. In multiple zoom mode, you can enlarge up to four different areas of
the trace simultaneously. An overview window indicates the zoom areas in the original
trace, while the zoomed trace areas are displayed in individual windows. The zoom
areas can be moved and resized any time. The zoom area that corresponds to the indi-
vidual zoom display is indicated in the lower right corner, between the scrollbars.

All Spectrum

Ref Level -10.00 cBm
Al 10 &8
SGL

Al

102 pts

Figure 8-3: Single zoom
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Spectrum 2
REW

MultiView Spectrum
Ref Level 0.00 dBm

Att
1 Frequency Sw

Spectrum 3 1Q Analyzer

Mode Auto FFT

) |
CF 500.0 MHz

[ ]

21 v 22

16... 5.26... Span 52.5806...|C Span 159.48...

CF 516.810...

Figure 8-4: Multiple zoom

Using the zoom area to restrict a peak search

The selected zoom area can be used to restrict the search range for a peak search,
but only in single zoom mode (see " Use Zoom Limits " on page 415).

Zoom Functions

Access: "Zoom" icons in toolbar

SINGIE ZOOM ..ttt e e e s e e e e e e aaaaeeeeeeere e arararara———————— 401
Y LU o T o o SRS 402
Restore Original DiSPlay ........oocueeeiiiiiieei e 402
& Deactivating Zoom (Selection Mode) .........ccoeeeeiiiiiiiiciieee e 402

Single Zoom

=R

A single zoom replaces the current diagram by a new diagram which displays an

enlarged extract of the trace. This function can be used repetitively until the required
details are visible.

Remote command:
DISPlay[:WINDow<n>] :ZOOM[:STATe] on page 836
DISPlay[:WINDow<n>] :Z00M:AREA on page 835

User Manual 1176.8445.02 — 09
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Zoomed Displays

Multi-Zoom
=3

In multiple zoom mode, you can enlarge several different areas of the trace simultane-
ously. An overview window indicates the zoom areas in the original trace, while the
zoomed trace areas are displayed in individual windows. The zoom area that corre-
sponds to the individual zoom display is indicated in the lower right corner, between
the scrollbars.

Remote command:

DISPlay[:WINDow<n>]:ZOOM:MULTiple<zoom>[:STATe] on page 837
DISPlay[:WINDow<n>] :Z00M:MULTiple<zoom>:AREA on page 836

Restore Original Display

Restores the original display, that is, the originally calculated displays for the entire
capture buffer, and closes all zoom windows.

Remote command:

Single zoom:

DISPlay[:WINDow<n>]:ZOOM[:STATe] on page 836

Multiple zoom:

DISPlay[:WINDow<n>]:Z00M:MULTiple<zoom>|[:STATe] on page 837 (for each
multiple zoom window)

%k Deactivating Zoom (Selection Mode)
Deactivates any zoom mode.

Selecting a point in the display no longer invokes a zoom, but selects an object.

Remote command:

Single zoom:

DISPlay[:WINDow<n>] :ZOOM[:STATe] on page 836

Multiple zoom:

DISPlay[:WINDow<n>] :Z00M:MULTiple<zoom>[:STATe] on page 837 (for each
multiple zoom window)

8.2.3 How to Zoom Into a Diagram
The remote commands required to zoom into a display are described in Chap-
ter 12.8.1, "Zooming into the Display", on page 835.
The following tasks are described here:

® "To zoom into the diagram at one position" on page 403

® "To return to selection mode in the diagram" on page 403

® "To return to original display" on page 403

® "To zoom into multiple positions in the diagram" on page 404
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To zoom into the diagram at one position

1.
B

Click on the "Single Zoom" icon in the toolbar.
Zoom mode is activated.

2. Select the area in the diagram to be enlarged using the mouse pointer. The
selected area is indicated by a dotted rectangle.

When you drop the mouse pointer, the diagram is replaced by the zoomed trace
area.

3. Repeat these steps, if necessary, to enlarge the diagram further.

®\ Scrolling in the zoomed display

You can scroll the diagram area to display the entire diagram using the scrollbars at
the right and at the bottom of the diagram.

To return to selection mode in the diagram

While you are in zoom mode, selecting points in the display changes the zoom area. In
order to select or move a trace or marker, you must switch back to selection mode:

N

Select the "Selection Mode" icon in the toolbar.
To return to original display
e

Click on the "Zoom Off" icon in the toolbar.

The original trace display is restored. Zoom mode remains active, however.
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To switch off zoom mode and return to selection mode, select the "Selection Mode
icon in the toolbar.

To zoom into multiple positions in the diagram

1.

Click on the "Multi-Zoom" icon in the toolbar.

Multiple zoom mode is activated.

2. Select the first area in the diagram to be enlarged as described in "To zoom into
the diagram at one position" on page 403. The selected area is indicated by a dot-
ted rectangle.

When you have completed your selection, the original trace is shown in an over-
view diagram with the selected area indicated by a dotted rectangle. The zoomed
trace area is displayed in a separate window (see Figure 8-4.

3. Inthe overview diagram, select the next area to be enlarged.
The second zoom area is indicated in the overview diagram, and a second zoom
window is displayed.

4. Repeat these steps, if necessary, to zoom into further trace areas (up to four).

To move or change zoom areas

In multiple zoom mode, you can change the size or position of the individual zoom
areas easily at any time.

1. If necessary, switch off zoom mode and return to selection mode by selecting the
"Selection Mode" icon in the toolbar.

2. Toresize a zoom area, set the mouse pointer directly on the corresponding frame
in the overview window and drag the line to change the size of the frame.
To move a zoom area, set the mouse pointer inside the corresponding frame in
the overview window and drag the frame to the new position.

The contents of the zoom windows are adapted accordingly.

8.3 Marker Usage

Markers help you analyze your measurement results by determining particular values
in the diagram. Thus you can extract numeric values from a graphical display both in
the time and frequency domain. In addition to basic markers, sophisticated marker
functions are provided for special results such as noise or demodulation.
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Markers in Spectrogram Displays
In the spectrogram result display, you can activate up to 16 markers or delta markers

at the same time. Each marker can be assigned to a different frame. Therefore, in
addition to the frequency you also define the frame number when activating a new
marker. If no frame number is specified, the marker is positioned on the currently
selected frame. All markers are visible that are positioned on a visible frame.

®  BaSiCS ON MAIKEIS. .....eeiiiiiiiieie et 405
@ Marker SEHINGS....coeieiiiiiccccci e e e e e e e e e e e e e e e e e aaaa——— 408
e Marker Search Settings and Positioning FUNCtions..............oooooiciiiiieeiieieeeee 413
e Marker (Measurement) FUNCHONS..........uuiiiiiiiiiiie e 420
o  How to WOrk With Markers..........uecoiie e 438
e Measurement Example: Measuring Harmonics Using Marker Functions............. 439

8.3.1 Basics on Markers

Some background knowledge on marker settings and functions is provided here for a
better understanding of the required configuration settings.

Markers are used to mark points on traces, to read out measurement results and to
select a display section quickly. R&S FPS provides 16 markers per display window. In
the Spectrum application, the same markers are displayed in all windows.

® The easiest way to work with markers is using a mouse. Simply drag the marker
and drop it at the required position. When a marker label is selected, a vertical line
is displayed which indicates the marker's current x-value.

8 14P Clrw

-20 dBm
-30 dem
-40 dBm
-50 dBm
-60 dBm
-70 dBm

-30 dem

CF 220.0 MHz Span 100.0 MHz
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8.3.1.1

8.3.1.2

® You can also set an active marker to a new position by defining its x-position
numerically. When you select the softkey for a marker, an edit dialog box is dis-
played.

® The most commonly required marker settings and functions are also available as
softkeys.
Softkeys for active markers (displayed on the screen) are highlighted blue. The
softkey for the currently selected marker (for which functions are performed) is
highlighted orange.

® To set individual markers very quickly, use the softkeys in the "Marker" menu.
® To set up several markers at once, use the "Marker" dialog box.

® To position the selected marker to a special value, use the softkeys in the "Marker
To" menu.

® To determine more sophisticated marker results, use the special functions in the
"Marker Function" dialog box.

In addition to basic markers, sophisticated marker functions are provided for special
results such as noise or demodulation.

L I V= T =) S Y/ oY= TSP 406
L I e (V2= 1] e TR\ = T =T RS 406
O Marker RESUILS. ... e 407
Marker Types

All markers can be used either as normal markers or delta markers. A normal marker
indicates the absolute signal value at the defined position in the diagram. A delta
marker indicates the value of the marker relative to the specified reference marker (by
default marker 1).

In addition, special functions can be assigned to the individual markers. The availability
of special marker functions depends on whether the measurement is performed in the
frequency or time domain, and on the type of measurement.

Temporary markers are used in addition to the markers and delta markers to analyze
the measurement results for special marker functions. They disappear when the asso-
ciated function is deactivated.

Activating Markers

Only active markers are displayed in the diagram and in the marker table.
Active markers are indicated by a highlighted softkey.

By default, marker 1 is active and positioned on the maximum value (peak) of trace 1
as a normal marker. If several traces are displayed, the marker is set to the maximum
value of the trace which has the lowest number and is not frozen (View mode). The
next marker to be activated is set to the frequency of the next lower level (next peak)
as a delta marker; its value is indicated as an offset to marker 1.

A marker can only be activated when at least one trace in the corresponding window is
visible. If a trace is switched off, the corresponding markers and marker functions are

HE
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also deactivated. If the trace is switched on again, the markers along with coupled
functions are restored to their original positions, provided the markers have not been
used on another trace.

8.3.1.3 Marker Results

Normal markers point to a sweep point on the time or frequency axis and display the
associated numeric value for that sweep point. Delta markers indicate an offset
between the level at the delta marker position and the level at the position of the
assigned reference marker, in dB.

Signal count markers determine the frequency of a signal at the marker position very
accurately.

The results can be displayed directly within the diagram area or in a separate table. By
default, the first two active markers are displayed in the diagram area. If more markers
are activated, the results are displayed in a marker table.

Marker information in diagram area

By default, the results of the last two markers or delta markers that were activated are
displayed in the diagram area.

-21.90 dB
-3.9180 GHz

-25.87 dBm
12.1970 GHz

The following information is displayed there:

® The marker type (M for normal, D for delta, or special function name)
® The marker number (1 to 16)

® The assigned trace number in square brackets [ ]

® The marker value on the y-axis, or the result of the marker function

® The marker position on the x-axis

For n dB down markers, additional information is displayed, see Table 8-1.

Marker information in marker table

In addition to the marker information displayed within the diagram area, a separate
marker table may be displayed beneath the diagram. This table provides the following
information for all active markers:

Type Marker type: N (normal), D (delta), T (temporary, internal) and number

Ref Reference marker for delta markers

Trc Trace to which the marker is assigned

Frame Spectrogram frame the marker is positioned in. Displayed only when the Spectro-
gram is displayed.

X-value X-value of the marker
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Y-value Y-value of the marker

Function Activated marker or measurement function

Function Result Result of the active marker or measurement function

8.3.2 Marker Settings

Or: MKR > "Marker Config"

The remote commands required to define these settings are described in Chap-
ter 12.8.3.1, "Setting Up Individual Markers", on page 862.

o Individual Marker SEIUP.....uuuuii i a e e 408
o General Marker SettiNgS. ... 411

8.3.2.1 Individual Marker Setup

Up to 17 markers or delta markers can be activated for each window simultaneously.
Initial marker setup is performed using the "Marker" dialog box.

Markers Marker Settings Search Settings

Ref.

Selected State Stimulus Link to Marker Trace

3696MHz |0

14-16 3317MHz |

All Marker Off

The markers are distributed among 3 tabs for a better overview. By default, the first
marker is defined as a normal marker, whereas all others are defined as delta markers
with reference to the first marker. All markers are assigned to trace 1, but only the first
marker is active.

HE
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Selected Marker
Marker name. The marker which is currently selected for editing is highlighted orange.

Remote command:
Marker selected via suffix <m> in remote commands.

Marker State
Activates or deactivates the marker in the diagram.

Remote command:
CALCulate<n>:MARKer<m>[:STATe] on page 867
CALCulate<n>:DELTamarker<m>[:STATe] on page 865

Marker Position X-value

Defines the position (x-value) of the marker in the diagram. For normal markers, the
absolute position is indicated. For delta markers, the position relative to the reference
marker is provided.

Remote command:
CALCulate<n>:MARKer<m>:X on page 867
CALCulate<n>:DELTamarker<m>:X on page 865

Frame (Spectrogram only)
Spectrogram frame the marker is assigned to.

Remote command:
CALCulate<n>:MARKer<m>:SPECtrogram:FRAMe on page 883
CALCulate<n>:DELTamarker<m>:SPECtrogram:FRAMe on page 888

Marker Type
Toggles the marker type.

The type for marker 1 is always "Normal" , the type for delta marker 1 is always
"Delta" . These types cannot be changed.

Note: If normal marker 1 is the active marker, switching the "Mkr Type" activates an
additional delta marker 1. For any other marker, switching the marker type does not
activate an additional marker, it only switches the type of the selected marker.

"Normal" A normal marker indicates the absolute value at the defined position
in the diagram.

"Delta" A delta marker defines the value of the marker relative to the speci-
fied reference marker (marker 1 by default).
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Remote command:
CALCulate<n>:MARKer<m>[:STATe] on page 867
CALCulate<n>:DELTamarker<m>[:STATe] on page 865

Reference Marker
Defines a marker as the reference marker which is used to determine relative analysis
results (delta marker values).

If the reference marker is deactivated, the delta marker referring to it is also deactiva-
ted.

If a fixed reference point is configured (see "Defining a Fixed Reference"
on page 412), the reference point ( "FXD" ) can also be selected instead of another
marker.

Remote command:
CALCulate<n>:DELTamarker<m>:MREF on page 864

Linking to Another Marker

Links the current marker to the marker selected from the list of active markers. If the x-
axis value of the initial marker is changed, the linked marker follows to the same posi-
tion on the x-axis. Linking is off by default.

Using this function you can set two markers on different traces to measure the differ-
ence (e.g. between a max hold trace and a min hold trace or between a measurement
and a reference trace).

Remote command:

CALCulate<n>:MARKer<m>:LINK:TO:MARKer<m> on page 866
CALCulate<n>:DELTamarker<m>:LINK:TO:MARKer<m> on page 863
CALCulate<n>:DELTamarker<m>:LINK on page 863

Assigning the Marker to a Trace

The "Trace" setting assigns the selected marker to an active trace. The trace deter-
mines which value the marker shows at the marker position. If the marker was previ-
ously assigned to a different trace, the marker remains on the previous frequency or
time, but indicates the value of the new trace.

If a trace is turned off, the assigned markers and marker functions are also deactiva-
ted.

Remote command:
CALCulate<n>:MARKer<m>:TRACe on page 867

Select Marker
The "Select Marker" function opens a dialog box to select and activate or deactivate
one or more markers quickly.
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Selected State Selected State Selected State

]
Marker 1 [ On Sl oeia 12 off

Remote command:
CALCulate<n>:MARKer<m>[:STATe] on page 867
CALCulate<n>:DELTamarker<m>[:STATe] on page 865

All Marker Off
Deactivates all markers in one step.

Remote command:
CALCulate<n>:MARKer<m>:AOFF on page 866

8.3.2.2 General Marker Settings

Some general marker settings allow you to influence the marker behavior for all mark-
ers.

Markers Marker Settings Search Settings

Standard [ o 2lel (el
Peak Search
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Marker Table DIiSPIay ......ccooiiieeeeee e e 412
MAIKEE INFO et e e eaneee e 412
BT T S (=Y o1 412
Defining a Fixed REefEreNCe.....c..ooiiiiiiiiiiie e 412

Marker Table Display
Defines how the marker information is displayed.

"On" Displays the marker information in a table in a separate area beneath
the diagram.
"Off" No separate marker table is displayed.

If Marker Info is active, the marker information is displayed within the
diagram area.

"Auto" (Default) If more than two markers are active, the marker table is dis-
played automatically.
If Marker Info is active, the marker information for up to two markers
is displayed in the diagram area.

Remote command:
DISPlay[:WINDow<n>] :MTABle on page 868

Marker Info
Turns the marker information displayed in the diagram on and off.
o 1Pk Clrw
M1[1] 86.73 dBpV

60.060000 MHz

Remote command:
DISPlay:MINFo[:STATe] on page 868

Marker Stepsize
Defines the size of the steps that the marker position is moved using the rotary knob.

"Standard" The marker position is moved in steps of (Span/1000), which corre-
sponds approximately to the number of pixels for the default display
of 1001 sweep points. This setting is most suitable to move the
marker over a larger distance.

"Sweep The marker position is moved from one sweep point to the next. This

Points" setting is required for a very precise positioning if more sweep points
are collected than the number of pixels that can be displayed on the
screen. It is the default mode.

Remote command:
CALCulate<n>:MARKer<m>:X:SSIZe on page 869

Defining a Fixed Reference
Instead of using a reference marker that may vary its position depending on the mea-
surement results, a fixed reference marker can be defined for trace analysis.

Note that this function may not be available in all result displays.
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User Manual 1176.8445.02 — 09 412



8.3.3

8.3.3.1

Marker Usage

For "State" = "On" , a vertical and a horizontal red display line are displayed, marked
as "FXD" . The normal marker 1 is activated and set to the peak value of the trace
assigned to marker 1, and a delta marker to the next peak. The fixed reference marker
is set to the position of marker 1 at the peak value. The delta marker refers to the fixed
reference marker.

The "Level" and "Frequency" or "Time" settings define the position and value of the ref-
erence marker. To move the fixed reference, move the red display lines marked "FXD"
in the diagram, or change the position settings in the "Marker Settings" tab of the
"Marker" dialog box.

Peak Search sets the fixed reference marker to the current maximum value of the
trace assigned to marker 1.

If activated, the fixed reference marker ( "FXD" ) can also be selected as a Reference
Marker instead of another marker.

Remote command:
CALCulate<n>:DELTamarker<m>:FUNCtion:FIXed[:STATe] on page 893
CALCulate<n>:DELTamarker<m>:FUNCtion:FIXed:RPOint:Y on page 893
CALCulate<n>:DELTamarker<m>:FUNCtion:FIXed:RPOint:X on page 892
CALCulate<n>:DELTamarker<m>:FUNCtion:FIXed:RPOint:MAXimum]|[ : PEAK]
on page 892

Marker Search Settings and Positioning Functions

Access: "Overview" > "Analysis" > "Marker" > "Search"
or: MKR TO

Several functions are available to set the marker to a specific position very quickly and
easily, or to use the current marker position to define another characteristic value. In
order to determine the required marker position, searches may be performed. The
search results can be influenced by special settings.

For more information on searching for signal peaks see Chapter 8.3.4.7, "Marker Peak
List", on page 434.

The remote commands required to define these settings are described in Chap-
ter 12.8.3.4, "Positioning the Marker", on page 873.

o Marker Search SettiNgS. ... ... e i 413
e Marker Search Settings for Spectrograms...........ooocoiii e 416
®  POSitioNiNg FUNCHONS........uiiiii e 419

Marker Search Settings

Access: MKR TO > "Search Config"

Markers are commonly used to determine peak values, i.e. maximum or minimum val-
ues, in the measured signal. Configuration settings allow you to influence the peak
search results.
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For Spectrograms, special marker settings are available, see Chapter 8.3.3.2, "Marker
Search Settings for Spectrograms”, on page 416.

Markers Marker Settings Search Settings

Peaksearch 5 hLimits

Next Peak Mode Left Limit -

Exclude LO Off Right Limit - lZﬁ’SGHZ|
Peak Excursion [[HKs] Ttireshold - |:120.0 dem )

Auto Mast Peak —— Use Zoom Limits M
Search Mode for NeXt PEaAK .........uueeiiiiiiiiieeie ettt e e e e e 414
o] (8o [T I R 414
oY= ot U] ] (o] o 415
Auto Max Peak Search / Auto Min Peak Search ............cccccooeviiiiiiieeeeeeen, 415
SEAICH LIMILS .ottt ettt ettt se s e e e e e eeeeaaaaeaereeeeeeeenees 415
L Search Limits (Left / RIGOt ).....ccvreieeiiieeeeeeeeeiees e eeesess e 415
L Search ThreShOld ..........cccoueucuiueeiieeeeeeeeee et 415
L USE ZOOM LIMILS .ottt et ettt e eeeeeeeaee e e eeeeeeeeeenes 415
L Deactivating All S€arch LIMItS ..........ccceveveveeeeeeeecceeeceeeteeeeeeeeseeeeeeesesneeens 416

Search Mode for Next Peak
Selects the search mode for the next peak search.

"Left" Determines the next maximum/minimum to the left of the current
peak.

"Absolute" Determines the next maximum/minimum to either side of the current
peak.

"Right" Determines the next maximum/minimum to the right of the current
peak.

Remote command:
Chapter 12.8.3.4, "Positioning the Marker", on page 873

Exclude LO
If activated, restricts the frequency range for the marker search functions.

"On" The minimum frequency included in the peak search range is = 5 x
resolution bandwidth (RBW).
Due to the interference by the first local oscillator to the first inter-
mediate frequency at the input mixer, the LO is represented as a sig-
nal at 0 Hz. To avoid the peak marker jumping to the LO signal at 0
Hz, this frequency is excluded from the peak search.
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"Off" No restriction to the search range. The frequency 0 Hz is included in
the marker search functions.

Remote command:
CALCulate<n>:MARKer<m>:LOEXclude on page 870

Peak Excursion
Defines the minimum level value by which a signal must rise or fall so that it is identi-
fied as a maximum or a minimum by the search functions.

Entries from 0 dB to 80 dB are allowed; the resolution is 0.1 dB. The default setting for
the peak excursion is 6 dB.

For more information see Chapter 8.3.4.7, "Marker Peak List", on page 434.

Remote command:
CALCulate<n>:MARKer<m>:PEXCursion on page 870

Auto Max Peak Search / Auto Min Peak Search
If activated, a maximum or minimum peak search is performed automatically for
marker 1 after each sweep .

For spectrogram displays, define which frame the peak is to be searched in.

Remote command:
CALCulate<n>:MARKer<m>:MAXimum:AUTO on page 873
CALCulate<n>:MARKer<m>:MINimum:AUTO on page 875

Search Limits
The search results can be restricted by limiting the search area or adding search con-
ditions.

Search Limits ( Left / Right ) — Search Limits
If activated, limit lines are defined and displayed for the search. Only results within the
limited search range are considered.

For details on limit lines for searches, see "Peak search limits" on page 434.

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 870
CALCulate<n>:MARKer<m>:X:SLIMits:LEFT on page 871
CALCulate<n>:MARKer<m>:X:SLIMits:RIGHt on page 871

Search Threshold < Search Limits
Defines an absolute threshold as an additional condition for the peak search. Only
peaks that exceed the threshold are detected.

Remote command:
CALCulate<n>:THReshold on page 872

Use Zoom Limits < Search Limits
If activated, the peak search is restricted to the active zoom area defined for a single
zoom.

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits:ZOOM[:STATe] on page 872
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8.3.3.2

Deactivating All Search Limits < Search Limits
Deactivates the search range limits.

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 870
CALCulate<n>:THReshold:STATe on page 873

Marker Search Settings for Spectrograms

Access: "Overview" > "Analysis" > "Markers" > "Search"
or: MKR TO > "Search Config"

Spectrograms show not only the current sweep results, but also the sweep history.
Thus, when searching for peaks, you must define the search settings within a single
time frame (x-direction) and within several time frames (y-direction).

These settings are only available for spectrogram displays.

Markers Marker Settings Search

MNext X Search

Absolute i
el a0
Left Limit . 0,0 Hz ]
Mext ¥ Search solute - I —

st Right Limit 18.0 GHz ]
\ =

Search Area

Threshold |-120.0 dBm J
N ——————

Use Zoom Limits m Off

Search Mode for Next Peak in X-Dir€Ction ........ccuuueeiiiiiiiieieeeeeeeeeee e 416
Search Mode for Next Peak in Y-Dir€Ction ........cccuueiiiiiiiieiee e 417
Marker SEArCh TYPE .....ueiiiie it e s e e e neeee s 417
MArKEI SEAICN ATBa .....oevvviviiiiiiticeee et e et ettt aeseseeeeeaeaaaaeeeseeereees 418
(el [ o [T I PRt 418
PEAK EXCUISION ...ccvitiiieieiietee ettt ettt e e e ettt e e e e e e ee e e e e s eesaa e e eeseesaaseeesenrnnaaees 418
Auto Max Peak Search / Auto Min Peak Search ...........ccuceieiiiiiiiee i, 418
Y=ol I T 1 418
L Search Limits ( Left / RIGNt )........ceeueueveueeeeeeeeeeeeeeeeeeeetee e ee e s neneee 418
Y e T 010 A1) [c IS 419
L USE ZOOM LIMIS ..vuvveeeceeeiceceeteteteteecee ettt en st ases ettt 419
L Deactivating All S€arch LIMItS .........ccceveueeerueueeeseeeeseeeeese e eese e eeseesseeee s 419

Search Mode for Next Peak in X-Direction
Selects the search mode for the next peak search within the currently selected frame.
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llLeftll

"Absolute"

llRightll

Marker Usage

Determines the next maximum/minimum to the left of the current
peak.

Determines the next maximum/minimum to either side of the current
peak.

Determines the next maximum/minimum to the right of the current
peak.

Remote command:
Chapter 12.8.3.4, "Positioning the Marker", on page 873

Search Mode for Next Peak in Y-Direction
Selects the search mode for the next peak search within all frames at the current

marker position.
llUpll

"Absolute"

llDownvl

Determines the next maximum/minimum above the current peak (in
more recent frames).

Determines the next maximum/minimum above or below the current
peak (in all frames).

Determines the next maximum/minimum below the current peak (in
older frames).

Remote command:

CALCulate<n>

on page 889
CALCulate<n>

on page 890

CALCulate<n>:
:DELTamarker<m>:SPECtrogram:Y:MAXimum:NEXT on page 890
CALCulate<n>:
CALCulate<n>:

CALCulate<n>

on page 891

CALCulate<n>:
CALCulate<n>:

on page 891

CALCulate<n>:
CALCulate<n>:

:MARKer<m>:SPECtrogram:Y:MAXimum:ABOVe on page 884
CALCulate<n>:

DELTamarker<m>:SPECtrogram:Y:MAXimum:ABOVe

:MARKer<m>:SPECtrogram:Y:MAXimum:BELow on page 885
CALCulate<n>:

DELTamarker<m>:SPECtrogram:Y:MAXimum:BELow
MARKer<m>:SPECtrogram:Y:MAXimum:NEXT on page 885

MARKer<m>:SPECtrogram:Y:MINimum:ABOVe on page 886
DELTamarker<m>:SPECtrogram:Y:MINimum:ABOVe

MARKer<m>:SPECtrogram:Y:MINimum:BELow on page 886
DELTamarker<m>:SPECtrogram:Y :MINimum: BELow

MARKer<m>:SPECtrogram:Y:MINimum:NEXT on page 886
DELTamarker<m>:SPECtrogram:Y:MINimum:NEXT on page 891

Marker Search Type
Defines the type of search to be performed in the spectrogram.

"X-Search"
"Y-Search"
"XY-Search"

Searches only within the currently selected frame.
Searches within all frames but only at the current frequency position.
Searches in all frames at all positions.

Remote command:
Defined by the search function, see Chapter 12.8.3.6, "Marker Search (Spectro-
grams)", on page 882
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Marker Search Area
Defines which frames the search is performed in.

"Visible" Only the visible frames are searched.
"Memory" All frames stored in the memory are searched.
Remote command:

CALCulate<n>:MARKer<m>:SPECtrogram:SARea on page 883
CALCulate<n>:DELTamarker<m>:SPECtrogram: SARea on page 888

Exclude LO
If activated, restricts the frequency range for the marker search functions.

"On" The minimum frequency included in the peak search range is = 5 x
resolution bandwidth (RBW).
Due to the interference by the first local oscillator to the first inter-
mediate frequency at the input mixer, the LO is represented as a sig-
nal at 0 Hz. To avoid the peak marker jumping to the LO signal at 0
Hz, this frequency is excluded from the peak search.

"Off" No restriction to the search range. The frequency 0 Hz is included in
the marker search functions.

Remote command:
CALCulate<n>:MARKer<m>:LOEXclude on page 870

Peak Excursion
Defines the minimum level value by which a signal must rise or fall so that it is identi-
fied as a maximum or a minimum by the search functions.

Entries from 0 dB to 80 dB are allowed; the resolution is 0.1 dB. The default setting for
the peak excursion is 6 dB.
For more information see Chapter 8.3.4.7, "Marker Peak List", on page 434.

Remote command:
CALCulate<n>:MARKer<m>:PEXCursion on page 870

Auto Max Peak Search / Auto Min Peak Search
If activated, a maximum or minimum peak search is performed automatically for
marker 1 after each sweep .

For spectrogram displays, define which frame the peak is to be searched in.

Remote command:
CALCulate<n>:MARKer<m>:MAXimum:AUTO on page 873
CALCulate<n>:MARKer<m>:MINimum:AUTO on page 875

Search Limits
The search results can be restricted by limiting the search area or adding search con-
ditions.

Search Limits ( Left / Right ) — Search Limits
If activated, limit lines are defined and displayed for the search. Only results within the
limited search range are considered.

For details on limit lines for searches, see "Peak search limits" on page 434.
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Marker Usage

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 870
CALCulate<n>:MARKer<m>:X:SLIMits:LEFT on page 871
CALCulate<n>:MARKer<m>:X:SLIMits:RIGHt on page 871

Search Threshold < Search Limits
Defines an absolute threshold as an additional condition for the peak search. Only
peaks that exceed the threshold are detected.

Remote command:
CALCulate<n>:THReshold on page 872

Use Zoom Limits < Search Limits
If activated, the peak search is restricted to the active zoom area defined for a single
zoom.

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits:Z200M[:STATe] on page 872

Deactivating All Search Limits < Search Limits
Deactivates the search range limits.

Remote command:
CALCulate<n>:MARKer<m>:X:SLIMits[:STATe] on page 870
CALCulate<n>:THReshold:STATe on page 873

Positioning Functions

Access: MKR ->

The following functions set the currently selected marker to the result of a peak search
or set other characteristic values to the current marker value.

PEAK SEAICI ... a e ————— 419
SEArCH NEXE PEAK ....cciiieeeeeeeeeeeeeeeeeeee ettt ettt e 419
7= 1o T 1Y/ 1o T 210 T o 420
Search Next MINIMUM .....ooooiiiieeeeee e et e s e e e e e e eeeeas 420
Center Frequency = Marker FIEQUENCY .....cccoiiuueiiiiiiiiieie ettt 420
Reference Level = Marker LEVEI .........eoieiieeieee et 420

Peak Search
Sets the selected marker/delta marker to the maximum of the trace. If no marker is
active, marker 1 is activated.

For spectrogram displays, define which frame the peak is to be searched in.
Remote command:

CALCulate<n>:MARKer<m>:MAXimum[:PEAK] on page 874
CALCulate<n>:DELTamarker<m>:MAXimum|[:PEAK] on page 877

Search Next Peak
Sets the selected marker/delta marker to the next (lower) maximum of the assigned
trace. If no marker is active, marker 1 is activated.
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Marker Usage

For spectrogram displays, define which frame the next peak is to be searched in.

Remote command:

CALCulate<n>:
CALCulate<n>:
:MARKer<m>:MAXimum:LEFT on page 874
CALCulate<n>:
CALCulate<n>:
CALCulate<n>:

CALCulate<n>

MARKer<m>:MAXimum:NEXT on page 874
MARKer<m>:MAXimum:RIGHt on page 875

DELTamarker<m>:MAXimum:NEXT on page 877
DELTamarker<m>:MAXimum:RIGHt on page 878
DELTamarker<m>:MAXimum:LEFT on page 877

Search Minimum
Sets the selected marker/delta marker to the minimum of the trace. If no marker is
active, marker 1 is activated.

For spectrogram displays, define which frame the minimum is to be searched in.

Remote command:
CALCulate<n>:MARKer<m>:MINimum[:PEAK] on page 876
CALCulate<n>:DELTamarker<m>:MINimum][:PEAK] on page 879

Search Next Minimum
Sets the selected marker/delta marker to the next (higher) minimum of the selected
trace. If no marker is active, marker 1 is activated.

For spectrogram displays, define which frame the next minimum is to be searched in.

Remote command:

CALCulate<n>:MARKer<m>:MINimum:NEXT on page 876
CALCulate<n>:MARKer<m>:MINimum:LEFT on page 875
CALCulate<n>:MARKer<m>:MINimum:RIGHt on page 876
CALCulate<n>:DELTamarker<m>:MINimum:NEXT on page 878
CALCulate<n>:DELTamarker<m>:MINimum:LEFT on page 878
CALCulate<n>:DELTamarker<m>:MINimum:RIGHt on page 879

Center Frequency = Marker Frequency

Sets the center frequency to the selected marker or delta marker frequency. A peak
can thus be set as center frequency, for example to analyze it in detail with a smaller
span.

This function is not available for zero span measurements.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:CENTer on page 776

Reference Level = Marker Level
Sets the reference level to the selected marker level.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:REFerence on page 792

Marker (Measurement) Functions

Access: "Overview" > "Analysis" > "Marker Functions"
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Signal Count

MNoise Measurement

Phase MNoise

Reference Fixed

All Functions Off

The remote commands required to define these settings are described in Chap-
ter 12.8.3, "Working with Markers", on page 862.

e Precise Frequency (Signal Count) Marker..........occcveeiiiiiieiioiiiiieie e 421
e Measuring Noise Density (Noise Meas Marker).........ccccccvvveeeeeieeeeee i, 422
o Phase Noise Measurement Marker..........c...ueeiiiiiiiiiiiiiee e 425
e Measuring Characteristic Bandwidths (n dB Down Marker)............ccccovvvvvvvevennnnns 428
o Fixed Reference Marker....... ..o 430
e Measuring the Power in a Channel (Band Power Marker)........cccccooeeeeieeeeeniinee 431
@ Marker Peak LiSt.....cccuueieiiiiiiiiiiiee et e e 434
e Deactivating All Marker FUNCHONS.........cccuiiiiiiieiieee e 437

8.3.4.1 Precise Frequency (Signal Count) Marker

Access: "Overview" > "Analysis" > "Marker Functions" > "Select Marker Function" >
"Signal Count" > "Signal Count Config"

Or: MKR FUNC > "Select Marker Function" > "Signal Count" > "Signal Count Config"

A normal marker determines the position of the point on the trace and indicates the sig-
nal frequency at this position. The trace, however, contains only a limited number of
points. Depending on the selected span, each trace point can contain many measure-
ment values. Thus, the frequency resolution of each trace point is limited.

(See also Chapter 7.5.1.8, "How Much Data is Measured: Sweep Points and Sweep
Count", on page 365).

Frequency resolution is further restricted by the RBW and sweep time settings.

To determine the frequency of a signal point accurately without changing the sweep

settings, the R&S FPS is equipped with a signal counter. The signal counter sets the
RF to the current marker position, then counts the zero crossings of the IF (thus the

term signal counter) and derives the precise frequency value.
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Signal counting can be performed explicitly at the current marker position ( "Signal
Count" marker function), or implicitly by the R&S FPS for certain functions.

Signal counting is only possible while the instrument is not sweeping. Thus, to perform
a signal count for a marker, the sweep is stopped at the marker position. The fre-
quency is determined with the desired resolution and then the sweep is allowed to con-
tinue.

Marker Signal Count Resolution

"On" [100 mHz

A measurement example is described in Chapter 6.1.3.2, "Measuring the Signal Fre-
quency Using the Signal Counter”, on page 128.

Signal counters are not available for measurements on |/Q-based data.

8.3.4.2

Remote commands:
CALCulate<n>:MARKer<m>:COUNt on page 908
CALCulate<n>:MARKer<m>:COUNt:RESolution on page 909

Signal Count Marker State ..........ueeeiiiiiiiiiiicccee e e 422
RESOIULION ..ttt et e e e e e e e et e e e e e e e e e e s aanneeee 422

Signal Count Marker State
Activates or deactivates the special signal count marker function.

When activated, the sweep stops at the reference marker until the signal counter has
delivered a result.

Remote command:
CALCulate<n>:MARKer<m>:COUNt on page 908
CALCulate<n>:MARKer<m>:COUNt: FREQuency? on page 909

Resolution
Defines the resolution with which the signal is analyzed around the reference marker 1.

Remote command:
CALCulate<n>:MARKer<m>:COUNt:RESolution on page 909

Measuring Noise Density (Noise Meas Marker)

Access: "Overview" > "Analysis" > "Marker Functions" > "Select Marker Function" >
"Noise Measurement" > "Noise Meas Config"
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Or: MKR FUNC > "Select Marker Function" > "Noise Measurement" > "Noise Meas
Config"

Using the noise measurement marker function, the noise power density is measured at
the position of the marker. In the time domain mode, all points of the trace are used to
determine the noise power density. When measurements are performed in the fre-
quency domain, eight points to the right and left of the marker (if available) are used for
the measurement to obtain a stable result.

Result display

Noise density is the noise referred to a bandwidth of 1 Hz. With logarithmic amplitude
units (dBm, dBmV, dBmuV, dBuA), the noise power density is output in dBm/Hz, i.e. as
the level in 1 Hz bandwidth with reference to 1 mW. With linear amplitude units (V, A,
W), the noise voltage density is analyzed in uV/vHz; the noise current density in A/
vHz; the noise power density in pW/vHz.

The result is indicated as the function result in the Marker Table.

Prerequisite settings
The following settings are required to obtain correct values:

® Detector: Sample or RMS

® \ideo bandwidth:
< 0.1 resolution bandwidth with sample detector
2 3 x resolution bandwidth with RMS detector

® Trace averaging:
In the default setting, the R&S FPS uses the sample detector for the noise function.
With the sample detector, you can set the trace to "Average" mode to stabilize the
measured values. When the RMS detector is used, trace averaging produces noise
levels that are too low and cannot be corrected. Instead, increase the sweep time
to obtain stable measurement results.

Correction factors

The R&S FPS uses the following correction factors to analyze the noise density from
the marker level:

® Since the noise power is indicated with reference to 1 Hz bandwidth, the bandwidth
correction value is deducted from the marker level. It is 10 x Ig (1 Hz/BWNoise),
where BWNoise is the noise or power bandwidth of the set resolution filter (RBW).

® RMS detector: With the exception of bandwidth correction, no further corrections
are required since this detector already indicates the power for each point of the
trace.

e Sample detector: As a result of video filter averaging and trace averaging, 1.05 dB
is added to the marker level. This is the difference between the average value and
the RMS value of white noise. With a logarithmic level axis, 1.45 dB is added addi-
tionally. Logarithmic averaging is thus fully taken into account, which yields a value
that is 1.45 dB lower than that of linear averaging.

® To allow for a more stable noise display, eight trace points on each side of the
measurement frequency are averaged.
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® For span > 0, the measured values are averaged versus time (after a sweep).

The R&S FPS noise figure can be calculated from the measured power density level. It
is calculated by deducting the set RF attenuation (RF Att) from the displayed noise
level and adding 174 to the result.

The individual marker settings correspond to those defined in the "Marker" dialog box
(see Chapter 8.3.2.1, "Individual Marker Setup”, on page 408). Any settings to the
marker state or type changed in the "Marker Function" dialog box are also changed in
the "Marker" dialog box and vice versa.
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Remote commands:
CALCulate<n>:MARKer<m>:FUNCtion:NOISe[:STATe] on page 898

CALCulate<n>:MARKer<m>:FUNCtion:NOISe:RESult? on page 897

= Ty = S =1 (Y TP 424
Y =T =T Y/ o 1= RPN 425
Noise Measurement STate .....cccccvieiiii i 425
Switching All Noise Measurement Off ....... ..o 425
Marker State

Activates or deactivates the marker in the diagram.

Remote command:

CALCulate<n>:MARKer<m>[:STATe] on page 867
CALCulate<n>:DELTamarker<m>[:STATe] on page 865
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Marker Usage

Marker Type
Toggles the marker type.

The type for marker 1 is always "Normal" , the type for delta marker 1 is always
"Delta" . These types cannot be changed.

Note: If normal marker 1 is the active marker, switching the "Mkr Type" activates an
additional delta marker 1. For any other marker, switching the marker type does not
activate an additional marker, it only switches the type of the selected marker.

"Normal" A normal marker indicates the absolute value at the defined position
in the diagram.

"Delta" A delta marker defines the value of the marker relative to the speci-
fied reference marker (marker 1 by default).

Remote command:
CALCulate<n>:MARKer<m>[:STATe] on page 867
CALCulate<n>:DELTamarker<m>[:STATe] on page 865

Noise Measurement State
Activates or deactivates noise measurement for the marker in the diagram.

This function is only available for normal markers.

If activated, the marker displays the noise power density measured at the position of
the marker.

For details see Chapter 8.3.4.2, "Measuring Noise Density (Noise Meas Marker)",
on page 422.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:NOISe[:STATe] on page 898
CALCulate<n>:MARKer<m>:FUNCtion:NOISe:RESult? on page 897

Switching All Noise Measurement Off
Deactivates noise measurement for all markers.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:NOISe[:STATe] on page 898

Phase Noise Measurement Marker

Access: "Overview" > "Analysis" > "Marker Functions" > "Phase Noise" > "Phase
Noise Config"

Or: MKR FUNC > "Select Marker Function" > "Phase Noise" > "Phase Noise Config"
For each of the 16 markers phase noise measurement can be activated.

Phase noise is unintentional modulation of a carrier; it creates frequencies next to the
carrier frequency. A phase noise measurement consists of noise density measure-
ments at defined offsets from the carrier; the results are given in relation to the carrier
level (dBc). The phase noise marker function measures the noise power at the delta
markers referred to 1 Hz bandwidth. Marker 1 is used as the reference for the phase
noise measurement. By default, the current frequency and level of marker 1 are used
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as the fixed reference marker. However, a peak search can be started to use the cur-
rent signal peak as the reference point, or a reference point can be defined manually.

Since the reference point is fixed, the reference level or the center frequency can be
set so that the carrier is outside the displayed frequency range after phase noise mea-
surement is started. Or a notch filter can be switched on to suppress the carrier.

Alternatively, the reference point can be determined automatically by a peak search
after each sweep. This function can be used to track a drifting source during a phase
noise measurement. The delta marker 2, which shows the phase noise measurement
result, keeps the delta frequency value. Therefore the phase noise measurement leads
to reliable results in a certain offset although the source is drifting. Only if the marker 2
reaches the border of the span, the delta marker value is adjusted to be within the
span. In these cases, select a larger span.

The result of the phase noise measurement is the difference in level between the refer-
ence point and the noise power density. It is indicated as the function result of the
phase noise marker in the marker table.

The sample detector is automatically used and the video bandwidth set to 0.1 times the
resolution bandwidth (RBW). The two settings are taken into account in the correction
values used for the noise power measurement. To obtain stable results, two pixels on
the right and the left of the delta marker position are taken for the measurement.

The procedure for determining the noise power is identical to the method used for the
noise power measurement (see Chapter 8.3.4.2, "Measuring Noise Density (Noise
Meas Marker)", on page 422).

The individual marker settings correspond to those defined in the "Marker" dialog box.
Any settings to the marker state or type changed in the "Marker Function" dialog box
are also changed in the "Marker" dialog box and vice versa.
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aranc

Marker State Type Phase Moise

Frequency
Marker 1

Delta 1

Delta 2 -20.65 dBm

20,0 MHz

Level

—

15-16 Delta 3 On Delta (o] Peak Search

Delta 4 m Deltz ! Auto Peak Search
Delta 5 @0 De m

Delta6 [ll(on)(elij

All Phase Noise Off

Remote commands:
CALCulate<n>:MARKer<m>:FUNCtion:PNOise[:STATe] on page 901

CALCulate<n>:MARKer<m>:FUNCtion:PNOise:RESult? on page 900

Phase Noise Measurement State ... 427
Defining Reference PoOiNt .........e e e e 427
Switching All Phase Noise Measurements Off ... 428

Phase Noise Measurement State
Activates or deactivates phase noise measurement for the reference point in the dia-
gram.

This function is only available for delta markers.

If activated, the delta markers display the phase noise measured at defined offsets
from the reference position.

Remote command:
CALCulate<n>:DELTamarker<m>:FUNCtion:PNOise[:STATe] on page 900
CALCulate<n>:DELTamarker<m>:FUNCtion:PNOise:RESult? on page 899

Defining Reference Point
Instead of using marker 1 as the reference marker, a fixed reference marker can be
defined for phase noise measurement.

The "Level" and "Frequency" or "Time" settings define the position and value of the ref-
erence point.
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Alternatively, a Peak Search can be performed to set the maximum value of the
selected trace as the reference point.

If "Automatic Peak Search" is activated, a peak search is started automatically after
each sweep and the result is used as the reference point.

Remote command:
CALCulate<n>:DELTamarker<m>:FUNCtion:FIXed:RPOint:Y on page 893
CALCulate<n>:DELTamarker<m>:FUNCtion:FIXed:RPOint:X on page 892
CALCulate<n>:DELTamarker<m>:FUNCtion:FIXed:RPOint:MAXimum]|[ : PEAK]
on page 892

CALCulate<n>:DELTamarker<m>:FUNCtion:PNOise:AUTO on page 899

Switching All Phase Noise Measurements Off
Deactivates phase noise measurement for all markers.

Remote command:
CALCulate<n>:DELTamarker<m>:FUNCtion:PNOise[:STATe] on page 900

8.3.4.4 Measuring Characteristic Bandwidths (n dB Down Marker)

Access: "Overview" > "Analysis" > "Marker Functions" > "n dB down" > "n dB Down
Config"

Or: MKR FUNC > "Select Marker Function" > "n dB down" > "n dB Down Config"

When characterizing the shape of a signal, the bandwidth at a specified offset from its
peak level is often of interest. The offset is specified as a relative decrease in ampli-
tude of n dB. To measure this bandwidth, you could use several markers and delta
markers and determine the bandwidth manually. However, using the n dB down
marker function makes the task very simple and quick.

The n dB down marker function uses the current value of marker 1 as the reference
point. It activates two temporary markers T1 and T2 located on the signal, whose level
is n dB below the level of the reference point. Marker T1 is placed to the left and
marker T2 to the right of the reference marker. The default setting for n is 3 dB, but it
can be changed.

If a positive offset is entered, the markers T1 and T2 are placed below the active refer-
ence point. If a negative value is entered (for example for notch filter measurements),
the markers T1 and T2 are placed above the active reference point.
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Multiview Spectrum

Ref Level RBW

Att 1 SWT Sus  VBW 0 Mode Auto FFT
1 Frequency Sweep

1001 pts 4.0 MHz/

IR Yy

Figure 8-5: n dB down marker function

The following marker function results are displayed:

Table 8-1: n dB down marker function results

Label Description

M1 Current position and level of marker 1

ndB Offset value (n dB down)

ndB down Bw/ | Determined bandwidth or pulse width (zero span) at the offset

Pwid

Q-factor Quality factor of the determined bandwidth (characteristic of damping or resonance)
T1,T2 Current position and level of the temporary markers

If the required position for the temporary markers cannot be determined uniquely, for
example due to noise, dashes are displayed as a result.

Marker n dB down M dB Down Value

o )

Remote commands:

CALCulate<n>:MARKer<m>:FUNCtion:NDBDown:STATe on page 907

|
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Common Analysis and Display Functions

8.3.4.5

CALCulate<n>:MARKer<m>:FUNCtion:NDBDown:RESult? on page 906

N AB dOWN Marker STAte .......oouuiiieiiieee ettt e e et e e e e e e e aeaas 430
N AB dOWN DEIA VAIUE ....coeeeeeeeee et e e e e e 430

n dB down Marker State
Activates or deactivates the special n dB down marker function.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:NDBDown:STATe on page 907
CALCulate<n>:MARKer<m>:FUNCtion:NDBDown:RESult? on page 906

n dB down Delta Value
Defines the delta level from the reference marker 1 used to determine the bandwidth or
time span.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:NDBDown:FREQuency? on page 905
CALCulate<n>:MARKer<m>:FUNCtion:NDBDown:TIME? on page 907

Fixed Reference Marker

Access: "Overview" > "Analysis" > "Marker Functions" > "Reference Fixed"
Or: MKR FUNC > "Select Marker Function" > "Reference Fixed"

Instead of using a reference marker that may vary its position depending on the mea-
surement results, a fixed reference marker can be defined for trace analysis. Once
positioned, the reference marker does not move during subsequent sweeps unless you
explicitely move it manually.

When you select this marker function, a vertical and a horizontal red display line are
displayed, marked as "FXD" . A normal marker is activated and set to the peak value
and a delta marker to the next peak. The fixed reference marker is set to the position of
the normal marker at the peak value. The delta marker refers to the fixed reference
marker.

1 Frequency Sweep

‘“"'W iy W‘ ﬂ V”’\ 1 IMn.ﬂ ¥

pan 40,0 MHz

Stimulus Response Function Function Result
.0 MHz -27.07 dBm
30.0 MHz -27.07 dBm
3.397 MHz -57.06 dB
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You can move the position of the fixed reference marker graphically by dragging the
display lines, or numerically by entering values for the marker position and level.
Remote commands:
CALCulate<n>:DELTamarker<m>:FUNCtion:FIXed[:STATe] on page 893
CALCulate<n>:DELTamarker<m>:FUNCtion:FIXed:RPOint:X on page 892

CALCulate<n>:DELTamarker<m>:FUNCtion:FIXed:RPOint:Y on page 893

8.3.4.6 Measuring the Power in a Channel (Band Power Marker)

Access: "Overview" > "Analysis" > "Marker Functions" > "Band Power" > "Band Power
Config"

or: MKR FUNC > "Select Marker Function" > "Band Power"

To determine the noise power in a transmission channel, you could use a noise marker
and multiply the result with the channel bandwidth. However, the results would only be
accurate for flat noise.

Band power markers allow you to measure the integrated power for a defined span
(band) around a marker (similar to ACP measurements). By default, 5 % of the current
span is used. The span is indicated by limit lines in the diagram. The results can be
displayed either as a power (dBm) or density (dBm/Hz) value and are indicated in the
marker table for each band power marker.

Relative band power markers

The results for band power markers which are defined as delta markers and thus have
a reference value can also be calculated as reference power values (in dB).

In this case, the result of the band power deltamarker is the difference between the
absolute power in the band around the delta marker and the absolute power for the ref-
erence marker. The powers are subtracted logarithmically, so the result is a dB value.
[Relative band power (Delta2) in dB] = [absolute band power (Delta2) in dBm] - [abso-
lute (band) power of reference marker in dBm]

The measured power for the reference marker may be an absolute power at a single
point (if the reference marker is not a band power marker), or the power in a band (if
the reference marker is a band power marker itself).

If the reference marker for the band power marker is also a delta marker, the absolute
power level for the reference marker is used for calculation.
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Band power markers are only available for standard frequency measurements (not
zero span) in the Spectrum application.

For the I/Q Analyzer application, band power markers are only available for Spectrum

displays.
The entire band must lie within the display. If it is moved out of the display, the result
cannot be calculated (indicated by "- - -" as the "Function Result" ). However, the width

of the band is maintained so that the band power can be calculated again when it
returns to the display.

MultiView  Spectrum Delta Marker 2

Ref Level 0.00 dBm -3.696 MHz x

Att
1 Frequency

'"1" u‘. L

lurﬂll,'r Span luurlm

Stimulus RPspnnRF L Function Result
20.0 MHz -20.65 dBm -18.75 dBm
-3.696 MHz -64.44 dB -81.61 dBm
-3.317 MHz -64.10 dB -83.16 dBm

All markers can be defined as band power markers, each with a different span. When a
band power marker is activated, if no marker is active yet, marker 1 is activated. Other-
wise, the currently active marker is used as a band power marker (all other marker
functions for this marker are deactivated).

If the detector mode for the marker trace is set to "Auto" , the RMS detector is used.

The individual marker settings correspond to those defined in the "Marker" dialog box
(see Chapter 8.3.2.1, "Individual Marker Setup”, on page 408). Any settings to the
marker state or type changed in the "Marker Function" dialog box are also changed in
the "Marker" dialog box and vice versa.

|
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Marker State Type Band Power Span Power Mode

6-11 m BT RelPower Density

mﬁ RelPower Density
12-16 RelPower Density
Delta RelPower Density
Delta “orr RelPower Density

All Bandpower Markers Off

Remote commands:
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer [:STATe] on page 902

CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:RESult? on page 902

Band Power Measurement STate ............ooovvvvviiieiiiiiiiccceeee e eeeeeaaaaans 433
T 0 =1 o F SO OO PRUTT 433
o) YT Y [ o = R 433
Switching All Band Power Measurements Off ..o 434

Band Power Measurement State
Activates or deactivates band power measurement for the marker in the diagram.

Band power markers are only available for standard frequency measurements (not
zero span) in the Spectrum application.

If activated, the markers display the power or density measured in the band around the
current marker position.

For details see Chapter 8.3.4.6, "Measuring the Power in a Channel (Band Power
Marker)", on page 431.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer [:STATe] on page 902
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer [:STATe] on page 904

Span
Defines the span (band) around the marker for which the power is measured. The span
is indicated by lines in the diagram.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer:SPAN on page 902
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer: SPAN on page 904

Power Mode
Defines the mode of the power measurement result.
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"Power" The result is an absolute power level.
The power unit depends on the Unit setting.
"Relative This setting is only available for a delta band power marker.
Power" The result is the difference between the absolute power in the band

around the delta marker and the absolute power for the reference
marker (see " Reference Marker " on page 410). The powers are sub-
tracted logarithmically, so the result is a dB value.

[Relative band power (Delta2) in dB] = [absolute band power (Delta2)
in dBm] - [absolute (band) power of reference marker in dBm]

For details see "Relative band power markers" on page 431

"Density" The result is a power level in relation to the bandwidth, displayed in
dBm/Hz.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer :MODE on page 901
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer :MODE on page 903

Switching All Band Power Measurements Off
Deactivates band power measurement for all markers.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:BPOWer [:STATe] on page 902
CALCulate<n>:DELTamarker<m>:FUNCtion:BPOWer [:STATe] on page 904

8.3.4.7 Marker Peak List

Access: "Overview" > "Analysis" > "Marker Functions" > "Marker Peak List"
Or: MKR FUNC > "Marker Peak List"

A common measurement task is to determine peak values, i.e. maximum or minimum
signal levels. The R&S FPS provides various peak search functions and applications:
® Setting a marker to a peak value once (Peak Search)

® Searching for a peak value within a restricted search area (Search Limits)

® (Creating a marker table with all or a defined number of peak values for one sweep
(Marker Peak List)

® Updating the marker position to the current peak value automatically after each
sweep (Auto Peak Search)

® Creating a fixed reference marker at the current peak value of a trace (Fixed Refer-
ence)

Peak search limits

The peak search can be restricted to a search area. The search area is defined by limit
lines which are also indicated in the diagram. In addition, a minimum value (threshold)
can be defined as a further search condition.
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When is a peak a peak? - Peak excursion

During a peak search, for example when a marker peak table is displayed, noise val-
ues may be detected as a peak if the signal is very flat or does not contain many
peaks. Therefore, you can define a relative threshold ( "Peak Excursion" ). The signal
level must increase by the threshold value before falling again before a peak is detec-
ted. To avoid identifying noise peaks as maxima or minima, enter a peak excursion
value that is higher than the difference between the highest and the lowest value mea-
sured for the displayed inherent noise.

Effect of peak excursion settings (example)

The following figure shows a trace to be analyzed.

1 Frequency Sweep

Stimulus Response Function Function Result

900.4995 MHz -8.46 dBm
-999.0 kHz 02 dB

-499.5 kHz -65.75 dB
504.5 kHz -74.53 dB
~-1.4985 MHz -73.83 dB

Figure 8-6: Trace example

The following table lists the peaks as indicated by the marker numbers in the diagram
above, as well as the minimum decrease in amplitude to either side of the peak:

Marker # Min. amplitude decrease to either side of the signal
1 30dB

2 29.85dB

3 20 dB

4 10dB

5 18 dB

In order to eliminate the smaller peaks M3,M4 and M5 in the example above, a peak
excursion of at least 20 dB is required. In this case, the amplitude must rise at least 20
dB before falling again before a peak is detected.

|
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Marker peak list

The marker peak list determines the frequencies and levels of peaks in the spectrum. It
is updated automatically after each sweep . How many peaks are displayed can be
defined, as well as the sort order. In addition, the detected peaks can be indicated in
the diagram. The peak list can also be exported to a file for analysis in an external
application.

Automatic peak search

A peak search can be repeated automatically after each sweep in order to keep the
maximum value as the reference point for a phase noise measurement. This is useful
to track a drifting source. The delta marker 2, which shows the phase noise measure-
ment result, keeps the delta frequency value. Therefore the phase noise measurement
leads to reliable results in a certain offset although the source is drifting.

Using a peak as a fixed reference marker

Some results are analyzed in relation to a peak value, for example a carrier frequency
level. In this case, the maximum level can be determined by an initial peak search and
then be used as a reference point for further measurement results.

mits

v il G oo I | oo+ ,|
SR IS | Right Limit . 26.5 GHz |
Maximum Number of Peaks |50 e ——

Peak Excursion 6.0 dB

Use Zoom Limits

Threshold . | -120,0 dBm |
, Off .

Display Marker Numbers Oon Search Limits Off

Expaort

Export Peak List Decimal Separator | Point :

Remote commands:
CALCulate<n>:MARKer<m>:FUNCtion:FPEaks:STATe on page 896

TRAC? LIST, see TRACe<n>|[:DATA] on page 854

o= | I A =) (= T 437
7o 011 (oo [ T OPPOURPRRR 437
Maximum NUMDEr Of PEAKS ........coiiiiiiiiie et 437
PEAK EXCUISION ...ccvviiieeieeiiee ettt ettt e e ettt e e e e e e es e e e e s eesba e e eesessaaaeeeeenrannaaees 437
Display Marker NUMDETS .......cooiiiiiiiieie e 437
g oTo] o Al == £ SRR 437

HE
User Manual 1176.8445.02 — 09 436



8.3.4.8

Marker Usage

Peak List State
Activates/deactivates the marker peak list. If activated, the peak list is displayed and
the peaks are indicated in the trace display.

For each listed peak the frequency/time ( "X-value" ) and level ( "Y-Value" ) values are
given.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:FPEaks:STATe on page 896

Sort Mode
Defines whether the peak list is sorted according to the x-values or y-values. In either
case the values are sorted in ascending order.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:FPEaks:SORT on page 896

Maximum Number of Peaks
Defines the maximum number of peaks to be determined and displayed.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:FPEaks:LIST:SIZE on page 896

Peak Excursion
Defines the minimum level value by which a signal must rise or fall so that it is identi-
fied as a maximum or a minimum by the search functions.

Entries from 0 dB to 80 dB are allowed; the resolution is 0.1 dB. The default setting for
the peak excursion is 6 dB.

For more information see Chapter 8.3.4.7, "Marker Peak List", on page 434.

Remote command:
CALCulate<n>:MARKer<m>:PEXCursion on page 870

Display Marker Numbers

By default, the marker numbers are indicated in the diagram so you can find the peaks
from the list. However, for large numbers of peaks the marker numbers may decrease
readability; in this case, deactivate the marker number display.

Remote command:
CALCulate<n>:MARKer<m>:FUNCtion:FPEaks:ANNotation:LABel[:STATe]
on page 894

Export Peak List
The peak list can be exported to an ASCI! file (. DAT) for analysis in an external appli-
cation.

Remote command:
MMEMory : STORe<n>: PEAK on page 964
FORMat :DEXPort:DSEParator on page 937

Deactivating All Marker Functions

Access: "Overview" > "Analysis" > "Marker Functions" > "All Functions Off"
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8.3.5.1

Marker Usage

Or: MKR FUNC > "All Functions Off"

All special marker functions can be deactivated in one step.

How to Work With Markers

The following step-by-step instructions demonstrate in detail how to work with markers.

e How to Analyze a Signal Point in Detall...........ccccooiiiiiiiiiieieec e, 438
e How to Use a Fixed Reference Marker............oouvvevuvivieiiiiiiieieieieeeeeeeeeeeeeeeeeeeeeeans 438

How to Analyze a Signal Point in Detail

Step-by-step instructions on working with markers are provided here. For details on
individual functions and settings see Chapter 8.3.2, "Marker Settings", on page 408.

The remote commands required to perform these tasks are described in Chap-
ter 12.8.3, "Working with Markers", on page 862.

8.3.5.2

When you need to analyze a characteristic point in the signal in more detail, the follow-
ing procedure can be helpful:

1. Perform a peak search to determine the characteristic point roughly by pressing
the PEAK SEARCH key.

2. If the required signal point is not the maximum, continue the peak search to one of
the subsequent maxima or minima:

a) Press the MKR -> key.

b) Select the "Next Peak" or "Next Min" key.

c) If necessary, change the search settings by selecting the "Search Config" soft-
key.

3. Center the display around the determined signal point by setting the marker value
to the center frequency. Select the "Center = Mkr Freq" softkey.
4. Determine the precise frequency of the signal point:

a) Select the "Select Marker Function" softkey.

b) Select the "Signal Count" button.

c) Select the "Signal Count Resolution" softkey.

d) Select the resolution depending on how precise the result needs to be.

How to Use a Fixed Reference Marker

By default, delta markers refer to marker 1. However, they can also refer to a fixed ref-
erence marker.
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How to Define and Move a Fixed Reference Marker

1.

2.

To display a fixed reference marker, do one of the following:

e Press the MKR FUNC key, then select the "Reference Fixed" marker function.
e In the "Marker" dialog box, in the "Reference Fixed" area of the "Marker Config
tab, set the "State" to "On" .

A vertical and a horizontal red display line are displayed, marked as "FXD" . The
normal marker 1 is activated and set to the peak value of the trace assigned to
marker 1, and a delta marker to the next peak. The fixed reference marker is set to
the position of marker 1 at the peak value.

To move the fixed reference marker, do one of the following:

e Change the "Level" and "Frequency" of the reference point in the "Marker Con-
fig" tab of the "Marker" dialog box, . By default, the current peak value of trace
1is set.

e Set the fixed reference marker to the current peak value by selecting the "Peak
Search" button in the "Marker Config" tab of the "Marker" dialog box.

e Move the "FXD" display lines that define the position of the fixed reference
marker by dragging them on the screen.

How to Assign a Fixed Reference Marker to Delta Markers

1.
2.

In the "Marker" dialog box, select the horizontal "Markers" tab.

For the active delta marker that is to refer to the fixed reference marker, select
"FXD" from the "Reference Marker" list.

The delta marker indicates the offset of the current trace value at the marker posi-
tion from the fixed reference value.

Measurement Example: Measuring Harmonics Using Marker Func-
tions

This measurement example describes how to measure harmonics using the provided
marker functions. Note that this task can be performed much simpler using the Har-
monic Distortion measurement (see Chapter 6.9, "Harmonic Distortion Measurement",
on page 280).

Signal generator settings (e.g. R&S FPS SMW):

Frequency: 128 MHz
Level: -25dBm
Procedure:

1.
2.

Preset the R&S FPS.

Set the center frequency to 128 MHz.
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3. Setthe span to 100 kHz.
The R&S FPS displays the reference signal with a span of 100 kHz and resolution
bandwidth of 1 kHz.

4. Switch on the marker by pressing the MKR key.
The marker is positioned on the trace maximum.

5. Set the measured signal frequency and the measured level as reference values:

a) Press the MKR FUNC key
b) Press the "Reference Fixed" softkey.

The position of the marker becomes the reference point. The reference point level
is indicated by a horizontal line, the reference point frequency with a vertical line.
At the same time, the delta marker 2 is switched on.

1 Frequency Sweep

CF 30.0 MH:z Span 40.0 MHz

A SRR A T AT

Trc Stimulus Response Function Function Result
30.0 MHz =27.07 dBm
30.0 MHz -27.07 dBm
3.397 MHz -57.06 dB

Figure 8-7: Fundamental wave and the frequency and level reference point

6. Make the step size for the center frequency correspond to the signal frequency: in
the "Frequency" configuration dialog box, select "Center Frequency Stepsize" =
"Marker" .

The step size for the center frequency is now equal to the marker frequency.

7. Move the center frequency to the 2" harmonic of the signal by pressing the UP (4+)
key.

The center frequency is set to the 2" harmonic.

8. Place the delta marker on the 2" harmonic: in the "Marker To" menu, select the
"Peak" softkey.

The delta marker moves to the maximum of the 2" harmonic. The displayed level
result is relative to the reference point level (= fundamental wave level).

|
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8.41

8.411

8.4.1.2

Display and Limit Lines

The other harmonics are measured by repeating steps step 7 and step 8, with the cen-
ter frequency being incremented or decremented in steps of 128 MHz using the UP or
DOWN keys.

Display and Limit Lines

Display and limit lines help you analyze a measurement trace.
Access: "Overview" > "Analysis" > "Lines"

For remote operation, see Chapter 12.8.4, "Configuring Display and Limit Lines",
on